Photoshop Elements 12 FOR DUMMIES

Learn to:

- Identify and fix the most common digital photo problems
- Edit and crop images, enhance color, and sharpen photos
- Organize photos with albums and tags

IN FULL COLOR!

Barbara Obermeier
Ted Padova

www.allitebooks.com
Get More and Do More at Dummies.com®

Start with FREE Cheat Sheets

Cheat Sheets include
- Checklists
- Charts
- Common Instructions
- And Other Good Stuff!

To access the Cheat Sheet created specifically for this book, go to www.dummies.com/cheatsheet/photoshopelements12

Get Smart at Dummies.com

Dummies.com makes your life easier with 1,000s of answers on everything from removing wallpaper to using the latest version of Windows.

Check out our
- Videos
- Illustrated Articles
- Step-by-Step Instructions

Plus, each month you can win valuable prizes by entering our Dummies.com sweepstakes. *

Want a weekly dose of Dummies? Sign up for Newsletters on
- Digital Photography
- Microsoft Windows & Office
- Personal Finance & Investing
- Health & Wellness
- Computing, iPods & Cell Phones
- eBay
- Internet
- Food, Home & Garden

Find out “HOW” at Dummies.com

*Sweepstakes not currently available in all countries; visit Dummies.com for official rules.

www.allitebooks.com
Contents at a Glance

**Introduction** ................................................................. 1

**Part I: Organizing and Editing Images** .................. 5
 Chapter 1: Getting Your Images .................................................. 7
 Chapter 2: Getting to Know the Editing Work Areas .................. 29
 Chapter 3: Getting Ready to Edit ............................................. 59
 Chapter 4: Working with Resolutions, Color Modes, and File Formats .... 71

**Part II: Managing Media** ........................................ 99
 Chapter 5: Tagging Photos and Creating Albums ...................... 101
 Chapter 6: Viewing and Finding Your Images .......................... 119

**Part III: Selecting and Correcting Photos** .......... 145
 Chapter 7: Making and Modifying Selections ......................... 147
 Chapter 8: Working with Layers ............................................ 177
 Chapter 9: Simple Image Makeovers ..................................... 199
 Chapter 10: Correcting Contrast, Color, and Clarity ................ 235

**Part IV: Exploring Your Inner Artist** ................. 267
 Chapter 11: Playing with Filters, Effects, Styles, and More ........ 269
 Chapter 12: Drawing and Painting ......................................... 307
 Chapter 13: Working with Type ............................................. 333

**Part V: Printing, Creating, and Sharing** .......... 351
 Chapter 14: Getting It on Paper ............................................. 353
 Chapter 15: Sharing Your Work ............................................ 369
 Chapter 16: Making Creations .............................................. 387

**Part VI: The Part of Tens** ........................................ 399
 Chapter 17: Ten Tips for Composing Better Photos ............... 401
 Chapter 18: Ten More Project Ideas ...................................... 407

**Index** ............................................................................. 413
# Table of Contents

**Introduction** ............................................................................................................. 1
- Conventions Used in This Book ............................................................................. 1
- Icons Used in This Book ........................................................................................ 2
- Beyond the Book ....................................................................................................... 3
- Where to Go from Here ............................................................................................ 3

**Part 1: Organizing and Editing Images** ................................................................. 5

**Chapter 1: Getting Your Images** ............................................................ 7
- Organizing Photos and Media on a Hard Drive ..................................................... 8
- Launching Photoshop Elements ........................................................................... 9
- Adding Images to the Organizer .......................................................................... 10
  - Adding files from folders and removable media ............................................... 11
  - Downloading images from your camera with the Elements Downloader .. 13
  - Importing additional photos from folders ...................................................... 14
  - Getting photos from iPhoto (Mac only) ........................................................... 16
- Understanding the Media Browser ....................................................................... 17
  - Viewing images in the Media Browser ........................................................... 17
  - Adding people in the Media Browser ............................................................... 18
- Using a Scanner ....................................................................................................... 21
  - Understanding image requirements .................................................................. 21
  - Using scanner plug-ins (Windows) .................................................................... 22
  - Scanning on the Mac .......................................................................................... 24
  - Scanning many photos at a time ....................................................................... 24
  - Phoning In Your Images .................................................................................... 25

**Chapter 2: Getting to Know the Editing Work Areas** ................................. 29
- Launching the Photo Editor .................................................................................... 30
- Examining the Photo Editor .................................................................................. 32
  - Examining the image window .......................................................................... 34
  - Moving through the menu bar .......................................................................... 38
  - Uncovering the contextual menus .................................................................... 39
  - Using the Tools panel ......................................................................................... 40
  - Selecting from the Tool Options ....................................................................... 42
  - Playing with panels ............................................................................................ 42
Using the Photo Bin ................................................................. 45
  Creating different views of an image .................................. 46
  Viewing filenames ............................................................... 46
  Using Panel Bin Actions ..................................................... 46
Creating Images from Scratch .................................................. 47
Using Quick Mode ................................................................. 49
Using Guided Mode ............................................................... 51
  Using Guided mode ............................................................ 52
  Exploring the Guided options ............................................. 53
Retracing Your Steps ............................................................. 54
  Using the Undo History panel ............................................. 55
  Reverting to the last save ................................................... 56
Getting a Helping Hand ........................................................... 56

Chapter 3: Getting Ready to Edit ................................................. 59
  Controlling the Editing Environment .................................... 59
    Launching and navigating preferences ............................... 60
    Checking out all the preferences panes ............................ 61
  Controlling the Organizer Environment ............................... 63
    Navigating Organizer preferences ................................... 63
    Setting preferences in all the panes ................................ 64
  Customizing Presets ............................................................ 65
  Getting Familiar with Color .................................................. 66
    Color the easy way .......................................................... 67
    Calibrating your monitor ................................................ 68
    Choosing a color workspace ............................................. 69
    Understanding how profiles work .................................... 69

Chapter 4: Working with Resolutions, Color Modes, and File Formats ................................................. 71
  Grappling with the Ubiquitous Pixels .................................... 72
    Understanding resolution ................................................ 73
    Understanding image dimensions ................................... 75
  The Art of Resampling ........................................................ 76
    Changing image size and resolution ................................. 76
    Understanding the results of resampling ........................... 78
  Choosing a Resolution for Print or Onscreen ........................ 80
  Go Ahead — Make My Mode! ............................................... 81
    Converting to Bitmap mode ............................................. 81
    Converting to Grayscale mode ....................................... 84
    Converting to Indexed Color mode .................................. 87
  Saving Files with Purpose .................................................. 87
    Using the Save/Save As dialog box ................................... 88
    Saving files for the web .................................................. 89
# Table of Contents

Understanding file formats .............................................................. 91
File formats at a glance ................................................................. 95
Audio and video formats supported in Elements ......................... 97

## Part II: Managing Media ............................................................... 99

### Chapter 5: Tagging Photos and Creating Albums ...................... 101
- Touring the Organizer ............................................................... 102
- Organizing Groups of Images with Tags .................................... 105
  - Creating and viewing a tag .................................................... 106
  - Adding icons to tags ............................................................ 107
  - Working with custom tags .................................................... 109
  - Working with default tags ................................................... 110
  - Working with subcategories .................................................. 111
  - Sorting photos according to tags .......................................... 111
- Creating Albums ........................................................................ 112
- Rating images .......................................................................... 113
- Adding rated files to an album ................................................ 114
- Editing an album ..................................................................... 116
- Finding out more about sharing your albums ........................... 117

### Chapter 6: Viewing and Finding Your Images .......................... 119
- Cataloging Files ........................................................................ 120
  - Using the Catalog Manager .................................................. 120
  - Working with catalogs ......................................................... 122
  - Backing up your catalog ...................................................... 122
  - Backing up photos and files (Windows) ................................. 124
- The Many Faces of the Organizer ............................................. 124
  - Using the View menu ........................................................... 124
  - Comparing the Organizer on Windows and the Mac ............. 125
- Viewing Photos in a Slide Show (Full Screen View) .................... 126
  - Taking a quick view of the slide show ................................... 126
  - Working with the Edit and Organize tools ............................. 128
  - Using the Slideshow toolbar ................................................ 129
  - Exploring more options in context menus ............................. 130
- Placing Pictures on Maps ......................................................... 131
- Working with Events ............................................................... 133
- Using Search Options .............................................................. 134
  - Using Search ........................................................................ 134
  - Advanced Search Options ................................................... 134
  - Searching by date ............................................................... 136
  - Searching for untagged items .............................................. 136
  - Searching captions and notes .............................................. 137

www.allitebooks.com
Photoshop Elements 12 For Dummies

Searching by history ................................................................. 137  
Searching metadata ................................................................. 138  
Searching similarities .............................................................. 139  
Grouping Files That Get in the Way ........................................ 141  
Marking files as hidden ......................................................... 141  
Stacking ’em up ..................................................................... 142  
Creating versions .................................................................. 143  

Part III: Selecting and Correcting Photos ......................... 145

Chapter 7: Making and Modifying Selections .......................... 147

Defining Selections ................................................................. 147  
Creating Rectangular and Elliptical Selections ...................... 148  
  Perfecting squares and circles with Shift and Alt or Option .... 149  
  Applying Marquee options .................................................. 150  
Making Freeform Selections with the Lasso Tools .................. 152  
  Selecting with the Lasso tool .............................................. 152  
  Getting straight with the Polygonal Lasso tool ................... 153  
  Snapping with the Magnetic Lasso tool ............................... 155  
Working Wizardry with the Magic Wand ............................... 157  
  Talking about Tolerance ...................................................... 157  
  Wielding the Wand to select ............................................... 157  
Modifying Your Selections ...................................................... 159  
  Adding to, subtracting from, and intersecting a selection .... 160  
  Avoiding key collisions ...................................................... 160  
Painting with the Selection Brush ........................................... 161  
Painting with the Quick Selection Tool ................................ 163  
Resizing Smartly with the Recompose Tool ............................ 165  
Working with the Cookie Cutter Tool ................................... 167  
Eliminating with the Eraser Tools ......................................... 168  
  The Eraser tool .................................................................... 169  
  The Background Eraser tool ............................................... 169  
  The Magic Eraser tool ........................................................ 171  
Using the Select Menu ............................................................ 171  
  Selecting all or nothing ....................................................... 171  
  Reselecting a selection ....................................................... 172  
  Inversing a selection ........................................................... 172  
  Feathering a selection ......................................................... 172  
  Refining the edges of a selection ........................................ 173  
  Using the Modify commands .............................................. 174  
  Applying the Grow and Similar commands ....................... 175  
  Saving and loading selections .......................................... 175
# Table of Contents

## Chapter 8: Working with Layers ................................. 177

- Getting to Know Layers .................................................. 178
- Converting a background to a layer .................................. 179
- Anatomy of the Layers panel ........................................... 179
- Using the Layer and Select menus .................................... 182

## Working with Different Layer Types .......................... 183

- Image layers .................................................................. 183
- Adjustment layers .......................................................... 184
- Fill layers ...................................................................... 186
- Shape layers ................................................................... 187
- Type layers ..................................................................... 188

## Tackling Layer Basics .................................................. 188

- Creating a new layer from scratch .................................... 188
- Using Layer via Copy and Layer via Cut ............................ 189
- Duplicating layers ........................................................... 190
- Dragging and dropping layers ......................................... 190
- Using the Paste into Selection command ......................... 191

## Moving a Layer’s Content .............................................. 192

## Transforming Layers ..................................................... 193

## Adding Layer Masks ...................................................... 194

## Flattening and Merging Layers ...................................... 195

- Flattening layers ............................................................. 196
- Merging layers ............................................................... 197

## Chapter 9: Simple Image Makeovers ............................ 199

## Cropping and Straightening Images ............................... 199

- Cutting away with the Crop tool ...................................... 200
- Cropping with a selection border ..................................... 203
- Straightening images ....................................................... 203

## Recomposing Images ..................................................... 204

## Employing One-Step Auto Fixes ..................................... 206

- Auto Smart Tone ............................................................. 207
- Auto Smart Fix ............................................................... 208
- Auto Levels ................................................................. 209
- Auto Contrast ............................................................... 210
- Auto Color Correction .................................................... 210
- Auto Sharpen ............................................................... 211
- Auto Red Eye Fix .......................................................... 212

## Editing in Quick Mode .................................................... 213

## Fixing Small Imperfections with Tools ......................... 217

- Cloning with the Clone Stamp tool ................................... 218
- Retouching with the Healing Brush .................................. 220
- Zeroing in with the Spot Healing Brush ......................... 222
- Repositioning with the Content-Aware Move tool ............ 224
Photoshop Elements 12 For Dummies

Lightening and darkening with Dodge and Burn tools........................................225
Smudging away rough spots........................................................................227
Softening with the Blur tool........................................................................228
Focusing with the Sharpen tool....................................................................229
Sponging color on and off...........................................................................230
Replacing one color with another.................................................................231

Chapter 10: Correcting Contrast, Color, and Clarity.....................................235

Editing Your Photos Using a Logical Workflow.............................................236
Adjusting Lighting.......................................................................................237
  Fixing lighting with Shadows/Highlights..................................................237
  Using Brightness/Contrast........................................................................238
  Pinpointing proper contrast with Levels..................................................239
Adjusting Color............................................................................................242
  Removing color casts automatically..........................................................242
  Adjusting with Hue/Saturation................................................................243
  Eliminating color with Remove Color.......................................................245
  Switching colors with Replace Color........................................................246
Correcting with Color Curves........................................................................248
Adjusting skin tones....................................................................................250
Defringing layers..........................................................................................251
Adjusting color temperature with photo filters.........................................252
Mapping your colors....................................................................................253
Adjusting Clarity...........................................................................................254
  Removing noise, artifacts, dust, and scratches.........................................255
  Blurring when you need to.......................................................................256
  Sharpening for better focus......................................................................259
Working Intelligently with the Smart Brush Tools........................................262

Part IV: Exploring Your Inner Artist............................................................267

Chapter 11: Playing with Filters, Effects, Styles, and More..........................269

Having Fun with Filters..............................................................................270
Applying filters.............................................................................................270
Corrective or destructive filters....................................................................271
One-step or multistep filters........................................................................271
Fading a filter...............................................................................................272
Selectively applying a filter..........................................................................272
Working in the Filter Gallery........................................................................273
Distorting with the Liquify filter....................................................................275
Correcting Camera Distortion......................................................................278
Chapter 12: Drawing and Painting ............................................ 307
Choosing Color ........................................................................ 307
   Working with the Color Picker ................................................. 308
   Dipping into the Color Swatches panel ................................... 309
   Sampling with the Eyedropper tool ........................................... 311
Getting Artsy with the Pencil and Brush Tools ......................... 312
   Drawing with the Pencil tool .................................................... 312
   Painting with the Brush tool .................................................... 314
   Using the Impressionist Brush ................................................ 316
   Creating your own brush ....................................................... 317
Filling and Outlining Selections ................................................ 317
   Fill 'er up ............................................................................ 318
   Outlining with the Stroke command ....................................... 319
Splashing On Color with the Paint Bucket Tool ......................... 320
Working with Multicolored Gradients ....................................... 321
   Applying a preset gradient ...................................................... 321
   Customizing gradients .......................................................... 323
Working with Patterns ............................................................. 325
   Applying a preset pattern ........................................................ 325
   Creating a new pattern .......................................................... 326
Photoshop Elements 12 For Dummies

Creating Shapes of All Sorts .......................................................... 327
  Drawing a shape ............................................................................ 328
  Drawing multiple shapes ............................................................. 329
  Specifying Geometry options ...................................................... 330
  Editing shapes ............................................................................. 331

Chapter 13: Working with Type ...................................................... 333
  Understanding Type Basics ......................................................... 333
    Tools .......................................................................................... 334
    Modes ......................................................................................... 334
  Formats ......................................................................................... 335
  Creating Point Type ...................................................................... 335
  Creating Paragraph Type ............................................................. 337
  Creating Path Type ........................................................................ 338
    Using the Text On Selection tool ............................................... 338
    Using the Text On Shape tool .................................................... 339
    Using the Text On Custom Path tool ......................................... 341
  Specifying Type Options ............................................................. 342
  Editing Text .................................................................................. 344
  Simplifying Type .......................................................................... 345
  Masking with Type ........................................................................ 345
  Stylizing and Warping Type ........................................................ 347
    Adjusting type opacity ............................................................... 348
    Applying filters to your type ...................................................... 348
    Painting your type with color and gradients ................................ 349
    Warping your type ................................................................. 350

Part V: Printing, Creating, and Sharing ....................................... 351

Chapter 14: Getting It on Paper ...................................................... 353
  Getting Pictures Ready for Printing .......................................... 354
  Working with Color Printer Profiles ........................................... 355
    Printing a photo with the printer managing color ................... 356
    Printing a photo with Elements managing color ...................... 362
  Getting Familiar with the Print Dialog Box .................................. 364
    Using Page Setup ......................................................................... 367
    Using More Options ..................................................................... 367
  Exploring Other Print Options ................................................... 368

Chapter 15: Sharing Your Work ...................................................... 369
  Getting Familiar with the Elements Sharing Options ............... 369
  Planning ahead ............................................................................. 370
  Understanding social media websites ....................................... 371
  Working with Adobe Revel ......................................................... 373
  Knowing what Adobe Revel offers you ...................................... 373
  Downloading the Adobe Revel applications (Mac only) .......... 374
Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the Adobe Revel interface</td>
<td>374</td>
</tr>
<tr>
<td>Editing a photo with Revel</td>
<td>377</td>
</tr>
<tr>
<td>Sharing photos with Adobe Revel</td>
<td>379</td>
</tr>
<tr>
<td>Working with Revel Carousels and Photoshop.com libraries</td>
<td>380</td>
</tr>
<tr>
<td>Using the Share Panel</td>
<td>381</td>
</tr>
<tr>
<td>E-mailing photos</td>
<td>382</td>
</tr>
<tr>
<td>Working with Adobe Premiere Elements</td>
<td>383</td>
</tr>
<tr>
<td>Sharing your photos on social networks</td>
<td>384</td>
</tr>
<tr>
<td>Chapter 16: Making Creations</td>
<td>387</td>
</tr>
<tr>
<td>Getting a Grip on Creations</td>
<td>387</td>
</tr>
<tr>
<td>Grasping Creation-Assembly Basics</td>
<td>388</td>
</tr>
<tr>
<td>Creating a Slide Show (Windows Only)</td>
<td>392</td>
</tr>
<tr>
<td>Creating a Slide Show project (Windows)</td>
<td>393</td>
</tr>
<tr>
<td>Exporting to slides and video</td>
<td>396</td>
</tr>
<tr>
<td>Making Additional Creations</td>
<td>398</td>
</tr>
<tr>
<td>Part VI: The Part of Tens</td>
<td>399</td>
</tr>
<tr>
<td>Chapter 17: Ten Tips for Composing Better Photos</td>
<td>401</td>
</tr>
<tr>
<td>Find a Focal Point</td>
<td>401</td>
</tr>
<tr>
<td>Use the Rule of Thirds</td>
<td>402</td>
</tr>
<tr>
<td>Cut the Clutter</td>
<td>402</td>
</tr>
<tr>
<td>Frame Your Shot</td>
<td>403</td>
</tr>
<tr>
<td>Employ Contrast</td>
<td>403</td>
</tr>
<tr>
<td>Experiment with Viewpoints</td>
<td>403</td>
</tr>
<tr>
<td>Use Leading Lines</td>
<td>404</td>
</tr>
<tr>
<td>Use Light</td>
<td>404</td>
</tr>
<tr>
<td>Give Direction</td>
<td>405</td>
</tr>
<tr>
<td>Consider Direction of Movement</td>
<td>406</td>
</tr>
<tr>
<td>Chapter 18: Ten More Project Ideas</td>
<td>407</td>
</tr>
<tr>
<td>Screen Savers</td>
<td>407</td>
</tr>
<tr>
<td>Flyers, Ads, and Online Auctions</td>
<td>408</td>
</tr>
<tr>
<td>Clothes, Hats, and More</td>
<td>410</td>
</tr>
<tr>
<td>Posters</td>
<td>410</td>
</tr>
<tr>
<td>Household and Business Inventories</td>
<td>411</td>
</tr>
<tr>
<td>Project Documentation</td>
<td>411</td>
</tr>
<tr>
<td>School Reports and Projects</td>
<td>411</td>
</tr>
<tr>
<td>Blogs</td>
<td>411</td>
</tr>
<tr>
<td>Wait — There’s More</td>
<td>412</td>
</tr>
<tr>
<td>Index</td>
<td>413</td>
</tr>
</tbody>
</table>
We live in a photo world. And Photoshop Elements has become a tool for both professional and amateur photographers who want to edit, improve, manage, manipulate, and organize photos and other media. Considering the power and impressive features of the program, Elements remains one of the best values for your money among computer software applications.

This book is an effort to provide as much of a comprehensive view of a wildly feature-rich program as we can. Additionally, this book is written for a cross-platform audience. If you’re a Macintosh user, you’ll find all you need to work in Elements 12 for the Mac, including support for placing photos on maps and more consistency with Windows features.

Elements is overflowing with features, and we try to offer you as much as possible within a limited amount of space. We begged for more pages, but alas, our publisher wants to get this book in your hands in full color and with an attractive price tag. Therefore, even though we may skip over a few little things, all you need to know about using Photoshop Elements for designing images for print, sharing, the web, versatile packaging, e-mailing, and more is covered in the pages ahead. If you still crave more, take a look at our *Adobe Photoshop Elements 12 All-in-One For Dummies*, where you can find more comprehensive coverage of Photoshop Elements 12.

Because Photoshop Elements has something for just about everyone, we know that our audience is large and also that not everyone will use every tool, command, or method we describe. We offer many cross-references throughout in case you want to jump around. You can go to just about any chapter and start reading. If a concept needs more explanation, we point you in the right direction for getting some background.

**Conventions Used in This Book**

Throughout this book, especially in step lists, we point you to menus for keyboard commands. For accessing a menu command, you may see something like this:

Choose File ➪ Get Photos ➪ From Files and Folders.

You click the File menu to open its drop-down menu, click the menu command labeled Get Photos, and then choose the command From Files and Folders from the submenu that appears. It’s that simple.
We also refer to *context menus*, which jump up at your cursor position and shows you a menu of options related to whatever you’re doing at the time. These menus look like the ones you select from the top of the Elements workspace. To open a context menu, just right-click the mouse, or Control-click on a Mac if you don’t have a two-button mouse.

When we mention that keys need to be pressed on your keyboard, the text looks like this:

Press Alt+Shift+Ctrl+S (Option+Shift+ calloc+S on the Mac).

In this case, you hold down the Alt key on Windows/the Option key on the Mac, then the Shift key, then the Control key on Windows/the calloc key on the Mac, and then press the S key. Then release all the keys at the same time.

**Icons Used in This Book**

In the margins throughout this book, you see icons indicating something important.

This icon informs you that this item is a new feature in Photoshop Elements 12.

Pay particular attention when you see the Warning icon. This icon indicates possible side effects or damage to your image that you might encounter when performing certain operations in Elements.

This icon is a heads-up for something you may want to commit to memory. Usually, it tells you about a shortcut for a repetitive task, where remembering a procedure can save you time.

A Tip tells you about an alternative method for a procedure, giving you a shortcut, a workaround, or some other type of helpful information.

Elements is a computer program, after all. No matter how hard we try to simplify our explanation of features, we can’t entirely avoid some technical information. If a topic is a little on the technical side, we use this icon to alert you that we’re moving into a complex subject. You won’t see many of these icons in the book because we try our best to give you the details in nontechnical terms.
Beyond the Book

We have online content that you can enjoy in conjunction with this book:

✓ **Cheat Sheet:** The Cheat Sheet for this book includes a detailed look at the Elements photo editing workspace, Tools Panel shortcuts, and tricks for selecting objects, and more.

   www.dummies.com/cheatsheet/photoshopelements12

✓ **Online articles:** We couldn’t fit everything we wanted into this book, so you can find additional content here:

   www.dummies.com/extras/photoshopelements12

   A few of the topics covered are organizing and importing photos, dynamically updating saved searches, finding and loading actions, and adjusting brightness/contrast with the Smart Brush tool. But there’s much more than these few topics. Be sure to check these out.

Where to Go from Here

Try to spend a little time reading through the four chapters in Part I. After you know how to acquire photos and organize them, feel free to jump around and pay special attention to the cross-referenced chapters, in case you get stuck on a concept. When you need a little extra help, check out Chapter 2, where we talk about using the online help documents available in Elements.

We hope you have much success and enjoyment in using Adobe Photoshop Elements 12, and it’s our sincere wish that the pages ahead provide you with an informative and helpful view of the program.
Part I
Organizing and Editing Images

getting started with
Photoshop Elements

For Dummies can help you get started with lots of subjects. Visit www.dummies.com to learn more.
In this part . . .

- Open Photoshop Elements.
- Import your photos from a digital camera, hard drive, iPad, iPod, iPhone, or scanner.
- Take a tour of the Photo Editor and discover the many different editing opportunities you have with Elements.
- Learn the essential image attributes to help you properly edit photos in the Photo Editor.
Getting Your Images

In This Chapter

▶ Organizing your photos on your computer
▶ Launching Photoshop Elements
▶ Importing photos into the Organizer
▶ Scanning photos and artwork
▶ Working with online services
▶ Acquiring photos from cellphones

Before you begin anything in Photoshop Elements, your first job is to handle organizing photos on your hard drive. We begin by looking at some options for organizing images before you first launch the program.

You can’t do much in Photoshop Elements until you bring in some pictures to work on. Therefore we begin by discussing importing images into the Elements Organizer. You have many different ways to import a picture into Elements, where you can play with it, experiment on it, and edit it. If you have a digital camera, you’re in the right place; we walk you through an easy method for importing images from cameras and card readers into the Organizer.

If you have a digital scanner, you’re in the right place, too, because we also talk about scanning photos. If you have CDs, sources of files on the Internet, some massive collection of images written to a DVD, or even a picture or two that you took with your cellphone, you’re still in the right place!

This chapter covers all you need to know about bringing images into Elements from all kinds of sources, and we explain how to move around the workspaces to get your files into Elements.
Organizing Photos and Media on a Hard Drive

Over the past decade, photos and media have become the primary data source on the average consumer’s computer. We grab a ton of images with our digital cameras and smartphones, import videos from cameras and phones, and capture both photos and other media with tablets. With Facebook claiming over one billion users, you can easily understand how important photos are to computer users.

For many people, a single internal hard drive doesn’t offer enough space to store their cherished memories, whether in the form of pictures, videos, or audio files. People need more storage space, and they need to organize their files, first on hard drives and then later in Photoshop Elements.

Fortunately, the price of large-capacity drives is well within the reach of most people who own a computer, digital camera, and smartphone. One of the best things you can do to accommodate your photography collection is to invest in a 1 to 3TB USB drive and attach it to your computer. Use the drive only for your photos, videos, and other media, and don’t copy other data files to it. You can always disconnect a USB drive and use another drive for other kinds of data files. For more demanding uses, you can buy a single or dual docking station for $20 to $35 and swap hard drives costing around $65 for 1TB drives.

Even if you store photos on your computer’s internal hard drive, organizing the photos in folders will help you manage them efficiently before you get into the Elements Organizer. Regardless of whether you follow our advice for storing your photos on a separate drive, you should look at organizing files in folders before you start working with Elements. How you label your folders is a personal choice. You may want to name the folders by years and use subfolders for organizing photos by events, locations, photo content, and so on. In Figure 1-1, you can see just one example of how you might organize your photos on a hard drive. For most

Figure 1-1: Organize photos and media in folders and subfolders on your hard drive.
Chapter 1: Getting Your Images

folks, photos with people are the most important photos. You may want to organize your photos differently, but organizing photos of people is one of our preferred methods. After you organize your photos into folders, you can use the command to import files from folders, as we explain later, in the section “Adding files from folders and removable media.”

As you find out in this chapter, your initial arrangement of folders and subfolders for your photos and media makes the enormous task of organizing content much easier in Photoshop Elements. For detailed steps on importing and organizing your photos, see our web extras at www.dummies.com/extras/photoshopelements12.

Launching Photoshop Elements

Photoshop Elements has two separate components: the Organizer and Photo Editor mode. The Organizer is where you manage photos, and Photo Editor mode is where you correct photos for brightness and color, add effects, repair images, and so on.

By default, the Adobe Photoshop Elements 12 icon appears on your desktop (Windows) or on the Dock (Mac) after installation; you can click the icon to launch the Photoshop Elements Welcome screen. In the Welcome screen, you can choose to visit the Organizer or Photo Editor mode.

Note that you have two buttons on the Welcome screen. The first is labeled Organizer. The other button is labeled Photo Editor. Click the Organizer button to open the Photoshop Elements Organizer. The Organizer is your central Photoshop Elements media file cabinet where all your imported images, videos, sound files, and PDF documents are displayed in the current catalog file. We talk more about catalog files in Chapter 6. The Photo Editor button is used to open Photo Edit mode. We talk more about this mode elsewhere, beginning in Chapter 2.

Look over the Welcome screen and browse the information provided. Here you find links to information and help in using Photoshop Elements.

Both the Organizer and the Photo Editor are workspaces. In this chapter, you take a look at the Organizer. (In Chapter 2, you look at the Photo Editor that you enter when clicking the Photo Editor button.) You open a workspace from the Welcome screen. For the purposes of this chapter, click Organizer to open the Photoshop Elements Organizer, shown in Figure 1-2.

If you’re new to Photoshop Elements, you see an empty Media Browser — this is the central panel in the Organizer. If you’re a new user, you should be looking at a window containing no image thumbnails. You find out how to add images to the Organizer in the next section.
If you're upgrading from a previous version of Photoshop Elements, you're prompted to convert a previous catalog. (We talk about catalogs in Chapter 6.)

If you already use a previous version of Elements, you know how to import images, so just skim the rest of this chapter to find out what’s new.

![Figure 1-2: The Photoshop Elements Organizer window.](image)

Adobe Revel — the link to it is on the left side of the Welcome screen — is an online photo sharing service that replaces the former Photoshop.com photo sharing service. To learn more about Adobe Revel and share your pictures on this service, see Chapter 15.

**Adding Images to the Organizer**

To edit photos in Photoshop Elements, you need to download your images from your camera to your computer’s hard drive and then import photos you want to edit into the Photoshop Elements Organizer.
You have several options for downloading photos from your camera and other sources to your computer:

- Using AutoPlay Wizards for Windows and Assistants on the Mac
- Importing photos directly from iPhoto if you use a Mac
- Using the Photoshop Elements Downloader

The built-in downloaders from your operating system attempt to make your life easier, but in reality, it may be more difficult to struggle with a downloader application and later organize files in folders (as we recommend earlier in this chapter).

Perhaps the easiest method for transferring photos from a camera or card reader is to cancel out of the operating system’s downloader application or any camera-specific applications and just stay with the tools that Photoshop Elements provides you.

The following sections introduce you to the tools available for adding images to the Organizer. If you’ve already organized images on your hard drive or other media into folders, the Get Files from Folders command (explained in the first section) can help. If images are still on your camera, the Elements Downloader enables you to download images from your camera into the folder where you want to keep the images, using whatever folder organization system you’ve created; the Elements Downloader also imports the images into the Organizer at the same time.

### Adding files from folders and removable media

Most people have photos on their computer’s hard drive, as well as on removable media, such as CDs or maybe even a USB flash drive. Adding images from your hard drive is easy. If you have a source such as a USB flash drive or a CD, you copy files from the source to the drive where you store photos, or you can copy files into the Organizer directly from the removable media.

The following steps explain how to import images from your hard drive into the Organizer Media Browser:

1. **Click the Import button in the top-left corner of the Organizer to open the drop-down menu and choose From Files and Folders.**

   Alternatively, you can open the File menu and choose Get Photos and Videos ➤ From Files and Folders. You can also press Ctrl+Shift+G (⌘+Shift+G on the Mac).
The Get Photos and Videos from Files and Folders dialog box opens, as shown in Figure 1-3.

![Image](image.png)

**Figure 1-3:** Choose File ➪ Get Photos and Videos ➪ From Files and Folders to import photos into the Organizer.

2. **Browse your hard drive for the photos you want to add.**

   You can import individual images, a single folder of photos, or a folder and all its subfolders.

3. **Select files or a folder and click Get Media.**

When you add files to the Organizer, the image thumbnails are links to the files stored on your drive. They aren’t the complete image data. Your catalog in Elements grows as you add more images, but the growth is miniscule compared with the photo file sizes.

To copy files from CDs, DVDs, or a USB flash drive, you can open the external device and drag photos to your hard drive. You can also choose File ➪ Get Photos and Videos ➪ From Files and Folders and import photos directly from the external device. By default, the Get Photos and Videos from Files and Folders dialog box copies your media to your hard drive when you click the Get Media button. You can deselect the Copy Files on Import check box so that only thumbnail images will appear in the Media Browser. To edit a photo, you have to reconnect the CD or DVD to your computer. If you elect to copy the images, the photos are available for editing each time you start a new Elements session.
Chapter 1: Getting Your Images

**Downloading images from your camera with the Elements Downloader**

Import photos from your camera to the Organizer as follows:

1. **Insert a media card from a camera or attach a camera to your computer via a USB port.**

   We recommend using a media card instead of attaching your camera, in case the battery is low on your camera. (If the battery runs out, the import stops.) If you have a media card for your camera, take it out and insert it into a card reader that you attach to your computer via a USB port or a built-in card reader in your computer.

2. **If you see an Autoplay Wizard on Windows or a dialog box for importing photos into iPhoto on the Mac, cancel out of the dialog box and let Elements control your import.**

3. **In Elements, open the Organizer workspace and choose Import ➪ From Files and Folders, or choose File ➪ Get Photos and Videos from Camera or Card Reader, or press Ctrl+G (⌘+G on the Mac).**

   The Elements Organizer – Photo Downloader opens, as shown in Figure 1-4.

---

**Figure 1-4**: Choose File ➪ Get Photos and Videos ➪ From Camera or Card Reader, and the Elements Organizer – Photo Downloader opens.
4. In the Photo Downloader, open the drop-down menu at the top of the dialog box and choose your media card.

5. Click the Browse button and locate the folder on your drive to which you want to copy the photos.

If you don’t click the Browse button and select a folder, all files copied to your hard drive are copied to the User Pictures folder. This is the default for Photoshop Elements. If you use an external hard drive to store your photos, you’ll want to copy photos to the external drive. When you select a folder, select the one that fits the overall folder organizational structure for your images so your image files stay organized.

We recommend leaving the rest of the settings at the defaults. Don’t rename the photos here. You can take care of file renaming in the Organizer later. Don’t delete the photos from your card just in case you delete some photos in the Organizer and want to retrieve them. After you’re certain everything in Elements is to your liking, you can later delete photos by using your camera.

There’s an Advanced dialog box for the Downloader that you access by clicking the Advanced Dialog button. In the Advanced settings, you can make choices for things like correcting for red-eye, creating photo stacks, and editing photo data that we call metadata. (We explain this in Chapter 6.) Because you can handle all these tasks in Elements, just leave the Advanced settings at their defaults.

6. Import photos by clicking the Get Media button in the Photo Downloader dialog box.

Elements adds the photos to the Organizer, and you eventually see thumbnail images in the Organizer’s Media Browser after the upload is completed.

**Importing additional photos from folders**

Suppose you have your folders organized and photos copied to various folders. You take some more pictures of family members and want to add these photos to a folder you already have labeled as Family. To add pictures to a folder on your hard drive, follow these steps:

1. **Copy photos from a CD, a media card, or an external media drive to your hard drive.**

   In this example, we want to copy photos to a folder we have labeled Family.

2. **In the Organizer, choose File ➪ Get Photos and Videos ➪ From Files and Folders.**
Chapter 1: Getting Your Images

The Get Photos and Videos from Files and Folders dialog box opens. (Refer to Figure 1-3.)

3. **Select the folder on your hard drive where you copied the new photos.**
   In this case, we select the folder labeled Family.

4. **Click the Get Media button.**
   The Getting Media dialog box appears and the photos are added to the Organizer.

5. **Click OK in the Getting Media dialog box.**
   Photoshop Elements is smart enough to import only new images into the Organizer, as shown in Figure 1-5. Any images you previously imported from a given folder are listed in the Getting Media dialog box, and you’re informed that the old images will not be imported.

![Figure 1-5: Only new photos added to a folder are imported in the Organizer.](image)
Getting photos from iPhoto (Mac only)

Mac users may want to use both Apple’s iPhoto and Elements. If you’re familiar with iPhoto and enjoy using it, you may want to view and manage photos, albums, and events in iPhoto, but still use the more powerful editing tools in Elements to edit your pictures.

If you want to convert an iPhoto library to the Elements Organizer, choose File ➪ Get Photos and Videos ➪ From iPhoto. Your photos are imported into the Organizer and appear in the Media Browser.

If you want to edit photos in Elements directly from iPhoto, take these steps:

1. Open iPhoto ➪ Preferences.
2. In the Preferences dialog box that appears, click the Advanced icon at the top. (See Figure 1-6.)
3. In the Advanced settings, open the Edit Photos drop-down menu. Choose In Application.
   The Open dialog box appears.

Figure 1-6: In iPhoto, click Advanced and choose In Application to open the Elements Editor.
Understanding the Media Browser

When you add photos to the Organizer, the photos and any additional media appear as thumbnails in the central portion of the Organizer. This area is called the Media Browser.

If you use the Elements Photo Downloader, you may see several folders in the Import panel where the new photos are found on your hard drive. Elements doesn’t provide you with a very good photo-management system when you’re using the Photo Downloader. You may take 50 photos in one session and find that when the photos are imported from a media card, they may be copied to a dozen different folders.

As we recommend earlier in this chapter in the section “Organizing Photos and Media on a Hard Drive,” our preference is to copy files to a hard drive, create the folder organization we want, place the photos in respective folders, and then choose File→Get Photos and Videos→From Files and Folders. This method makes it much easier to locate photos than trying to find your images in a series of folders with date labels.

In the following sections, you discover basic tips for viewing images in the Media Browser and find out how to use the Elements face-recognition feature to tag people in your photos. Before the photos are scrambled around your catalog, you can also delete photos, assign ratings to them, add tags to the photos, or perform other organizational tasks.

Viewing images in the Media Browser

After files are imported into the Organizer, you see just those photos you imported in the Media Browser. To see all the photos in your catalog, click the All Media button at the top of the Media Browser.

Folders appear by default in the left Import panel. You can collapse the panel to provide more viewing area in the Media Browser by clicking the Hide Panel button in the lower-left corner of the Organizer workspace. (See Figure 1-7.)

The Import panel provides you with two different views. By default, you see the Folder List view that shows all folders imported in alphabetical order. If you have photos in subfolders, the List View doesn’t reflect the hierarchy for how your photos are organized on your hard drive. To see a different view in the Organizer, click the icon adjacent to My Folders (two little folders), and you change the Import panel view to the Hierarchy View shown in Figure 1-7.
When you click a folder in the Import panel, only those photos contained within the respective folder are displayed in the Media Browser. To view all photos in your catalog, click the All Media button.

![Figure 1-7: Photos displayed in a Hierarchy View in the Import panel.](image)

If you have a touchscreen monitor or device, you can swipe photos to view them one at a time.

### Adding people in the Media Browser

For most people, the most enjoyable pictures are those of family and friends. You may take photos of landscapes and wonderful places, but quite often you’ll ask someone to stand in front of the Coliseum, Louvre, Grand Canyon, or other notable landmark.

For just that reason, Photoshop Elements makes it easy for you to identify, sort, and view pictures with people in your catalogs.

You know that you can add folders of pictures to the Organizer to help manage photos. After you add new pictures to the Organizer, you can select a folder in the Import panel and label all the people in the photos. Elements makes it easy to label people’s faces:

1. **Add photos from a folder on your hard drive.**
   
   Copy photos to a folder and choose File ➪ Get Photos and Videos ➪ From Files and Folders.
Chapter 1: Getting Your Images

2. Select the folder in the Import panel and click the Add People icon at the bottom of the Organizer.

   If you have several photos in a folder, Elements prompts you in a dialog box to confirm your action.

3. Click OK if you see the prompt.

   The People Recognition – Label People window opens, as shown in Figure 1-8. You see the words *Who Is This?* below each photo.

4. Click the *Who Is This?* text and type the name of the individual, as shown in Figure 1-9.
That’s it! After you label the photos, you can easily search, sort, and locate photos with specific people. You can even download your Facebook friends’ list to the Organizer to help simplify labeling people.

Elements is very good at recognizing people, but it’s not perfect. Elements has particular difficulty with recognizing profile shots as photos of people. The good news, though, is that even if Elements doesn’t recognize that people are in a photo, you can still tag it. To add people tags when you aren’t prompted to do so, take these steps:

1. **Double-click a photo in the Media Browser.**
   
   You must first double-click a photo before proceeding. When you double-click a photo, the Mark Face tool appears in the Tools panel at the bottom of the Organizer, as shown in Figure 1-10.

2. **Click the Mark Face button.**
   
   Elements adds a new rectangle that you can move and resize.

![Figure 1-10: Double-click a photo in the Media Browser, and the Mark Face tool appears in the bottom Tools panel.](image-url)
3. Move the rectangle to a person that hasn’t been tagged and click the Who Is This? text box.

4. Type the person’s name and click the check mark adjacent to the text box (shown in Figure 1-10) to confirm your action.

Using a Scanner

Scanners connect through the same ports as cameras and card readers. (The exception is a SCSI, or Small Computer System Interface device; SCSI is another type of connection port, almost nonexistent today.) Most scanners today use either USB or FireWire. Low-end scanners sold now are typically USB devices.

Even the lowest-end scanners provide 16-bit scans that help you get a little more data in the shadows and highlights. As with a digital camera, a scanner’s price is normally in proportion with its quality.

Understanding image requirements

All scanning software provides you with options for determining resolution and color mode before you start a new scan:

- **Resolution:** An image’s resolution determines how many pixels it contains. Indeed, resolution is measured in ppi, or pixels per inch.

  Images displayed on the web use low resolutions because monitors don’t need lots of pixels to display images clearly. Also, images download faster the lower their resolutions are, and fast download times are ideal for the web. A good-looking print requires a higher resolution because printers and paper require more pixels than monitors do to render an image clearly.

- **Color mode:** RGB, Grayscale, or Bitmap (line art).

You should decide what output you intend to use and scan originals at target resolutions designed to accommodate a given output. Some considerations include the following:

- **Scan the artwork or photo at the size and resolution for the final output.** If you have a 3-x-5 photo that needs to be 1.5 x 2.5 inches on a web page, scan the original with a 50-percent reduction in size at 72 ppi (the desired resolution for images on the web). See Chapter 4 for information about resizing images.

- **Size images with the scanner software.** If you have a 4-x-6 photo that needs to be output for prepress and commercial printing at 8 x 12 inches,
scan the photo at 4 x 6 inches at 600 ppi (a resolution that’s large enough to increase the image size to 200 percent and still have a 300 dpi image, which is the desired resolution for a print).

✓ **Scan properly for line art.** Line art is 1-bit black and white only and should be used for scanning not only black-and-white artwork but also text. When you print line art on a laser printer or prepare files for commercial printing, the line art resolution should match the device resolution. For example, printing to a 600 dpi (dots per inch) laser printer requires 600 ppi for a 1-bit line-art image.

✓ **Scan grayscale images in color.** In some cases, it doesn’t matter, but with some images and scanners, you can get better results by scanning in RGB (red, green, and blue) color and converting to grayscale by using the Hue/Saturation dialog box or the Convert to Black and White dialog box, as we explain in Chapter 4.

✓ **Scan in high bit depths.** If your scanner is capable of scanning in 16- or 32-bit, by all means, scan at the higher bit depths to capture the most data. See Chapter 4 for more information about working with higher-bit images.

### Using scanner plug-ins (Windows)

Generally, when you install your scanner software, a standalone application and a plug-in are installed to control the scanning process. **Plug-ins** are designed to work inside other software programs, such as Photoshop Elements. When you’re using the plug-in, you can stay right in Elements to do all your scanning. Here’s how it works:

1. **After installing a new scanner and the accompanying software, launch Elements and then open the Organizer by clicking Organizer on the Welcome screen.**

2. **From the Organizer, open the Preferences dialog box by pressing Ctrl+K.**

3. **Click Scanner in the left column and adjust the Scanner preferences.**

When the Preferences dialog box displays your scanner, you know that the connection is properly set up and you’re ready to scan. Here’s how to complete your scan:

1. **To open the scanner software from within Elements, choose File ➤ Get Photos ➤ From Scanner (Windows).**

   You must be in the Organizer to access this menu command.
2. In the Get Photos from Scanner dialog box that appears (as shown in Figure 1-11), make your choices and click OK.

Here you can choose your scanner in the Scanner drop-down menu, a location on your hard drive for saving the scanned images, a quality setting, and an option to automatically correct red-eye.

Elements may churn a bit, but eventually your scanner software window appears atop the Organizer, as you can see in Figure 1-12. The window is the scanner software provided by your scanner manufacturer. (Your window will look different from Figure 1-12 unless you use the same scanner we use.)

3. Preview the scan.

Regardless of which software you use, you should have similar options for creating a preview; selecting resolution, color mode, and image size; scaling; and other options. If you click the Preview button, you see a preview before scanning the photo(s).

4. Adjust the options according to your output requirements and the recommendations made by your scanner manufacturer.
5. **When everything is ready to go, click the Scan button.** The final image drops into an Elements image window.

**Scanning on the Mac**

Photoshop Elements doesn’t support scanning on the Mac by default as it does for Windows.

However on the Mac and on Windows, you can install a TWAIN plug-in that recognizes your scanner and permits you to scan from within the Photo Editor.

The TWAIN plug-in is in the Optional Plug-ins folder. You need to move the plug-in from the Optional Plug-ins folder to the Plug-ins folder found in your Application folder.

For a complete detail on how to install and use the plug-in, see the web extras at [www.dummies.com/extras/photoshopelements12](http://www.dummies.com/extras/photoshopelements12).

**Scanning many photos at a time**

If you have several photos to scan, you can lay them out on the scanner platen and perform a single scan to acquire all images in one pass. Arrange the photos to scan on the glass and set up all the options in the scanner window for your intended output. When you scan multiple images, they form a single scan, as you can see in Figure 1-13.

After you scan multiple images, Elements makes it easy for you to separate each image into its own image window, where you can save the images as separate files. In Photo Editor mode, choose Image→Divide Scanned Photos to make Elements magically open each image in a separate window while your original scan remains intact. The images are neatly tucked away in the Photo Bin, where you can select them for editing, as shown in Figure 1-14. (For more information on using the Photo Editor and working with the Photo Bin, see Chapter 2.)
Chapter 1: Getting Your Images

After you choose Image ➤ Divide Scanned Photos, the scan is split.

When scanning multiple images and using the Divide Scanned Photos command, be sure to keep your photos on the scanner bed aligned vertically, horizontally, and parallel to each other as best you can. Doing so enables Elements to do a better job of dividing and straightening your photos.

If you close one of the images that were divided, Elements prompts you to save the image. Only the scan was saved when you started the process. You still need to save the divided scans.

After dividing the images, choose File ➤ Close All. Elements closes all files that have been saved and individually prompts you to save all unsaved images.

**Phoning In Your Images**

You can acquire images from cellphones, iPhones, iPods, iPads, and a variety of different handheld devices. As a matter of fact, you can do quite a bit with uploading, downloading, and preparing photos for handheld devices.
If you want to add images from a cellphone to the Organizer or open images in one of the editing modes, you need to copy files to your hard drive via a USB or Bluetooth connection or download an e-mail attachment of the photos if your phone is capable of using e-mail. Follow these steps after copying files to your hard drive:

1. **Choose File ➤ Get Photos and Video ➤ From Files and Folders, or press Ctrl+G (⌘+G on the Mac).**
   
The Get Photos and Videos from Files and Folders dialog box opens. (Refer to Figure 1-3.)

2. **Locate the folder into which you copied the files and add them to your Organizer.**
   
   Or you can open them in one of the editing modes.

   With an iPhone, iPod touch, or iPad, you can use the Photo Downloader to transfer media.

3. **Hook up the device with a USB cable.**
   
The Photo Downloader automatically opens.

4. **Click the Browse button, as shown in Figure 1-15, to open the Select Directory to Store Files window and select a destination folder. Click the Select Folder Button to identify where the photos are saved.**

5. **Click the Get Media button to download the photos to your computer.**

---

**Figure 1-15:** Hook up an iPhone or iPad via a USB cable to your computer and choose File ➤ Get Photos and Videos ➤ From Camera or Card Reader.
For iPhone, iPod touch, and iPad, you can also hook up your device via a USB cable and choose File ➪ Get Photos and Videos ➪ From Camera or Card Reader. Elements recognizes the device, and the Photo Downloader opens, giving you options for importing all photos or selected images.

To upload Elements creations and edited photos to your iPhone, iPad, or iPod touch, use Apple’s iTunes or Dropbox:

1. In iTunes, choose File ➪ Add Files to Library.
2. Select the images and videos from a folder on your hard drive that you want to upload to the device.
   
   When uploading photos to an iPhone or iPad, use only the formats these devices support, such as JPEG, TIFF, GIF, and PNG.
3. Hook up the iPhone or iPad or connect wirelessly and click the Photos and/or Videos tab at the top of the iTunes window.
4. Select the check boxes adjacent to each item you want to upload and then click the Sync button.
   
   Your files are uploaded to your device while the sync is in progress.

You can bypass iTunes with the iPad by using the Camera Connection Kit, provided by Apple for $29.95. The kit supports only SD cards, but you can attach many different types of card readers to the USB port on the Camera Connection Kit and use other media cards. Copy files from the Organizer to the media card and use it as you would use an external media source to share photos back and forth between your computer and the iPad.
Photoshop Elements has two workspaces: the Organizer, which we introduce in Chapter 1, and the Photo Editor. You manage and arrange your photos in the Organizer, and you edit photos in the Photo Editor.

In this chapter, we provide you with a basic understanding of the Photo Editor so that you can begin to edit your pictures. There’s much more to the Organizer than Chapter 1 covers, and there’s much more to the Photo Editor than we can cover here in Chapter 2. In Chapters 3 through 6, you find much more detail about both the Organizer and the Photo Editor.

In this chapter, you first find out how to navigate back and forth between the Organizer and the Photo Editor and how to access the Photo Editor’s three editing modes: Expert, Quick, and Guided. After taking a tour of each mode, you find out how to undo edits so that you can start over easily and discover where to find sources of help within Elements.

If you’ve used an earlier version of Elements, you’ll notice that the way you launch the Photo Editor from within the Organizer and the way you access...
the editing modes is different. The nomenclature has also changed a bit. In earlier versions of Elements, we referred to the Photo Editor as Full Photo Edit mode. In versions 11 and 12, we simply refer to the editing workspace as the Photo Editor and recognize the fact that the Photo Editor has three modes. It may sound complicated now, but we help you understand the entire editing process in Photoshop Elements.

Launching the Photo Editor

After you get pictures into the Organizer, you may want to edit the pictures by cropping a photo, modifying the brightness, adding text, merging two or more photos, or applying an interesting filter to a photo. You perform all these tasks in the Photo Editor. Hence, you leave the Organizer and open the Photo Editor, or you can launch the Photo Editor from your desktop and completely bypass the Organizer.

When you first open Elements, you can click the Photo Editor button on the Welcome screen to open the Photo Editor. However, most often you'll open the Photo Editor from within the Organizer. Why? Because in the Organizer you see thumbnail images of your photos (as shown in Figure 2-1). You may have several very similar photos and want to choose which photo to edit. Therefore, you're most likely to look over the photos in the Organizer, select the one you want to edit, and open the selected photo in the Photo Editor.

Figure 2-1: As a matter of standard practice, you open photos in the Photo Editor from thumbnails shown in the Organizer.
Here’s how you move into the Photo Editor:

✓ **From the initial Welcome screen:** Click Photo Editor and open a photo by choosing File ➪ Open and selecting the photo you want to open from files and folders on your hard drive. Your Elements window then appears in Photo Editor mode, as shown in Figure 2-2.

✓ **From the Organizer:** This is the method you’ll probably use the most. Click a photo (or several photos) and then click Editor at the bottom of the Organizer. The selected file(s) open in the Photo Editor.

![Figure 2-2: The default Photo Editor workspace with several files open in the Photo Editor.](image)

When you jump to the Photo Editor, you can access the various editing modes by clicking the three tabs at the top of the Photo Editor workspace. The three editing modes are Quick, Guided, and Expert. Most of the work you do in the Photo Editor takes place in Expert mode, but when you open Photo Editor the first time, it opens in Quick mode. After you change the mode, all future sessions open in the last mode you selected.
Examining the Photo Editor

Before you begin editing photos, you’ll find it helpful to look over the Photo Editor and learn how to move around the workspace. When the Photo Editor is in Expert mode, you find the following (as labeled in Figure 2-2):

A. **Menu bar:** Most of the menu commands you find in Elements 12 are the same as those you found in earlier versions of Elements.

B. **Photo Editor modes:** The Photo Editor modes has three modes. The Expert mode is shown in Figure 2-2.

C. **Panel Bin:** Figure 2-2 shows the Layers panel. You change panels by clicking the icons at the bottom of the Panel Bin. (The icons are described in item P.) *Creations* (things you make) are also contained in the Panel Bin when you click the Create button (item E).

D. **Open menu:** When you select several thumbnails in the Organizer and click the Editor button, all the files you selected are opened in the Photo Editor. Figure 2-2 shows four files tabbed at the top of the image window. You have several ways to place one of the open files in the foreground in the image window:

   - Click a tab at the top of the image window to move the image to the foreground (item F).
   - Click a photo in the Photo Bin (item M).
   - Open the Window menu and choose a photo.
   - Click Open and from the drop-down menu click the image you want to move to the foreground. Note that the Open menu also offers you an option to create a new, blank file.

E. **Create:** When you click the Create button and choose an option from the menu, you leave the current editing mode. For example, when in Expert mode, click the Create button and click Photo Collage, and all the options that were available in the Photo Editor temporarily disappear when the creation wizard opens. To return to the Photo Editor, complete the creation or cancel the wizard. (For more information on using the Create panel, see Chapter 16.)

F. **Photo tabs:** Multiple photos opened in the Photo Editor appear in different tabs at the top of the window by default. We call this a *docked* position, where the photos are docked in the image window. You can click a tab and drag it down to *undock* the photo. However, you must change a preference setting to undock the windows. (See Chapter 3 for more on changing preferences.) Doing so makes the photo appear as a *floating window.* You might want to float windows when copying and pasting image data between two or more photos. You can also view all open files in a floating window without changing preferences by choosing All Floating from the Layout pop-up menu (item K).
Chapter 2: Getting to Know the Editing Work Areas

G. **Tools panel:** Here you find the Photo Editor toolbox, where you click a tool and apply an edit to the photo. See “Using the Tools panel” later in this chapter.

H. **Photo Bin/Tool Options:** Figure 2-2 shows the Photo Bin opened. (See item M for more on the Photo Bin.) Click the Tool Options button, and a set of Tool Options replaces the Photo Bin. You can also open the Tool Options by clicking a tool in the Tools panel.

Tool Options provide you more editing features for a tool that you select in the Tools panel. For example, click the Brush tool to see tool options for the Brush tool (as shown in Figure 2-3). Each tool in the Tools panel supports various tool options. To return to the Photo Bin, click the Photo Bin button at the bottom left of the window.

![Figure 2-3: Tool Options provide more editing features for tools selected in the Tools panel.](image)

I. **Undo/Redo:** Click the respective tool for Undo or Redo. You can also press Ctrl+Z (⌘+Z on the Mac) for Undo and Ctrl+Y (⌘+Y) for Redo.

J. **Rotate:** Click the arrow to open a pop-up menu and choose the Clockwise or Counterclockwise tool to rotate the photo you see in the image window.

K. **Layout:** When you have multiple photos open in the Photo Editor, you can make choices in the Layout pop-up menu for how the photos are displayed in the image window (such as rows, columns, as a grid, and so on). To return to the tabbed view, choose Default from the Layout pop-up menu.

L. **Organizer:** Click the Organizer button to return to the Organizer. Elements makes it very easy for you to toggle back and forth between the Organizer and the Photo Editor by clicking the respective buttons at the bottom of the windows.

M. **Photo Bin:** The Photo Bin displays thumbnail images of the photos you have open in the Photo Editor. Double-click a thumbnail to bring the photo to the foreground in the image window.

N. **Image window:** In this window, you view a photo you want to edit. Likewise, you can view multiple photos you want to edit.
O. **Photo Bin Options menu**: Click this icon to open a pop-up menu of tasks, such as making creations from photos selected in the Photo Bin and printing selected photos.

P. **Panel Bin icons**: Click an icon at the bottom of the Panel Bin to display a different panel. Your choices are the Layers panel, the Effects panel, the Graphics panel, and the Favorites panel. These panels are docked in the Panel Bin by default and cannot be removed unless you choose Custom Workspace (item Q). We talk more about these panels in the later section, “Playing with panels.”

Q. **Panels Options menu**: To open additional panels, click the right-pointing arrow and you open a pop-up menu of choices. The panels you open from the Panel Options menu appear as floating windows and cannot be docked in the Panel Bin.

Notice at the bottom of the pop-up menu you find Custom Workspace. When you click Custom Workspace, you can move panels around and dock or undock them in the Panel Bin.

The description of the Photo Editor workspace is brief in this chapter. Most of the options you have for using tools, panels, and menu commands are discussed in later chapters. For now, try to get a feel for what the Photo Editor provides and how to move among many of the Photo Editor features.

### Examining the image window

Not surprisingly, the image window’s tools and features are most useful when an image is open in the window. To open an image in the image window (as shown in Figure 2-2), follow these steps:

1. **Choose File ➤ Open**.

   The standard Open dialog box appears. It works like any ordinary Open dialog box that you find in other applications.

   You can always click one or more photos in the Organizer and click the Editor button to open the selected photos in the Photo Editor.

2. **Navigate your hard drive (by using methods you know to open folders) and then select a picture**.

   If you haven’t yet downloaded digital camera images or acquired scanned photos and want an image to experiment with, you can use a sample image. Both your operating system and Photoshop Elements typically provide sample images:

   - On your operating system, sample images are typically found in your Pictures folder that’s one of the default folders in both Windows and OS X installations.
Elements installs some nice sample images with the application installation. Look in the appropriate folder — Program Files/Adobe/Photoshop Elements 12\Sample Files (Windows) or /Applications/Adobe Photoshop Elements 12/Support Files/Tutorials (Mac) — to find some photos to play with.

3. Select a picture and click Open.

The photo opens in a new image window in Elements.

You can open as many image windows in Elements as your computer memory can handle. When each new file is opened, a thumbnail image is added to the Photo Bin at the bottom of the workspace. (Refer to Figure 2-2.)

Notice that in Figure 2-2, filenames appear as tabs above the image window. Additionally, photo thumbnails appear in the Photo Bin. To bring a photo forward, click the filename in a tab or double-click a thumbnail in the Photo Bin. To close a photo, click the X adjacent to the filename or choose File→Close.

Here’s a look at important items in the image window, as shown in Figure 2-4:
Part I: Organizing and Editing Images

✓ **Filename:** Appears above the image window for each file open in the Photo Editor.

✓ **Close button:** Click the X to the right of the filename to close the file. (On the Mac, click the red button in the upper-left corner.)

✓ **Scroll bars:** Become active when you zoom in on an image. You can click the scroll arrows, move the scroll bar, or grab the Hand tool in the Tools panel and drag within the window to move the image.

For Mac users: If you don’t see scroll bars on your Finder windows, open the System Preferences by clicking the System Preferences icon on the Dock. In General Preferences, click Always in the Show Scroll Bars section.

✓ **Magnification box:** Shows you at a glance how much you’ve zoomed in or out.

✓ **Information box:** Shows you a readout for a particular tidbit of information. You can choose what information you want to see in this area by selecting one of the options from the pop-up menu, which we discuss in more detail later in this section.

When you’re working on an image in Elements, you always want to know the physical image size, the image resolution, and the color mode. (These terms are explained in more detail in Chapter 4.) Regardless of which menu option you select from the status bar, you can quickly glimpse these essential stats by clicking the Information box (not the right-pointing arrow but the box itself), which displays a pop-up menu like the one shown in Figure 2-5.

✓ **Size box:** Enables you to resize the window. If you move the cursor to the box, a diagonal line with two opposing arrows appears. When the cursor changes, drag in or out to size the window smaller or larger, respectively.

You can also resize the window by dragging any corner in or out.

Now that you’re familiar with the overall image window, we want to introduce you to the Information box’s pop-up menu, which enables you to choose the type of information you want to view in the Information box. Click the right-pointing arrow to open the menu, as shown in Figure 2-6.

Here’s the lowdown on the options you find on the pop-up menu:

✓ **Document Sizes:** Shows you the saved file size. For information on file sizes and resolutions, see Chapter 4.
Chapter 2: Getting to Know the Editing Work Areas

✓ **Document Profile:** Shows you the color profile used with the file. Understanding color profiles is important when printing files. Turn to Chapters 4 and 14 for more information on using color profiles.

✓ **Document Dimensions:** When selected, this option shows you the physical size in your default unit of measure, such as inches.

✓ **Current Selected Layer:** When you click a layer in the Layers panel and choose Current Selected Layer, the layer name appears as the readout.

✓ **Scratch Sizes:** Displays the amount of memory on your hard drive that’s consumed by all documents open in Elements. For example, 20M/200M indicates that the open documents consume 20 megabytes and that a total of 200 megabytes are available for Elements to edit your images. When you add more content to a file, such as new layers, the first figure grows while the second figure remains static.

✓ **Efficiency:** Indicates how many operations you’re performing in RAM, as opposed to using your scratch disk (space on your hard drive). When the number is 100 percent, you’re working in RAM. When the number drops below 100 percent, you’re using the scratch disk.

If you continually work below 100 percent, it’s a good indication that you need to buy more RAM to increase your efficiency.

✓ **Timing:** Indicates the time it took to complete the last operation.

✓ **Current Tool:** Shows the name of the tool selected from the Tools panel.

Why is this information important? Suppose you have a great photo you want to add to your Facebook account and you examine the photo to find the physical size of 8 x 10 inches at 300 pixels per inch (ppi). You also find that the saved file size is over 20MB. At a quick glance, you know you want to resize or crop the photo to perhaps 4 x 6 inches at 72 ppi. (Doing so drops the file size from over 20MB to around 365K.) Changing the resolution dramatically reduces the file size. We cover file sizes and changing the physical dimensions of your photos in Chapter 4. For now, realize that the pop-up menu shows you information that can be helpful when preparing files for print and display.

Don’t worry about trying to understand all these terms. The important thing to know is that you can visit the pop-up menu and change the items at will during your editing sessions.
Moving through the menu bar

Like just about every other program you launch, Elements supports drop-down menus. The menus are logically constructed and identified to provide commands for working with your pictures (including many commands that you don’t find supported in tools and on panels). A quick glimpse at the menu names gives you a hint of what might be contained in a given menu list.

Here are the 10 menus (11 on a Mac):

- **Adobe Photoshop Elements Editor (Mac only):** On the Mac, you find the Adobe Photoshop Elements Editor menu preceding the File menu. This menu provides you the Quit command used to exit Elements, and it provides access to Photo Edit and Preferences, which we cover in Chapter 3.

- **File:** Just as you might suspect, the File menu contains commands for working with your picture as a file. You find commands for saving, opening, processing, importing, exporting, and printing. We cover saving files in Chapter 6 and printing or exporting for other output in Part V.

- **Edit:** The old-fashioned Copy, Cut, and Paste commands are located on this menu. Additionally, you have important application settings commands on the menu, including Preferences (Windows), which we cover in more detail in Chapter 3.

- **Image:** You use the Image menu most often when you want to effect changes to the entire image, such as changing a color mode or cropping, rotating, and resizing the image. For details about sizing and color modes, check out Chapter 4. For more about cropping and rotating images, flip to Chapter 9.

- **Enhance:** Just the name of this menu should tell you what commands to expect here. This is where you go to change the appearance of an image, such as changing its brightness and contrast, adjusting its color and lighting, and doing other smart fix-up work to improve its appearance. On the Enhance→Adjust Color submenu, you find a number of commands that offer you a variety of color adjustments. Look to Chapter 10 for some detail on correcting color. In Chapters 9 and 10, you can find out how to use correction tools so that your images look their best.

- **Layer:** As we describe in great detail in Chapter 8 (a whole chapter just about layers), most kinds of editing you do in Elements are best handled by using layers. Elements neatly tucks away most of the relevant commands associated with working in layers right in this menu.

- **Select:** Selections are equally as important as layers. Whereas the Image menu contains commands that are applied to the entire image, you can edit isolated areas of an image by using the commands on the Select menu. To isolate an area, you need to create a selection, as we explain in Chapter 7. This menu contains commands to help you with many essential tasks related to working with selections.
Filter: The Filter menu is where you find professional photographic darkroom techniques, or you can completely leave the world of photography and explore the world of a fine artist. With tons of different filter commands, you can create some extraordinary effects. Find out all about filters in Chapter 11.

View: From the View menu, you handle tasks such as zooming in and out of images, turning on a grid, exposing horizontal and vertical rulers, adding annotations, and checking out the print sizes of your pictures. Chapter 5 unearths secrets of the Zoom tool, rulers, and more.

Window: Elements supports a number of panels, as we explain in the section “Playing with panels,” later in this chapter. Elements has so many panels that keeping them all open at one time is impractical. Thanks to the Window menu, you can easily view and hide panels, reopen the Welcome window, tile and cascade open windows, and bring inactive windows to the foreground.

Help: We hope that you get all the help you need right here in this book. However, just in case we miss something (or your neighbor has borrowed it, fine book that it is), you have interactive help right at your mouse-tip on the Help menu. The menu also offers links to the Adobe website for more information and a little assistance, courtesy of the tutorials accessible from this menu. (You can find a little more detail about accessing help in the section “Getting a Helping Hand,” later in this chapter.)

Uncovering the contextual menus

Contextual menus are common to many programs, and Photoshop Elements is no exception. They’re those little menus that appear when you right-click, offering commands and tools related to whatever area or tool you right-clicked.

The contextual menus are your solution when you’re in doubt about where to find a command on a menu. You just right-click an item, and a pop-up menu opens.

Because contextual menus provide commands respective to the tool you’re using or the object or location you’re clicking, the menu commands change according to the tool or feature you’re using and where you click at the moment you open a contextual menu. For example, in Figure 2-7, you can see the contextual menu that appears after we create a selection marquee and right-click that marquee in the image window. Notice that the commands are all related to selections.

Figure 2-7: A contextual menu for selections.
Using the Tools panel

Elements provides a good number of panels for different purposes. The one that you’ll use most is the Tools panel. In panel hierarchy terms, you typically first click a tool on the Tools panel and then use another panel for additional tool options or use the Tool Options (which we describe in the section “Selecting from the Tool Options,” later in the chapter) for fine-tuning your tools. More often than not, clicking a tool on the Tools panel is your first step in editing operations.

Where did all the tools go? When you first open the Photo Editor and look over the Tools panel, you might think that Elements reduced the number of tools you had available in earlier versions of the program.

You have the same tools available in Elements 12 as you had in Elements 11 and earlier. However, rather than clutter the Tools panel with pop-up toolbars, Elements 12 provides you with additional tools in the Tool Options. For example, you may click the Marquee Rectangle tool and wonder what happened to the Elliptical Marquee tool. It’s now in the Tool Options, directly below the image window.

Figure 2-8 shows how the Magic Wand tool is the current tool in the Tools panel. The Quick Selection tool, the Selection Brush tool, and the Magic Wand tool are all in the Tool Options.

Keep in mind that if you don’t find a tool in the Tools panel, look in the Tool Options for additional tools within a tool group.

You can easily access tools in Elements by pressing shortcut keys on your keyboard. For a quick glance at the Tools panel, look over Figure 2-9.
Chapter 2: Getting to Know the Editing Work Areas

Figure 2-9: The Tools panel with keystroke equivalents to access a tool from the keyboard.
The following tips can help you find your way around the Tools panel with keyboard shortcuts:

- **To select tools within a tool group by using keystrokes, press the respective key to access the tool.** For example, press the L key to select the next tool — the Magnetic Lasso tool. Press L again and repeatedly press the shortcut key to step through all tools in a given group.

- **Whether you have to press the Shift key to select tools is controlled by a preference setting.** To change the default setting so that you don’t have to press Shift, choose Edit ➪ Preferences ➪ General or press Ctrl+K. (Choose Photoshop Elements 12 ➪ Preferences ➪ General or press ⌘+K on the Mac.) Then, in the General Preferences, deselect the Use Shift Key for Tool Switch check box.

- **The shortcuts work for you at all times, except when you’re typing text with the cursor active inside a text block.** Be certain to click the Tools panel to select a tool when you finish editing text or click the Commit green check mark to end using the Text tool.

The tools are varied, and you may find that you don’t use all the tools in the Tools panel in your workflow. Rather than describe the tool functions here, we address the tools in the rest of this book as they pertain to the respective Elements tasks.

**Selecting from the Tool Options**

When you click a tool on the Tools panel, the Tool Options appears at the bottom of the workspace and offers you choices specific to the selected tool. (Refer to Figure 2-8, which shows the Quick Selection tool options.) In addition to providing you choices for selecting tools within a tool group, you can adjust settings for a selected tool.

In Figure 2-8, you see choices for adjusting the Magic Wand tolerance, a button to refine the edge, and choices for adding and subtracting from selections or creating a new selection.

You can find many of these fine-tuning adjustments in the Tool Options for most of the tools you select in the Tools panel.

**Playing with panels**

In addition to the Tool Options, covered in the preceding section, Elements provides you with a bunch of panels that contain settings and options for tools and features such as layers, effects, and more. In the Photo Editor, you open these panels in the Panel Bin:
Layers: The Layers panel displays all the layers you’ve added to a photo. We talk much more about layers in Chapter 8. For now, look at how the different panels are designed. In the Layers panel, you find various tools at the top-left corner and an icon with horizontal lines in the top-right corner (as shown in Figure 2-10).

When you click the icon at the top right, a pop-up menu appears. In Figure 2-11, you see menu items supporting the tasks you perform in the Layers panel.

Effects: At the bottom of the Panel Bin, click the fx button to open the Effects panel. The Effects panel contains menus and tabs for applying a number of different effects to your pictures. You simply double-click the effect you want when you edit the photo. Applying effects is covered in Chapter 16.

Graphics: The Graphics panel contains several menus where you can choose among a huge assortment of graphic illustrations that can also be applied to your photos. For more information on using the Graphics panel, see Chapter 16.

Favorites: The Favorites panel also contains a number of graphic images. You can also select items from the Effects and the Graphics panel and add them to the Favorites panel.

Additional panels: Click the down-pointing arrow at the bottom of the Panel Bin, and a pop-up menu opens, allowing you to choose additional panels. The Layers, Effects, Graphics, and Favorites panels are docked in the Panel Bin and cannot be removed.
The panels you open from the pop-up menu shown in Figure 2-12 open as floating panels. These are your options:

- **Actions**: Earlier versions of Elements supported Actions; however, in those versions, you had to select Actions from options in Guided Edit mode. In Elements 11, Actions became its own panel. Actions are like macros that enable you to automate a series of edits to your pictures. In Figure 2-13, you can see the Actions that are supported when you open the Text Effects presets. As with other panels, a pop-up menu is supported, and it offers Load, Replace, Reset, and Clear options so you can modify Actions.

Elements 12 still doesn’t support recording your own series of editing steps and capturing the steps as an Action. However, most of the Actions that are created in Adobe Photoshop can be loaded in Elements.

You can find a number of free downloadable Actions on the Internet. Just search for *Photoshop Actions* and explore the many downloads available to you. For step-by-step details on how to load Actions, see our web extras at www.dummies.com/extras/photoshop elements12.

- **Adjustments**: The Adjustments panel works only when you have an Adjustment layer. For details about using the Adjustments panel and Adjustment layers, see Chapter 8.
Chapter 2: Getting to Know the Editing Work Areas

- **Color Swatches**: This panel displays color swatches you might use for coloring and painting that we cover in Chapter 12.

- **Histogram**: Open this panel to display a histogram of the photo in the foreground. We talk more about histograms in Chapters 9 and 10.

- **History**: Choose this item to display the Undo History panel. See the section “Retracing Your Steps,” later in this chapter, for more on using the Undo History panel.

- **Info**: The Info panel provides readouts for different color values and physical dimensions of your photos.

- **Navigator**: The Navigator panel helps you zoom in and move around on a photo in the image window.

- **Custom Workspace**: When you click Custom Workspace, you can dock and undock panels. This option enables you to configure a custom workspace to your liking.

**NEW FEATURE**

- **Create/Share panel**: These panels also exist in the Organizer. Click Create at the top right of the Panel Bin to open the Create panel in the Photo Editor. The Create panel in both the Photo Editor and the Organizer is used for making a number of creations such as calendars, photo books, greeting cards, photo collages, and more. The Share panel contains many options for sharing your photos. We talk more about making creations in Chapter 16, and we cover using the Share panel in Chapter 15.

When you open the additional panels as floating windows, the panels are docked in a common floating window. You can drag a panel out of the docked position and view it as a separate panel or move it to the docked panels.

When you open a panel in either the Organizer or the Photo Editor, you find other options available from tools, drop-down menus, and a menu you open by clicking the icon with horizontal lines in the top-right corner of the panel.

**Using the Photo Bin**

The Photo Bin displays thumbnail views of all your open images. You can immediately see a small image of all the pictures you have open at one time, as shown earlier in Figure 2-2. You can also see thumbnail views of all the different views you create for a single picture. Find out all the details in the following sections.
If you want to rearrange the thumbnails in the Photo Bin, click and drag horizontally to change the order of the thumbnails.

**Creating different views of an image**

What? Different views of the same picture, you say? Yes, indeed. You might create a new view when you want to zoom in on an area for some precise editing and then want to switch back to a wider view. Here’s how you do it:

1. **Double-click a thumbnail image in the Photo Bin.**
   
   You must have a photo open in the Photo Editor. The photo you double-click in the Photo Bin appears in the image window as the active document.

2. **Choose View > New Window for <filename>**.
   
   Note that <filename> is the name of the file in the image window.

3. **Zoom to the new view.**
   
   A new view appears for the active document, and you see another thumbnail image added to the Photo Bin.

   To zoom quickly, click the Zoom tool in the Tools panel and then click a few times on the picture in the image window to zoom in to the photo.

4. **Toggle views of the same image by using the thumbnails in the Photo Bin.**
   
   Double-click the original thumbnail to see the opening view; double-click the other thumbnail to see the zoomed view.

**Viewing filenames**

By default, photos open and are displayed in the Photo Bin without the associated filenames. If you want the name of each file shown in the Photo Bin, open a contextual menu on a photo in the Photo Bin and choose Show Filenames.

**Using Panel Bin Actions**

A nice feature in Elements is the Panel Bin Actions menu, where you find tasks that you can perform on photos open in the Photo Editor. Click the Photo Bin Options menu to display the menu commands shown in Figure 2-14.
Chapter 2: Getting to Know the Editing Work Areas

Figure 2-14: Open the Bin Actions pop-up menu to display various actions you can perform on pictures open in the Photo Bin.

The Panel Bin Actions available in the menu are

✓ **Print Bin Files**: Select the files in the Photo Bin that you want to print and choose Print Bin Files. The selected files open in the Print dialog box where you can make photo prints of the selected images.

✓ **Save Bin As an Album**: You can add photos to an existing album or you can create a new album. You can do many wonderful things with Photo Albums, and we cover it all in Chapter 15.

✓ **Reset Style Bin**: Resets the Style Bin images when you’re performing a Photomerge style match. (To find out more about Photomerge, see Chapter 11.)

✓ **Show Grid**: By default, no divider lines appear between photos in the Photo Bin. When you select Show Grid, divider lines appear between the photos.

Creating Images from Scratch

You may want to start from scratch by creating a new document in Elements. New, blank pages have a number of uses. You can mix and merge images in a new document, as we explain in Chapter 8; create a canvas where you can draw and paint, as we explain in Chapter 12; or use the New dialog box to find out a file’s size, dimensions, and resolution.

Follow these steps to create a new document while working in any editing mode:

1. **Open Elements and select an editing mode.**
   
   From the Welcome screen, clicking the Photo Editor button does the trick.

2. **Choose File ➤ New ➤ Blank File in any workspace or press Ctrl+N (⌘+N on the Mac).**
Alternatively, you can click the Open drop-down menu in the Photo Editor and choose New Blank File.

Either way, the New dialog box opens, as shown in Figure 2-15.

3. Select the attributes for the new file.

When you select these attributes, among the things you need to consider is the output you want to use for the image: screen or paper. Files created for the web or for screen views are measured in pixels, and you don’t need to specify a resolution. For print, you want to use a measurement other than pixels and you need to specify resolution. We explain how all this works for the relevant settings in the following bulleted list.

![Figure 2-15: When you create a new, blank file, the New dialog box opens.](image)

You have several options from which to choose:

- **Name**: Type a name for your file.
- **Preset**: Select from a number of sizes.
- **Size**: You can select a preset size from a long drop-down menu. This setting is optional because you can change the file attributes in the other text boxes and drop-down menus.
- **Dimensions (Width/Height)**: Values in the Width and Height text boxes are independent; either box can be edited without affecting the other. Adjacent to the values in the Width and Height text boxes, you find drop-down menus that offer many options for units of measure, such as the default units of pixels followed by inches, centimeters (cm), millimeters (mm), points, picas, and columns.
• **Resolution:** Resolution here is similar to editing the resolution value in the Image Size dialog box when the Resample check box is selected. Resolution is a critical concept when working with photo images; we cover working with image resolution in much more detail in Chapter 4.

• **Color Mode:** Your choices are Bitmap, Grayscale, and RGB Color. (See Chapter 4 for more information about color modes.)

• **Background Contents:** You have three choices: White, Background Color, and Transparent. The selection you make results in the color of the blank image. If you choose Background Color, the current background color assigned on the Tools panel is applied to the background. See Chapter 12 for information on changing background color. If you choose Transparent, the image is created as a layer, and the layer name changes to Layer 0, as we explain in Chapter 8.

• **Image Size:** This value (displayed in the lower-right corner of the dialog box) dynamically changes when you change the Width, Height, and Resolution values. The Image Size value tells you how much file space is required to save the uncompressed file.

4. **Click OK after setting the file attributes to create the new document.**

Sometimes you may want to copy a selection to the Clipboard and convert the Clipboard information to an image. Be sure you have copied some image data to the Clipboard. In Elements, choose File ➪ New ➪ Image from Clipboard. The data on the Clipboard appears in a new document window.

In addition to creating new, blank files, the New dialog box can be a helpful source of information for all your work in Elements. Suppose that you want to know how many images you can copy to a USB storage device with 256MB of free space, or how large your digital camera files will print with a 150-ppi resolution. All you have to do is press Ctrl-N (⌘+N on the Mac) to open the New dialog box, plug in the values, and read the Image Size number or examine the file dimensions. If your files will be converted to grayscale, choose Grayscale from the Color Mode drop-down menu and check the Image Size number to see how much your file size is reduced. Because the Image Size number is dynamic, it updates with each change you make to the file attributes.

**Using Quick Mode**

Quick mode is designed to provide you with just those tools that you need to prepare a picture for its intended destination, whether it’s printing, onscreen viewing, or one of the other organizing items. Use this mode to make your
pictures look good. You don’t find tools for painting with brushes or applying gradients in Quick mode. Rather, what you find is a completely different set of panels for enhancing the overall look of your image, such as balancing contrast and brightness, lighting, and sharpening. This mode is like having a digital darkroom on your desktop, where you take care of perfecting an image like you would in analog photography darkrooms.

To enter Quick mode while you’re in Expert mode, click the Quick tab, and the view changes, as shown in Figure 2-16.

![Figure 2-16: Click the Quick tab to open Quick mode.](image)

Following are several differences between Expert and Quick mode:

- **Completely different sets of panels are docked in the Panel Bin.** All the panels in Quick mode are related to adjusting brightness controls, and they’re designed to improve the overall appearance of your pictures. In addition, all the Window menu commands for accessing panels are grayed out. While you work in Quick mode, Elements insists on limiting your use of panels to just the ones docked in the Panel Bin.
Chapter 2: Getting to Know the Editing Work Areas

The Tools panel shrinks. Quick mode offers only these tools on the Tools panel:

- Zoom
- Hand
- Quick Selection
- Red Eye Removal
- Whiten Teeth
- Horizontal Type
- Spot Healing Brush
- Crop
- Move tool (added in Elements 12)

None of the other Elements tools are accessible while you work in this mode.

Multiple viewing options are available. Notice in Figure 2-16 that you see two views of the same image. The Before view on the left displays the unedited image. The After view shows you the results of changes you make with panel options and menu commands. You select different viewing modes from menu choices on the View pop-up menu below the image window.

If you want to return to Expert mode, simply click the Expert tab and the edited version appears in the Photo Editor, where you can use all the Photo Editor tools.

Using Guided Mode

Guided mode is a marvelous editing feature in Elements. It’s the third and final editing mode we discuss in this chapter. You access Guided mode by clicking the Guided tab.

Guided mode, as the name implies, is a guided process for performing various editing tasks. When you open the Guided panel, you find a list of items for producing various edits, as shown in Figure 2-17. Not all editing tasks are contained in the Guided panel, but what you have available is an impressive list of many tasks you’ll perform often.

As you peruse the panel, notice that some of the basic photo-editing items you have available are similar to what you find in Quick mode, such as Brightness
and Contrast, Lighten and Darken, and other brightness control adjustments. As you scroll down the panel to reveal items such as Photo Effects, Photo Play, and Photomerge, you find some interesting, fun edits you can make with photos.

**Using Guided mode**

The process is the same for all the items you use in the Guided panel. You open a file in the Photo Editor and click Guided. Then you click one of the items listed under a category head. For example, suppose you want to show some motion in your photo or a lightning-fast zoom appearance.

The Zoom Burst Effect is one of three new Guided modes you find in Elements 12. Elements 12 also introduces the Restore Old Photo Guided Edit that takes you through the steps for restoring a photo and the Puzzle Effect that enables you to turn any photo into a picture puzzle.

To create a Zoom Burst Effect image similar to Figure 2-18, do the following:

1. With an image open in the Photo Editor, click Guided and then click Zoom Burst Effect in the Guided Photo Edit panel.

2. (Optional) If your image needs cropping, click the Crop tool in the Guided panel and drag the Crop tool in the image to define the crop area.

3. Click the Add Zoom Burst Effect button in the Guided panel.

4. Click the Add Focus Area button and then click and drag in the image the areas you want to remain in focus.

   Use short drag strokes as you move around the image.

   For the image in Figure 2-18, we dragged the cursor in the areas you see that are in focus.

5. Click Done.
Chapter 2: Getting to Know the Editing Work Areas

Figure 2-18: Follow steps in the Guided Photo Edit panel to produce a final image.

This example is quite simple because you have only a few steps to follow. However, even the more complicated items in Guided mode offer you step-by-step instructions you can easily follow to create a final result.

Exploring the Guided options

The best way to discover what results you can achieve is to open photos and apply various edits using the Guided panel. Some of the more complicated options, such as creating Out of Bounds effects, offer you a link to online video tutorials to help you further simplify the process. (For steps on creating an Out of Bounds effect, you can also check out our web extras at www.dummies.com/extras/photoshopelements12.)

Some items, such as Photomerge and Photo Stack, require using multiple images. Load up the Photo Bin with photos and apply the effects to multiple images.

You have effects that can help improve images that might otherwise be uninteresting photos. Experiment with the Lomo effect (which is similar to cross-processing film), Old Fashioned Photo effect, Saturated Slide Film effect, and
Soft Focus effect. For a new creative experience, use the Puzzle effect that was introduced in Elements 12.

For portraiture, the Perfect Portrait item in the Advanced Edits group offers an easy way to improve portrait-type images, as you can see in Figure 2-19.

The best way to find out more about Guided mode is to open images, apply effects, and have a lot of fun!

![Figure 2-19: The Perfect Portrait effect is a set of easy steps to help you improve portraits.](image)

Retracing Your Steps

Ever since the Apple Macintosh brought a window-like interface to the masses, the Undo command has been one of the most frequently used menu commands in every program developed. You make a change to your document, and if you don’t like it, you simply choose Edit ➪ Undo or press the keyboard shortcut Ctrl+Z (⌘+Z on the Mac).

In Elements, your options to undo your work provide you much more than reverting to the last view, as we explain in the following sections.
Using the Undo History panel

Elements takes the Undo command to new levels by offering you a panel on which all (well, almost all) of your changes in an editing session are recorded and available for undoing at any step in an editing sequence.

Each edit you make is recorded on the Undo History panel. To open the panel, choose Window ‹ Undo History. Make changes to your document, and each step is recorded on the panel, as you see in Figure 2-20.

If Elements slows down and you’re moving along at a snail’s pace, choose Edit ‹ Clear ‹ Undo History or choose Clear Undo History from the panel’s Options menu. Elements flushes all the recorded history and frees up some precious memory, which often enables you to work faster. Just be sure you’re okay with losing all the history in the Undo History panel thus far. You can also choose Edit ‹ Clear Clipboard or Edit ‹ Clear ‹ All to eliminate Clipboard data from memory.

We said almost all steps are recorded because the number of steps the History panel can record is controlled by a preference setting that tops out at 1,000 steps. If you choose Edit ‹ Preferences (Windows) or Adobe Photoshop Elements 12 ‹ Preferences (Mac) and look at the Performance preferences, as we explain in more depth in Chapter 3, the number of history states (times you can go back in history and undo) defaults to 50. You can change the number to the maximum of 1,000, if you like. But realize that the more history states you record, the more memory Elements requires.

When you want to undo multiple edits, open the Undo History panel and click any item listed on the panel. Elements takes you to that last edit while scrubbing all edits that follow the selected item. If you want to bring back the edits, just click again on any step appearing grayed out on the panel to redo up to that level.

All your steps are listed on the Undo History panel as long as you remain in Elements and don’t close the file. When the file is closed, all history information is lost.
Reverting to the last save

While you make edits on photos in Elements, always plan on saving your work regularly. Each time you save in an editing session, the Undo History panel preserves the list of edits you made before the save and up to the maximum number of history states defined in the General preferences.

If you save, then perform more edits, and then want to return to the last saved version of your document, Elements provides you with a quick, efficient way to do so. If you choose Edit ➤ Revert, Elements eliminates your new edits and takes you back to the last time you saved your file.

When you choose Revert, Revert appears in the Undo History panel. You can eliminate the Revert command from the Undo History panel by right-clicking (Windows) or Ctrl-clicking (on a Mac with a one-button mouse) the Revert item on the Undo History panel and choosing Delete from the context menu that appears. This command returns you to the edits made after the last save.

Getting a Helping Hand

You can reach for this book whenever you want some details about accomplishing a task while working in Elements. However, for those little annoying moments, and just in case some coffee stains blot out a few pages in this book, you may want to look for an alternative feature description from another source.

Rather than accumulate a library of Elements books, all you need to do is look within Elements to find valuable help information quickly and easily. If you’re stuck on understanding a feature, ample help documents are only a mouse click away and can help you overcome some frustrating moments.

Your first stop in exploring the helpful information Elements provides is the Help menu. On this menu, you can find several commands that offer information:

- **Photoshop Elements Help:** Choose Help ➤ Photoshop Elements Help or press the F1 key (Windows) or the Help key (on a Mac with an extended keyboard) to open the Elements Help file. You can type a search topic and press Enter to display a list of items that provide helpful information about the searched words.

- **Key Concepts:** While you read this book, if we use a term that you don’t completely understand, choose Help ➤ Key Concepts. A web page opens in your default web browser and provides many web pages with definitions of terms and concepts.
Support: This menu command launches your default web browser and takes you to the Adobe website (www.adobe.com), where you can find information about Elements, problems reported by users, and some workaround methods for getting a job done. You can find additional web-assisted help information by clicking Photoshop Elements Online and Online Learning Resources. The vast collection of web pages on Adobe’s website offers you assistance, tips and techniques, and solutions to many problems that come with editing images. Be sure to spend some time browsing these web pages.

Video Tutorials: Choose Help ➤ Video Tutorials to open a web page where videos for common tasks are hosted on Adobe’s website.

Forum: Choose Help ➤ Forum to explore user comments and questions with answers to many common problems.

Tip: Tooltips can be another helpful resource. While you move your cursor around tools and panels, pause a moment before clicking the mouse. A slight delay in your actions produces a tooltip, which is a small box that describes the item your mouse is pointing to. Elements provides this sort of dynamic help when you pause the cursor before moving to another location.
Getting Ready to Edit

In This Chapter
▶ Specifying editing preferences
▶ Specifying organizing preferences
▶ Working with presets
▶ Understanding color in Photoshop Elements
▶ Setting up your color-management system

You quickly discover that when working in Photoshop Elements you constantly toggle back and forth between the Organizer and the Photo Editor. This chapter explains how to take charge of Elements and customize your work environment, first by adjusting preference settings in both the Organizer and the Photo Editor, and then by setting up a color-management system. If you’re new to Elements or image editing in general, you might not know just how you want to set up certain features right away. However, you can always refer to this chapter later, after you become familiar with Elements and have a sense for how you’d like to change the default setup for the way you use Elements.

Although not as exciting as firing up Elements and working on your pictures, customizing Elements for your personal work habits and properly setting up color management are critical to everything else you do in the program.

Controlling the Editing Environment

Opening Elements for the first time is like moving into a new office. Before you begin work, you need to organize the office. At minimum, you need to set up the desk and computer before you can do anything. In Elements terms,
the office organization consists of specifying preference settings. Preferences are settings that provide a means to customize your work in Elements and to fine-tune the program according to your personal work habits.

What we offer in the following sections is a brief description of the available preference options. When you need details about one preference option or another, look at the help documents we discuss in Chapter 2. If you use the help documents as a reference, you won’t need to memorize the vast number of settings Elements provides.

Elements has two Preferences dialog boxes: one in the Photo Editor workspace and another in the Organizer workspace. The following sections cover the Preferences dialog box that you open when in the Photo Editor, whether you’re using Windows or the Mac. In the later “Controlling the Organizer Environment” section, you set the preferences for the Organizer workspace.

Launching and navigating preferences

The Photo Editor’s Preferences dialog box organizes all the options into nine panes. By default, when you open the Preferences dialog box, you see the General pane.

To open the Preferences dialog box, choose Edit ➤ Preferences ➤ General (or Photoshop Elements ➤ Preferences ➤ General on the Mac). Alternatively, press Ctrl+K (⌘+K on the Mac). Using either method opens the Preferences dialog box to the General pane, as shown in Figure 3-1.

![Figure 3-1: The General pane in the Preferences dialog box.](image-url)
In Figure 3-1, you see items on both the left and right sides of the dialog box that are common to all preferences panes. Here’s a quick introduction to what these items are and how they work:

- **Panes list:** Elements lists all the different panes along the left side of the Preferences dialog box. Click an item in the list to make the respective pane open on the right side of the dialog box.
- **OK:** Click OK to accept any changes made in any pane and dismiss the Preferences dialog box.
- **Cancel:** Click Cancel to return to the same settings as when you opened a pane and to dismiss the dialog box.
- **Reset:** Clicking the Reset button returns the dialog box to the same settings as when you opened the dialog box. The dialog box stays open for you to set new settings.
- **Prev:** Switch to the previous pane.
- **Next:** Switch to the next pane. Alternatively, you can jump to another pane by pressing Ctrl+(1 through 9) in Windows or pressing ⌘+(1 through 9) on the Mac.

Of particular importance in the General tab are the items you see for Allow Floating Documents in Expert Mode and Enable Floating Document Window Docking. As we discuss in Chapter 2, these check boxes should be selected if you want to undock the document windows from the tabs.

**Checking out all the preferences panes**

The settings in the Preferences dialog box are organized into different panes that reflect key categories of preferences. The following list briefly describes the types of settings you can adjust in each preferences pane:

- **General preferences**, as the name implies, apply to general settings you adjust for your editing environment.
- **Saving Files preferences** relate to options available for saving files. You can add extensions to filenames, save a file with layers or flatten layers (as we explain in Chapter 8), save files with image previews that appear when you’re viewing files as icons on your desktop (Windows), and save with some compatibility options. On the Mac, the Finder generates thumbnails automatically without the need for specifying thumbnails in a Save dialog box.
- **Performance preferences** is the pane where you find history states (explained in Chapter 6) and memory settings, such as scratch disk settings. (See the nearby sidebar “What’s a scratch disk?” for more on scratch disks.)
Part I: Organizing and Editing Images

✓ Display & Cursors preferences offer options for how certain tool cursors are displayed and how you view the Crop tool when you’re cropping images. Chapter 9 explains how cropping works.

✓ Transparency preferences require an understanding of how Elements represents transparency. Imagine painting a portrait on a piece of clear acetate. The area you paint is opaque, and the area surrounding the portrait is transparent. To display transparency in Elements, you need some method to represent transparent areas. (Chapter 7 has more details.) Open the Transparency preferences and make choices for how transparency is displayed in your 2-D Elements environment.

✓ Units & Rulers preferences let you specify settings for ruler units, column guides, and document preset resolutions.

✓ Guides & Grid preferences offer options for gridline color, divisions, and subdivisions. A grid shows you nonprinting horizontal and vertical lines. You use a grid to align objects, type, and other elements. You can snap items to the gridlines to make aligning objects much easier. You can drag guides (sometimes called guidelines) from the ruler and position them between gridlines.

✓ Plug-Ins preferences include options for selecting an additional Plug-Ins folder for storing third-party utilities to work with Elements. Keeping plug-ins in a separate folder can be advantageous when you need to upgrade, reinstall, or delete plug-ins.

✓ Type preferences provide options for setting text attributes. You have options for using different quote marks, showing Asian characters, showing font names in English, and previewing font sizes.

What’s a scratch disk?

Assume that you have 1GB of free RAM (your internal computer memory), and you want to work on a picture that consumes 1.25GB of hard drive space. Elements needs to load all 1.25GB of the file into RAM. Therefore an auxiliary source of RAM is needed for you to work on the image. Elements uses your hard drive. When a hard drive is used as an extension of RAM, this source is a scratch disk.

If you have more than one hard drive connected to your computer, you can instruct Elements to use all hard drives, and you can select the order of the hard drives that Elements uses for your extension of RAM. All disks and media sources appear in a list as 1, 2, 3, 4, and so on.

Warning: Don’t use USB 1.1 external hard drives or other drives that have connections slower than USB 2.0, Thunderbolt, or FireWire. Using slower drives slows Elements’ performance.

What’s a scratch disk?

Assume that you have 1GB of free RAM (your internal computer memory), and you want to work on a picture that consumes 1.25GB of hard drive space. Elements needs to load all 1.25GB of the file into RAM. Therefore an auxiliary source of RAM is needed for you to work on the image. Elements uses your hard drive. When a hard drive is used as an extension of RAM, this source is a scratch disk.

If you have more than one hard drive connected to your computer, you can instruct Elements to use all hard drives, and you can select the order of the hard drives that Elements uses for your extension of RAM. All disks and media sources appear in a list as 1, 2, 3, 4, and so on.

Warning: Don’t use USB 1.1 external hard drives or other drives that have connections slower than USB 2.0, Thunderbolt, or FireWire. Using slower drives slows Elements’ performance.
Controlling the Organizer Environment

A whole different set of Preferences appears when you open the Organizer and choose Edit ➪ Preferences or press Ctrl+K in Windows. (Choose Adobe Elements 12 Organizer ➪ Preferences or press ⌘ + K on the Mac.) Initially, you may be confused because the dialog box that opens when you work in the Organizer is also named Preferences, just like the one in the Photo Editor workspace. However, a quick glance at the dialog box shows you a different set of choices; see Figure 3-2. The following sections introduce you to the Organizer preferences that Elements has to offer.

Navigating Organizer preferences

The Organizer Preferences dialog box allows you to toggle through a number of panes in the same way the Photo Editor Preferences dialog box does. Click the names in the list on the left side of the dialog box to open the respective panes on the right. At the bottom of the dialog box, you find items that are common to all panes in the Preferences dialog box. These items are

- **Restore Default Settings**: Click Restore Default Settings to change all panes to their original defaults.
- **OK**: Click OK to accept new changes.
- **Cancel**: If you click Cancel in any pane, any changes you made aren’t registered.
- **Help**: Click Help to open the Help window and find information about Organize & Share preferences.
Setting preferences in all the panes

Here’s an overview of what you can find in the Organizer Preferences dialog box:

✓ **General:** These items affect a miscellaneous group of settings that are applied to files for print, date views, searches, font handling, and transitions.

✓ **Files:** Here you find options for managing file data, connecting to missing files, setting prompts to back up your data, saving catalogs, choosing file and folder locations for saved files, rotating images, burning CDs and DVDs (Windows only), and handling preview sizes.

✓ **Editing:** You can enable another application that provides some editing features not found in Elements to edit an image based on its file type. One good example for adding another editor is when you’re editing video clips. If you have Adobe Premiere Elements, you can add Premiere Elements as another editor. If you don’t have Premiere Elements installed, you can use another editor, such as Windows Movie Maker (Windows) or iMovie (Macintosh).

✓ **Camera or Card Reader:** Here you can specify how Elements acquires images from digital cameras and media storage cards. Your computer may have a built-in card reader into which you can insert a media card, such as SD cards, CompactFlash or Smart Media, or a USB card reader that supports a media card. In other cases, you may have a cable that connects from your camera to a USB port on your computer. Use these preferences with media cards, camera connections, and download options.

✓ **Scanner (Windows only):** If you scan images with a scanner connected to your computer, the Scanner preferences hold all the options you may want to set.

✓ **Keyword Tags and Albums:** These preferences help you find and sort your images, as we explain in much more detail in Chapters 5 and 6. Tag preferences offer options for sorting tags and icon views for tags.

✓ **Sharing:** The options on this pane relate to sharing files via e-mail. Options are available for setting an e-mail client and adding captions to e-mailed files.

✓ **Adobe Partner Services:** These preferences offer choices for handling program updates and online service orders. You can choose to check for program updates automatically or manually; choose options for printing and sharing images; and specify how you want to update creations, accounts, and more.

✓ **Media-Analysis:** Media-Analysis performs automatic analysis of media in a catalog — such as analyzing photos with people in the images. You can turn off Media-Analysis in this pane.
Adobe Revel: This setting controls the behavior of Adobe Revel. Adobe Revel is a web hosting service for storing your photos in the cloud, where you can view and share your photos on any device, such as a computer, smartphone, tablet, or notebook. If you select the Sync check box, Mobile Albums doesn’t appear in the Import panel. Your photos hosted on Adobe Revel are synced between Elements and your mobile devices. To access Mobile Albums from the Import panel, uncheck the Sync check box. See Chapter 15 for details on Adobe Revel.

Customizing Presets

Part of the fun of image editing is choosing brush tips, swatch colors, gradient colors, and patterns to create the look you want. To get you started, Elements provides you with a number of preset libraries that you can load and use when you want. For example, you can load a Brushes library to acquire different brush tips that you can use with the Brush tool and the Eraser tool. But you’re likely to want to customize the preset libraries at least a little bit, too.

You can change libraries individually in respective panels where the items are used. For example, you can change color swatch libraries on the Color Swatches panel or choose brush-tip libraries in the Tool Options. Another way you can change libraries is to use the Preset Manager dialog box, shown in Figure 3-3.

We cover using the presets in Chapter 12, which is where you can find out how to use the many presets that Elements provides. The important thing to note here is that you can change the presets according to your editing needs.

To open the Preset Manager dialog box, choose Edit ➤ Preset Manager. The available options in the dialog box are

- **Learn More About: The Preset Manager**: Click the blue Preset Manager hyperlinked text to open the Help document and find out more about managing presets.
- **Preset Type**: Open the drop-down menu to choose from Brushes, Swatches, Gradients, and Patterns.
More: The More drop-down menu lists the viewing options. You can view the library items as text lists or as thumbnail views.

Done: Any changes you make in the Preset Manager are recorded and saved when you click Done.

Append: Click the Append button to append a library to the existing library open in the Preset Manager.

Add: Click this button to open another library. Elements allows you to choose from several libraries for each preset type.

Save Set: You can save any changes you make in the Preset Manager as a new library. If you make a change, use this option so that you don’t disturb the original presets.

Rename: Each item in a library has a unique name. If you want to rename an item, click the thumbnail in the Preview pane, click Rename, and then type a new name in the dialog box that appears.

Delete: Click an item in the Preview window and click Delete to remove the item from the library.

---

**Getting Familiar with Color**

We could spend a whole lot of time and many pages in this book delving into the complex world of color theory and definitions. You wouldn’t likely read it, and we’re not so inclined to reduce this book from a page-turner to something that’s likely to sedate you. Rather, in the following sections, we offer some fundamental principles to make your work in Elements easier when you’re editing color images.

Your first level of understanding color is to understand what RGB is and how it works. *RGB* stands for red, green, and blue. These are the primary colors in the computer world. Forget about what you know about primary colors in an analog world; computers see primary colors as RGB. RGB color is divided into *color channels*. Although you can’t see the individual channels in Elements, you still need to understand just a little about color channels.

When you see a color *pixel* (a tiny square), the color is represented as different levels of gray in each channel. This may sound confusing at first, but stay with us for just a minute. When you have a color channel, such as the red channel, and you let all light pass through the channel, you end up with a bright red. If you screen that light a little with a gray filter, you let less light pass through, thereby diluting the red color. This is how channels work. Individually, they all use different levels of gray that permit up to 256 levels of light to pass through them. When you change the intensity of light in the different channels, you ultimately change the color.
Each channel can have up to 256 levels of gray that mask out light. The total number of possibilities for creating color in an RGB model is achieved by multiplying the values for each channel \((256 \times 256 \times 256)\). The result is more than 16.7 million; that’s the total number of colors a computer monitor can display in RGB color.

This is all well and good as far as theory goes, but what does that mean in practical terms? Actually, you see some of this information in Elements’ tools and dialog boxes. As an experiment, open a file in Elements and choose Enhance \(\rightarrow\) Adjust Lighting \(\rightarrow\) Levels; the dialog box shown in Figure 3-4 opens.

![Figure 3-4: Choose Enhance \(\rightarrow\) Adjust Lighting \(\rightarrow\) Levels to open the Levels dialog box.](image)

Notice that the Channel drop-down menu shows you Red, Green, and Blue as individual channels, as well as a composite RGB selection. Furthermore, the Output Levels area shows you values ranging from 0 on the left to 255 on the right. Considering that 0 is a number, you have a total of 256 different levels of gray.

What’s important is that you know that your work in color is related to RGB images that comprise three different channels. There are 256 levels of gray that can let through or hold back light and change brightness values and color. See Chapters 9 and 10 for more on using tools, such as levels, to adjust color in this way.

**Getting Color Right**

In Elements, when it comes to color, the challenge isn’t understanding color theory or definitions, but rather matching the RGB color you see on your computer monitor as closely as possible to your output. Output can be a printout from a color printer or a screen view on a web page.

We say match “as closely as possible” because you can’t expect to achieve an exact match. You have far too many printer and monitor variables to deal with. However, if you properly manage color, you can get a very close match.

To match color between your monitor and your output, you need to first calibrate your monitor and then choose a color workspace profile. In the following sections, you can find all the details.
Color the easy way

The upcoming sections are complex and require some dedicated effort to follow the descriptions. If you're interested in sharing photos only onscreen (that is, on your own website or on Flickr, Facebook, Twitter, and so on) and you plan to leave the printing to others, you don't need to bother with color correction and going through a maze of steps to get the color perfected. In that case, you can skip the technical stuff in the following sections.

The only consideration you need to make is your overall monitor brightness. If your monitor displays images darker or lighter than other computers viewing your images, then you need to follow the upcoming sections and understand how to adjust your overall monitor brightness.

Calibrating your monitor

Your monitor needs to be calibrated to adjust the gamma and brightness; correct any color tints or colorcasts; and generally get your monitor to display, as precisely as possible, accurate colors on your output. You can choose among a few tools to adjust monitor brightness. These tools range from a low-cost hardware device that sells for less than $100 to expensive calibration equipment of $3,000 or more — or you can skip the hardware and use tools provided by OS X or Windows.

Gamma is the brightness of midlevel tones in an image. In technical terms, it's a parameter that describes the shape of the transfer function for one or more stages in an imaging pipeline.

We skip the costly high-end devices and software utilities that don't do you any good and suggest that you make, at the very least, one valuable purchase for creating a monitor profile: a hardware profiling system. On the low end, some affordable devices go a long way toward helping you adjust your monitor brightness and color balance, with prices ranging from $60 to $100. The best way to find a device that works for you is to search the Internet for hardware descriptions, dealers, and costs. You'll find items such as the ColorVision Spyder2express ($100) and Pantone huey Pro ($99), to name just a couple.

On LCD/LED monitors, you need to adjust the hardware controls to bring your monitor into a match for overall brightness with your photo prints. Be certain to run many test prints and match your prints against your monitor view to make the two as similar as possible.

You have a lot to focus on when calibrating monitors and getting the color right on your monitor and your output. We talk more about color output in Chapter 14.
Chapter 3: Getting Ready to Edit

Choosing a color workspace

After you adjust your monitor color by using a hardware profiling system, your next step is to choose your color workspace. In Elements, you have a choice between two workspace colors: either sRGB or Adobe RGB (1998). You access your color workspace settings by choosing Edit ➪ Color Settings. The Color Settings dialog box opens, as shown in Figure 3-5.

The Color Settings dialog box gives you these options:

- **No Color Management**: This choice turns off all color management. Don’t choose this option for any work you do in Elements. When using No Color Management, you need to work with files that have color profiles embedded in the photos. Most likely you won’t use these types of photos. For information on when you might use the No Color Management option, see Chapter 14.

- **Always Optimize Colors for Computer Screens**: Selecting this radio button sets your workspace to sRGB. sRGB color is used quite often for viewing images on your monitor, but this workspace often results in the best choice for color printing, too. Many color printers can output all the colors you can see in the sRGB workspace. In addition, many photo services we talk about in Chapter 16 prefer this workspace color.

- **Always Optimize for Printing**: Selecting this option sets your color workspace to Adobe RGB (1998). The color in this workspace has more available colors than you can see on your monitor. If you choose this workspace, be certain that your printer is capable of using all the colors in this color space.

- **Allow Me to Choose**: When you select this option, Elements prompts you for a profile assignment when you open images that contain no profile. This setting is handy if you work back and forth between screen and print images.

Understanding how profiles work

You probably created a monitor color profile when you calibrated your monitor. You probably also selected a color profile when you opened the Color Settings dialog box and selected your workspace color. When you start
your computer, your monitor color profile kicks in and adjusts your overall monitor brightness and corrects for any colorcasts. When you open a photo in Elements, color is automatically converted from your monitor color space to your workspace color.

At print time, you use another color profile to output your photos to your desktop color printer. Color is then converted from your workspace color to your printer’s color space. In Chapter 14, we show you how to use color profiles for printing. For now, just realize that each of these color profiles, and using each one properly, determines whether you can get good color output.
Working with Resolutions, Color Modes, and File Formats

In This Chapter
▶ Understanding and changing resolution
▶ Resampling images
▶ Understanding color modes
▶ Working with file formats

When you open a picture in Photoshop Elements, you’re looking at a huge mass of pixels. These pixels are tiny, colored squares, and the number of pixels in a picture determines the picture’s resolution.

This relationship between pixels and resolution is important for you to understand in all your Elements work. You’ll find the concepts covered in this chapter especially helpful when creating selections (as we explain in Chapter 7), printing files (Chapter 14), and sharing files (Chapter 15).

Additionally, you need to understand color modes, which are also represented as collections of pixels. Color modes are important when you’re using tools and printing and sharing files. Basically, you want to choose a color mode for your image that is best suited for print or onscreen and the type of image you have (a photo with lots of colors versus a line drawing with only a few colors, for example).

Like resolution and color modes, the file format in which you save an image often depends on your desired output — print or screen — so this chapter concludes with an introduction to choosing a file format. This
chapter helps you understand the basics of working with resolution, color modes, and file formats that are essential to great results in your final images. We talk about changing resolution by resizing images, converting color modes, and saving the results in different file formats.

**Grappling with the Ubiquitous Pixels**

Files you open in Elements are composed of millions of tiny, square pixels. Each pixel has one, and only one, color value. The arrangement of the pixels of different shades and colors creates an illusion to your eyes when you’re viewing an image onscreen. For example, you may have black-and-white pixels arranged in an order that creates the impression that you’re looking at something gray — not at tiny black-and-white squares.

Just about everything you do in Elements has to do with changing pixels:

- Surrounding pixels with selection tools to select what appear to be objects in your image
- Making pixels darker or lighter to change contrast and brightness.
- Changing shades and tints of pixels for color correction
- Performing a variety of other editing tasks

An image made of pixels is called a *raster image*. If you open a file in Elements that isn’t made of pixels, you can let Elements *rasterize* the data. In other words, Elements converts other data to pixels if the document wasn’t originally composed of pixels.

Images not made of pixels are typically *vector images*. You can also have vector content in an Elements file. Text added with the Type tool, for example, is a vector object. When you save an Elements file with the Text layer intact or save it as a Photoshop PDF file, the vector data is retained. We talk more about vector data in Chapter 13. For this chapter, you just need to focus on raster data.

To use most of the tools and commands in Elements, you must be working on a raster image file. If your data isn’t rasterized, many tools and commands are unavailable.

The pixels in an image determine an image’s resolution and dimensions, as we explain in the following sections.
Chapter 4: Working with Resolutions, Color Modes, and File Formats

Understanding resolution

The number of pixels in an image file determines the image’s resolution, which is measured in pixels per inch. For example:

- If you have 300 pixels in 1 inch, your image resolution is 300 ppi.
- If you have 72 pixels across a 1-inch horizontal line, your image resolution is 72 pixels per inch (ppi).

Image resolution is critical to properly outputting files in the following instances:

- **Printing images:** The optimal resolution for print is 300 ppi. If the image resolution is too low, the image prints poorly. If the resolution is too high, you waste time processing all the data that needs to be sent to your printer.

- **Showing images onscreen:** The best resolution for onscreen images is 72 ppi. Onscreen resolution is lower than print to match typical screen resolutions (also called *display resolution*). Just as images have resolution inherent in their files, your computer monitor displays everything you see on it in a fixed resolution. Computer monitors display images at 72 ppi (or 85 or 96 ppi or higher). That’s all you get. What’s important to know is that you can always best view photos on your computer monitor at a 72-ppi image size in a 100 percent view.

Newer devices such as smartphones and tablets have screens with higher resolutions. You can find device display resolutions from 150 ppi to over 300 ppi on a variety of devices. When you design for different displays, it’s important to know the device display-resolution capabilities before you start working in Elements.

To see how image resolution and screen resolution combine and impact what you see onscreen, take a look at Figure 4-1. You see an image reduced to 50 percent and then at different zoom sizes. When the size changes, the monitor displays your image at different resolutions. For example, if you view a photo with a resolution of 72 ppi and reduce the size to 50 percent view on your monitor, the resolution on the monitor appears as though the photo is at 144 ppi. When the size is 100 percent, the image resolution is the same as the monitor resolution. Table 4-1 provides a closer look at these differences in resolution.
Figure 4-1: The same image is viewed at different zoom levels.

Table 4-1: How Image and Display Resolutions Affect What You See Onscreen

<table>
<thead>
<tr>
<th>Image Resolution</th>
<th>Display Resolution</th>
<th>Zoom Level</th>
<th>How Image Appears Onscreen</th>
</tr>
</thead>
<tbody>
<tr>
<td>72 ppi</td>
<td>72 ppi</td>
<td>100%</td>
<td>Image appears onscreen at its actual resolution, so the onscreen display is the same as what you would see if you printed the image. The print won’t be crisp, however, because the resolution is too low for print. A low resolution looks fine on a monitor but not on paper.</td>
</tr>
<tr>
<td>72 ppi</td>
<td>72 ppi</td>
<td>50%</td>
<td>Image appears smaller onscreen, as though it has a higher image resolution (144 ppi, or twice the resolution that it actually has).</td>
</tr>
</tbody>
</table>
### Chapter 4: Working with Resolutions, Color Modes, and File Formats

<table>
<thead>
<tr>
<th>Image Resolution</th>
<th>Display Resolution</th>
<th>Zoom Level</th>
<th>How Image Appears Onscreen</th>
</tr>
</thead>
<tbody>
<tr>
<td>72 ppi</td>
<td>72 ppi</td>
<td>200%</td>
<td>Image appears larger onscreen, as though it has a lower image resolution (36 ppi, or half of its actual resolution). The display needs to simulate “spreading out” the pixels to make the image appear bigger.</td>
</tr>
<tr>
<td>300 ppi</td>
<td>72 ppi</td>
<td>100%</td>
<td>Image appears larger onscreen than it will in print, because the monitor can display only 72 ppi.</td>
</tr>
<tr>
<td>300 ppi</td>
<td>72 ppi</td>
<td>50%</td>
<td>Image appears smaller onscreen but will print larger than the monitor view.</td>
</tr>
<tr>
<td>300 ppi</td>
<td>72 ppi</td>
<td>200%</td>
<td>Image appears larger onscreen but will print smaller than the monitor view.</td>
</tr>
</tbody>
</table>

This relationship between the image resolution and viewing the image at different zoom levels is an important concept to grasp. If you grab an image off the web and zoom in on it, you may see a view like the 800 percent view shown in Figure 4-1. If you acquire a digital camera image, you may need to zoom out to a 16 percent view to fit the entire image in the image window.

The reason that these displays vary so much is because of image resolution. That image you grabbed off a web page might be a 2-inch-square image at 72 ppi, and that digital camera image might be a 10-x-15-inch image at 240 ppi. To fill the entire window with the web image, you need to zoom in on the file. When you zoom in, the image appears as though it is reduced in resolution.

When you zoom into or out of an image, you change the resolution as it appears on your monitor. *No resolution changes are made to the file.* The image resolution remains the same until you use one of the Elements tools to reduce or increase the image resolution.

**Understanding image dimensions**

Image dimensions involve the physical size of your file. If the size is 4 x 5 inches, for example, the file can be any number of different resolution values. After the file is open in Elements, you can change the dimensions of the image, the resolution, or both.
When you change only the dimensions of an image (not the number of pixels it contains), an inverse relationship exists between the physical size of your image and the resolution. When image size is increased, resolution decreases. Conversely, when you raise resolution, you reduce image size.

**The Art of Resampling**

In some cases, images are too large, and you need to reduce their resolution and physical size. In other cases, you might need a higher resolution to output your images at larger sizes. This method of sizing — changing the size, as well as the number of pixels — is called resampling an image. Specifically, reducing resolution is downsampling, and raising resolution is upsampling.

Use caution when you resample images; when you resample, you either toss away pixels or manufacture new pixels. We discuss the resampling details in the section “Understanding the results of resampling,” later in this chapter.

**Changing image size and resolution**

You can change an image’s size and resolution in a couple of different ways. One method is cropping images. You can use the Crop tool with or without resampling images. For more information on using the Crop tool, see Chapter 9. Another method is using the Image Size dialog box, which you use in many of your editing sessions in Elements.

To resample an image with the Image Size dialog box, follow these steps:

1. **Choose Image ➤ Resize ➤ Image Size.**
   Alternatively, you can press Ctrl+Alt+I (⌘+Option+I on the Mac). The Image Size dialog box opens, as shown in Figure 4-2.

The Pixel Dimensions area in the Image Size dialog box shows the file size (in this example, 12.1M). This number is the amount of space the image takes up on your hard drive. The width and height values are fixed unless you select the Resample Image check box at the bottom of the dialog box.

![Figure 4-2: Choose Image ➤ Resize ➤ Image Size to open the Image Size dialog box.](image-url)
2. In the Document Size area, redefine dimensions and resolution.

The options are

- **Width**: Type a value in the text box to resize the image’s width and then press Tab to move out of the field to implement the change. From the drop-down menu to the right of the text box, you can choose a unit of measure: percent, inches, centimeters, millimeters, points, picas, or columns.

- **Height**: The Height options are the same as the Width options for height adjustments.

   If you keep the sizing proportional, you typically edit either the Width or Height text box, but not both. When you alter either width or height, the resolution changes inversely.

- **Resolution**: Type a value in the text box to change resolution, and press the Tab key to commit the change. After you edit the resolution, the Width and Height values are changed inversely (if the Constrain Proportions check box is selected).

3. If you’re okay with resampling your image to get the desired size, select the Resample Image check box.

With this check box selected, you can change dimensions and pixels at the same time, which results in either reducing or increasing the number of pixels. When the check box is deselected, the values for dimensions are linked; changing one value automatically changes the other values.

Before you resample your image, however, be sure to check out the following section, “Understanding the results of resampling.”

4. If you select the Resample Image check box, choose a resampling method from the drop-down menu below it and/or select the other resample options above it.

In the drop-down menu, you find different choices for resampling. See Table 4-2 for details on each of the methods.

When you select the Resample Image check box, the two check boxes above it become active. Here’s what they do:

- **Scale Styles**: Elements has a Styles panel from which you can add a variety of different style effects to images. (See Chapter 11 for details.) When you apply a style, such as a frame border, the border appears at a defined width. When you select the Scale Styles check box and then resize the image, the Styles effect is also resized. Leaving the check box deselected keeps the style at the same size while the image is resized.

- **Constrain Proportions**: By default, this check box is selected, and you should leave it that way unless you want to intentionally distort an image.
5. When you’re done selecting your options, click OK to resize your image.

<table>
<thead>
<tr>
<th>Table 4-2 Resampling Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Method</strong></td>
</tr>
<tr>
<td>Nearest Neighbor</td>
</tr>
<tr>
<td>Bilinear</td>
</tr>
<tr>
<td>Bicubic</td>
</tr>
<tr>
<td>Bicubic Smoother</td>
</tr>
<tr>
<td>Bicubic Sharper</td>
</tr>
</tbody>
</table>

**Understanding the results of resampling**

As a general rule, reducing resolution is okay, but increasing resolution isn’t. If you need a higher-resolution image and you can go back to the original source (such as rescanning the image or reshooting a picture), try (if you can) to create a new file that has the resolution you want instead of resampling in Elements. In some cases, upsampled images can be severely degraded. Regardless of whether you upsample or downsample an image, always save a copy of the photo under a new filename.

If you take a picture with a digital camera and want to add the picture to a web page, the image needs to be sampled at 72 ppi. In most cases, you visit the Image Size dialog box, select the Resample Image check box, add a width or height value, and type 72 in the Resolution text box. What you end up with is an image that looks great on your web page. In Figure 4-3, you can see an image that was downsampled in Elements from over 14 inches horizontal width.
Chapter 4: Working with Resolutions, Color Modes, and File Formats

Figure 4-3: Downsampling images most often produces satisfactory results.

WARNING!

If you start with an image that was originally sampled for a web page and you want to print a large poster, you can forget about using Elements or any other image editor. Upsampling low-resolution images often turns them to mush, as you can see in Figure 4-4.

Figure 4-4: Upsampling low-resolution images often produces severely degraded results.
You might wonder whether upsampling can be used for any purpose. In some cases, yes, you can upsample with some satisfactory results. You can achieve better results with higher resolutions of 300 ppi and more if the resample size isn’t extraordinary. If all else fails, try applying a filter to a grainy, upsampled image to mask the problem. Chapter 11 has the details on filters.

Choosing a Resolution for Print or Onscreen

The importance of resolution in your Elements work is paramount to printing files. Good ol’ 72-ppi images can be forgiving, and you can get many of your large files scrunched down to 72 ppi for websites and slide shows. With output to printing devices, it’s another matter. Many different printing output devices exist, and their resolution requirements vary.

For your own desktop printer, plan to print a variety of test images at different resolutions and on different papers. You can quickly determine the best file attributes by running tests. When you send files to service centers, ask the technicians what file attributes work best with their equipment.

White does not print as a color. When you use white, it appears transparent on your prints and the color appears the same as the paper color you’re using.

For a starting point, look over the recommended resolutions for various output devices listed in Table 4-3.

<table>
<thead>
<tr>
<th>Output Device</th>
<th>Optimum</th>
<th>Acceptable Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop laser printers</td>
<td>300 ppi</td>
<td>200 ppi</td>
</tr>
<tr>
<td>Desktop color inkjet printers</td>
<td>300 ppi</td>
<td>180 ppi</td>
</tr>
<tr>
<td>Large-format inkjet printers</td>
<td>150 ppi</td>
<td>120 ppi</td>
</tr>
<tr>
<td>Professional photo lab printers</td>
<td>300 ppi</td>
<td>200 ppi</td>
</tr>
<tr>
<td>Desktop laser printers (black and white)</td>
<td>170 ppi</td>
<td>100 ppi</td>
</tr>
<tr>
<td>Magazine quality — offset press</td>
<td>300 ppi</td>
<td>225 ppi</td>
</tr>
<tr>
<td>Screen images (web, slide shows, video)</td>
<td>72 ppi</td>
<td>72 ppi</td>
</tr>
<tr>
<td>Tablet devices and smartphones</td>
<td>150+ ppi</td>
<td>150 ppi</td>
</tr>
</tbody>
</table>
Go Ahead — Make My Mode!

Regardless of what output you prepare your files for, you need to consider color mode and file format. In Chapter 3, we talk about RGB (red, green, and blue) color mode. This color mode is what you use to prepare color files for printing on your desktop color printer or to prepare files for photo service centers.

You can also use color modes other than RGB. If you start with an RGB color image, menu options in Elements enable you to convert to a different color mode. Photoshop Elements uses an algorithm (a mathematical formula) to convert pixels from one mode to another. In some cases, the conversion that’s made via a menu command produces good results, and in other cases, a method other than a menu command works better.

In the following sections, we introduce the modes that are available in Elements, discuss when changing an image’s color mode can be useful, and explain how to convert from RGB to the mode of your choice: bitmap, grayscale, or indexed color.

Another mode you may have heard of is CMYK. Although CMYK mode isn’t available in Photoshop Elements, you should be aware of what it is and the purposes of CMYK images. CMYK, commonly referred to as process color, contains percentages of cyan, magenta, yellow, and black colors. This mode is used for commercial printing. If you design a magazine cover in Elements and send the file to a print shop, the file is ultimately converted to CMYK. Also note that most desktop printers use different ink sets within the CMYK color space.

Converting to Bitmap mode

Bitmap mode is most commonly used in printing line art, such as black-and-white logos, illustrations, or black-and-white effects that you create from your RGB images. Also, you can scan your analog signature as a bitmap image and import it into other programs, such as the Microsoft Office applications. If you’re creative, you can combine bitmap images with RGB color to produce many interesting effects.

One important thing to keep in mind is that when you combine images into single documents, you need to convert bitmap files to grayscale or color if you want to merge the images with an RGB image. If you convert to grayscale, Elements takes care of converting grayscale to RGB mode.
As an example of an effect resulting from combining grayscale and color images, look over Figure 4-5. The original RGB image was converted to a bitmap and then saved as a different file. The bitmap was converted to grayscale and dropped on top of the RGB image. After you adjust the opacity, the result is a grainy effect with desaturated color.

You can acquire Bitmap mode images directly in Elements when you scan images that are black and white. Illustrated art, logos, your signature, or a copy of a fax might be the kinds of files you scan directly in Bitmap mode. Additionally, you can convert your images to Bitmap mode.

Converting RGB color to bitmap is a two-step process. You need to first convert to grayscale and then convert from grayscale to bitmap. If you select the Bitmap menu command while in RGB color, Elements prompts you to convert to grayscale first.

The Elements Bitmap mode isn’t the same as the Windows .bmp file format. In Elements, Bitmap mode is a color mode. A Windows .bmp file can be an RGB color mode image, a Grayscale color mode image, or a Bitmap color mode image.

To convert from RGB mode to Bitmap mode, do the following:

1. **In the Photo Editor workspace, open an image that you want to convert to Bitmap mode in either Expert or Quick mode.**

2. **Choose Image ➤ Mode ➤ Bitmap.**

   If you start in RGB mode, Elements prompts you to convert to grayscale.

3. **At the prompt, if you see it, click OK.**

   The Bitmap dialog box opens and provides options for selecting the output resolution and a conversion method.

4. **Select a resolution.**

   By default, the Bitmap dialog box, shown in Figure 4-6, displays the current resolution. You can edit the Output box and resample the image or accept the default. See the section “The Art of Resampling,” earlier in this chapter, for more on changing image resolutions.
5. From the Use drop-down menu, select a method for converting an RGB image to a bitmap image.

Your options are as follows:
- 50% Threshold
- Pattern Dither
- Diffusion Dither

Figure 4-7 shows the effect each method creates.

6. Click OK to convert your image to Bitmap mode.

Figure 4-6: Type a resolution for your output and select the conversion method from the Use drop-down menu.

Figure 4-7: An original RGB image converted to bitmap by using 50% Threshold, Pattern Dither, and Diffusion Dither.
Part I: Organizing and Editing Images

Converting to Grayscale mode

Grayscale images have black-and-white pixels and any one of an additional 254 levels of gray. By converting an RGB image to grayscale, you can make it look like a black-and-white photo.

You can convert an image to grayscale in one of three ways, but remember that one of these methods isn’t as good as the others. We recommend that you avoid converting to grayscale by choosing Image ➪ Mode ➪ Grayscale. When Elements performs this conversion, it removes all the color from the pixels, so you lose some precious data during the conversion and can’t regain the color after conversion. If you were to convert an image to grayscale, save the file, and delete the original from your hard drive or memory card, the color image would be lost forever. You could save a secondary file, but this method can add a little confusion and require some more space on your hard drive.

The following two sections explain better ways to create a grayscale image.

Desaturating a layer

You don’t have to give up your color data when you convert to grayscale. As an alternative to using the menu command for converting images to grayscale, follow these steps:

1. Open an RGB image in Elements.
2. Duplicate a layer.

   The default Panels Bin contains the Layers panel. In this panel, click the icon in the upper-right corner. From the pop-up menu, choose Duplicate Layer. (For more information on working with layers, see Chapter 8.) In this example, we duplicated the layer, adjusted the duplicate layer, and duplicated again to create a third layer.

   You can also duplicate a layer by dragging the layer name to the New Layer icon at the bottom of the Layers panel.

3. Choose Enhance ➪ Adjust Color ➪ Adjust Hue/Saturation to open the Hue/Saturation dialog box, shown in Figure 4-8.

   Alternatively, you can press Ctrl+U (⌘+U on the Mac).

4. Drag the Saturation slider to the far left to desaturate the image on the selected layer. Then click OK.

   All color disappears, but the brightness values of all the pixels remain unaffected. (For more information on using the Hue/Saturation dialog box and the other Adjust Color commands, see Chapter 10.)
5. Turn off the color layer by clicking the eye icon in the Layers panel.

In the Layers panel, you see three layers, as shown in Figure 4-9. You don’t need to turn off the color layer to print the file in grayscale, but turning it off can help you remember which layer you used the last time you printed or exported the file.

Following the preceding steps provides you with a file that contains both RGB and grayscale information. If you want to print the color layer, you can turn off the grayscale layer. If you need to exchange files with graphic designers, you can send the layered file, and then the design professional can use both the color image and the grayscale image.

The other advantage of converting RGB color to grayscale by using the Hue/Saturation dialog box is that you don’t disturb any changes in the brightness values of the pixels. Moving the Saturation slider to desaturate the image affects only the color. The luminance and lightness values remain the same.

Choosing the Convert to Black and White command

A menu command exists for converting color images to black and white. Choose Enhance→Convert to Black and White in either Expert or Quick mode to get to the Convert to Black and White dialog box, as shown in Figure 4-10.

This dialog box contains these controls for adjusting brightness and contrast in images that you convert to grayscale:
Select a Style list: Select from some preset options and as you make adjustments, keep your eye on the dynamic preview in the After thumbnail area.

Adjustment Intensity area: Move the sliders until you get the result you like.

Click OK to close the Convert to Black and White dialog box when you’re done.

If you want to keep your original RGB image in the same file as the grayscale version, duplicate the background by choosing Duplicate Layer from the Layers panel’s More menu. Click the background and choose Enhance ➪ Convert to Black and White. The conversion is applied only to the background, leaving the copied layer in your original color mode.
Chapter 4: Working with Resolutions, Color Modes, and File Formats

Converting to Indexed Color mode

Indexed Color is a mode you use occasionally with web graphics saved in GIF or PNG-8 format. When saving indexed color images, sometimes you can create smaller file sizes than RGB that are ideal for using in website designs (because the smaller the file size, the faster a page downloads to the visitor’s browser).

RGB images in 24-bit color (8 bits per channel) are capable of rendering a palette of 16.7 million colors. An indexed color image is an 8-bit image with only a single channel. The total number of colors you get with indexed color can be no more than 256. When you convert RGB images to indexed color, you can choose to dither the color, which displays the image with an effect much like what you see with bitmapped images. (See the section “Converting to Bitmap mode,” earlier in this chapter, for more on diffusion dithering.) This dithering effect makes the file appear as though it has more than 256 colors, and the transition between colors appears smoother than if no dithering was applied.

On occasion, indexed color images have an advantage over RGB images when hosting the images on web servers: The fewer colors in a file, the smaller the file size. When you prepare images for web hosting, you can choose to use indexed color or RGB color. Whether you choose one over the other really depends on how well the image appears on your monitor. If you have some photos that you want to show on web pages, you should use RGB images and save them in a format appropriate for web hosting, as we explain in the section “Saving files for the web,” later in this chapter.

If you have files composed of artwork, such as logos, illustrations, and drawings, you may find that the appearance of index colors is no different from the same images in RGB mode. If that’s the case, you can keep the indexed color image and use it for your web pages.

To convert RGB images to indexed color, choose Image ▸ Mode ▸ Indexed Color; the Indexed Color dialog box opens. Several options are available to you, and fortunately, you can preview the results while you make choices. Get in and poke around, and you can see the options applied in the image window.

Saving Files with Purpose

You can save Photoshop Elements files in a variety of formats. Some format types require you to convert a color mode before you can use the format. Therefore, a relationship exists between file formats and saving files. Additionally, bit depths in images also relate to the kinds of file formats you can use when saving files.
Before you go too far in Elements, become familiar with file formats and the conversions that you need to make in order to save in one format or another. If you do nothing to an image in terms of converting modes or changing bit depth, you can save a file after editing in the same format in which the file was opened. In many circumstances, you open an image and prepare it for some form of output, which requires more thought about the kind of file format you use when saving the file.

Using the Save/Save As dialog box

In most any program, the Save (or Save As) dialog box is a familiar place where you make choices about the file to be saved. With Save As, you can save a duplicate copy of your image or save a modified copy and retain the original file. However, if you’re planning to upload your final image to the web, skip the familiar Save (or Save As) dialog box and see the next section, “Saving files for the web.”

To use the Save (or Save As) dialog box, choose File➪Save for files to be saved the first time, or choose File➪Save As for any file, and a dialog box then opens.

As a matter of good practice when you open an image, choose File➪Save As for your first step in editing a photo. Save with a new filename to make a copy and then proceed to edit the photo. If you don’t like your editing results, you can return to the original, unedited photo and make another copy for editing.

The standard navigational tools you find in any Save dialog box appear in the Elements Save/Save As dialog box. Here are two standard options you find in the Elements Save/Save As dialog box:

- **Filename:** This item is common to all Save (Windows) or Save As (Mac) dialog boxes. Type a name for your file in the text box.

- **Format:** From the drop-down menu, you select file formats. We explain the formats supported by Elements in the section “Understanding file formats,” later in this chapter.

A few options make the Photoshop Elements Save/Save As dialog box different from other Save dialog boxes that you might be accustomed to using. The Save Options area in the Save As dialog box provides these choices:

- **Include in the Elements Organizer:** If you want the file added to the Organizer, select this check box. (For more information about using the Organizer, see Chapter 1.)
Chapter 4: Working with Resolutions, Color Modes, and File Formats

- **Save in Version Set with Original:** You can edit images and save a version of your image, but only in Quick mode. When you save the file from Quick mode, this check box is enabled. Select the box to save a version of the original, which appears in the Organizer.

- **Layers:** If your file has layers, selecting this check box preserves the layers.

- **As a copy:** Use this option to save a copy without overwriting the original file.

- **Color:** Select the box for ICC (International Color Consortium) Profile. Depending on which profile you’re using, the option appears for sRGB or Adobe RGB (1998). When the check box is selected, the profile is embedded in the image. See Chapter 3 for more information on profiles.

- **Thumbnail (Windows only):** If you save a file with a thumbnail, you can see a miniature representation of your image when viewing it in folders or on the desktop. If you select Ask When Saving in the Saving Files preferences, the check box can be enabled or disabled. If you select an option for Never Save or Always Save in the Preferences dialog box, this box is enabled or disabled (grayed out) for you. You need to return to the Preferences dialog box if you want to change the option.

- **Use Lower Case Extension (Windows only):** File extensions give you a clue to which file format was used when a file was saved. Elements automatically adds the extension to the filename for you. Your choices are to use uppercase or lowercase letters for the extension name. Select the check box for Use Lower Case Extension for lowercase or deselect the check box if you want to use uppercase characters in the filename.

**Saving files for the web**

When you want to prepare photos for web browsers and for onscreen viewing such as interactive PDF files, you can optimize the images for the web by choosing File ➤ Save for Web. After you open a file in the Photo Editor in Expert mode and choose the command, the Save for Web dialog box opens, as shown in Figure 4-11. In this dialog box, you see your original image on the left, and the result of making changes for file format and quality settings appears on the right.

The standard rule with web graphics is to find the smallest file size for an acceptable image appearance. In the Save for Web dialog box, you have many choices for reducing file size. Notice in Figure 4-11 that you see the original image with the file size reported below the image on the left. After choosing JPEG for the file type, you can see that the image size is reduced from the original 3.55MB to 55.52K.
From the drop-down menu, you can make choices for the file type from JPEG to GIF, PNG-8, or PNG-24. You can also use the Quality item that appears to the right of the drop-down menu to adjust the final quality of the saved file.

For photographs that are continuous tone images, JPEG or PNG-24 are most often your best choices. If you experiment and view the result of making changes in the drop-down menu for other file types, be certain to zoom in on the image by clicking the Zoom tool in the Tools panel on the left, or press Ctrl++ (plus key) to zoom in and Ctrl+- (minus key) to zoom out (⌘++ and ⌘+- on the Mac). In the lower-left corner of the dialog box, you can choose zoom levels from the drop-down menu or just type a value in the field box.

For the most accurate viewing, set the zoom size to 100 percent. If there is any loss of image quality, you can easily discern the loss when viewing at a 100 percent view.

If you have an image with just a few colors such as a logo, try the GIF or PNG-8 format. If you need transparency in an image, you need to use either GIF or PNG-24. Quite often you’ll find PNG-24 results in the best-looking image.

Working in the Save for Web dialog box is a matter of making choices and viewing the results. Toggle the different file type choices and make adjustments for quality. If you see image degradation, change to a different quality setting.
or file format. Always look at the file-size item reported below the image on the right and try to find the lowest file size that produces a good-looking image. See our web extras for detailed steps on saving files for the web at www.dummies.com/extras/photoshopelements12.

Understanding file formats

When you save files in Elements, you need to pick a file format in the Format drop-down menu found in both the Save and Save As dialog boxes.

When you choose from the format options, keep the following information in mind:

- **File formats are especially important when you exchange files with other users.** Each format has a purpose, and other programs can accept or reject files depending on the format you choose.

- **Whether you can select one format or another when you save a file depends on the color mode, the bit depth, and whether layers are present.** If a format isn’t present in the Format drop-down menu when you attempt to save a file, return to one of the edit modes and perform some kind of edit, such as changing a color mode or flattening layers, in order to save the file in your chosen format.

Elements provides you a long list of file formats, many of which are outdated. What is important is to know the essentials and what you’re likely to use in your editing sessions. Although many different file formats are available, you’ll want to use only a few. Figure 4-12 shows the open Format drop-down menu you see in the Save or Save As dialog box.

In the following sections, we explain the most common formats you will typically use.

**Photoshop (*.PSD, *.PDD)**

This format is the native file format for both Photoshop and Photoshop Elements. The format supports saving all color modes and bit depths, and you can preserve layers. Use this format when you want to save in a native format or exchange files with Photoshop users. Also use it for saving files that you need to return to for more editing. When you save layers, any text you add to layers can be edited when you return to the file. (See Chapter 13 for more information on adding text to an image.)
**BMP (*.BMP, *.RLE, *.DIB)**

The term *bitmap* can be a little confusing. You have both a file format type that’s bitmap and a color mode that’s bitmap. Don’t confuse the two. The bitmap format supports saving in all color modes and in all bit depths. The Bitmap color mode, which we cover in the section “Converting to Bitmap mode,” earlier in this chapter, is a 1-bit black-and-white mode only.

Use the bitmap format when you want to add images to system resources, such as wallpaper for your desktop. Bitmap is also used with many programs. If you can’t import images in other program documents, try to save them as BMP files.

**CompuServe GIF (*.GIF)**

When CompuServe was the host for our e-mail accounts, Barb was a college coed, and Ted had a mustache and wore a green leisure suit. We exchanged files and mail on 300-baud modems. Later, in 1977, CompuServe developed GIF (Graphics Interchange Format) to exchange files between mainframe computers and the ever-growing number of users working on Osborne, Kaypro, Apple, and Radio Shack TRS-80 computers.

If you choose to use the GIF format, don’t save the file using the File ➪ Save or File ➪ Save As command. Instead, choose File ➪ Save for Web, as we explain earlier, in the section “Saving files for the web.”

**Photo Project Format (*.PSE)**

Use this option when you create a project in Elements and want to save the file as a project. See Chapter 16 for more on creating projects.

**JPEG (*.JPG, *.JPEG, *.JPE)**

JPEG (Joint Photographic Experts Group) is perhaps the most common file format now in use. JPEG files are used with e-mail attachments and by many photo labs for printing files, and they can be viewed in JPEG viewers and directly in web browsers. Just about every program capable of importing images supports the JPEG format. Creative professionals wouldn’t dream of using the JPEG format in design layouts, but everyone else uses the format for all kinds of documents.

You need to exercise some caution when you’re using the JPEG format. JPEG files are compressed to reduce file size, so you can scrunch an image of
Chapter 4: Working with Resolutions, Color Modes, and File Formats

several megabytes into a few hundred kilobytes. When you save a file with JPEG compression, however, you experience data loss. You might not see this on your monitor, or it might not appear noticeably on photo prints if you’re using low compression while preserving higher quality. However, when you save with maximum compression, more pixels are tossed away, and you definitely notice image degradation.

When you save, open, and resave an image in JPEG format, each new save degrades the image more. If you need to submit JPEG images to photo labs for printing your pictures, keep saving in the Photoshop PSD file format until you’re ready to save the final image. Save in JPEG format when you want to save the final file for printing, and use a low compression with high quality.

When you select JPEG for the format and click Save, the JPEG Options dialog box opens, as shown in Figure 4-13. You choose the amount of compression by typing a value in the Quality text box or by moving the slider below the Quality text box. The acceptable range is from 0 to 12 — 0 is the lowest quality and results in the highest compression, and 12 is the highest quality that results in the lowest amount of compression.

Notice that you also have choices in the Format Options area of the JPEG Options dialog box. The Progressive option creates a progressive JPEG file commonly used with web browsers. This file type shows progressive quality while the file downloads from a website. The image first appears in a low-quality view and shows higher-resolution views until the image appears at full resolution when it’s completely downloaded in your browser window.

Photoshop PDF (*.PDF, *.PDP)

Adobe PDF (Portable Document Format) is designed to maintain document integrity and exchange files between computers. PDF is one of the most popular formats, and you can view it in the free Adobe Reader program available for installation on your Elements CD installer or by downloading it from the Adobe website. On the Mac, you can also view PDFs in Apple’s Preview application or the QuickLook feature of OS X.
PDF is all over the place in Elements. When you jump into Organize mode and create slide presentations, cards, and calendars, for example, you can export your documents as PDF files. When you save in Photoshop PDF format, you can preserve layers and text. Text is recognizable in Adobe Reader (or other Acrobat viewers), and you can search text by using the Reader’s Find and Search tools.

PDF files can be printed, hosted on websites, and exchanged with users of Windows, Mac, Unix, and Linux. All in all, this format is well suited for all the files you create in Elements that contain text, layers, and transparency, and for when you want to exchange files with users who don’t have Elements or Photoshop.

**Pixar (*.PXR)**
This format is used for exchanging files with Pixar workstations. In all likelihood, you may never use this format.

**PNG (*.PNG)**
PNG (Portable Network Graphics) is another format used with web pages. PNG supports all color modes, 24-bit images, and transparency. One disadvantage of using PNG is that color profiles can’t be embedded in the images, like they can with JPEG. An advantage, however, is that PNG uses lossless compression, resulting in images without degradation.

PNG is also an option in the Save for Web dialog box we describe in the section “Saving files for the web.” Choose File ➪ Save for Web to export your photos as PNG.

**TIFF (*.TIF, *.TIFF)**
TIFF (Tagged Image File Format) is the most common format used by graphic designers. TIFF is generally used for importing images in professional layout programs, such as Adobe InDesign and QuarkXPress, and when commercial photo labs and print shops use equipment that supports downloading TIFF files directly to their devices. (*Note:* Direct downloads are used in lieu of opening a Print dialog box.)

Inasmuch as creative professionals have used TIFF for so long, a better choice for designers using a program such as Adobe InDesign is saving in the native Photoshop PSD file format. This requires a creative professional to save only one file in native format without bothering to save both native and TIFF formats.

TIFF, along with Photoshop PSD and Photoshop PDF, supports saving layered files and works in all color modes. When you save in TIFF format, you can
also compress files in several different compression schemes, and compression with TIFF files doesn’t lose data unless you choose a JPEG compression.

When you select TIFF for the format and click Save in the Save/Save As dialog box, the TIFF Options dialog box opens, as shown in Figure 4-14.

In the Image Compression area, you have these choices:

- **NONE**: Selecting this option results in no compression. You use this option when sending files to creative professionals for creating layouts in programs such as Adobe InDesign. (None of the three compression schemes listed next is recommended for printing files to commercial printing devices.)

- **LZW**: This lossless compression scheme results in much lower file sizes without destroying data.

- **ZIP**: ZIP is also a lossless compression scheme. You can favor ZIP compression over LZW when you have large areas of the same color in an image.

- **JPEG**: JPEG is lossy and results in the smallest file sizes. Use JPEG here the same as when you apply JPEG compression with files saved in the JPEG format.

Leave the remaining items in the dialog box at defaults and click OK to save the image.

**File formats at a glance**

Although we’ve been working with Photoshop (which saves in the same formats listed in this section) since 1989, we have never used all the formats available in Photoshop Elements. At most, you’ll use maybe three or four of these formats.

You don’t need to remember all the formats and what they do. Just pick the ones you use in your workflow, mark Table 4-4 for reference, and check it from time to time until you have a complete understanding of how files need to be prepared in order to save them in your desired formats. If you happen to receive a file from another user in one of the formats you don’t use, come back to the description in this chapter when you need details about what the format is used for.
### Table 4-4: File Format Attributes Supported by Photoshop Elements

<table>
<thead>
<tr>
<th>Format</th>
<th>Color Modes Supported</th>
<th>Embed Profiles* Supported</th>
<th>Bit Depth Supported**</th>
<th>Layers Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoshop PSD, PDD</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>Yes</td>
<td>1, 8, 24, H</td>
<td>Yes</td>
</tr>
<tr>
<td>BMP</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>No</td>
<td>1, 8, 24, H</td>
<td>No</td>
</tr>
<tr>
<td>CompuServe GIF***</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>No</td>
<td>1, 8</td>
<td>No</td>
</tr>
<tr>
<td>JPEG</td>
<td>RGB, Grayscale</td>
<td>Yes</td>
<td>8, 24</td>
<td>No</td>
</tr>
<tr>
<td>Photoshop PDF</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>Yes</td>
<td>1, 8, 24, H</td>
<td>Yes</td>
</tr>
<tr>
<td>Pixar</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>No</td>
<td>1, 8, 24, H</td>
<td>No</td>
</tr>
<tr>
<td>PNG</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>No</td>
<td>1, 8, 24, H</td>
<td>No</td>
</tr>
<tr>
<td>TIFF</td>
<td>Bitmap, RGB, Index, Grayscale</td>
<td>Yes</td>
<td>8, 24, H</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* Embedding profiles is limited to embedding either sRGB IEC61966-2.1 or AdobeRGB (1998).

** The letter H in Column 4 represents higher-bit modes, such as 16- and 32-bit images, which you might acquire from scanners and digital cameras. See Chapter 5 for more information on higher-bit images.

*** CompuServe GIF doesn’t support saving layers, although it supports saving layers as frames. You use the frames when creating an animated GIF file to be used for web pages.
Audio and video formats supported in Elements

In addition to the image formats listed in Table 4-4, Elements supports audio and video files. The support is limited to adding and viewing audio and video files in the Organizer and printing the first frame in a video file. Other kinds of edits made to audio and video files require special software for audio and video editing.

Audio files can be imported in slide shows, as we explain in Chapter 15. The acceptable file formats for audio files are MP3, WAV, QuickTime, and WMA. If you have audio files in another format, you need to convert the file format. For these kinds of conversions, you can search the Internet for a shareware audio-conversion program.

Video files can also be imported in slide shows, as we discuss in Chapter 15. Elements supports the WMV (Windows) and Apple QuickTime (Mac) video formats. As with audio files, if videos are saved in other formats (too numerous to mention), you need to convert the video format to a format acceptable to Elements. For video-conversion utilities, you can also find shareware and freeware programs to do the job. Search the Internet for a video converter.
Find detailed steps on how to create albums at www.dummies.com/extras/photoshopelements12.
In this part . . .

- Manage files and keep your media well organized to quickly locate media you want to use for editing, sharing, and making creations.
- Search for media and use the many commands in the Find menu.
- View your pictures in the Media Browser and change views.
- Create albums to further help you organize your media.
Tagging Photos and Creating Albums

In This Chapter
▶ Creating and organizing keyword tags
▶ Working with albums

In this chapter, we jump back to the Organizer (already introduced in earlier chapters) and cover many of the features it offers for managing and organizing your photos. You need some photo-management skills so you can easily find photos you want to edit in the Photo Editor, add photos to a new creation, or share photos with friends and family.

Downloading a bunch of media cards filled with photos and leaving them in folders distributed all over your hard drive is like having a messy office with papers stacked haphazardly all over your desk. Trying to find a file, even with all the great search capabilities we cover in Chapter 6, can take you as much time as sorting through piles of papers. What you need is a good file-management system.

In this chapter, we talk about tagging photos, organizing and annotating files, creating versions and stacks, creating photo albums, and performing other tasks so that you can quickly sort through large collections of photos. Be certain to take some time to understand the organizational methods that Elements offers, keep your files organized when you copy them to your hard drive, and (for Windows users) back up files to CDs or DVDs. The time you invest in organizing your pictures helps you quickly locate files when you need them.
Although the Organizer wasn’t always available to Mac users, now Macintosh users can take almost full advantage of all the Organizer tools and methods in Photoshop Elements 9 and above. This chapter, of course, focuses on how the tools work in PhotoShop Elements 12.

Touring the Organizer

In Chapter 1, we talk about some of the tasks you can perform using the Elements Organizer, but we don’t give you an overall view of the Organizer and the various panels associated with it. Therefore, we begin this chapter about more Organizer tasks by first offering a glimpse at the Organizer workspace.

Figure 5-1 shows you an Organizer view. The various items in the Organizer include the following:

Figure 5-1: The Organizer workspace.
A. **Menu bar:** The Organizer menus appear in the top-left section of the menu bar. In Windows, the menus belong to the application. On the Mac, the menu bar is part of the operating system’s menus.

B. **All Media/Sort By:** When you click a folder as you see in item J, the thumbnail images shown in the Media Browser (item V) display only those photos within the selected folder. Figure 5-1 shows the Macau folder selected. If you click the All Media button, you leave the selected folder and see all photos from all folders in the Media Browser. Adjacent to the All Media button is a drop-down menu where you can sort the thumbnails in the Media Browser according to Newest, Oldest, and Batches of photos that you imported.

C. **Media/People/Places/Events:** At the top of the Organizer window, you find four tabs:

- **Media:** The first tab is Media. Click the Media tab to display thumbnails of photos either in a folder or in the entire catalog. (See Chapter 6 for more on catalogs.)
- **People:** Click this tab to display photos where you have tagged faces, as we discuss in Chapter 1.
- **Places:** Click this tab, and a Google map appears in the Panel Bin. Geospatial mapping was available in Elements 11, where you can tag photos according to map coordinates by using Google maps. You click the Add Places button (item R) to tag an image with a place on the map. See Chapter 6 for more on adding places.
- **Events:** Click this tab to display photos that have been tagged as Events. To tag a photo with an event, click the Add Event button (item S). See Chapter 6 for more on Events.

We talk more about tagging photos later in this chapter, in the section “Organizing Groups of Images with Tags.”

D. **Search:** Any photos you have tagged with keywords can be searched. Type the search criteria such as the name of a person you have tagged with the People tag in the text box, and then press Enter/Return or click the magnifying-glass icon.

E. **Features buttons:** In Windows, you find Maximize, Minimize, and Close buttons in the top-right corner of the Organizer. On the Mac, in the top-left corner you find Close, Minimize to Dock, and Maximize.

F. **Albums:** When you create albums (as we explain in the section “Creating Albums,” later in this chapter), your albums appear at the top of the left panel.

G. **Create/Share:** These two items are drop-down menus. You choose a menu item that takes you either to the Photo Editor or a wizard where you work step-by-step to complete a task. For more information on making creations, see Chapter 16. For more information on sharing photos, see Chapter 15.
H. **Mobile Albums:** Click the Refresh arrow and you can sync photos stored in your Adobe Revel albums. See Chapter 15 to find out how to use Adobe Revel.

I. **Panel Bin:** Within the Panel Bin, you find various panels that are docked. By default, you see Keyword Tags, Information, and Image Keywords. The section “Organizing Groups of Images with Tags,” later in this chapter, has details about using the panels.

J. **My Folders:** If you read Chapter 1, this panel should be familiar to you. You import photos in the Organizer, and the photos are organized by folders.

K. **Instant Fix:** Click this button, and you see the same panel in the Organizer that opens when you select Quick mode in the Photo Editor. We explain Quick mode in Chapter 2. The nice thing about having the Quick mode options in the Organizer is that you don’t need to open files in the Photo Editor to apply some edits to your photos.

L. **Keyword/Info:** If you click this button while the Keyword Tags panel is open, the Panel Bin is dismissed. Click again to display the Panel Bin.

M. **Hide Panel:** Click this button to hide the left panel. If you click this button and the Keyword/Info button (item L), you can hide both panels. Doing so provides you a maximum viewing area for the photo thumbnails.

N. **Status bar:** The bottom of the Organizer window provides information. On the left, you see the number of items in your catalog and the date you created the catalog. On the far right, you see the name of your catalog.

O. **Undo/Redo:** Click the tiny arrow and a pop-up menu displays Undo and Redo. Choose an item to undo or redo your last action.

P. **Rotate:** When you click the arrow, you can choose to rotate a photo clockwise or counterclockwise. To use either tool, you must first select a thumbnail in the Media Browser.

Q. **Add People:** In Chapter 1, we talk about adding people when you import photos in the Media Browser. Elements does a nice job of recognizing people, but it has a hard time with profile shots, tilted heads, and photos where people are not easily recognized.

Double-click a photo to zoom into it and click the Add People button. A new rectangle appears in the photo that you can move to position and add a name.

R. **Add Places:** When you click Add Places, a window opens atop the Organizer. A filmstrip appears at the top of the window, displaying files currently shown in the Media Browser. Below the filmstrip is a large map where you can assign map locations to the photos you select in the filmstrip.
Chapter 5: Tagging Photos and Creating Albums

S. **Add Event**: Add Event is yet another item that helps you organize your photos. You can add tags for people, places, and then events to help narrow down a large collection of photos. Each of these items can be sorted by clicking the respective tab at the top of the Organizer.

T. **Slide Show**: Slide Show provides an onscreen view of all the photos you have open in the Media Browser. You can sort photos according to tags, click Slide Show, and sit back and watch the photos scroll on your computer monitor.

U. **Editor**: Click to return to the Photo Editor.

V. **Media Browser**: Shows thumbnail displays of your images.

W. **Zoom**: Adjust the slider to see thumbnails larger or smaller.

This overall description of the Organizer can be helpful when you perform tasks related to the Organizer. Earmark this page and use it as a reference to quickly identify items contained in the Organizer.

**Organizing Groups of Images with Tags**

Elements provides you with a great opportunity for organizing files, in the form of tags. After you acquire your images in the Organizer, as we discuss in Chapter 1, you can sort them and add tags according to the dates when you took the pictures, the subject matter, or some other categorical arrangement.

In the Organizer, the Tags panel helps you sort your pictures and keep them well organized. You use the Tags panel to identify individual images by using a limitless number of options for categorizing your pictures. On this panel, you can create tags and collection groups to neatly organize files.

In Elements 12, tags have been refined. Earlier versions of Elements offered a panel with tags listed in a linear order and non-grouped. With Elements 12, the Tags panel is divided into four categories, as shown in Figure 5-2: Keywords, People Tags, Places Tags, and Events Tags.

Elements helps you organize your photos into these four main categories, and each category has a drop-down menu you can use to create new tags and add new subcategories. In the following sections, you can find out how to create and manage tags.

---

Figure 5-2: The Tags panel in the Organizer.
Creating and viewing a tag

To create a new tag and add tags to photos, follow these steps:

1. **Open photos in the Organizer.**
   
   See Chapter 1 for more on opening images in the Organizer.

2. **To create a new tag, choose which category you want to use (Keywords, People Tags, Places Tags, or Events Tags) and then click the plus (+) icon next to that category to open a drop-down menu.**

3. **From the drop-down menu, choose an option:**
   
   - **Keywords:** Choose New Keyword Tag.
   - **People Tags:** Choose New Person.
   - **Places Tags:** Choose Add a New Place.
   - **Events Tags:** Choose Add an Event.

   When you add a new Keyword tag, the Create Keyword Tag dialog box opens, as shown in Figure 5-3, where you can add information about the tag attributes. Depending on what category you choose, the information you fill into the dialog box varies. For example, when you add a new tag in the Keywords category, the Create Keyword Tag dialog box provides options for editing the tag icon, specifying a category, typing a name, and adding comments. If you add a People tag, you type a person’s name and choose a group such as family, friends, and so on. If you add a Places tag, you can choose to map the location. If you add an Event tag, you type the tags for the event, choose dates, and add a description. Hence, the attributes change according to the type of tag you create.

   ![Figure 5-3: The Create Keyword Tag dialog box.](image)

   In our example, we add a new tag to the Keywords category.

4. **Specify a category.**
Chapter 5: Tagging Photos and Creating Albums

Click the Category drop-down menu and choose one of the preset categories listed in the menu. (See the next section for instructions on customizing these categories.)

5. **Type a name for the tag in the Name text box and add a note to describe the tag.**

You might use the location where you took the photos, the subject matter, or other descriptive information for the note.

6. **Click OK.**

You return to the Organizer.

7. **In the Organizer, select the photos to which you want to add tags.**

Click a photo and Shift-click another photo to select photos in a group. Click a photo and Ctrl-click (⌘-click) different photos scattered around the Organizer to select nonsequential photos.

8. **To add a new tag to a photo (or selection of photos), click one of the selected photos in the Organizer and the plus (+) symbol in the Tags panel shown in Figure 5-4 or drag the photos to the tag in the panel.**

Alternatively, you can drag a tag to the selected photos.

When you release the mouse button, the photos are added to the new tag.

9. **Repeat Steps 2 through 6 to create tags for all the images you want to organize.**

Tags help you in many ways as we explain later in this chapter in the sections “Sorting photos according to tags” and “Creating Albums.” The more you become familiar with tagging photos, the more opportunities you have for sorting and finding photos and adding found photos to albums. We encourage you to play with the Tags panel and explore creating tags and tagging photos in each of the different categories.

**Adding icons to tags**

By default Elements provides a set of icons displayed adjacent to all tag names. You can change the icon appearance to match a view similar to one
of the photos you tag for a given keyword. If you want to add an image to the tag icon, you can handle it in a few ways. Perhaps the most reliable is to edit the tag as follows:

1. **Right-click a tag in the Tags panel and choose Edit.**

   The Edit Keyword Tag dialog box opens.

2. **Click the Edit Icon button.**

   At this point, the Edit Keyword Tag Icon dialog box opens, as shown in Figure 5-5. The dialog box displays the total number of images that are tagged with the current tag, a button to import an image for the icon, and left and right arrows to scroll through all the images and choose one for an icon.

   Additionally, you can click the Find button to open a window displaying thumbnail images of all the photos you have tagged for the given category.

3. **Select an image for the tag icon.**

4. **(Optional) Crop the image by moving handles on the rectangle displayed in the Edit Keyword Tag Icon dialog box.**

5. **Click OK when you finish editing the icon.**

   The icon is displayed in the Tags panel.

To view the icons appearing in the Tags panel with the custom appearance you add in the Edit Icon dialog box, you need to view the Tags panel with Large Icons. See the next section, “Working with custom tags,” to change the view.
Working with custom tags

We refer to custom tags as those tags you create in the Tags panel. Elements offers you a number of preset tags that you can use to tag your photos, and those we refer to as the default tags. In this section, we look at creating and editing custom tags.

You can manage tags by using menu commands from the Tags panel drop-down menu (click the down arrow adjacent to one of the + icons) and other commands from a contextual menu that you open by right-clicking a tag on the Tags panel.

In the Tags panel drop-down menu, you can access these commands:

- **New Keyword Tag**: Create a new tag, as we describe in the steps in the preceding section.
- **New Sub-Category**: A subcategory is like a nested bookmark. Create a subcategory by choosing New Sub-Category from the New menu; a dialog box opens, prompting you to type a name for the new subcategory. As an example of how you would use tags and subcategories, you might have a tag named Uncle Joe’s Wedding. Then you might create subcategories for Bride Dressing Room, Ceremony, Family Photos, Reception, and so on.
- **New Category**: Choose New Category to open a dialog box that prompts you to type a name for the new category. By default, you can find predefined category names for People, Places, Events, and Other. If you want to add your own custom categories, use this menu command.
- **Edit**: Choose Edit to open the Edit Keyword Tag dialog box. This dialog appears exactly the same as the Create Keyword Tag dialog box, shown earlier in Figure 5-3.
- **Import Keyword Tags from File**: If you export a tag, the file is written as XML (eXtensible Markup Language). When you choose From File, you can import an XML version of a tags file.
- **Save Keyword Tags to a File**: You can save tags to a file that you can retrieve with the Import Keyword Tags from File command. This option is handy when you open a different catalog file and want to import the same collection names created in one catalog file to another catalog file. (See Chapter 6 for more information.)
**Collapse All Keyword Tags:** Tags appear like bookmark lists that can be collapsed and expanded. An expanded list shows you all the subcategory tags. Choose Collapse All Keyword Tags to collapse the list.

**Expand All Keyword Tags:** This command expands a collapsed list.

**Show Large Icon:** Click this option to display the tag icons larger in the Tags panel. When you change the view to large icons, you see the custom edits you make when editing an icon.

Tags are saved automatically with the catalog you work with. By default, Elements creates a catalog and automatically saves your work to it. If you happen to create another catalog, as we explain in the next section, your tags disappear. Be aware of which catalog is open when you create tags in order to return to them.

**Working with default tags**

When you create a custom tag, you can modify its appearance. With the default tags that Elements provides, you can make some changes to the tags’ appearances, but in limited ways. For example, you cannot add a custom image for the tag icon. You can also modify the names for the preset tags, and you can add some custom subcategories.

To edit a preset category tag, follow these steps:

1. **On one of the predefined categories, right-click and choose Edit.**
   
The Edit Category dialog box opens, as shown in Figure 5-6.

2. **Click the Choose Color button to change the color of the tag icon.**

3. **To choose an icon for the preset category, move the scroll bar horizontally and click the icon you want to use.**
   
   You are limited to the images Elements provides you for displaying icons on the predefined categories.

4. **Click OK when you’re done.**
Chapter 5: Tagging Photos and Creating Albums

Working with subcategories

A category tag is at the top of the tag hierarchy. As we mention earlier, there are four main categories. Below a category, you can add subcategories, and each subcategory can have subcategories below it. For example, you may want to create separate tags for different people in the People Tags category. You can’t use custom icons, and you’re restricted to using the icons provided by Elements, as shown in Figure 5-6. Here’s how to add a new category and subcategory:

1. From one of the Tags panel drop-down menus (+ icon), choose New Category.
   
   In this case, we’re working with People Tags, so we clicked Family and then clicked the plus (+) icon to add a new tag name. The Create Sub-Category Name dialog box then opens.

2. Provide a name in the Sub-Category Name dialog box and choose a group from the Parent Group or Sub-Category drop-down menu.

3. Click OK and repeat these steps until you create all the subcategories you want.

   Notice that you don’t have options for creating custom icons or for adding icons provided by Elements. All the subcategory icons are predefined for you, as shown in Figure 5-7, where three subcategories appear on the People Tags panel.

Sorting photos according to tags

Creating tags is useless unless you have a way to view the photos according to the tags you add to the Tags panel. Viewing your tagged photos in the Organizer is made easy in Elements. Simply click the right-pointing arrow you see when you move the mouse cursor to a tag. The Media Browser view changes to show you all the tags listed in the four main tag categories, as shown in Figure 5-8.

In the Media Browser, just select the check boxes for the different tags, and the respective photos are shown in the Organizer.
Creating Albums

With tags, you can organize files into categories and subcategories, which help keep your files neatly organized within a catalog. Elements offers additional organizing control in the Albums panel. For instance, you can do the following:

- Assemble an album.
- Rate each photo in an album with a range of one to five stars.
- Use the Albums panel to further segregate images within different categories.

Think of a catalog as a parent item, and think of tags as its children. With tags, you can use the sort options (discussed in Chapter 6) to sort files according to tag names and other criteria such as dates. If you still have a number of files in the Organizer that are hard to manage, you can create
tags that form subcategories within the tags. Additionally, you can create an
album out of a number of photos within a given tag. For example, say you
have a huge number of photos taken on a European vacation, and all these
photos are in your catalog. You can create tags for photos according to the
country visited. You then might rate the photos according to the best pic-
tures you took on your trip. The highest-rated images could then be assem-
bled in an album.

**Rating images**

You can rate photos in the Organizer by assigning images a number of stars,
from one to five. You might have some photos that are exceptional, which
you want to give five-star ratings, whereas poor photos with lighting and
focus problems might be rated with one star.

To assign a star rating to a photo, select a photo in the Media Browser and
click a star in the Information panel, as shown in Figure 5-9. One star is the
lowest rating, and five stars is the highest.

![Figure 5-9: Rating photos with stars in the Information panel.](image)
After assigning star ratings to photos, you can sort photos according to their ratings. For example, click a star that appears in the Ratings at the top of the Media Browser. (See Figure 5-9.) If you click the third star, all photos rated with three, four, and five stars appear in the Media Browser. If you click the fifth star, only those photos rated with five stars appear in the Media Browser.

Be certain to click the star value in the Information panel when rating a photo with a star rating. If you click a star next to the Ratings label at the top of the Media Browser, Elements thinks you want to sort photos in the Media Browser according to star rating.

**Adding rated files to an album**

You might want to rate images and then add all your images to an album. Within the album, you can still choose to view your pictures according to star ratings.

**Creating an album**

With albums and star ratings, you can further break down a collection into groups that you might want to mark for printing, sharing, or onscreen slide shows.

To create an album, follow these steps:

1. **Sort photos in the Media Browser to determine what photos you want to include in a new album.**
   
   In our example, we clicked the third star to sort photos ranked with three or more stars.

2. **Click the plus (+) icon next to Albums at the top of the left panel, as shown in Figure 5-10. From the drop-down menu, choose New Album.**
   
   Notice in Figure 5-10 that you see the Albums menu on the left side of the Organizer. When you create a new album, the remaining work you perform on an album (such as naming it, categorizing it, adding content to it, and sharing it) is all handled in the Panel Bin on the right side of the Organizer. The location of the menu is different from earlier versions of Elements where the menu and the album options were all contained in the Panel Bin.
3. **Name the new album.**

   In the Panel Bin, you see the Add New Album panel. Type a name for the album in the Name text box, as shown in Figure 5-11.

   If you didn’t sort files in Step 1, you can do so now or simply pick and choose which photos to add to the new album from photos appearing in your catalog.

4. **Drag photos from the Media Browser to the Content tab in the Add New Album panel, as shown in Figure 5-11.**

   If photos are sorted and you want to include all photos in the Media Browser, press Ctrl+A/⌘+A to select all the photos or choose Edit ➪ Select All. Once the files are selected, drag them to the Content pane in the Add New Album panel. (See Figure 5-11.)

   If you don’t have files sorted, click one or more photos and drag them to the Content pane. Repeat dragging photos until you have all photos you want to include in your new album.

---

**Figure 5-11:** Drag photos to the items window in the Album Content panel.
5. Click Done at the bottom of the panel.

Your new album now appears listed in the Albums category on the Import panel.

That’s it! Your new album is created, and the photos you dragged to the album are added to it. You can display all the photos within a given album in the Media Browser by clicking the album name in the Albums panel.

Creating multiple albums uses only a fraction of the computer memory that would be required if you wanted to duplicate photos for multiple purposes, such as printing, web hosting, sharing, and so on.

**Using albums for temporary work**

You can add an album for temporary work and then delete the album when you no longer need it.

For instance, you may want to explore some of the creation and sharing items in the Create and Share panels. Before you peruse the options, create an album and add photos to it. Then proceed use the sharing feature that interests you. When you finish, right-click to open a contextual menu and choose Delete <album name>.

**Editing an album**

After creating an album, you may want to change the album name, add more photos to an album, delete some photos from an album, change the album category, or make some other kind of edit.

Your first step in performing any kind of edit to an album is to look at the left side of the Organizer. In the Import panel, you see a list of albums under the Albums category. To edit an album, right-click the album name and choose Edit. After clicking Edit, the album appears in the Panel Bin on the right side of the Organizer, much like you see in Figure 5-11.

Other commands are available in the context menu you open from an album name in the Import panel. You can rename an album, delete an album, explore some export options, share an album, and add more media to your album.

If you want to use the context menu commands, you must close the Add New Album panel in the Panel Bin. While this panel is open, you cannot open a context menu on an album name. Click either Done or Cancel to close the Add New Album panel in the Panel Bin.
Finding out more about sharing your albums

An album is a starting point for many exciting things you can do with a collection of photos. Albums help you assemble a collection of photos that can be viewed on many devices and shared with others. Later in this book, we explore many ways you can share your albums with friends, family, and even the world, if you like:

- Host albums online for others to view your photos.
- Write albums to CDs and DVDs (Windows only).
- Save the albums to a file on your hard drive.
- Organize an album for sharing photos with others on Adobe Revel.
- View albums as slide shows.

Chapter 15 gives you the details on all of these sharing tricks, except the last bullet. To find out how to view albums as slide shows, see Chapter 16.

What happened to Smart Albums?

In Elements 12, you won't find Smart Albums. Adobe believes that when you create a search and save your searches, the process is very similar to creating Smart Albums, so a bit of redundancy is removed from this version of Elements. Whether you agree or not, Smart Albums are gone. We have web extras that explain how to create albums from the Photo Editor Panel Bin and how to use saved searches and create albums similar to Smart Albums. You can find them at www.dummies.com/extras/photoshop elements12.
Viewing and Finding Your Images

In This Chapter
▶ Working with catalogs
▶ Viewing photos in the Organizer
▶ Viewing slide shows
▶ Comparing Organizer on Windows and Mac
▶ Mapping photos
▶ Creating Events
▶ Sorting photos
▶ Showing and hiding files

Photo organization begins with adding images to a catalog. By default, the Organizer creates a new catalog for you. As your catalog grows with the addition of more files, you’ll want to discover ways to search and use a given set of images for a project.

In this chapter, we begin by talking about catalogs and then look at how to view and organize your pictures in the Organizer and the Media Browser, and we show how the many options help speed up your work in Photoshop Elements. Before tackling this chapter, you’ll want to be familiar with the Organizer — Chapter 1 offers a brief glimpse of the Organizer and looks at a few different views; Chapter 5 explains how to tag photos and create photo albums in the Organizer.
Cataloging Files

When you import files in the Organizer, all your files are saved automatically to a catalog. The files themselves aren’t really saved to the catalog; rather, links from the catalog to the individual files are saved. Links are like pointers that tell the catalog where to look for a file. When you add and delete files within the Organizer, the catalog is continually updated.

After you import files in the Organizer, the Organizer maintains a link to the media. If you move the media on your hard drive, the link is broken. You need to reestablish the link by opening the file in the Photo Editor. The Find Offline Drives – Edit dialog box opens so that you can reconnect the file by browsing for its new location.

Your default catalog is titled My Catalog by the Organizer. As you add photos in the Organizer, your default catalog grows and may eventually store thousands of photos. At some point, you may want to create one or more additional catalogs to store photos. You may want to use one catalog for your family’s and friends’ photos and another for business or recreational activities. You may want to create separate catalogs for special purposes such as business, family, social networking, or other kinds of logical divisions.

Using the Catalog Manager

Catalogs are created, deleted, and managed in the Catalog Manager. To access the Catalog Manager, choose File ➪ Catalog. The Catalog Manager opens, as shown in Figure 6-1.

To keep your photos organized and your catalog files small, you can start a completely new catalog before you import photos. Follow these steps:

1. Choose File ➪ Catalog and click the New button in the Catalog Manager dialog box, shown in Figure 6-1.
2. When the New Catalog dialog box opens, type a name for the new catalog in the File Name text box.

3. (Optional) If you want to add the free music files that installed with Elements, select the Import Free Music into All New Catalogs check box.

   We recommend selecting the Import Free Music into All New Catalogs and Import Music Files check box. The Organizer ships with free music files that you can use in a variety of projects. See Chapter 16 for more on making creations.

4. Click Save to create the new catalog.

5. Choose File ➤ Get Photos and Videos ➤ From Files and Folders to add files to the new catalog.

   The Get Photos and Videos from Files and Folders dialog box opens.

6. Navigate your hard drive and select the photos you want to add. After you identify all the files, click Open.

   The selected photos are added to your new collection of media contained in the catalog.

In Figure 6-2 we created a new catalog and named it MyNewCatalog. You can see the catalog name in the lower-right corner. A folder containing photos and a Music folder appear in the Import panel.

![Figure 6-2: Imported photos and free music in a new catalog.](image-url)
Part II: Managing Media

Working with catalogs

After you create different catalogs for your images, the following tips for working with catalogs will come in handy:

✓ **Understanding how you want to organize your photos before creating your first catalog:** Unfortunately, Elements doesn’t provide you with a command to split large catalogs into smaller ones. However, if you’ve created a large catalog and want to split it into two or more separate catalogs, you can manually add new photos to a new catalog and delete photos from the older catalog.

✓ **Switching to a different catalog:** When you need to open a different catalog file, choose File ➪ Catalog and select the name of the catalog you want to open. Click Open at the bottom of the dialog box to open the selected catalog. The Organizer window changes to reflect files contained in that catalog.

✓ **Fixing a corrupted catalog:** Notice the Repair button in Figure 6-1. If you can’t see thumbnail previews of images or open them in one of the editing modes, your catalog file might be corrupted. Click the Repair button to try to fix the problem.

✓ **Improving catalog performance:** When catalogs get sluggish, you might need to optimize a catalog to gain better performance. You should regularly optimize your catalog (by clicking the Optimize button in the Catalog Manager) to keep your catalog operating at optimum performance.

Backing up your catalog

Computer users often learn the hard way about the importance of backing up a hard drive and the precious data they spent time creating and editing. We can save you that aggravation right now, before you spend any more time editing your photos in Elements.

We authors are so paranoid when we’re writing a book that we back up our chapters on multiple drives, CDs, and DVDs when we finish them. The standard rule is that if you spend sufficient time working on a project and it gets to the point where redoing your work would be a major aggravation, then it’s time to back up files.

When organizing your files, adding keyword tags, creating albums, and creating stacks and version sets, you want to back up the catalog file in case it becomes corrupted. Fortunately, backing up catalogs is available to both Windows and Mac users; however, backing up to a CD or DVD from within Elements is available only on Windows.
Here’s how you can use Elements to create a backup of your catalog:

1. **Choose File ➪ Backup Catalog to open the Backup Catalog Wizard.**
   
   This wizard has two panes that Elements walks you through to painlessly create a backup of your files.

2. **Select the source to back up.**
   
   The first pane in the Backup Catalog to CD, DVD, or Hard Drive Wizard offers two options:
   
   - **Full Backup:** Select this radio button to perform your first backup or write files to a new media source.
   - **Incremental Backup:** Select this radio button if you’ve already performed at least one backup and you want to update the backed-up files.

3. **Click Next and select a target location for your backed-up files, as shown in Figure 6-3.**
   
   Active drives, including CD/DVD drives (on Windows) attached to your computer or mounted network drives available to your computer, appear in the Select Destination Drive list. Select a drive, and Elements automatically assesses the write speed and identifies a previous backup file if one was created. The total size of the files to copy is reported in the wizard. This information is helpful so that you know whether more than one CD or DVD is needed to complete the backup (on Windows) or a backup drive has enough space to complete the backup.

4. **If you intend to copy files to your hard drive or to another hard drive attached to your computer, click the Browse button and identify the path.** If you use a media source, such as a CD or DVD (Windows only), Elements prompts you to insert a disc and readies the media for writing.
5. Click Done, and the backup commences.

Be certain to not interrupt the backup. It might take some time, so just let Elements work away until you’re notified that the backup is complete.

**Backing up photos and files (Windows)**

With files stored all over your hard drive, manually copying files to a second hard drive, CD, or DVD would take quite a bit of time. Fortunately, Elements makes finding files to back up a breeze.

Choose File ➪ Copy/Move to Removable Drive and then, in the dialog box that opens, select the Move Files check box and click Next. Select a hard drive or a CD/DVD drive, type a name for the backup folder, and click OK. Elements goes about copying all files shown in the Organizer to your backup source.

Mac users don’t have an option for backing up photos from the Organizer to CDs or DVDs. On the Mac, you can create a burn folder in the Finder, select all photos in the Organizer, and drag the selected files to the burn folder. Click the Burn button, and the files are copied to a CD or DVD.

**The Many Faces of the Organizer**

The Organizer provides you several different viewing options. In Chapter 1, you find out about viewing files in the Media Browser and look at viewing recent imports and all files. You can also view files according to a timeline, a slide show, certain media types such as those media types listed in the View ➪ Media Types menu, and places and events. We discuss how to view photos in an upcoming section. Here we take a look at the View menu and how the Organizer differs between Windows and Macs.

**Using the View menu**

On the View menu, you have choices for sorting files that are displayed in the Media Browser. Some of the menu choices you have are

- **Media Types:** Choose View ➪ Media Types and look over the submenu. You can eliminate video, audio, and PDF by selecting the respective items if you want to view just photos in the Media Browser. Likewise you can eliminate photos and explore the other choices by selecting or deselecting the submenu items.

- **Hidden Files:** If files are hidden, you can view all files by choosing View ➪ Hidden Files, and then you can choose (in the submenu) to view All Files, view Hidden Files, or (if files are in view) to hide Files.
Chapter 6: Viewing and Finding Your Images

✓ **Details:** By default, file details such as file creation dates and star ratings are hidden. You can show file details by choosing View ➪ Details or pressing Ctrl+D/⌘+D.

✓ **File Names:** By default, the filenames of the photos appearing in the Media Browser are hidden. You can show filenames by choosing View ➪ File Names.

✓ **Timeline:** Choose View ➪ Timeline, and a horizontal bar opens at the top of the Organizer. A slider appears on the bar that you can drag left and right to select a time when your photos were taken. In Figure 6-4, you can see the timeline, details, and filenames.

![Figure 6-4: The Media Browser displaying a timeline, file details, and filenames.](image)

**Comparing the Organizer on Windows and the Mac**

Unfortunately, not all the options available to Windows users are available to Mac users in the Organizer. The following list gives you a quick glance at the Organizer features the Windows version of Elements supports but that the Mac version does not and points you to more information about each feature:
Burn data to CD/DVD. See the “Backing up photos and files” section, later in this chapter.

Create slide shows. See Chapter 16.

Use HTML-based photo mail. See Chapter 15 and the Photoshop Elements Help document for information that goes into more depth than the chapter.

Watch folders. See Photoshop Elements Help document.

The reason you find differences between the features that are available on Windows and the Mac is because of significant technical issues related to the platform differences. Some native supported OS features on Windows are integrated with Elements.

Viewing Photos in a Slide Show (Full Screen View)

Are you ready for some exciting viewing in Photoshop Elements? To take an alternative view of your Organizer files, you can see your pictures in a self-running slide show (in Full Screen view), complete with transition effects and background music. For the purposes of clarity, think of Full Screen view and viewing a slide show as the same thing. Full-screen viewing temporarily hides the Elements tools and menus, and it gives you the most viewing area on your monitor to see your pictures.

Viewing files in Slideshow view can be helpful for quickly previewing the files you want to edit for all kinds of output, as well as for previewing photos that you might use for an exported slide show (available on Windows only), which we explain in Chapter 15.

Creating slide shows and outputting to a movie file is supported only on Windows. However, viewing slide shows in Elements is supported for both Windows and Mac users. Also, both Windows and Mac users can create PDF slide shows, as we explain in Chapter 16. The only limitation Mac users have is that they cannot export slide shows directly from Elements as movie files unless they have Premiere Elements installed.

Taking a quick view of the slide show

To set up your slide show and/or enter Full Screen view, follow these steps:
1. Open the Organizer.

2. Select images that you want to see in a slide show or select none to use all the images in the Organizer for your slide show.

   If no images are selected when you enter Full Screen view, all photos in the Media Browser are shown in Full Screen view.

3. Click the Slideshow button at the bottom of the Organizer or press the F11 key (⌘+F11 on the Mac).

   After choosing the menu command, you jump right into the Full Screen view with some panels and tools displayed, as shown in Figure 6-5.

4. View the slides.

   By default, the photos change every 4 seconds, but you can change that interval in the Settings dialog box that you can open in the Slideshow toolbar. You can watch the slide show or you can click the arrow keys at the bottom of the screen to move forward and back through the slides.

![Figure 6-5: Elements takes you right to Full Screen view after you click the Slideshow button or press the F11 key (⌘+F11 on the Mac).](image-url)
You can also scroll through slides by pressing the left and right arrow keys on your keyboard.

5. **Exit the Full Screen view by pressing the Esc key to return to the Organizer.**

You can also open Full Screen view by choosing View ➪ Full Screen or pressing F11 (_ctr+F11 on the Mac). Opening the Full Screen view is the same as clicking the Slideshow button in the Organizer. Laptop owners may need to use the Function key with the keystrokes to open Full Screen view.

**Working with the Edit and Organize tools**

Full Screen and Slideshow views provide you with several editing tools. When you open selected photos from the Organizer in Full Screen or Slideshow view, you find two panels on the left side of the screen:

- **The Edit panel** provides Edit tools for editing photos, such as sharpening images and removing red-eye.
- **The Organize panel** permits you to add keyword tags for easily organizing photos. (See Chapter 5 for more on adding keyword tags to photos.)

**The Edit tools**

To open the Edit panel, click the vertical tab on the left side of the Full Screen view or click the Fix button on the Slideshow toolbar. The Edit panel opens, as shown in Figure 6-6.

Notice that as you move the mouse cursor over the tools, tooltips display the tool name. You can easily locate tools in the Edit panel and make image adjustments without leaving the Full Screen/Slideshow view.

Elements provides you many editing options using the basic edit tools, and we cover each of the tools in Chapter 9.

**The Organize tools**

The other panel on the left side of the Full Screen/Slideshow view is the Organize panel. Click Organize on the left side of the window to open the panel or click the Organize button on the Slideshow toolbar.
Chapter 6: Viewing and Finding Your Images

As shown in Figure 6-7, this panel offers you choices for adding keyword tags. For more information on creating keyword tags, see Chapter 5.

**Using the Slideshow toolbar**

The Slideshow toolbar shown earlier in Figure 6-5 offers the following options for slide viewing (from left to right):

- **Previous Media**: Click the left arrow to open the previous photo or other media.
- **Play/Pause**: Click to play or pause a slide show.
- **Next Media**: Click the right arrow to advance to the next photo or other media.
- **Theme**: This item was named Transitions in earlier versions of Elements. When you enter Full Screen view, the Themes tool is selected, and when you click it, the Select Transition dialog box opens, as shown in Figure 6-8. Four transition effects are displayed in the dialog box. You can preview a transition effect by placing the cursor over one of the images. When you find an effect you like, click the image and click OK to change the transition.
- **Filmstrip**: Click this tool to show or hide the filmstrip that appears on the bottom of the Full Screen view.
- **View**: The View tool displays a pop-up menu when you click the tool. The pop-up menu gives you two choices for how you view media side by side: horizontally or vertically. Choosing either option splits the screen where two media items are shown. When one of these options is chosen, you can return to the default for a view of a single item onscreen by selecting the single monitor icon.

While viewing a slide show, you can zoom in and out of photos by using the scroll wheel on your mouse.

- **Sync Panning and Zooming**: This tool is active only when you view media side by side vertically or horizontally. Click the tool and both media items sync when panning and zooming.
✓ **Settings:** Click to open the Full Screen View Options dialog box, shown in Figure 6-9. Notice that you can choose a music file to play background music while viewing a slide show, set the page durations, and display items such as captions.

✓ **Fix:** Click this tool to open the Edit panel.

✓ **Organize:** Click this tool to open the Organize panel.

✓ **Info:** Click this tool to open the Properties panel. This panel contains the same information and editing options as the Information panel we discuss in Chapter 1.

✓ **Exit:** Click this tool to exit Full Screen view and return to the Organizer. You can also press Esc to exit Full Screen view.

✓ **Show All Controls (left arrow):** Click the tiny right-pointing arrow on the right side of the toolbar, and the toolbar expands to reveal additional tools or collapse the panel and hides the Fix, Organize, and Info tools.

The main thing to keep in mind is that the Full Screen view is a temporary viewing option you have in Elements. It’s not permanent. You use the view for a quick display method on your computer when you want to show off some photos to family and friends. Windows users have more permanent options for saving files as slide shows that they can share with other users, as we explain in Chapter 15.

**Exploring more options in context menus**

Notice that when you’re in Full Screen view you lose the top-level menus. If you’re wondering how you can add the slide images to an album or create a slide show movie file (Windows only), you need a menu command. Because the menus are hidden, you must open a contextual menu in the Full Screen view by right-clicking.

Figure 6-10 shows a contextual menu opened in Full Screen view, where you find options not available in the panels or the slide show tools. You have menu commands for adding images to an existing album as well as several commands for working with keyword tags. You also find the Mark for Printing option (which opens a dialog box when you exit Slideshow view and offers choices for printing the file or ordering prints online) and the Create Slide Show option (which is Windows only).
Figure 6-10: Open a contextual menu when in Full Screen view to access menu commands.

When in doubt, always look for commands and features by opening a contextual menu with an expedient right-click.

**Placing Pictures on Maps**

You may take vacations to interesting places and want to sort photos according to the location where the photos were shot. You can easily place photos on geospatial maps.

To see how easy placing photos on maps is, do the following:

1. **Select a folder of photos in the Media Browser in the Organizer.**
   
   If you followed some of our recommendations in Chapter 1 for sorting photos in folders on your hard drive, you should have photos taken from various places sorted in individual folders. If not, you can simply view photos in the Media Browser in any sort order or view All Media.

2. **Click the Add Places icon at the bottom of the Media Browser.**
   
   The Organizer changes to the Add Places window, as shown in Figure 6-10.
3. **Search for a location.**

In the search text box at the top of the Google map, type the name of a location that you want to assign photos. The Google map offers some suggestions in a drop-down menu below the search text box. Click the area on the map you want for assigning photos.

4. **Select photos to assign to locations.**

At the top, you can click individual photos and press Ctrl or ⌘ and click to add more photos to a selection. If you want to add all photos to a given location, open the drop-down menu in the top-right corner and choose Select All. (See Figure 6-11.)

5. **Click the check mark to assign the photos to the location.**

The selected photos are now assigned to the specified location.

![Figure 6-11: Click the Add Places icon at the bottom of the Media Browser to open the Add Places window.](image)

If you want to sort photos according to location, choose Find ➤ Using Advanced Search. The Organizer changes to the view you see later in Figure 6-12. Notice the column for Places. All photos assigned to places are listed in this column. You can easily select the check boxes to find photos assigned to a given place or select multiple check boxes to find photos from several places.
Chapter 6: Viewing and Finding Your Images

Working with Events

You may have photos taken at special occasions or during holidays. You can add more organization opportunities to your Organizer management by assigning photos to different Events.

An Event can be any function of your choosing, such as a Christmas party, a ski trip, or an anniversary celebration. To create an Event and assign photos to it, do the following:

1. Select photos in the Media Browser in the Organizer.
   You can select photos in folders, select from an All Media view, or use any sort order you choose.

2. Click the Add Event icon at the bottom of the Media Browser.
   The Panel Bin changes to reveal options for naming an Event and assigning photos to the new Event.

3. Type a name for the Event in the Event text field in the Add New Event panel, as shown in Figure 6-12.

4. Choose dates for the Event by clicking the calendar icons in the Add New Event panel.

5. Type a description in the Description text box.

6. Add photos to the Event.
   Drag the selected photos to the panel, as shown in Figure 6-12.

7. Click Done.
   The photos are now assigned to an Event. To view events, click the Events tab at the top of the Organizer. You see collections of photos if you added several Events, with the first photo in the Event appearing on top. To view all photos, double-click the Event thumbnail you want to view.

Figure 6-12: Type an Event name, choose the start and end dates, type a description, and drag photos to the Add New Event panel to assign photos to a new Event.
Using Search Options

With all the Photoshop Elements modes and workspaces, you need a consistent starting place to handle all your editing tasks. Think of the Organizer as Grand Central Terminal, from which you can take the Long Island Railroad to any destination you desire. In Elements terms, rather than head out to Port Washington, you travel to an editing mode. Rather than go to the Hamptons, you journey through all the creation areas. In short, the Organizer is the central depot on the Photoshop Elements map.

In addition to being a tool to navigate to other workspaces, the Organizer is a management tool you can use to organize, sort, search, and describe photos with identity information. In terms of sorting and organizing files, Elements provides many options, and we cover them all in the following sections.

Using Search

Before we explore the many options you have from menu commands on the Find menu, take a look at the Media Browser. At the top, you find a text box and magnifying glass. You type search criteria in the text box and press Enter or Return to search through your catalog and find matches for your criteria. If you click the magnifying glass to open a drop-down menu, you find more options to narrow your search.

This search feature in Elements is very powerful. Not only can you search for a single criterion (such as searching for a person’s name), but you can take advantage of Boolean expressions to narrow your search — the AND, OR, and NOT expressions all work. For example, you can search for Jack AND Jill, and only photos having both those names in the image metadata, tags, and filenames are returned. Likewise, you can search for Jack OR Harry NOT Jill, and photos of either Jack or Harry are returned but not any photos containing Jack and Jill or Harry and Jill.

To get a feel for how you use Boolean expressions, play around with the Search text box and experiment a little. When you become familiar with this powerful search feature in the Organizer, you’ll find yourself reaching for the Search text box before going to the many menu commands on the Find menu.

Advanced Search Options

The Organizer’s Find menu is devoted entirely to searching photos. From the Find menu, you can locate photos in collections, catalogs, and the Organizer according to a variety of different search criteria.
To use the commands on the Find menu, you need to have photos loaded in the Media Browser or you need to create collections or catalogs. The categories in the following sections can be searched in the Organizer.

As you review various choices for finding photos, keep in mind that you don’t necessarily need to use all the search options Elements provides. Look over the commands on the Find menu and familiarize yourself with a couple of options that suit your needs for finding files. Open the Find menu, and the first menu command you see is Using Advanced Search. Choose this command, and a row of items appears at the top of the screen displaying columns for Keywords, People, Places, and Events. If you tagged photos with keyword tags, added People Recognition, identified photos for Places and/or added Events, you find several check boxes that you can select, as shown in Figure 6-13.

You can save your searches and use them in a number of ways, such as dynamically updating photo albums. For more information on using saved searches, see our web extras at www.dummies.com/extras/photoshop elements12.

As you select check boxes displayed in the Advanced Search Options, all media meeting the criteria are displayed in the Media Browser.

To provide more viewing area in the Media Browser, click the Hide Panel button in the lower-left corner of the Organizer.

At the top of the Organizer, you see the Sort by drop-down menu. Here you have choices for the photos to be listed in the Media Browser according to the Newest files, Oldest files, and the Import Batch.

Photoshop Elements 12 adds another Sort By item to the menu. You can now search files according to filename. Choose Name from the drop-down menu to display an alphabetical order of the files listed by filenames.
**Searching by date**

When you have a number of different files in a catalog from photos shot on different dates, you can narrow your search to find photos, and all other types of files supported by Elements, through a date search.

In the Organizer, the date is taken from the camera metadata; however, if a date isn’t available from the camera data, the date is taken from the file creation date. The creation date isn’t likely to be the date you shot the photo. Most often it is the date you imported the file from the camera or other media.

To search files by date in the Organizer, follow these steps:

1. **Verify you have media added in the Organizer.**
   - At this point, we assume you have media added to a catalog. If you haven’t added photos to your catalog yet, see Chapter 1 for details.

2. **Select a date range by choosing Find ➤ Set Date Range.**
   - The Set Date Range dialog box opens.

3. **Specify the dates.**
   - In the Start Date area, type a year in the Year text box. Select the month and day from the Month and Day drop-down menus. Repeat the same selections for the end date.

4. **Click OK.**
   - The thumbnails shown in the Organizer include only files created within the specified date range.

**Searching for untagged items**

You can tag files with a number of different criteria, as we explain in Chapter 5. When tags are added to images, you can sort files according to tag labels. We also cover sorting by tag labels in Chapter 5. For now, take a look at the Find menu and notice the Untagged Items command. If you haven’t added tags to some items and want to show only the untagged files so that you can begin to add tags, choose Find ➤ Untagged Items or press Ctrl+Shift+Q on Windows or ⌘+Shift+O on the Mac.

Elements displays all files without tags in the Media Browser. This option is helpful when you want to locate files that meet criteria for different keyword tags. You can select photos and tag them with keyword tags that meet the criteria for tags you have created.
Chapter 6: Viewing and Finding Your Images

Searching captions and notes

Captions and notes are added in the Information panel. When captions or notes are added to files, you can search for the caption name, contents of a note, or both. To search caption names and notes, follow these steps:

1. **Make sure you have media added to a catalog.**
   
   If you’re adding files stored on your hard drive, choose File ➪ Get Photos and Videos ➪ From Files and Folders.

2. **Add captions and/or notes.**
   
   If you don’t have any files tagged with captions or notes, you need to add them in the Information panel. Open the Information panel and type captions and notes in the respective text boxes.

3. **Choose Find ➪ By Caption or Note.**
   
   The Find by Caption or Note dialog box opens, as shown in Figure 6-14.

4. **In the Find Items with Caption or Note text box, type the words you want to locate and choose to match all or part of the word or words you typed.**

   Options in the dialog box are
   
   • **Match Only the Beginning of Words in Captions and Notes:** Select this radio button when you know that your caption or note begins with words you type in the text box.
   
   • **Match Any Part of Any Word in Captions and Notes:** Select this radio button if you’re not sure whether the text typed in the box is used at the beginning of a caption or note, or whether it’s contained within the caption name or note text.

5. **Click OK.**
   
   The results appear in the Organizer.

Searching by history

Searching *history* is searching for chronologically ordered information about operations performed on your media, such as printing, e-mailing, sharing, and so on. Elements keeps track of what you do with your photos when you
perform a number of different tasks. You can search for files based on their file history by choosing Find ➪ By History. Select the options you want on the By History submenu, and Elements reports files found on date searches that meet your history criteria.

**Searching metadata**

Metadata includes information about your images that’s supplied by digital cameras, as well as custom data you add to a file. Metadata contains descriptions of the image, such as your camera name, the camera settings you used to take a picture, copyright information, and much more.

Metadata also includes some of the information you add in Elements, such as keyword tags, albums, People tags, and so on. You can combine various metadata items in your search, such as keyword tags, camera make and model, f-stop, ISO setting, and so on. Searching for metadata might be particularly helpful when you have photos taken during an event by several family members and friends. In this example, you might want to isolate only those photos taken with a particular camera model.

To search metadata, follow these steps:

1. **Choose Find ➪ By Details (Metadata) in the Organizer.**
   
The Find by Details (Metadata) dialog box, shown in Figure 6-15, opens.

   ![Figure 6-15: Choose Find ➪ By Details (Metadata) in the Organizer to open the dialog box in which metadata are specified.](image)
2. Choose to search for one of your criteria or all of your criteria by selecting a radio button.

   The first two radio buttons in the dialog box offer choices for Boolean OR and Boolean AND. In other words, do you want to search for one item or another, or to search for one item and another? The results can be quite different depending on the criteria you identify in the menus below the radio buttons.

3. Choose an item from the first menu (we used People in Figure 6-15) and then choose to include or exclude the item, and then fill in the third column.

   How you fill in the third column depends on your selections in the first two columns.

   Items are listed as menus in horizontal rows. The third column can be a menu or a text box, as shown in Figure 6-15.

4. (Optional) To add criteria (in our example, we use four items for our search), click the plus (+) symbol.

   Another row is added to the dialog box, and you select your choices as explained in Step 3.

5. After identifying your search criteria, click Search.

   The media matching the criteria is shown in the Media Browser.

**Searching similarities**

We discussed tagging people in Chapter 1. When you have people tagged, you can easily click the People tab at the top of the Organizer and locate all the people you have tagged.

**Searching visually similar photos**

Elements also provides you with the ability to search photos for visual similarities. You may have group shots, architecture, animal life, and so on and want to search for photos containing objects that are visually similar.

To search for photos with visual similarities, choose Find ➤ By Visual Searches Visually Similar Photos and Videos, Objects within Photos, and Duplicate Photos.

**Searching duplicates**

You may have a number of photos that are duplicates or are very close to being duplicate images. You might want to locate duplicates or near-duplicate
images and delete some from your catalog or stack the photos. (See “Stacking ’em up,” later in this chapter.) Searching for duplicates is a two-step process:

1. Choose **Find** ➪ **By Visual Searches** ➪ **Visually Similar Photos and Videos**.
2. Choose **Find** ➪ **By Visual Searches** menu and choose **Duplicate Photos**.

Photos that are visually similar appear in horizontal rows. In Figure 6-16, you can see one of the rows as it appeared after we performed a search. Notice the Stack button on the right side of the figure. Click Stack, and the photos are stacked.

Figure 6-16: Elements search features can help you find duplicate photos.

If you want to delete photos, click a photo and click the **Remove from Catalog** button at the bottom of the window.

**Searching objects**

You may have objects in photos such as buildings, automobiles, trees, groups of people, and so on that you want to stack or delete. To search for objects, follow these steps:

1. Choose **Find** ➪ **By Visual Searches** ➪ **Visually Similar Photos and Videos**.
2. Search again and choose Objects within Photos from the By Visual Searches submenu.

A rectangle appears for selecting a photo that contains the object you want to search.

3. Move the rectangle and resize it so it surrounds the object you’re looking for, as shown in Figure 6-17.

4. Click the Search Object button, and Elements displays its search results.

![Figure 6-17: Mark the object you want to search and click the Search Object button.](image)

**Grouping Files That Get in the Way**

Elements offers a few ways to organize images that are getting in the way. You can hide files, stack files, or create versions, as we explain in the following sections.

**Marking files as hidden**

With a simple menu command, you can mark selected files in the Organizer as hidden. Select files you want to hide, and, from either the Edit menu or a contextual menu, choose Visibility ➤ Mark as Hidden. To see the files you
mark for hiding, return to the same Visibility menu and choose Show Hidden. Essentially, you remove the check mark for Show Hidden, which results in the files being hidden. To easily toggle between showing and hiding files marked for hiding, choose View ➪ Hidden Files.

Stacking ’em up

Think of a stack of images as like a stack of cards that is face-up: You see only the front card, and all the other cards are hidden behind that card. Stacks in the Organizer work the same way. You hide different images behind a foreground image. At any time, you can sort the images or display all images in the stack in the Organizer.

To create a stack, follow these steps:

1. **In the Organizer, select several photos.**
   - You can select any number of photos. However, you can’t stack audio or movie files.

2. **Choose Edit ➪ Stack ➪ Stack Selected Photos.**
   - Elements stacks your photos. The first image you select remains in view in the Media Browser. In the upper-right area, an icon that looks like a stack of cards appears on the image thumbnail when you’ve stacked some images.

3. **Double-click the photo to open the stack in the Media Browser.**
   - You find the stack icon in the top-right corner, as shown in Figure 6-18.

In Figure 6-17, you see an arrow icon to the right of a stack. Click the arrow, and the stack expands. A left-pointing arrow appears on the right of the last image in a stack. Click this arrow, and the photos are stacked.
Chapter 6: Viewing and Finding Your Images

After you stack a group of images, you can use the Stack submenu commands to manage the photos. Click a stack to select it and then choose Edit ➪ Stack. The available submenu commands are as follows:

- Automatically Suggest Photo Stacks
- Stack Selected Photos
- Unstack Photos
- Expand Photos in Stack
- Collapse Photos in Stack
- Flatten Stack

When you flatten a stack, all photos except for the top photo are deleted from the catalog but not from your hard drive.

- Remove Photo from Stack
- Set as Top Photo

If you want to view all stacks in the Media Browser in expanded form, choose View ➪ Expand All Stacks. Using this command doesn’t require you to individually select stacks in the Media Browser before expanding them.

Creating versions

Versions are similar to stacks, but you create versions from only one file. You can edit an image and save both the edited version and the original as a version set. Also, you can make additional edits in either editing mode and save to a version set. To create a version set, follow these steps:

1. Select an image by clicking it in the Media Browser.
2. Apply an edit.

For example, right in the Organizer, you can correct some brightness problems in your image. Click Instant Fix to open the Instant Fix panel and click one of the tools in the panel. See Chapter 9 for more details on using the Instant Fix tools or any other editing tool.

3. View the items in the version set by clicking the image in the Media Browser and choosing Edit ➪ Version Set ➪ Expand Items in Version Set.

Elements automatically creates a version set for you when you apply the Instant Fix to the file. The Media Browser shows two thumbnail images — one representing the original image and the other representing the edited version. Figure 6-19 shows a photo expanded from a version set.
4. **To open the original image in the Photo Editor, select the image in the Media Browser and then click the Editor button.**

5. **Edit the image in Expert mode.**
   
   You can choose from many different menu commands to edit the image. For example, change the color mode to Indexed Color by choosing **Image ➪ Mode ➪ Indexed Color**, as we explain in Chapter 4.

6. **Save a version by choosing File ➪ Save As.**

7. **In the Save Options area of the Save As dialog box, select the Include in the Organizer and Save in Version Set with Original check boxes.**
   
   Chapter 4 also explains the options for saving files.

8. **Click Save.**
   
   The edits made in the Photo Editor are saved as another version in your version set.

After you create a version set, you find additional submenu commands that you can use to manage the version set. Choose **Edit ➪ Version Set** or right-click a version set and then choose **Version Set**.
Part III

Selecting and Correcting Photos

Visit www.dummies.com/extras/photoshopelements12 to find guided steps for correcting your images.
In this part . . .

- Change, optimize, perfect, and combine images into composite designs.
- Select image content and then alter that content for a variety of purposes, such as correcting the color, changing the appearance, and extracting the content so that you can introduce it in other photos.
- Correct an image’s contrast, brightness, and color irregularity.
- Convert from one color mode to another.
Making and Modifying Selections

In This Chapter
▶ Creating selections with the Lasso tools, Magic Wand, and more
▶ Resizing smartly with the Recompose tool
▶ Using the Cookie Cutter tool
▶ Rubbing away pixels with the Eraser tools
▶ Saving and loading your selections

If all you want to do is use your photos in all their unedited glory, feel free to skip this chapter and move on to other topics. But if you want to occasionally pluck an element out of its environment and stick it in another or apply an adjustment to just a portion of your image, this chapter’s for you.

Finding out how to make accurate selections is one of those skills that’s well worth the time you invest. In this chapter, we cover all the various selection tools and techniques. We also give you tips on which tools are better for which kinds of selections. But remember that you usually have several ways to achieve the same result. Which road you choose is ultimately up to you.

Defining Selections

Before you dig in and get serious about selecting, let us clarify for the record what we mean by “defining a selection.” When you define a selection, you specify which part of an image you want to work with. Everything within a selection is considered selected. Everything outside the selection is unselected. After you have a selection, you can then adjust only that portion, and the unselected portion remains unchanged. Or you can copy the selected area into another image altogether. Want to transport yourself out of your background and onto a white, sandy beach? Select yourself out of that backyard BBQ photo, get a stock photo of the tropical paradise of your choice, and drag and drop yourself onto your tropics photo with the Move tool. It’s that easy.
When you make a selection, a dotted outline — called a *selection border*, an *outline*, or a *marquee* — appears around the selected area. Elements, the sophisticated imaging program that it is, also allows you to partially select pixels, which allows for soft-edged selections. You create soft-edged selections by feathering the selection or by using a mask. Don’t worry: We cover these techniques in the section “Applying Marquee options,” later in this chapter.

For all the selection techniques described in this chapter, be sure that your image is in Expert mode in the Photo Editor and not in Quick or Guided modes or in the Organizer.

**Creating Rectangular and Elliptical Selections**

If you can drag a mouse, you can master the Rectangular and Elliptical Marquee tools. These are the easiest selection tools to use, so if your desired element is rectangular or elliptical, by all means, grab one of these tools.

The Rectangular Marquee tool, as its moniker states, is designed to define rectangular (including square) selections. This tool is great to use if you want to home in on the pertinent portion of your photo and eliminate unnecessary background.

Here’s how to make a selection with this tool:

1. **Select the Rectangular Marquee tool from the Tools panel.**
   
   It looks like a dotted square. You can also press M to access the tool. If it isn’t visible, press M.

2. **Drag from one corner of the area you want to select to the opposite corner.**

   While you drag, the selection border appears. The marquee follows the movement of your mouse cursor.

3. **Release your mouse button.**

   You now have a completed rectangular selection, as shown in Figure 7-1.

*Figure 7-1: Use the Rectangular Marquee tool to create rectangular selections.*
The Elliptical Marquee tool is designed for elliptical (including circular) selections. This tool is perfect for selecting balloons, clocks, and other rotund elements.

Here’s how to use the Elliptical Marquee:

1. **Select the Elliptical Marquee tool from the Marquee flyout menu on the Tools panel.**
   - It looks like a dotted ellipse. You can also press M to access this tool if it’s visible. If it isn’t, press M.

2. **Position the crosshair near the area you want to select and then drag around your desired element.**
   - With this tool, you drag from a given point on the ellipse. While you drag, the selection border appears.

3. **When you’re satisfied with your selection, release the mouse button.**
   - Your elliptical selection is created, as shown in Figure 7-2. If your selection isn’t quite centered around your element, simply move the selection border by dragging inside the border.

You can move a selection while you’re making it with either of the Marquee tools by holding down the spacebar while you’re dragging.

**Perfecting squares and circles with Shift and Alt or Option**

Sometimes you need to create a perfectly square or circular selection. To do so, simply press the Shift key after you begin dragging. After you make your selection, release the mouse button and then release the Shift key. You can also set the aspect ratio to 1:1 in the Tool Options.

When you’re making an elliptical selection, making the selection from the center outward is often easier. To draw from the center, first click the mouse button where you want to position the center, press Alt (Option on the Mac), and then drag. When you make your selection, release the mouse button and then release the Alt (Option on the Mac) key.
If you want to draw from the center outward and create a perfect circle or square, press the Shift key as well. After you make your selection, release the mouse button and then release the Shift+Alt (Shift+Option on the Mac) keys.

**Applying Marquee options**

The Marquee tools offer additional options when you need to make precise selections at specific measurements. You also find options for making your selections soft around the edges.

The only thing to remember is that you must select the options in the Tool Options, shown in Figure 7-3, before you make your selection with the Marquee tools. Options can’t be applied after the selection has already been made. The exception is that you can feather a selection after the fact by choosing Select $\rightarrow$ Feather.

![Figure 7-3: Apply Marquee settings in the Tool Options.](image)

Here are the various Marquee options available to you:

- **Feather**: Feathering creates soft edges around your selection. The amount of softness depends on the value, from 0 to 250 pixels, that you enter by adjusting the slider. The higher the value, the softer the edges, as shown in Figure 7-4. Very small amounts of feathering can be used to create subtle transitions between selected elements in a collage or for blending an element into an existing background. Larger amounts are often used when you’re combining multiple layers so that one image gradually fades into another. If you want a selected element to have just a soft edge without the background, simply choose Select $\rightarrow$ Inverse and delete the background. See more on inverting selections in the “Modifying Your Selections” section, later in this chapter. For more on layers, see Chapter 8.

  Don’t forget that those soft edges represent partially selected pixels.

- **Anti-aliasing**: Antialiasing barely softens the edge of an elliptical or irregularly shaped selection so that the jagged edges aren’t quite so obvious. An antialiased edge is always only 1 pixel wide. We recommend leaving this option chosen for your selections. It can help to create natural transitions between multiple selections when you’re creating collages.
✓ **Aspect**: The Aspect drop-down menu contains three settings:

- **Normal**: The default setting, which allows you to freely drag a selection of any size.

- **Fixed Ratio**: Lets you specify a fixed ratio of width to height. For example, if you enter 3 for width and 1 for height, you get a selection that’s three times as wide as it is high, no matter what the size.

- **Fixed Size**: Lets you specify desired values for the width and height. This setting can be useful when you need to make several selections that must be the same size.

✓ **Width (W) and Height (H)**: When you select Fixed Ratio or Fixed Size from the Aspect drop-down menu, you must also enter your desired values in the Width and Height text boxes. To swap the Width and Height values, click the double-headed arrow button between the two measurements.

✓ **Refine Edge**: For details on this great option, see “Refining the edges of a selection,” later in this chapter.

The default unit of measurement in the Width and Height text boxes is pixels (px), but that doesn’t mean that you’re stuck with it. You can enter any unit of measurement that Elements recognizes — pixels, inches (in), centimeters (cm), millimeters (mm), points (pt), picas (pica), or percentages (%). Type your value and then type the word or abbreviation of your unit of measurement.
Making Freeform Selections with the Lasso Tools

You can’t select everything with a rectangle or an ellipse. Life is just way too freeform for that. Most animate, and many inanimate, objects have undulations of varying sorts. Luckily, Elements anticipated the need to capture these shapes and provided the Lasso tools.

The Lasso tools enable you to make any freehand selection you can think of. Elements generously provides three types of lasso tools:

- Lasso
- Polygonal
- Magnetic

Although all three tools are designed to make freeform selections, they differ slightly in their methodology, as we explain in the sections that follow.

To use these tools, all that’s really required is a steady hand. You’ll find that the more you use the Lasso tools, the better you become at your tracing technique. Don’t worry if your initial lasso selection isn’t super-accurate. You can always go back and make corrections by adding and deleting from your selection. To find out how, see the section “Modifying Your Selections,” later in this chapter.

If you find that you really love the Lasso tools, you may want to invest in a digital drawing tablet and stylus. This device makes tracing (and also drawing and painting) on the computer more comfortable. It better mimics pen and paper, and many users swear that they’ll never go back to a mouse after trying it out. This is especially handy for laptop users. Accurately drawing on a trackpad can make you downright cranky.

Selecting with the Lasso tool

Using the Lasso tool is the digital version of tracing an outline around an object on a piece of paper. It’s that easy. And you have only three choices in the Tool Options — Feather, Antialias, and Refine Edge. To find out more about Feather and Antialias, see the section “Applying Marquee options,” earlier in this chapter. For the scoop on Refine Edge, see the section “Refining the edges of a selection,” later in this chapter.

Here’s how to make a selection with the Lasso tool:

1. **Select the Lasso tool from the Tools panel.**

   It’s the tool that looks like a rope. You can also just press the L key. If the Lasso tool isn’t visible, press L to cycle through the various Lasso flavors.
2. **Position the cursor anywhere along the edge of the object you want to select.**

   The leading point of the cursor is the protruding end of the rope, as shown in Figure 7-5. Don’t be afraid to zoom in to your object, using the Zoom tool — or, more conveniently, pressing Control++ (⌘++ on the Mac) — if you need to see the edge more distinctly. In this figure, we started at the top of the tulip.

3. **Hold down the mouse button and trace around your desired object.**

   Try to include only what you want to select. While you trace around your object, an outline follows the mouse cursor.

   Try not to release the mouse button until you return to your starting point. When you release the mouse button, Elements assumes that you’re done and closes the selection from wherever you released the mouse button to your starting point; if you release the button too early, Elements creates a straight line across your image.

4. **Continue tracing around the object and return to your starting point; release the mouse button to close the selection.**

   You see a selection border that matches your lasso line. Look for a small circle that appears next to your lasso cursor when you return to your starting point. This icon indicates that you’re closing the selection at the proper spot.

---

### Getting straight with the **Polygonal Lasso tool**

The Polygonal Lasso tool has a specific mission in life: to select any element whose sides are straight. Think pyramids, stairways, skyscrapers, barns — you get the idea. It also works a tad differently from the Lasso tool. You don’t drag around the element with the Polygonal Lasso. Instead, you click and release the mouse button at the corners of the element you’re selecting. The Polygonal Lasso tool acts like a stretchy rubber band.

Follow these steps to select with the Polygonal Lasso tool:
1. Select the Polygonal Lasso tool from the Tools panel.
   You can also press the L key to cycle through the various Lasso tools. The tool looks like a straight-sided lasso rope.

2. Click and release at any point to start the Polygonal Lasso selection line.
   We usually start at a corner.

3. Move (don’t drag) the mouse and click at the next corner of the object. Continue clicking and moving to each corner of your element.
   Notice how the line stretches out from each point you click.

4. Return to your starting point and click to close the selection.
   Be on the lookout for a small circle that appears next to your lasso cursor when you return to your starting point. This circle is an indication that you’re indeed closing the selection at the right spot.
   Note that you can also double-click at any point, and Elements closes the selection from that point to the starting point.
   After you close the polygonal lasso line, a selection border appears, as shown in Figure 7-6.

Figure 7-6: After you close the polygonal lasso line, Elements creates a selection border.
Snapping with the Magnetic Lasso tool

The third member of the Lasso team is the Magnetic Lasso. We aren’t huge fans of this Lasso tool, which can sometimes be hard to work with. However, we show you how it works so that you can decide whether to use it. The Magnetic Lasso tool works by defining the areas of the most contrast in an image and then snapping to the edge between those areas, as though the edge has a magnetic pull.

You have the most success using the Magnetic Lasso tool on an image that has a well-defined foreground object and high contrast between that element and the background — for example, a dark mountain range against a light sky.

The Magnetic Lasso tool also has some unique settings, which you can adjust in the Tool Options before you start selecting:

- **Width:** Determines how close to the edge (between 1 and 256 pixels) you have to move your mouse before the Magnetic Lasso tool snaps to that edge. Use a lower value if the edge has a lot of detail or if the contrast in the image is low. Use a higher value for high-contrast images or smoother edges.

- **Contrast:** Specifies the percentage of contrast (from 1 percent to 100 percent) that’s required before the Magnetic Lasso snaps to an edge. Use a higher percentage if your image has good contrast between your desired element and the background.

- **Frequency:** Specifies how many fastening points (from 1 to 100) to place on the selection line. The higher the value, the greater the number of points. As a general rule, if the element you want to select has a smooth edge, keep the value low. If the edge has a lot of detail, try a higher value.

- **Tablet Pressure (pen icon):** If you’re the proud owner of a pressure-sensitive drawing tablet, select this option to make an increase in stylus pressure cause the edge width to decrease.

Follow these steps to use the Magnetic Lasso tool:

1. **Select the Magnetic Lasso tool from the Tools panel.**
   
   You can also press the L key to cycle through the various Lasso tools. The Magnetic Lasso tool looks like a straight-sided lasso with a little magnet on it.

2. **Click the edge of the object that you want to select to place the first fastening point.**
Fastening points anchor the selection line, as shown in Figure 7-7. You can start anywhere; just be sure to click the edge between the element you want and the background you don’t want.

3. **Continue to move your cursor around the object without clicking.**

   While the selection line gets pinned down with fastening points, only the newest portion of the selection line remains active.

   If the Magnetic Lasso tool starts veering off the desired edge of your object, back up your mouse and click to force down a fastening point. Conversely, if the Magnetic Lasso tool adds a fastening point where you don’t want one, press Backspace (Delete on the Mac) to delete it. Note that successive presses of the Backspace or Delete key continue to remove the fastening points.

   If the Magnetic Lasso isn’t cooperating, you can temporarily switch to the other Lasso tools. To select the Lasso tool, hold down Alt (Option on the Mac) and then click the mouse button and drag. To select the Polygonal Lasso tool, hold down Alt (Option on the Mac) and click.

4. **Return to your starting point and click the mouse button to close the selection.**

   You see a small circle next to your cursor, indicating that you’re at the right spot to close the selection. You can also double-click, whereby Elements closes the selection from where you double-clicked to your starting point. The selection border appears when the selection is closed.
Working Wizardry with the Magic Wand

The Magic Wand tool is one of the oldest tools in the world of digital imaging. This beloved tool has been around since Photoshop was in its infancy and Elements was not yet a twinkle in Adobe’s eye. It’s extremely easy to use, but you’ll have a somewhat harder time predicting what selection results it will present.

Here’s how it works: You click inside the image, and the Magic Wand tool makes a selection. This selection is based on the color of the pixel you clicked. If other pixels are similar in color to your target pixel, Elements includes them in the selection. What’s sometimes hard to predict, however, is how to determine how similar the color has to be to get the Magic Wand tool to select it. Fortunately, that’s where the Tolerance setting comes in. In the sections that follow, we first introduce you to this setting and then explain how to put the Magic Wand to work.

Talking about Tolerance

The Tolerance setting determines the range of color that the Magic Wand tool selects. It’s based on brightness levels that range from 0 to 255:

- Setting the Tolerance to 0 selects one color only.
- Setting the Tolerance to 255 selects all colors, or the whole image.

The default setting is 32, so whenever you click a pixel, Elements analyzes the value of that base color and then selects all pixels whose brightness levels are between 16 levels lighter and 16 levels darker.

What if an image contains a few shades of the same color? It’s not a huge problem. You can make multiple clicks of the Magic Wand to pick up additional pixels that you want to include in the selection. You can find out how in the section “Modifying Your Selections,” later in this chapter. Or you can try a higher Tolerance setting. Conversely, if your wand selects too much, you can also lower your Tolerance setting.

So you can see by our talk on tolerance that the Magic Wand tool works best when you have high-contrast images or images with a limited number of colors. For example, the optimum image for the Wand would be a solid black object on a white background. Skip the wand if the image has a ton of colors and no real definitive contrast between your desired element and the background.

Wielding the Wand to select

To use the Magic Wand tool and adjust its Tolerance settings, follow these steps:
1. Select the Magic Wand tool from the Tools panel.

It looks like a wand with a starburst on the end. You can also just press A to cycle through the Magic Wand, Quick Selection, and Selection Brush tools. Or you can choose any of the tools and then select your desired tool in the Tool Options.

2. Click anywhere on your desired element, using the default Tolerance setting of 32.

Remember that the pixel you click determines the base color.

If the pixel gods are with you and you selected everything you want on the first click, you’re done. If your selection needs further tweaking, like the top image shown in Figure 7-8, continue to Step 3.

Figure 7-8: The Magic Wand selects pixels based on a specified Tolerance setting.

If the Magic Wand selects more than you want, lower the Tolerance setting. If the wand didn’t select enough, increase the value. While you’re poking around in the Tool Options, here are a couple more options to get familiar with:

- **Sample All Layers**: If you have multiple layers and enable this option, the Magic Wand selects pixels from all visible layers. Without this option, the tool selects pixels from the active layer only. For more on layers, see Chapter 8.

- **Contiguous**: Forces the Magic Wand to select only pixels that are adjacent to each other. Without this option, the tool selects all pixels within the range of tolerance, whether or not they’re adjacent to each other.

- **Anti-aliasing**: Softens the edge of the selection by one row of pixels. See the section “Applying Marquee options,” earlier in this chapter, for details.

- **Refine Edge**: Click the Refine Edge button. In the Refine Edge dialog box, clean up your selection by moving the Smooth slider to reduce the amount of jagginess in your edges. Feather works like the feather option discussed in the “Applying Marquee options” section, earlier in the chapter. Move the Shift Edge slider to the left or right to decrease or increase the selected area, respectively. For even more details, see the section “Refining the edges of a selection,” later in this chapter. We explain yet another way to refine edges (which you don’t find in the Tool Options) in “Applying the Grow and Similar commands,” also later in this chapter.

4. Click your desired element again.

Unfortunately, the Magic Wand tool isn’t magical enough to modify your first selection automatically. Instead, it deselects the current selection and makes a new selection based on your new Tolerance setting. If it still isn’t right, you can adjust the Tolerance setting again. Try, try again.

**Modifying Your Selections**

It’s time for a seventh-inning stretch in this chapter on selection tools. In this section, you can find out how to refine that Marquee, Lasso, or Magic Wand selection to perfection.
You’re not limited to the manual methods described in the following sections or even to keyboard shortcuts. You can also use the four selection option buttons on the left side of the Tool Options to create a new selection (the default), add to a selection, subtract from a selection, or intersect one selection with another. Just choose your desired selection tool, click the selection option button you want, and drag (or click if you’re using the Magic Wand or Polygonal Lasso tool).

**Adding to, subtracting from, and intersecting a selection**

Although the Marquee, Lasso, or Magic Wand tools do an okay job of capturing the bulk of your selection, if you take the time to add or subtract a bit from your selection border, you can ensure that you get only what you really want:

- **Add:** If your selection doesn’t quite contain all the elements you want to capture, you need to add those portions to your current selection border. To add to a current Marquee selection, simply press the Shift key and drag around the area you want to include. If you’re using the Polygonal Lasso, click around the area. And if you’re wielding the Magic Wand, just press the Shift key and click the area you want.

  You don’t have to use the same tool to add to your selection that you used to create the original selection. Feel free to use whatever selection tool you think can get the job done. For example, it’s very common to start off with the Magic Wand and fine-tune with the Lasso tool.

- **Subtract:** Got too much? To subtract from a current selection, press the Alt (Option on the Mac) key and drag the marquee around the pixels you want to subtract. With the Alt (Option on the Mac) key, use the same method for the Magic Wand and Polygonal Lasso as you do for adding to a selection.

- **Intersect two selections:** Get your fingers in shape. To intersect your existing selection with a second selection, press Shift+Alt (Shift+Option on the Mac) and drag with the Lasso or Marquee tools. Or, if you’re using the Magic Wand or Polygonal Lasso, press those keys and click rather than drag.

**Avoiding key collisions**

If you read the beginning of this chapter, you found out that by pressing the Shift key, you get a perfectly square or circular selection. We tell you in the section “Adding to, subtracting from, and intersecting a selection,” earlier in this chapter, that if you want to add to a selection, you press the Shift key. What if you want to create a perfect square while adding to the selection? Or what if you want to delete part of a selection while also drawing from the
center outward? Both require the use of the Alt (Option on the Mac) key. How in the heck does Elements know what you want? Here are a few tips to avoid keyboard collisions — grab your desired Marquee tool:

- **To add a square or circular selection, press Shift and drag.** While you drag, keep the mouse button pressed, release the Shift key for just a second, and then press it again. Your added selection area suddenly snaps into a square or circle. You must then release the mouse button and then release the Shift key.

- **To delete from an existing selection while drawing from the center outward, press Alt (Option on the Mac) and drag.** While you drag, keep the mouse button pressed, release the Alt (Option on the Mac) key for just a second, and then press it down again. You’re now drawing from the center outward. Again, release the mouse button first and then release the Alt (Option on the Mac) key.

You can also use the selection option buttons in the Tool Options.

Painting with the Selection Brush

If you like the organic feel of painting on a canvas, you’ll appreciate the Selection Brush. Using two different modes, you can either paint over areas of an image that you want to select or paint over areas you don’t want to select. This great tool also lets you make a basic, rudimentary selection with another tool, such as the Lasso, and then fine-tune the selection by brushing additional pixels into or out of the selection.

Here’s the step-by-step process of selecting with the Selection Brush:

1. **Select the Selection Brush from the Tools panel.**
   It looks like a paintbrush with a dotted oval around the tip. Or simply press the A key to cycle through the Selection Brush, Quick Selection, and Magic Wand tools. You can also select any of these tools and then choose your desired tool in the Tool Options.

   This tool works in either Expert or Quick mode.

2. **Specify your Selection Brush options in the Tool Options.**
   Here’s the rundown on each option:
   - **Mode:** Choose Selection if you want to paint over what you want to select or Mask if you want to paint over what you don’t want.

   If you choose Mask mode, you must choose some additional overlay options. An overlay is a layer of color (that shows onscreen only) that hovers over your image, indicating protected or unselected areas. You must also choose an overlay opacity.
between 1 and 100 percent (which we describe in the Tip at the end of these steps). You can change the overlay color from the default red to another color. This option can be helpful if your image contains a lot of red.

- **Brush Presets Picker:** Choose a brush from the presets drop-down menu. To load additional brushes, click the downward-pointing arrow to the left of Default Brushes and choose the preset library of your choice. You can select the Load Brushes command from the panel menu (top-right down-pointing arrow).

- **Size:** Specify a brush size, from 1 to 2,500 pixels. Enter the value or drag the slider.

- **Hardness:** Set the hardness of the brush tip, from 1 to 100 percent.

3. **Paint the appropriate areas:**

   - **If your mode is set to Selection:** Paint over the areas you *want* to select.

     You see a selection border. Each stroke adds to the selection. (The Add to Selection button in the Tool Options is automatically selected.) If you inadvertently add something you don’t want, simply press the Alt (Option on the Mac) key and paint over the undesired area. You can also select the Subtract from Selection button in the Tool Options. After you finish painting what you want, your selection is ready to go.

   - **If your mode is set to Mask:** Paint over the areas that you *don’t* want to select.

     When you’re done painting your mask, choose Selection from the Selection/Mask drop-down menu or simply choose another tool from the Tool Options, in order to convert your mask into a selection border. Remember that your selection is what you *don’t* want.

     While you paint, you see the color of your overlay. Each stroke adds more to the overlay area, as shown in Figure 7-9. In the example, the sky is masked (with a red overlay) to replace it with a different sky. When working in Mask mode, you’re essentially covering up, or *masking*, the areas you want to protect from manipulation. That manipulation can be selecting, adjusting color, or performing any other Elements command. Again, if you want to remove parts of the masked area, press Alt (Option on the Mac) and paint.

     If you painted your selection in Mask mode, your selection border is around what you *don’t* want. To switch to what you do want, choose Select ▶ Inverse.
Which mode should you choose? Well, it’s up to you. But one advantage to working in Mask mode is that you can partially select areas. By painting with soft brushes, you create soft-edged selections. These soft edges result in partially selected pixels. If you set the overlay opacity to a lower percentage, your pixels are even less opaque, or “less selected.” If this partially selected business sounds vaguely familiar, it’s because this is also what happens when you feather selections, as we discuss in the section “Applying Marquee options,” earlier in this chapter.

**Painting with the Quick Selection Tool**

Think of the Quick Selection tool as a combination Brush, Magic Wand, and Lasso tool. Good news — it lives up to its “quick” moniker. Better news — it’s also easy to use. The best news? It gives pretty decent results, so give it a whirl.

Here’s how to make short work of selecting with this tool:

1. **Select the Quick Selection tool from the Tools panel.**

   The tool looks like a wand with a marquee around the end. It shares the same Tools panel space with the Selection Brush tool and the Magic Wand tool. You can also press the A key to cycle through the Quick Selection, Selection Brush, and Magic Wand tools.

   This tool works in either Expert or Quick mode.
2. **Specify the options in the Tool Options.**

Here’s a description of the options:

- **New Selection:** The default option enables you to create a new selection. There are also options to add to and subtract from your selection.

- **Size:** Choose your desired brush size. Specify the diameter, from 1 to 2,500 pixels.

- **Brush Settings:** With these settings, you can specify hardness, spacing, angle, and roundness. For details on these settings, see Chapter 12.

- **Sample All Layers:** If your image has layers and you want to make a selection from all the layers, select this option. If you leave it deselected, you will select only from the current layer.

- **Auto-Enhance:** Select this option to have Elements automatically refine your selection by implementing an algorithm.

3. **Drag or paint the desired areas of your image.**

Your selection grows as you drag, as shown in Figure 7-10. If you stop dragging and click in another portion of your image, your selection includes that clicked area.

4. **Add to or delete from your selection, as desired:**

- **To add to your selection,** press the Shift key while dragging across your desired image areas.

- **To delete from your selection,** press the Alt (Option on the Mac) key while dragging across your unwanted image areas.
You can also select the Add to Selection and Subtract from Selection options in the Tool Options.

5. **If you need to fine-tune your selection, click the Refine Edge option in the Tool Options and then change the settings, as desired.**

The settings are explained in detail in the “Refining the edges of a selection” section, later in this chapter.

Note that if your object is fairly detailed, you may even need to break out the Lasso or another selection tool to make some final cleanups. Eventually, you should arrive at a selection you’re happy with.

---

**Resizing Smartly with the Recompose Tool**

The Recompose tool is like an über-intelligent crop-and-transform tool. You can move elements closer together or even change the orientation of a landscape shot from horizontal to vertical without sacrificing your most vital content.

Here’s how this great tool works:

1. **In the Photo Editor, in Expert mode, select the Recompose tool from the Tools panel.**

   It looks like a square with a gear in front of it. You can also press the W key.

2. **Using the Brushes and Erasers in the Tool Options, mark the areas you want to protect and eliminate.**

   Although this step isn’t mandatory, it helps to give you better results.

   Here’s a description of these tools:

   - **Mark for Protection Brush:** Brush over the areas of the image you want to protect or retain. (Strokes will be green.) You don’t have to be super precise; just give Elements an inkling of what you want to keep (or remove, in the case of the next brush), as shown in Figure 7-11.

   - **Mark for Removal Brush:** Brush over those areas you want to remove first. (Strokes will be red.) Make sure to choose the area you don’t mind eliminating at all.

   - **Erase Highlight Marked for Protection:** Use this tool to erase any area you erroneously marked to retain.

   - **Erase Highlights Marked for Removal:** Use this tool to erase any area you erroneously marked to remove.
3. Specify the other options in the Tool Options.

Here's a description of those options:

- **Size**: Drag the slider to make the brush diameter smaller or larger.
- **Threshold**: Set a recomposition threshold to help minimize distortion. Start with a higher percentage and then adjust as needed.
- **Presets**: Use a preset ratio or size to which to recompose your image. Or leave on the default of No Restriction.
- **Width and Height**: Enter width and height scale percentages if desired.
- **Highlight Skin tones**: Select this option and brush over skin areas to prevent skin tones from being distorted when scaled.

4. Grab an image handle and resize your image.

As you drag, the red areas are removed first, and the green areas remain intact. After all the red areas have been removed, Elements begins to “carve” out areas you didn’t mark to protect.

5. After you’ve recomposed your image as desired, click the Commit (green) check-mark icon in the image window to accept the composition.

Retouch any areas as needed with the Clone Stamp or Healing tools. For our example, shown in Figure 7-12, we cloned a few seams on the grass, which we repaired.
Working with the Cookie Cutter Tool

The Cookie Cutter tool is a cute name for a pretty powerful tool. You can think of it as a Custom Shape tool for images. But whereas the Custom Shape tool creates a mask and just hides everything outside the shape, the Cookie Cutter cuts away everything outside the shape. The preset libraries offer you a large variety of interesting shapes, from talk bubbles to Swiss cheese. (We’re not being funny here — check out the food library.)

Here’s the lowdown on using the Cookie Cutter:

1. **Choose the Cookie Cutter tool from the Tools panel.**
   
   There’s no missing it; it looks like a flower. You can also press the C key. The Cookie Cutter lost its private space in the Tool panel and now shares a space with the Crop tool. If you don’t see it, press C a second time or select the Crop tool and then select the Cookie Cutter in the Tool Options.

2. **Specify your options in the Tool Options.**
   
   Here’s the list:
   
   - *Shape*: Choose a shape from the Custom Shape picker preset library. To load other libraries, click the shapes pop-up menu and choose one from the submenu.
• **Geometry Options**: These options let you draw your shape with certain parameters:
  
  • **Unconstrained**: Enables you to draw freely.
  
  • **Defined Proportions**: Enables you to keep the height and width proportional.
  
  • **Defined Size**: Crops the image to the original, fixed size of the shape you choose. You can’t make it bigger or smaller.
  
  • **Fixed Size**: Allows you to enter your desired width and height.
  
  • **From Center**: Allows you to draw the shape from the center outward.
  
  • **Feather**: This option creates a soft-edged selection. See the section “Applying Marquee options,” earlier in this chapter, for more details.
  
  • **Crop**: Click this option to crop the image into the shape. The shape fills the image window.

3. **Drag your mouse on the image to create your desired shape, size the shape by dragging one of the handles of the bounding box, and position the shape by placing the mouse cursor inside the box and dragging.**

You can also perform other types of transformations, such as rotating and skewing. You can use these functions by dragging the box manually or by entering values in the Tool Options. For more on transformations, see Chapter 9.

4. **Click the Commit button on the image or press Enter to finish the cutout.**

See Figure 7-13 to see the image cut into a leaf shape. If you want to bail out of the bounding box and not cut out, you can always click the Cancel button on the image or press Esc.

![Figure 7-13: Crop your photo into interesting shapes with the Cookie Cutter.](image)

**Eliminating with the Eraser Tools**

The Eraser tools let you erase areas of your image. Elements has three Eraser tools: the regular Eraser, the Magic Eraser, and the Background Eraser. The Eraser tools look like those pink erasers you used in grade school, so you can’t miss them. If you can’t locate them, you can always press E to cycle through the three tools.
When you erase pixels, those pixels are history — they’re gone. So before using the Eraser tools, always have a backup of your image stored somewhere. Think of it as a cheap insurance policy in case things go awry.

**The Eraser tool**

The Eraser tool enables you to erase areas on your image to either your background color or, if you’re working on a layer, a transparent background, as shown in Figure 7-14. For more on layers, check out Chapter 8.

To use this tool, simply select it and drag through the desired area on your image, and you’re done. Because it isn’t the most accurate tool on the planet, remember to zoom way in and use smaller brush tips to do some accurate erasing.

You have several Eraser options to specify in the Tool Options:

- **Brush Presets Picker**: Click the drop-down menu to access the Brush presets. Choose a brush. Again, additional brush libraries are available on the Brush menu. (Click the down-pointing arrow in the top-right corner.)

- **Size**: Slide the Size slider and choose a brush size between 1 and 2,500 pixels.

- **Opacity**: Specify a percentage of transparency for your erased areas. The lower the Opacity setting, the less it erases. Opacity isn’t available in Block mode.

- **Type**: Select Brush, Pencil, or Block. When you select Block, you’re stuck with one size (a 16-x-16-pixel tip) and can’t select other preset brushes.

**The Background Eraser tool**

The Background Eraser tool, which is savvier than the Eraser tool, erases the background from an image while being mindful of leaving the foreground untouched. The Background Eraser tool erases to transparency on a layer. If
you use this tool on an image with only a background, Elements converts the background into a layer.

The key to using the Background Eraser is to carefully keep the hot spot, the crosshair at the center of the brush, on the background pixels while you drag. The hot spot samples the color of the pixels and deletes that color whenever it falls inside the brush circumference. But if you accidentally touch a foreground pixel with the hot spot, it’s erased as well. And the tool isn’t even sorry about it! This tool works better with images that have good contrast in color between the background and foreground objects, as shown in Figure 7-15. If your image has very detailed or wispy edges (such as hair or fur), and you’re up for a challenge, layer masking can also provide good results. We describe layer masks in Chapter 8.

Here’s the rundown on the Background Eraser options:

- **Brush Settings:** Click the Brush Settings button to bring up the settings to customize the Size, Hardness, Spacing, Roundness, and Angle of your brush tip. The Size and Tolerance settings at the bottom are for pressure-sensitive drawing tablets.

- **Limits:** *Discontiguous* erases all similarly colored pixels wherever they appear in the image. *Contiguous* erases all similarly colored pixels that are adjacent to those under the hot spot.

- **Tolerance:** The percentage determines how similar the colors have to be to the color under the hot spot before Elements erases them. A higher value picks up more colors, whereas a lower value picks up fewer colors. See the section “Talking about Tolerance,” earlier in this chapter, for more details.
The Magic Eraser tool

You can think of the Magic Eraser tool as a combination Eraser and Magic Wand tool. It selects and erases similarly colored pixels simultaneously. Unless you’re working on a layer with the transparency locked (see Chapter 8 for more on locking), the pixels are erased to transparency. If you’re working on an image with just a background, Elements converts the background into a layer.

Although the Magic Eraser shares most of the same options with the other erasers, it also offers unique options:

- **Sample All Layers**: Samples colors using data from all visible layers but erases pixels on the active layer only.
- **Contiguous**: Selects and erases all similarly colored pixels that are adjacent to those under the hot spot.
- **Anti-aliasing**: Creates a slightly soft edge around the transparent area.

If you’re looking for the Magic Extractor, don’t bother. Adobe gave it the ax in Elements 12.

Using the Select Menu

In the following sections, we breeze through the Select menu. Along with the methods we describe in the “Modifying Your Selections” section, earlier in this chapter, you can use this menu to further modify selections by expanding, contracting, smoothing, softening, inverting, growing, and grabbing similarly colored pixels. If that doesn’t satisfy your selection needs, nothing will.

Selecting all or nothing

The Select All and Deselect commands are no-brainers. To select everything in your image, choose Select ➪ All or press Ctrl+A (⌘+A on the Mac). To deselect everything, choose Select ➪ Deselect or press Ctrl+D (⌘+D on the Mac). Remember that you usually don’t have to Select All. If you don’t have a selection border in your image, Elements assumes that the whole image is fair game for any manipulation.
Reselecting a selection

If you sacrifice that second cup of coffee to steady your hand and take the time to carefully lasso around your desired object, you don’t want to lose your selection before you have a chance to perform your next move. But all it takes is an inadvertent click of your mouse while you have an active selection border to obliterate your selection. Fortunately, Elements anticipated such a circumstance and offers a solution: If you choose Select››Reselect, Elements retrieves your last selection.

One caveat: The Reselect command works for only the last selection you made, so don’t plan to reselect a selection you made last Tuesday or even just five minutes ago, if you selected something else after that selection. If you want to reuse a selection for the long term, save it as we explain in the section “Saving and loading selections,” later in this chapter.

Inversing a selection

You know the old song lyric: “If you can’t be with the one you love, love the one you’re with.” Well, making selections in Elements is kind of like that. Sometimes it’s just easier to select what you don’t want rather than what you do want. For example, if you’re trying to select your beloved in his or her senior photo, it’s probably easier to just click the studio backdrop with the Magic Wand and then inverse the selection by choosing Select››Inverse.

Feathering a selection

In the “Applying Marquee options” section earlier in this chapter, we describe how to feather a selection when using the Lasso and Marquee tools by entering a value in the Feather box in the Tool Options. Remember that this method of feathering requires that you set the Feather value before you create your selection. What we didn’t tell you is that there’s a way to apply a feather after you make a selection.

Choose Select››Feather and enter your desired amount from 0.2 to 250 pixels. Your selection is subsequently softened around the edges.

This method is actually a better way to go. Make your selection and fine-tune it by using the methods we describe earlier in this chapter. Then apply your feather. The problem with applying the feather before you make a selection happens when you want to modify your initial selection. When you make a selection with a feather, the marquee outline of the selection adjusts to take into account the amount of the feathering. So the resulting marquee outline doesn’t resemble your precise mouse movement, making it harder to modify that selection.
Refining the edges of a selection

The Refine Edge option enables you to fine-tune the edges of your selection. It doesn’t matter how you got the selection, just that you have one. You can find the command in the Tool Options of the Magic Wand, Lasso, and Quick Selection tools. And, of course, you can find it on the Select menu. Here’s the scoop on each setting for this option, as shown in Figure 7-16:

✓ **View Mode:** Choose a mode from the pop-up menu to preview your selection. Hover your cursor over each mode to get a tooltip. For example, Marching Ants shows the selection border. Overlay lets you preview your selection with the edges hidden and a semi-opaque layer of color in your unselected area. On Black and On White show the selection against a black or white background. Show Original shows the image without a selection preview. Show Radius displays the image with the selection border.

✓ **Smart Radius:** Select this option to have Elements automatically adjust the radius for hard and soft edges near your selection border. If your border is uniformly hard or soft, you may not want to select this option. This enables you to have more control over the radius setting.

✓ **Radius:** Specify the size of the selection border you will refine. Increase the radius to improve the edge of areas with soft transitions or a lot of detail. Move the slider while looking at your selection to find a good setting.

✓ **Smooth:** Reduces jaggedness along your selection edges.

✓ **Feather:** Moves the slider to create an increasingly softer, more blurred edge.

✓ **Contrast:** Removes artifacts while tightening soft edges by increasing the contrast. Try using the Smart Radius option before playing with Contrast.
Part III: Selecting and Correcting Photos

✓ **Shift Edge:** Decreases or increases your selected area. Slightly decreasing your selection border can help to *defringe* (eliminate undesirable background pixels) your selection edges.

✓ **Decontaminate Colors:** Replaces background fringe with the colors of your selected element. Note that because decontamination changes the colors of some of the pixels, you will have to output to, or create, another layer or document to preserve your current layer. To see the decontamination in action, choose Reveal Layer for your View mode. Chapter 8 explains how to work with layers.

✓ **Amount:** Changes the level of decontamination.

✓ **Output To:** Choose whether you want to output your refined, decontaminated selection to a selection on your current layer, layer mask, layer, layer with layer mask, new document, or new document with layer mask.

✓ **Refine Radius tool:** Select the Paintbrush tool on the left and brush around your border to adjust the area you are refining. To understand exactly what area is being included or excluded, change your View mode to Marching Ants. Use the right and left brackets to decrease and increase the brush size.

✓ **Erase Refinements tool:** Use this tool (looks like an Eraser), also located on the left, to clean up any unwanted refinements made with the Refine Radius Tool.

✓ **Zoom tool:** Allows you to zoom in to your image to see the effects of your settings.

✓ **Hand tool:** Enables you to pan around your image window to see the effects of your settings.

---

**Using the Modify commands**

Although the commands on the Modify submenu definitely won’t win any popularity contests, they may occasionally come in handy. Here’s the scoop on each command:

✓ **Border:** Selects the area, from 1 to 200 pixels, around the edge of the selection border. By choosing Edit→Fill Selection, you can fill the border with color.

✓ **Smooth:** Rounds off any jagged, raggedy edges. Enter a value from 1 to 100 pixels, and Elements looks at each selected pixel and then includes or deselected the pixels in your selection based on your chosen value. Start with a low number, like 1, 2, or 3 pixels. Otherwise, your selection may be less accurate.
Expand: Enables you to increase the size of your selection by a given number of pixels, from 1 to 100. This command is especially useful if you just barely missed getting the edge of an elliptical selection and need it to be a little larger.

Contract: Decreases your selection border by 1 to 100 pixels. When you’re compositing multiple images, you often benefit by slightly contracting your selection if you plan to apply a feather. That way, you avoid picking up a fringe of background pixels around your selection.

Applying the Grow and Similar commands
The Grow and Similar commands are often used in tandem with the Magic Wand tool. If you made an initial selection with the Magic Wand but didn’t quite get everything you want, try choosing Select > Grow. The Grow command increases the size of the selection by including adjacent pixels that fall within the range of tolerance. The Similar command is like Grow except that the pixels don’t have to be adjacent to be selected. The command searches throughout the image and picks up pixels within the tolerance range.

These commands don’t have their own tolerance options. They use whatever Tolerance value is displayed on the Tool Options when the Magic Wand tool is selected. You can adjust that Tolerance setting to include more or fewer colors.

Saving and loading selections
At times, you toil so long over a complex selection that you really want to save it for future use. Saving it is not only possible but highly recommended. It’s also a piece of cake. Here’s how:

1. After you perfect your selection, choose Select > Save Selection.

2. In the Save Selection dialog box, leave the Selection option set to New Selection and enter a name for your selection, as shown in Figure 7-17.

   The operation is automatically set to New Selection.

3. Click OK.

4. When you want to access the selection again, choose Select > Load Selection and choose a selection from the Selection drop-down menu.
Working with Layers

In This Chapter
▶ Getting to know layers and the Layers panel
▶ Working with the Layer and Select menus
▶ Using different layer types
▶ Creating new layers
▶ Moving and transforming layers
▶ Adding layer masks
▶ Merging and flattening layers

Using Elements without ever using layers would be like typing a book on an old IBM Selectric typewriter: Sure, you could do it, but it wouldn’t be fun. An even bigger issue would occur when it came time to edit that book and make changes. Correction tape, Wite-Out, and erasers would make that task downright tedious, not to mention messy. The benefit of using layers is that you have tremendous flexibility. You can make as many edits as you want for as long as you want, as long as you keep your composite image in layers. Layers make working in Elements a lot more productive. Don’t give a darn about productivity? Well, let’s just say that layers also make it a breeze for you to bring out your more artsy side.

This chapter explains the tools and techniques you need to start working with layers. After you give layers a try, you’ll wonder how you ever lived without them.
Getting to Know Layers

Think of layers as sheets of acetate or clear transparency film. You have drawings or photographs on individual sheets. What you place on each sheet doesn’t affect any of the other sheets. Any area on the sheet that doesn’t have an image on it is transparent. You can stack these sheets on top of the others to create a combined image, or composite (or collage, if you prefer). You can reshuffle the order of the sheets, add new sheets, and delete old sheets.

In Elements, layers are essentially digital versions of these clear acetate sheets. You can place elements, such as images, text, or shapes, on separate layers and create a composite, as shown in Figure 8-1. You can hide, add, delete, or rearrange layers. Because layers are digital, of course, they have added functionality. You can adjust how opaque or transparent the element on a layer is. You can also add special effects and change how the colors interact between layers.

To work with layers, you must be in the Photo Editor in Expert mode.

Figure 8-1: Layers enable you to easily create composite images.
Chapter 8: Working with Layers

Converting a background to a layer

When you create a new file with background contents of white or a background color, scan an image into Elements, or open a file from a CD or your digital camera, you basically have a file with just a background. There are no layers yet.

An image contains at most one background, and you can’t do much to it besides paint on it and make basic adjustments. You can’t move the background or change its transparency or blend mode. How do you get around all these limitations? Convert your background into a layer by following these easy steps:

1. **Choose Window ➪ Layers to display the Layers panel.**
   - The Layers panel is explained in detail in the next section.

2. **Double-click Background on the Layers panel.**
   - Or choose Layer ➪ New ➪ Layer From Background.

3. **Name the layer or leave it at the default name of Layer 0.**
   - You can also adjust the blend mode and opacity of the layer in the New Layer dialog box. Or you can do it via the Layers panel commands later.

4. **Click OK.**
   - Elements converts your background into a layer, known also as an image layer.

When you create a new image with transparent background contents, the image doesn’t contain a background but instead is created with a single layer.

Anatomy of the Layers panel

Elements keeps layers controlled with a panel named, not surprisingly, the **Layers panel**. To display the Layers panel, shown in Figure 8-2, choose Window ➪ Layers in the Photo Editor in Expert mode.

The order of the layers on the Layers panel represents the order in the image. We refer to this concept in the computer graphics world as the **stacking order**. The top layer on the panel is the top layer in your image, and so on. Depending on what you’re doing, you can work on a single layer or on multiple layers at one time. Here are some tips for working with the Layers panel:

- **Select a layer.** Click a layer name or its thumbnail. Elements highlights the active layer on the panel.
- **Select multiple contiguous layers.** Click your first layer and then Shift-click your last layer.
Select multiple noncontiguous layers. Ctrl-click (⌘-click on the Mac) your desired layers.

**View and hide layers.** To hide a layer, click the eye icon for that layer so that the eye disappears. To redisplay the layer, click the blank space in the eye column. You can also hide all the layers except one by selecting your desired layer and Alt-clicking (Option-clicking on the Mac) the eye icon for that layer. Redisplay all layers by Alt-clicking (Option-clicking on the Mac) the eye icon again. Hiding all the layers except the one you want to edit can be helpful in allowing you to focus without the distraction of all the other imagery.

Only layers that are visible are printed. This can be useful if you want to have several versions of an image (each on a separate layer) for a project within the same file.

Select the actual element (the nontransparent pixels) on the layer. Ctrl-click (⌘-click on the Mac) the layer’s thumbnail (not the name) on the panel.

Create a new blank layer. Click the Create a New Layer icon at the top of the panel.

Add a layer mask. Click the Add Layer Mask icon at the top of the panel. A layer mask enables you to selectively show and hide elements or adjustments on your layer, as well as creatively blend layers together. For more details, see “Adding Layer Masks,” later in this chapter.

Create an adjustment layer. Click the Create a New Fill or Adjustment Layer icon at the top of the panel. Adjustment layers are special layers that modify contrast and color in your image. You can also add fill layers — layers containing color, gradients, or patterns — by using this command. We give you more details on adjustment and fill layers in the section “Working with Different Layer Types,” later in this chapter.

Duplicate an existing layer. Drag the layer to the Create a New Layer icon at the top of the panel.

Rearrange layers. To move a layer to another position in the stacking order, drag the layer up or down on the Layers panel. While you drag, you see a fist icon. Release the mouse button when a highlighted line appears where you want to insert the layer.
If your image has a background, it always remains the bottommost layer. If you need to move the background, convert it to a layer by double-clicking the name on the Layers panel. Enter a name for the layer and click OK.

✓ **Rename a layer.** When you create a new layer, Elements provides default layer names (Layer 1, Layer 2, and so on). If you want to rename a layer, double-click the layer name on the Layers panel and enter the name directly on the Layers panel.

✓ **Adjust the interaction between colors on layers and adjust the transparency of layers.** You can use the blend modes and the opacity options at the top of the panel to mix the colors between layers and adjust the transparency of the layers, as shown in Figure 8-3.

✓ **Link layers.** Sometimes you want your layers to stay grouped as a unit to make your editing tasks easier. If so, link your layers by selecting the layers on the panel and then clicking the Link Layers icon at the top of the panel. A link icon appears to the right of the layer name. To remove the link, click the Link Layers icon again.

✓ **Lock layers.** Select your desired layer or layers and then click one of the two lock icons at the top of the panel. The *checkerboard square icon* locks all transparent areas of your layers. This lock prevents you from painting or editing any transparent areas on the layers. The *lock icon* locks your entire layer and prevents it from being changed in any way, including moving or transforming the elements on the layer. You can, however, still make selections on the layer. To unlock the layer, simply click the icon again to toggle off the lock.

By default, the background is locked and can’t be unlocked until you convert it into a layer by choosing Layer ➪ New ➪ Layer from Background.

✓ **Delete a layer.** Drag it to the trash icon.
Using the Layer and Select menus

As with many features in Elements, you usually have more than one way to do something. This is especially true when it comes to working with layers. Besides the commands on the Layers panel, you have two layer menus — the Layer menu and the Select menu — both of which you can find on the main menu bar at the top of the application window (top of the screen on the Mac).

The Layers menu

Much of what you can do with the Layers panel icons you can also do by using the Layer menu on the menu bar and the Layers panel menu connected to the Layers panel. (Access the Layers panel menu by clicking the horizontally lined button in the upper-right corner of the Layers panel.) Commands, such as New, Duplicate, Delete, and Rename, are omnipresent throughout. But you find commands that are exclusive to the Layers panel, the main Layer menu, and the Layers menu, respectively. So if you can’t find what you’re looking for in one area, just go to another. Some commands require more explanation and are described in the sections that follow. However, here’s a quick description of most of the commands:

- **Delete Linked Layers and Delete Hidden Layers**: These commands delete only those layers that have been linked or those hidden from display on the Layers panel.
- **Layer Style**: These commands manage the styles, or special effects, you apply to your layers.
- **Arrange**: This enables you to shuffle your layer stacking order with options such as Bring to Front and Send to Back. Reverse switches the order of your layers if you have two or more layers selected.
- **Create Clipping Mask**: In a clipping mask, the bottommost layer (base layer) acts as a mask for the layers above it. The layers above “clip” to the opaque areas of the base layer and don’t show over the transparent areas of the base layer. Clipping masks work well when you want to fill a shape or type with different image layers.
- **Type**: The commands in the Type submenu control the display of type layers. For more on type, see Chapter 13.
- **Rename Layer**: This enables you to give a layer a new name. You can also simply double-click the name on the Layers panel.
- **Simplify Layer**: This converts a type layer, shape layer, or fill layer into a regular image layer. Briefly, a *shape layer* contains a vector object, and a *fill layer* contains a solid color, a gradient, or a pattern.
✓ Merge and Flatten: The various merge and flatten commands combine multiple layers into a single layer or, in the case of flattening, combine all your layers into a single background.

✓ Panel Options: You can select display options and choose to use a layer mask on your adjustment layers. Leave this option selected.

The Select menu
Although the Select menu’s main duties are to assist you in making and refining your selections, it offers a few handy layer commands. Here’s a quick introduction to each command:

✓ Select all layers. Want to quickly get everything in your file? Choose Select➪All Layers.

✓ Select layers of similar type. This command is helpful if you have different types of layers in your document, such as regular layers, type layers, shape layers, and adjustment layers, and you want to select just one type. Select one of your layers and then choose Select➪Similar Layers. For details on different types of layers, see the following section.

✓ Deselect all layers. If you want to ensure that nothing is selected in your document, simply choose Select➪Deselect Layers.

Working with Different Layer Types
Layer life exists beyond just converting an existing background into a layer, which we describe in the section “Getting to Know Layers,” earlier in this chapter. In fact, Elements offers five kinds of layers. You’ll probably spend most of your time creating image layers, but just so that you’re familiar with all types, the following sections describe each one.

Image layers
The image layer, usually just referred to as a layer, is the type of layer we’re referring to when we give the analogy of acetate sheets in the section “Getting to Know Layers,” earlier in this chapter. You can create blank layers and add images to them, or you can create layers from images themselves. You can have as many image layers as your computer’s memory allows.

The more layers you have, the larger your file size and the slower your computer speed.
Each layer in an image can be edited without affecting the other layers. You can move, paint, size, or apply a filter, for example, without disturbing a single pixel on any other layer or on the background, for that matter. And when an element is on a layer, you no longer have to make a selection to select it — just drag the element with the Move tool. If, however, you only want part of that layer, you need to make a selection. (See Chapter 7 for information on selections.)

Adjustment layers

An adjustment layer is a special kind of layer used for modifying color and contrast; Figure 8-4 shows an example. The advantage of using adjustment layers for your corrections, rather than applying them directly on the image layer, is that you can apply the corrections without permanently affecting the pixels. This means that adjustment layers are totally nondestructive. And because the correction is on a layer, you can edit, or even delete, the adjustment at any time. Adjustment layers apply the correction only to all the layers below them without affecting any of the layers above them.

Another unique feature of adjustment layers is that when you create one, you also create a layer mask on that layer at the same time. If you’re unfamiliar with layer masks, take a peek at the section “Adding Layer Masks,” later in this chapter. The layer mask allows you to selectively and even partially apply the adjustment to the layers below it by applying shades of gray — from white to black — on the mask. By default, the mask is completely white (as shown in Figure 8-4), which allows the adjustment to be fully applied to the layers. If you paint on a layer mask with black, the areas under those black areas don’t show the adjustment. If you paint with a shade of gray, those areas partially show the adjustment. Note that if you have an active selection border in your image before you add an adjustment layer, the adjustment is applied only to that area within the selection border.

Elements has eight kinds of adjustment layers, and you can use as many as you want. These are the same adjustments that you find on the Enhance ➪ Adjust Lighting, Enhance ➪ Adjust Color, and Filter ➪ Adjustments submenus. For specifics on each adjustment, see Chapters 9 and 10. Here’s how to create an adjustment layer:
1. **Open an image that needs a little contrast or color adjustment.**
   
   Note that you don’t need to convert your background into a layer to apply an adjustment layer.

2. **Click the Create New Fill or Adjustment Layer icon at the top of the Layers panel, and from the drop-down menu, choose your desired adjustment.**
   
   The Adjustment Layer icon and a thumbnail appear on the adjustment layer. The thumbnail represents the layer mask. And the dialog box specific to your adjustment appears in the Adjustments panel.

3. **Make the necessary adjustments in the particular Adjustments panel.**
   
   To selectively allow only portions of your image to receive the adjustment, you can paint on the layer mask using the Brush or Pencil tool. Or you can make a selection and fill that selection with any shade of gray, from white to black. Another technique is to use the Gradient tool on the mask to create a gradual application of the adjustment, as shown in Figure 8-5.

As with image layers, you can adjust the opacity and blend modes of an adjustment layer. Reducing the opacity of an adjustment layer reduces the effect of the adjustment on the underlying layers.

Here are a few more tips on using adjustment layers:

> **To view your image without the adjustment**, click the eye icon in the left column of the Layers panel to hide the adjustment layer.

> **To delete the adjustment layer**, drag it to the trash icon on the Layers panel.

> **To edit an adjustment layer**, simply double-click the adjustment layer on the Layers panel. You can also choose Layer ➤ Layer Content Options. In the dialog box that appears in the Adjustment panel, make any
desired edits. The only adjustment layer that you can’t edit is the Invert adjustment. It’s either on or off.

✓ To use the adjustment panel controls, click an icon. From left to right, here’s what the icons do:
  • Have the adjustment layer clip to the layer below. (It will affect only the layer directly beneath it, not all the underlying layers in the stack.)
  • Toggle the adjustment layer on and off.
  • Reset the adjustment layer settings back to the default.

**Fill layers**

A fill layer lets you add a layer of solid color, a gradient, or a pattern. Like adjustment layers, fill layers also include layer masks. You can edit, rearrange, duplicate, delete, and merge fill layers similarly to adjustment layers. You can blend fill layers with other layers by using the opacity and blend mode options on the Layers panel. Finally, you can restrict the fill layer to just a portion of your image by either making a selection first or painting on the mask later.

Follow these steps to create a fill layer:

1. **Open an image.**
   
   Use an image that will look good with a frame or border of some kind. Remember that if you don’t have a selection, the fill layer covers your whole image.

2. **Click the Create New Fill or Adjustment Layer icon on the Layers panel. From the drop-down menu, choose a fill of a solid color, gradient, or pattern.**
   
   The dialog box specific to your type of fill appears.

3. **Specify your options, depending on the fill type you chose in Step 2:**
   
   • **Solid Color:** Choose your desired color from the Color Picker. See Chapter 12 for details on choosing colors and also gradients and patterns.
   
   • **Gradient:** Click the down-pointing arrow to choose a preset gradient from the drop-down panel, or click the gradient preview to display the Gradient Editor and create your own gradient.
   
   • **Pattern:** Select a pattern from the drop-down panel. Enter a value to scale your pattern, if you want. Click Snap to Origin to make the origin of the pattern the same as the origin of the document. Select the Link with Layer option to specify that the pattern moves with the fill layer if you move that layer.
4. Click OK.

The fill layer appears on the Layers panel, as shown in Figure 8-6. Notice the layer mask that was created on the fill layer. We filled our entire layer mask with black, with just the exception of the outside edge to create a frame around our image.

Figure 8-6: Add a frame or border with a fill layer.

**Shape layers**

If you haven’t made your way to Chapter 12 yet, you may be surprised to discover that Elements also lets you draw shapes with seven different drawing tools. These shapes have the bonus of being vector-based. This means that the shapes are defined by mathematical equations, which consist of points and paths, instead of pixels. The advantage of vector-based objects is that you can freely resize these objects without causing degradation. In addition, they’re always printed with smooth edges, not with the jaggies you’re familiar with seeing in pixel-based elements.

To create a shape layer, grab a shape tool from the Tools panel and drag it on your canvas. When you create a shape, it resides on its own, unique shape layer, as shown by the yin-and-yang logo in the bottom-right corner of Figure 8-6. As with other types of layers, you can adjust the blend modes and opacity of a shape layer. You can also edit, move, and transform the actual shapes. However, to apply filters, you must first simplify the shape layer by choosing `Layer` > `Simplify Layer`. This process converts the vector paths to pixels.
Type layers
To add words to your images (refer to Figure 8-6), click your canvas with the Type tool selected and just type. It’s really as easy as that. Well, you can specify options, such as a font family and size, in the Tool Options, but when you click the Commit button on the image window, you create a type layer. On the Layers panel, the type layer displays a T icon. For details on working with type, check out Chapter 13.

Tackling Layer Basics
Image layers are the heart and soul of the layering world. You can create multiple image layers within a single image. Even more fun is creating a composite from several different images. Add people you like; take out people you don’t. Pluck people out of boring photo studios and put them in exotic locales. The creative possibilities are endless. In the following sections, we cover all the various ways to create image layers.

Creating a new layer from scratch
If you’re creating a new, blank file, you can select the Transparent option for your background contents. Your new file is created with a transparent layer and is ready to go. If you have an existing file and want to create a new, blank layer, here are the ways to do so:

✓ Click the Create a New Layer icon at the bottom of the Layers panel.
✓ Choose New Layer from the Layers panel menu.
✓ Choose Layer ➪ New ➪ Layer.

Note that if you create a layer by using either of the menu commands, you’re presented with a dialog box with options. In that dialog box, you can name your layer and specify options for grouping, blending, and adjusting opacity. Provide a name for your layer and click OK. You can always adjust the other options directly on the Layers panel later.

You can also use the Copy and Paste commands without even creating a blank layer first. When you copy and paste a selection without a blank layer, Elements automatically creates a new layer from the pasted selection. A better method of copying and pasting between multiple images, however, is to use the drag-and-drop method, which we describe in the section “Dragging and dropping layers,” later in this chapter.
Chapter 8: Working with Layers

The Copy Merged command on the Edit menu creates a merged copy of all visible layers within the selection.

After you create your layer, you can put selections or other elements on that layer by doing one or more of the following:

✔ **Paint:** Grab a painting tool, such as the Brush or Pencil, and paint on the layer.

✔ **Copy a selection:** Make a selection on another layer or on the background within the same document, or from another image entirely, and then choose Edit ➪ Copy. Select your new, blank layer on the Layers panel and then choose Edit ➪ Paste.

✔ **Cut a selection:** Make a selection on another layer or on the background within the same document, or from another image, and then choose Edit ➪ Cut. Select your new, blank layer and then choose Edit ➪ Paste. Be aware that this action removes that selection from its original location and leaves a transparent hole, as shown in Figure 8-7.

Note that if you cut a selection from a Background instead of an image layer, the space isn’t a transparent hole; it’s filled with the background color.

**Using Layer via Copy and Layer via Cut**

Another way to create a layer is to use the Layer via Copy and Layer via Cut commands on the Layer menu’s New submenu. Make a selection on a layer or background and choose Layer ➪ New ➪ Layer via Copy or Layer via Cut. Elements automatically creates a new layer and puts the copied or cut selection on the layer. Remember that if you use the Layer via Cut command, your selection is deleted from its original location layer, and you’re left with a transparent hole when cutting from an image layer. If you use the background for the source, your background color fills the space. A reminder: You can use these...
two commands only within the same image. You can’t use them among multiple images.

**Duplicating layers**

Duplicating layers can be helpful if you want to protect your original image while experimenting with a technique. If you don’t like the results, you can always delete the duplicate layer. No harm, no foul.

To duplicate an existing layer, select it on the Layers panel and do one of four things:

- Drag the layer to the Create a New Layer icon at the top of the panel. Elements creates a duplicate layer with Copy appended to the name of the layer.
- Choose Duplicate Layer from the Layers panel menu.
- Choose Layer ➪ Duplicate Layer.
- Choose Layer ➪ New ➪ Layer via Copy. (Make sure you don’t have an active selection when choosing this command.)

If you use the menu methods, a dialog box appears, asking you to name your layer and specify other options. Provide a name for your layer and click OK. You can specify the other options later if you want.

**Dragging and dropping layers**

The most efficient way to copy and paste layers between multiple images is to use the drag-and-drop method. Why? Because it bypasses your Clipboard, which is the temporary storage area on your computer for copied data. Storing data, especially large files, can bog down your system. By keeping your Clipboard clear of data, your system operates more efficiently.

If you already copied data and it’s lounging on your Clipboard, choose Edit ➪ Clear ➪ Clipboard Contents to empty your Clipboard.

Here’s how to drag and drop layers from one file to another:

1. **Select your desired layer in the Layers panel.**
2. **Grab the Move tool (the four-headed arrow) from the Tools panel.**
3. **Drag and drop the layer onto your destination file.**

The dropped layer pops in as a new layer above the active layer in the image. You don’t need to have a selection border to copy the entire layer. But if you want to copy just a portion of the layer, make your
selection before you drag and drop with the Move tool. If you want the selected element to be centered on the destination file, press the Shift key while you drag and drop.

Here’s a handy tip: If you have several elements (that aren’t touching each other) on one layer and you want to select only one of the elements to drag and drop, use the Lasso tool to make a crude selection around the object without touching any of the other elements. Then press the Ctrl (⌘ on the Mac) key and press the up-arrow key once. The element then becomes perfectly selected. You can now drag and drop with the Move tool.

**Using the Paste into Selection command**

The Paste into Selection command lets you put an image on a separate layer while also inserting that image into a selection border. For example, in Figure 8-8, we used this command to make it appear as though our surfer is in the water.

You can do the same by following these steps:

1. **Make your desired selection on the layer in your destination image.**
   
   In our figure, we selected the area in the water where the surfer would be positioned.

2. **Select the image that will fill that selection.**
   
   The image can be within the same file or from another file. Our surfer was in another file.

3. **Choose Edit ➪ Copy.**

4. **Return to the destination image layer and choose Edit ➪ Paste into Selection.**

   Elements converts the selection border on the layer into a layer mask. The pasted selection is visible only inside the selection border. In our example, the surfer only shows inside the selected area. His ankles and feet are outside the border and therefore are hidden.
Moving a Layer’s Content

Moving the content of a layer is a piece of cake: Grab the Move tool from the Tools panel, select your layer on the Layers panel, and drag the element on the canvas to your desired location. You can also move the layer in 1-pixel increments by using the keyboard arrow keys. Press Shift with the arrows to move in 10-pixel increments. **Note:** If you hold down Alt (Option on the Mac) while moving your element you make a duplicate of that element.

The Auto Select Layer option in the Tool Options enables you to switch to a layer when you click any part of that layer’s content with the Move tool. But be careful if you have a lot of overlapping layers because this technique can sometimes be more trouble than it’s worth.

The Move tool has additional settings found in Tool Options. Here’s the lowdown:

✔ **Show Bounding Box:** This option surrounds the contents of your layer with a dotted box that has handles, enabling you to easily transform your layer. Find details in the following section.

✔ **Show Highlight on Rollover:** Hover your mouse anywhere over the canvas to make an outline appear around the element on your layer. Click the highlighted layer to select it and then move it.

✔ **Arrange submenu:** This menu enables you to change your selected layer’s position in the stacking order.

✔ **Link Layers:** This option, which resides not in the Tool Options, but in the Layers panel, connects the layers to make it easier to move (or transform) multiple layers simultaneously. Select a layer and then Ctrl-click (Option-click on the Mac) to select more layers. Click the Link Layers option.

✔ **Align submenu:** Align your selected layers on the left, center, right, top, middle, and bottom. As with linking, select your first layer and then Shift-click to select more layers. Ctrl-click (Option-click on the Mac) to select nonconsecutive layers. Choose an alignment option.

✔ **Distribute submenu:** Use this menu to evenly space your selected layers on the left, center, right, top, middle, and bottom. As with aligning, select your first layer and then Shift-click to select more layers. Ctrl-click (Option-click on the Mac) to select nonconsecutive layers. Choose your desired distribution option.
Transforming Layers

When working with layers, you may need to scale or rotate some of your images. You can do so easily by applying the Transform and Free Transform commands. The methods to transform layers and selections are identical.

Here’s how to transform a layer:

1. **Select your desired layer.**
   
   You can also apply a transformation to multiple layers simultaneously by linking the layers first.

2. **Choose Image $\rightarrow$ Transform $\rightarrow$ Free Transform.**

   A bounding box surrounds the contents of your layer.

3. **Adjust (or transform) the bounding box.**

   - *Size the contents:* Drag a corner handle.
   - *Constrain the proportions:* Press Shift while dragging.
   - *Rotate the contents:* Move the mouse cursor just outside a corner handle until it turns into a curved arrow, and then drag. Or choose Image $\rightarrow$ Rotate.
   - *Distort, skew, or apply perspective to the contents:* Right-click and choose the desired command from the context menu. You can also click the rotate, scale, and skew icons in the Tool Options, as well as enter your transform values numerically in the fields.

   If you want to apply just a single transformation, you can also choose the individual Distort, Skew, and Perspective commands from the Image $\rightarrow$ Transform menu.

4. **When your layer is transformed to your liking, double-click inside the bounding box.**

Try to perform all your transformations in one execution. Each time you transform pixels, you put your image through the *interpolation process* (analyzing the colors of the original pixels and “manufacturing” new ones). Done to the extreme, this process can degrade the quality of your image. This is why it’s prudent to use the Free Transform command rather than individual commands — so that all transformations can be executed in one fell swoop.

When the Move tool is active, you can transform a layer without choosing a command. Select the Show Bounding Box option in the Tool Options. This option surrounds the layer or selection with a box that has handles. Drag the handles to transform the layer or selection.
Adding Layer Masks

One of the best creative tools Elements has to offer is layer masks. *Masking* is essentially just another way of making a selection. Instead of making a selection with a single selection outline — either it is selected or it isn’t — masks enable you to define your selection with up to 256 levels of gray (from white to black). You can therefore have varying levels of a selection.

Here’s how it works. First, think of a layer mask as a sheet of acetate that hovers over your layer. To add it to a layer, click the layer mask icon (dark rectangle with a light circle) at the top of the Layers panel. Then, with any of the painting tools (Brush tool, Gradient tool, and others), you apply black, white, or any shade of gray onto the layer mask. Where the mask is white, the image on the layer is selected and shows. Where the mask is black, the image is unselected and is hidden. And where the mask is gray, the image is partially selected; therefore, it partially shows. The lighter the gray, the more the image shows. By default, the mask starts out completely white so that everything is selected and shows.

Here are some things you can do with layer masks:

- **Creatively blend one layer into another.** If you want one image to gradually dissolve into another, using a layer mask is the way to go. Try using the Gradient tool with the black-to-white gradient selected to create a soft dissolve. You can use layer masks to blend images together in a realistic manner, as shown in Figure 8-9, where we combined a goldfish and a strange, bottled green beverage. In the figure, you can see where we painted with black to completely hide the original background of the fish image. We painted with gray on the fish to make it appear as if it is truly “swimming” in the green liquid. In other words, some of the liquid of the underlying bottle image shows through to the fish layer.

- **Adjust your layer mask to selectively show and hide the...**

![Figure 8-9: Add a layer mask to gradually blend one layer into another.](image)
effects of the adjustment layer. See the earlier section, “Adjustment layers.”

✓ **Apply a filter to your layer mask to create an interesting special effect.** One of the best aspects of layer masks is that you can endlessly edit them. Unlike just making a feathered selection, you can keep adjusting how much of your current layer or underlying images show. Or you can adjust how gradually one image blends into another: Simply change the areas of white, black, and gray on the layer mask by painting with any of the painting tools. Just make sure you select the layer mask and not the image. When you select the layer mask thumbnail in the Layers panel, you see the appearance of an outline around the thumbnail.

You can’t add a layer mask to a background. You must convert the background into a layer first.

Here are some other things to keep in mind when you use layer masks:

✓ **To load the mask as a selection outline,** simply Ctrl-click (⌘-click on the Mac) the layer mask thumbnail in the Layers panel.

✓ **To temporarily hide a mask,** Shift-click the layer mask thumbnail in the Layers panel. Repeat to show the mask.

✓ **To view the mask without viewing the image,** Alt-click (Option-click on the Mac) on the Layer Mask thumbnail in the Layers panel. This trick can be helpful when editing a layer mask.

✓ **To unlink a layer from its layer mask,** click the link icon in the Layers panel. Click again to reestablish the link. By default, Elements links a layer mask to the contents of the layer. This link enables them to move together.

✓ **To delete a layer mask,** drag its thumbnail to the trash icon in the Layers panel.

✓ **To apply a layer mask,** drag the mask thumbnail to the trash icon in the Layers panel and be sure to click Apply in the dialog box. When you apply a layer mask, you fuse the mask to the layer so editing is no longer possible.

Note that many of the preceding commands are also available in the Layer ▶ Layer Mask submenu.

---

**Flattening and Merging Layers**

Layers are fun and fantastic, but they can quickly chew up your computer’s RAM and bloat your file size. And sometimes, to be honest, having too many
layers can start to make your file tedious to manage, thereby making you less productive. Whenever possible, you should merge your layers to save memory and space. Merging combines visible, linked, or adjacent layers into a single layer (not a Background). The intersection of all transparent areas is retained.

In addition, if you need to import your file into another program, certain programs don’t support files with layers. Therefore, you may need to flatten your file before importing it. Flattening an image combines all visible layers into a background, including type, shape, fill, and adjustment layers. You’re prompted as to whether you want to discard hidden layers, and any transparent areas are filled with white. We recommend, however, that before you flatten your image, you make a copy of the file with all its layers intact and save it as a native Photoshop file. That way, if you ever need to make any edits, you have the added flexibility of having your layers.

By the way, the only file formats that support layers are native Photoshop (.psd); Tagged Image File Format, or TIFF (.tif); and Portable Document Format, or PDF (.pdf). If you save your file in any other format, Elements automatically flattens your layers into a background. See Chapter 4 for details on these file types.

**Flattening layers**

To flatten an image, follow these steps:

1. **Make certain that all layers you want to retain are visible.**
   
   If you have any hidden layers, Elements asks whether you want to discard those hidden layers.

   It’s always good insurance to save a copy of image with layers while flattening another copy. You just never know—you may need to make edits at a later date.

2. **Choose Flatten Image from the Layers panel menu or the Layer menu.**
   
   All your layers are combined into a single background, as shown in Figure 8-10.

   If you mistakenly flatten your image, choose Edit\(^*\)Undo or use your Undo History panel. (If you’re not familiar with the History panel, see Chapter 2 for details.)
Chapter 8: Working with Layers

Figure 8-10: Flattening combines all your layers into a single background.

Merging layers

Unlike flattening layers, where all layers get combined into a single Background, you can choose to merge just a few layers. Also, remember, when you do choose to merge all of your layers, they combine into a single layer versus a Background.

You can merge your layers in a few ways. Here’s how:

- **Select only those layers you want to merge.** Choose Merge Layers from the panel menu or the Layer menu.
- **Display only those layers you want to merge.** Click the eye icon on the Layers panel to hide those layers you don’t want to merge. Choose Merge Visible from the Layers panel menu or the Layer menu.
- **Arrange the layers you want to merge so that they’re adjacent on the Layers panel.** Select the topmost layer of that group and choose Merge Down from the Layers panel menu or the Layer menu. Note that Merge Down merges your active layer with the layer directly below it.

If you mistakenly merge your layers, choose Edit ➪ Undo or use your Undo History panel. (If you’re not familiar with the History panel, see Chapter 2 for details.)
Fixing images quickly, without pain or hassle, is probably one of the most desirable features you’ll find in Elements and one that we’re sure you’ll embrace frequently. Whether you’re an experienced photographer or an amateur shutterbug, cropping away unwanted background, tweaking the lighting or color of an image, and erasing the minor blemishes of a loved one’s face are all editing tasks you’ll most likely tackle. With the simple image-makeover tools in Elements, completing these tasks is as easy as clicking a single button or making a few swipes with a brush.

**Cropping and Straightening Images**

Cropping a photo is probably one of the easiest things you can do to improve its composition. Getting rid of the unnecessary background around your subject creates a better focal point. Another dead giveaway of amateurish photography is crooked horizon lines. Not a problem. Elements gives you several ways to straighten those images after the fact. So after your next photo shoot, launch the Elements Photo Editor and then crop and straighten your images before you show them off.
Cutting away with the Crop tool

The most common way to crop a photo is by using the Crop tool. Simple, quick, and easy, this tool gets the job done. Here’s how to use it:

1. In either Expert or Quick mode, select the Crop tool from the Tools panel.

   You can also press the C key. The Crop tool looks like two intersecting “L” shapes. For details on the different editing modes, see Chapter 2. For full details on Quick mode, see the section “Editing in Quick Mode,” later in this chapter.

2. Specify your aspect ratio and resolution options in the Tool Options under the image window.

   Here are your choices:

   - No Restriction: Allows you to freely crop the image at any size.
   - Use Photo Ratio: Retains the original aspect ratio of the image when you crop.
   - Preset Sizes: Offers a variety of common photographic sizes. When you crop, your image then becomes that specific dimension.

   When you crop an image, Elements retains the original resolution of the file (unless you specify otherwise in the resolution option). Therefore, to keep your image at the same image size while simultaneously eliminating portions of your image, Elements must resample the file. Consequently, your image must have sufficient resolution so that the effects of the resampling aren’t too noticeable. This is especially true if you’re choosing a larger preset size. If all this talk about resolution and resampling is fuzzy, be sure to check out Chapter 4.

   - Width (W) and Height (H): Enables you to specify a desired width and height to crop your image.
   - Resolution: Specify a desired resolution for your cropped image. Again, try to avoid resampling your image.
   - Pixels/in or Pixels/cm: Specify your desired unit of measurement.
   - Overlay: Elements gives you an added tool to help you frame your image prior to cropping. Choose from the various options, such as None, Grid, Rule of Thirds, or Golden Ratio.

     Grid: Displays just that — a grid of intersecting horizontal and vertical lines — over the image.
**Rule of Thirds:** This rule is a longtime photographic principle that encourages placing most interesting elements, or your intended focal point, at one of four intersecting points in your grid of two vertical and two horizontal lines, as shown in Figure 9-1. See Chapter 17 for additional information about the rule of thirds.

**Golden Ratio** (aka Golden Rectangle): This is another compositional principle, used by artists and architects throughout history, based on a rectangle that can then be divided into a square and rectangle—in which that resulting rectangle is also a golden rectangle. If you
subdivide that rectangle into a square and rectangle, you will once again get another golden rectangle, and so on. The actual ratio works out to 1:1.618. You can crop your image into this magical golden rectangle. Also within the golden rectangle, the intersection of the two diagonals or in the very center (as you see in the overlay) is a great spot to put your focal point. Interestingly, the rule of thirds is really a simplified version of the golden ratio. Click the Flip button to flip your Golden Ratio overlay. Note that you can also rotate your overlay.

3. Drag around the portion of the image you want to retain and release the mouse button.

When you drag, a crop marquee bounding box appears. Don’t worry if your cropping marquee isn’t exactly correct. You can adjust it in Step 4.

The area outside the cropping marquee (called a shield) appears darker than the inside in order to better frame your image, as shown in Figure 9-1. If you want to change the color and opacity of the shield, or if you don’t want it at all, change your Crop preferences by choosing Edit ➤ Preferences ➤ Display & Cursors. (On the Mac, choose Adobe Photoshop Elements Editor ➤ Preferences ➤ Display & Cursors.)

4. Adjust the cropping marquee by dragging the handles of the crop marquee bounding box.

To move the entire marquee, position your mouse inside the marquee until you see a black arrowhead cursor, and then drag.

If you move your mouse outside the marquee, your cursor changes to a curved arrow. Drag with this cursor to rotate the marquee. This action allows you to both rotate and crop your image simultaneously — handy for straightening a crooked image. Just be aware that rotation, unless it’s in 90-degree increments, also resamples your image.

5. Double-click inside the cropping marquee.

You can also just press Enter or click the green Commit button next to the marquee. Elements then discards the area outside the marquee. To cancel your crop, click the red Cancel button.

If you’re in the Organizer, and not the Photo Editor, click the Instant Fix button in the bottom-right corner. You can find the Crop tool in the Photo Fix Options panel.
Cropping with a selection border
You can alternatively crop an image by choosing Image ➪ Crop in either Expert or Quick mode. First, make a selection with any of the selection tools and then choose the command. You can use this technique with any selection border shape. That is, your selection doesn’t have to be rectangular. It can be round or even freeform. Your cropped image doesn’t take on that shape, but Elements crops as close to the boundaries of the selection border as it can. For details about making selections, see Chapter 7.

Straightening images
There may be times when you just didn’t quite get that horizon straight when you took a photo of the beach. Or maybe you scanned a photo and it wasn’t quite centered in the middle of the scanning bed. It’s not a big deal. Elements gives you several ways to straighten an image.

Using the Straighten tool
This tool enables you to specify a new straight edge, and it then rotates the image accordingly. Here’s how to use the Straighten tool:

1. In **Expert mode**, select the **Straighten tool from the Tools panel (or press the P key)**.
   It looks like an analog level tool.

2. Specify your desired setting from the **Canvas Options in the Tool Options**.
   Here are your choices:
   - **Grow or Shrink** rotates the image and increases or decreases the size of the canvas to fit the image area.
   - **Original Size** rotates your image without trimming any background canvas.
   - **Remove Background** trims background canvas outside the image area. This choice is helpful if you scan an image and white areas appear around your photo that you want removed.

   If you select either the Original Size or Remove Background option, you can select the **Auto Fill Edges option**. When selected, after you straighten the image, the edges that have missing pixels will fill using the content-aware algorithm. Note that you can also vertically straighten your image by pressing Ctrl (⌘ on a Mac) and dragging along a vertical edge.
3. **(Optional) Select Rotate All Layers.**

   If you have an image with layers and you want all of them rotated, select this option.

4. **Draw a line in your image to represent the new straight edge.**

   Your image is then straightened and, if you chose any of the crop options in Step 2, also cropped.

**Using the Straighten menu commands**

In addition to using the Straighten tool, you can straighten your images by using two commands on the Image menu, in either Expert or Quick mode:

- **To automatically straighten an image without cropping,** choose `Image ➪ Rotate ➪ Straighten Image`. This straightening technique leaves the canvas around the image.

- **To automatically straighten and crop the image simultaneously,** choose `Image ➪ Rotate ➪ Straighten and Crop Image`.

**Recomposing Images**

This great tool actually allows you to resize, or as the name implies, recompose, your image without losing any vital content. For example, if you need to have people in your shot closer together because you need the final, cropped image to be more square than rectangular, this tool can help. Here’s how it works:

1. **In Expert mode, select the Recompose tool from the Tools panel.**

   You can also press the W key. It looks like a square with a gear on it.

2. **In the Tool Options, select the Mark for Protection Brush (the brush with a plus sign icon) and brush over the areas in your image that you want to keep or protect.**

   You can specify your brush size with the Size option slider. You can erase any mistakes by using the Erase Highlights Marked for Protection tool (the eraser with a plus sign icon).

3. **With the Mark for Removal Brush (the brush with a minus sign icon), brush over the areas in your image that you want to remove or aren’t vital to your final image, as shown in Figure 9-2.**
You can specify your brush size with the Size option slider. You can erase any mistakes by using the Erase Highlights Marked for Removal tool (eraser with a minus sign icon).

4. **Specify any other desired settings in the Tool Options.**

Here are the other options:

- **Threshold:** The slider determines how much recomposing appears in your adjustment. Selecting 100% totally recomposes your image. Experiment to get the results you want.

- **Preset ratios:** Choose from preset aspect ratios to have your image framed to those dimensions. Or choose No Restriction to have free reign.

- **Width and Height:** This option resizes your image to your specified dimensions.

- **Highlight Skin Tones (green man icon):** Select this option to prevent skin tones from distorting when resizing.

![Figure 9-2](https://istockphoto.com/alynst IMAGE #11082865)

**Figure 9-2:** Brush over areas you want to protect and remove in your image.

5. **Resize, or recompose, your image by dragging the corner or side handles.**
The bikes are now closer together, as shown in Figure 9-3.

6. Click the Commit button (green check-mark icon) when you have your desired composition.

![Figure 9-3: Recompose your image to your desired size and aspect ratio without losing vital content.](https://istockphoto.com/alyest/image-11082865)

**Employing One-Step Auto Fixes**

Elements has seven automatic lighting-, contrast-, and color-correction tools that can improve the appearance of your images with just one menu command. These commands are available in either Expert or Quick mode, and they’re all on the Enhance menu. For more on Quick mode, see the section “Editing in Quick Mode,” later in this chapter.

The advantage of these one-step correctors is that they’re extremely easy to use. You don’t need to have one iota of knowledge about color or contrast to use them. The downside to using them is that sometimes the result isn’t as good as you could get via a manual color-correction method. And sometimes these correctors may even make your image look worse than before by giving you weird color shifts. But because these correctors are quick and easy, you can try them on an image that needs help. Usually, you don’t want to use more than one of the auto fixes. If one doesn’t work on your image, undo the
fix and try another. If you still don’t like the result, move on to one of the manual methods we describe in Chapter 10.

**Auto Smart Tone**

The Auto Smart Tone auto fix is designed to adjust the tonal values in your image.

Here are the steps to use this adjustment:

1. **In either Expert or Quick mode, with your image open, select Enhance ➪ Auto Smart Tone.**
   - Elements automatically applies a default correction.

2. **Moving what Adobe refers to as the “joystick,” fine-tune your correction.**
   - The thumbnail previews, as shown in Figure 9-4, in each corner give you an idea of how the image will look when you move the joystick in that particular direction.
   - Click the eye icon to see the before and after the adjustment previews.

3. **Select the Learn from This Correction option in the lower-left corner of the dialog box to have Elements “learn” from this editing session.**
   - If you select this option, Elements remembers the corrections you made on this image and positions the joystick on the basis of that correction on the next image you open and correct. The more images that are corrected, the smarter the Auto Smart Tone corrections become. This intelligent algorithm is able to distinguish between various image types (based on the tonal characteristics) and remembers the adjustment for that particular type image.
   - If your adjustments are starting out out of whack and you need to reset the learning archive, choose Edit ➪ Preferences ➪ General ➪ Reset Auto Smart Tone Learning (Adobe Photoshop Elements Editor ➪ Preferences ➪ General ➪ Reset Auto Smart Tone Learning on the Mac).

4. **After you’re satisfied with the adjustment, click OK.**
   - If you want to start over, click the Reset button. The top of Figure 9-4 shows our image before and after our adjustment.
Figure 9-4: Apply Auto Smart Fix to quickly adjust the tonal values of an image.

**Auto Smart Fix**

The Auto Smart Fix tool is an all-in-one command touted to adjust it all. It’s designed to improve the details in shadow and highlight areas, and correct the color balance, as shown in Figure 9-5. The overexposed image on the left was improved quite nicely with the Auto Smart Fix command.

Figure 9-5: In a hurry? Apply the Auto Smart Fix command to quickly improve an image.
The Auto Smart Fix command, as well as the Auto Color, Auto Levels, Auto Contrast, Auto Sharpen, and Auto Red Eye Fix commands, are also available in the Organizer (in the Photo Fix Options pane), where you can apply the commands to several selected images simultaneously.

If the Auto Smart Fix was just too “auto” for you, you can crank it up a notch and try Adjust Smart Fix. This command is similar to Auto Smart Fix but gives you a slider that allows you, not Elements, to control the amount of correction applied to the image.

**Auto Levels**

The Auto Levels command adjusts the overall contrast of an image. This command works best on images that have pretty good contrast (even range of tones and detail in the shadow, highlight, and midtone areas) to begin with and need just a minor amount of adjustment. Auto Levels works by mapping, or converting, the lightest and darkest pixels in your image to black and white, thereby making highlights appear lighter and shadows appear darker, as shown in Figure 9-6.

Although the Auto Levels command can improve contrast, it may also produce an unwanted color cast (a slight trace of color). If this happens, undo the command and try the Auto Contrast command instead. If that still doesn’t improve the contrast, it’s time to bring out the big guns. Try the Levels command we describe in Chapter 10.

![Figure 9-6: Auto Levels adjusts the overall contrast of an image.](image-url)
**Auto Contrast**

The Auto Contrast command is designed to adjust the overall contrast in an image without adjusting its color. This command may not do as good a job of improving contrast as the Auto Levels command, but it does a better job of retaining the color balance of an image. Auto Contrast usually doesn’t cause the funky color casts that can occur when you’re using Auto Levels. This command works great on images with a haze, as shown in Figure 9-7.

![Figure 9-7: The Auto Contrast command works wonders on hazy images.](image)

**Auto Color Correction**

The Auto Color Correction command adjusts both the color and contrast of an image, based on the shadows, midtones, and highlights it finds in the image and a default set of values. These values adjust the amount of black and white pixels that Elements removes from the darkest and lightest areas of the image. You usually use this command to remove a color cast or to balance the color in your image, as shown in Figure 9-8. Occasionally, this command can also be useful in correcting oversaturated or undersaturated colors.
Chapter 9: Simple Image Makeovers

Figure 9-8: Use Auto Color Correction to remove a colorcast.

**Auto Sharpen**

Photos taken with a digital camera or scanned on a flatbed scanner often suffer from a case of overly soft focus. Sharpening gives the illusion of increased focus by increasing the contrast between pixels. Auto Sharpen attempts to improve the focus, as shown in Figure 9-9, without overdoing it. What happens when you oversharpen? Your images go from soft to grainy and noisy. For more precise sharpening, check out the Unsharp Mask and Adjust Sharpness features we cover in Chapter 10.

Always make sharpening your last fix after you make all your other fixes and enhancements.
Auto Red Eye Fix

The Auto Red Eye Fix command is self-explanatory. It automatically detects and eliminates red-eye in an image. Red-eye happens when a person or an animal (where red-eye can also be yellow-, green-, or even blue-eye) looks directly into the flash.

If for some reason the Auto Red Eye Fix doesn’t quite do the trick, you can always reach for the Red Eye tool on the Tools panel. Here’s how to remove red-eye manually:

1. **Select the Red Eye Removal tool from the Tools panel.**
   You can also press Y.

2. **Using the default settings, click the red portion of the eye in your image.**
   This one-click tool darkens the pupil while retaining the tonality and texture of the rest of the eye, as shown in Figure 9-10.
3. If you’re unhappy with the fix, adjust one or both of these settings in the Tool Options:

- **Pupil Radius**: Use the slider to increase or decrease the size of the pupil.
- **Darken**: Use the slider to darken or lighten the color of the pupil.

Previously, the Red Eye Removal tool didn’t do a great job with the white, green, blue, or yellow eyes that pets can get from the flash. Now, however, Elements 12 provides a Pet Eye option in Tool Options. If this new option still doesn’t do it, your best bet is to use the Color Replacement tool. See the section “Replacing one color with another,” at the end of this chapter.

**Editing in Quick Mode**

Quick mode is a pared-down version of Expert mode that conveniently provides basic fixing tools and tosses in a few unique features, such as a before-and-after preview of your image.
Here’s a step-by-step workflow that you can follow in Quick mode to repair your photos:

1. **Select one or more photos in the Organizer, click the Editor button at the bottom of the workspace, and then click the Quick button at the top of the workspace.**

   Or if you’re in Expert mode, select your desired image(s) from the Photo Bin and then select the Quick button at the top of the workspace.

   Note that you can also open images by simply clicking the Open button and selecting your desired files.

2. **Specify your preview preference from the View drop-down menu at the top of the workspace.**

   You can choose to view just your original image (Before Only), your fixed image (After Only), or both images side by side (Before & After) in either portrait (Vertical) or landscape (Horizontal) orientation, as shown in Figure 9-11.

3. **Use the Zoom and Hand tools to magnify and navigate around your image.** (See Chapter 2 for more on these tools.)

![Figure 9-11: Quick mode enables you to view before-and-after previews of your image.](image-url)
You can also specify the Zoom percentage by using the Zoom slider in the Tool Options or in the top-right of the workspace.

4. **Choose your desired window view by selecting one of the following buttons located in the Tool Options:** 1:1 (Actual Pixels), Fit Screen, Fill Screen (which zooms your image to fill your screen), or Print Size.

You also have another Zoom slider located in the Tool Options.

5. **Crop your image by using the Crop tool on the Tools panel.**

You can also use any of the methods we describe in the “Cropping and Straightening Images” section, earlier in this chapter, except for the Straighten tool, which is exclusive to Expert mode.

6. **To rotate the image in 90-degree increments, click the Rotate Counter Clockwise or Rotate Clockwise button in the left side of the workspace.**

7. **Apply any necessary auto fixes, such as Auto Smart Fix, Auto Levels, Auto Contrast, and Auto Color Correction.**

All these commands are on the Enhance menu or in the Smart Fix, Levels, and Color sections in the Basic Edit pane of the workspace. If the commands aren’t visible, click the Basic Edit button in the bottom-right corner of the workspace.

Each of these fixes is described in detail in the section “Employing One-Step Auto Fixes,” earlier in this chapter. Remember that usually one of the fixes is enough. Don’t stack them on top of each other. If one doesn’t work, click the Reset button in the top-right corner of the image preview and try another. If you’re not happy with the results, go to Step 8. If you are happy, skip to Step 9.

8. **If the auto fixes don’t quite cut it, get more control by using the sliders, or clicking the thumbnails, available for Smart Fix, Exposure, Levels, Color, and Balance located on the right side of the workspace.**

For all adjustments, you can hover your mouse over any of the thumbnails in the pane to get a dynamic preview of that particular adjustment. The slider automatically moves accordingly.

Here’s a brief description of each available adjustment:

- **Shadows:** When you drag the slider to the right, it lightens the darker areas of your image without adjusting the highlights.

For all adjustments, you can hover your mouse over any of the thumbnails in the pane to get a dynamic preview of that particular adjustment. The slider automatically moves accordingly.
• **Highlights:** When you drag the slider to the right, it darkens the lighter areas of your image without adjusting the shadows.

• **Midtones:** Adjusts the contrast of the middle (gray) values and leaves the highlights and shadows as they are.

• **Exposure:** Adjusts the brightness or darkness of an image. Move the slider left to darken and right to lighten. The values are in increments of f-stops and range from –4 to 4.

• **Saturation:** Adjusts the intensity of the colors.

• **Hue:** Changes all colors in an image. Make a selection first to change the color of just one or more elements. Otherwise, use restraint with this adjustment.

• **Vibrance:** Adjusts the saturation of an image by increasing the saturation of less saturated colors more than those that are already saturated. This option tries to minimize clipping (loss of color) as it increases saturation and preserves skin tones. Move the slider right to increase saturation. The values are in increments of f-stops and range from –1 to 1.

• **Temperature:** Adjusts the colors to make them warmer (red) or cooler (blue). You can use this adjustment to correct skin tones or to correct overly cool images (such as snowy winter photos) or overly warm images (such as photos shot at sunset or sunrise).

• **Tint:** Adjusts the tint after you adjust temperature to make the color more green or magenta.

If you still don’t get the results you need, move on to one of the more manual adjustments that we describe in Chapter 10.

Note that you can also apply fixes to just selected portions of your image. Quick mode offers the Quick Selection tool for your selection tasks. For details on using this tool, see Chapter 7.

9. **Add finishing fixes by using the remaining tools in the Tools panel.**

Here is a description of each tool:

• **Red Eye Removal tool:** Try the Auto Red Eye Fix to remove red-eye from your people’s eyes. But if it doesn’t work, try using the Red Eye tool. This method is described in the section “Auto Red Eye Fix,” earlier in this chapter.

• **Whiten Teeth:** This fix does what it says — it whitens teeth. Be sure to choose an appropriate brush size from the Size slider in the Tool Options. Click the Brush Settings option to specify Hardness,
Spacing, Roundness, and Angle of the brush tip. (For more on brush options, see Chapter 12.) Using a brush diameter that’s larger than the area of the teeth also whitens/brightens whatever else it touches — lips, chin, and so on. Click the teeth. Note that this tool makes a selection and whitens simultaneously. After your initial click, your selection option converts from New Selection to Add to Selection in the Tool Options. If you pick up too much in your dental selection, click the Subtract from Selection option and click the area you want to eliminate. When you’re happy with the results of your whitening session, choose Select ⇒ Deselect or press Ctrl+D (⌘+D on the Mac).

- **Spot Healing Brush/Healing Brush:** These tools are great for fixing flaws, both big (Healing Brush) and small (Spot Healing Brush). For a detailed explanation on using these tools, see the upcoming sections “Retouching with the Healing Brush” and “Zeroing in with the Spot Healing Brush.”

10. **(Optional) Add any desired text by clicking your image with the Text tool.**

   See Chapter 13 for details on working with text.

   Use the Move tool in Quick mode to fine-tune the positioning of your text.

11. **Sharpen your image automatically by clicking the Auto button under Sharpen in the right pane.**

   You can also choose Enhance ⇒ Auto Sharpen. If automatically sharpening doesn’t do the fix, you can manually drag the Sharpen slider.

   This fix should always be the last adjustment you make on your image.

   The Quick mode sports additional panels in Elements 12. Click the Effects icon in the bottom-right corner of the workspace to access various effects, such as Cross Process and Scary Movie, that you can apply to your image. Click the Frames icon to apply borders, such as Scrapbook and Comic, to the perimeter of your photo. You can also click the Textures icon to access textures, such as Cracked Paint and Sunburst. Click the Adjustments icon to return to your default panel settings.

### Fixing Small Imperfections with Tools

Elements provides you with several handy tools to correct minor imperfections in your photos. You can use the Clone Stamp tool to clone parts of
your image, heal blemishes with the Healing Brush or Spot Healing Brush tools, lighten or darken small areas with the Dodge and Burn tools, soften or sharpen the focus with the Blur or Sharpen tools, and fix color with the Sponge or Color Replacement tools.

**Cloning with the Clone Stamp tool**

Elements enables you to clone elements without the hassle of genetically engineering DNA. In fact, the Clone Stamp tool works by just taking sampled pixels from one area and copying, or cloning, them onto another area. The advantage of cloning, rather than making a selection and then copying and pasting, is that it’s easier to realistically retain soft-edged elements, such as shadows, as shown in Figure 9-12.

The Clone Stamp doesn’t stop there. You can also use this tool for fixing flaws, such as scratches, bruises, date/time stamp imprints from cameras, and other minor imperfections. Although the birth of the healing tools (discussed in the following sections) has somewhat pushed the Clone Stamp tool out of the retouching arena, it can still do a good repair job in many instances.

Here’s how to use the Clone Stamp tool:

1. **In Expert mode, choose the Clone Stamp tool from the Tools panel.**
   It looks like an analog rubber stamp.

2. **In the Tool Options, choose a brush from the Brush Preset Picker panel and then use the brush as is or adjust its size with the Size slider.**

   Keep in mind that the size of the brush you specify should be appropriate for what you’re trying to clone or retouch. If you’re cloning a large object, use a large brush. For repairing small flaws, use a small brush.

©istockphoto/Beano5 Image #14501558

Figure 9-12: The Clone Stamp tool enables you to realistically duplicate soft-edged elements, such as shadows.
Cloning with a soft-edged brush usually produces more natural results. For details on brushes, see Chapter 12.

3. Choose your desired Opacity and Blend Mode percentage.
For more on blend modes, see Chapter 11. To make your cloned image appear ghosted, use an opacity percentage of less than 100 percent.

4. Select or deselect the Aligned option.
With Aligned selected, the clone source moves when you move your cursor to a different location. If you want to clone multiple times from the same location, leave the Aligned option deselected.

5. Select or deselect the Sample All Layers check box.
This option enables you to sample pixels from all visible layers for the clone. If this option is deselected, the Clone Stamp tool clones from only the active layer. Check out Chapter 8 for details about working with layers.

6. Click the Clone Overlay button if you want to display an overlay.
Displaying an overlay can be helpful when what you’re cloning needs to be in alignment with the underlying image. In the Clone Overlay dialog box, select the Show Overlay check box. Adjust the opacity for your overlay. If you select Auto Hide, when you release your mouse, you see a ghosted preview of how your cloned pixels will appear on the image. While you’re cloning, however, the overlay is hidden. Select Clipped to have the overlay contained only within the boundaries of your brush. We think that this makes it easier to more precisely clone what you want. Finally, select Invert Overlay to reverse the colors and tones in your overlay.

7. Alt-click (Option-click on the Mac) the area of your image that you want to clone to define the source of the clone.

8. Click or drag along the area where you want the clone to appear.
While you drag, Elements displays a crosshair cursor along with your Clone Stamp cursor. The crosshair is the source you’re cloning from, and the Clone Stamp cursor is where the clone is being applied. While you move the mouse, the crosshair also moves, so you have a continuous reference to the area of your image that you’re cloning. Watch the crosshair, or else you may clone something you don’t want.

9. Repeat Steps 7 and 8 until you’ve finished cloning your desired element.
If you’ve selected the Aligned option when cloning an element, try to clone it without lifting your mouse. Also, when you’re retouching a flaw, try not to overdo it. One or two clicks on each flaw is usually plenty. If you’re heavy-handed with the Clone Stamp, you get a blotchy effect that’s a telltale sign something has been retouched.

Retouching with the Healing Brush

The Healing Brush tool is similar to the Clone Stamp tool in that you clone pixels from one area onto another area. But the Healing Brush is superior in that it takes into account the tonality (highlights, midtones, and shadows) of the flawed area. The Healing Brush clones by using the texture from the sampled area (the source) and then using the colors around the brush stroke while you paint over the flawed area (the destination). The highlights, midtones, and shadow areas remain intact, giving you a realistic and natural repair that isn’t as blotchy or miscolored as the repair you get with the Clone Stamp tool.

Here are the steps to heal a photo:

1. In Expert mode, open an image in need of a makeover and select the Healing Brush tool from the Tools panel.

   The tool looks like a bandage. You can also press J to cycle between the Healing Brush and Spot Healing Brush tools. You can also select either of these tools and then choose the other tool from the Tool Options.

   You can also heal between two images, but be sure that they have the same color mode — for example, both RGB (red, green, blue). We chose a couple who are super photogenic but might appreciate a little tune-up, as shown in Figure 9-13.

   ©istockphoto.com/Yuri_Arcurs Image #10297652

Figure 9-13: Wipe out ten years in two minutes with the Healing Brush tool.
2. **Specify a size for the Healing brush tool in the Tool Options.**

   You can also adjust the hardness, spacing, angle, and roundness in the Brush Settings. For details on these options, see Chapter 12. Don’t be shy. Be sure to adjust the size of your brush as needed. Using the appropriate brush size for the flaw you’re retouching is critical to creating a realistic effect.

3. **Choose your desired blend mode.**

   For most retouching jobs, you probably should leave the mode as Normal. Replace mode preserves textures, such as noise or film grain, around the edges of your strokes.

4. **Choose one of these Source options:**

   - *Sampled* uses the pixels from the image. You use this option for the majority of your repairs.
   - *Pattern* uses pixels from a pattern chosen from the Pattern Picker drop-down panel.

5. **Select or deselect the Aligned option.**

   For most retouching tasks, you probably should leave Aligned selected. Here are the details on each option:

   - *With Aligned selected:* When you click or drag with the Healing Brush, Elements displays a crosshair along with the Healing Brush cursor. The crosshair represents the sampling point, also known as the source. When you move the Healing Brush tool, the crosshair also moves, providing a constant reference to the area you’re sampling.
   - *With Aligned deselected:* Elements applies the source pixels from your initial sampling point, no matter how many times you stop and start dragging.

6. **Select the Sample All Layers check box to heal an image by using all visible layers.**

   If this option is deselected, you heal from only the active layer. To ensure maximum editing flexibility later, select the Sample All Layers check box and add a new, blank layer above the image you want to heal. When you heal the image, the pixels appear on the new layer and not on the actual image, which means you can adjust opacity and blend modes and make other adjustments to the healed layer.

7. **Click the Clone Overlay button if desired.**

   See the previous section, “Cloning with the Clone Stamp tool,” for details on using an overlay.
8. Establish the sampling point by Alt-clicking (Option-clicking on the Mac).

Make sure to click the area of your image that you want to clone from. In our example, we clicked a smooth area of the forehead when working on each person.

9. Release the Alt (Option on the Mac) key and click or drag over a flawed area of your image.

Keep an eye on the crosshair because that’s the area you’re healing from. We brushed over the wrinkles under and around the eyes, mouth, and forehead. (Refer to Figure 9-12.) This couple never looked so good, and they endured absolutely no recovery time.

Zeroing in with the Spot Healing Brush

Whereas the Healing Brush is designed to fix larger flawed areas, the Spot Healing Brush is designed for smaller imperfections, with one exception — the Content-Aware option, which we explain in Step 3 in the following steps. The Spot Healing Brush doesn’t require you to specify a sampling source. It automatically takes a sample from around the area to be retouched. It’s quick, easy, and often effective. But it doesn’t give you control over the sampling source, so keep an eye out for less-than-desirable fixes.

Here’s how to quickly fix flaws with the Spot Healing Brush tool:

1. In Expert mode, open your image and grab the Spot Healing Brush tool.

It looks like a bandage with a dotted oval behind it. You can also press J to cycle between the Healing Brush and Spot Healing Brush tools. You can also select either of these tools and then choose the other tool from the Tool Options.

2. In the Tool Options, click the Brush Preset Picker and select a brush tip. You can further adjust the diameter by dragging the Size slider.

Select a brush that’s a little larger than the flawed area you’re fixing.

3. Choose a type in the Tool Options:

   • Proximity Match: This type samples the pixels around the edge of the selection to fix the flawed area.

   • Create Texture: This type uses all the pixels in the selection to create a texture to fix the flaw.
• **Content-Aware**: If you want to eliminate something larger than a mole or freckle, this is the option of choice where actual content from the image is used as a kind of patch for the flawed area. Large objects can be zapped away; Figure 9-14 shows how we eliminated the cannonballer. Note that you may have to paint over the offending object a couple of times to get your desired result. Also, a touch-up with the Clone Stamp or other healing tools may be needed.

![Figure 9-14: Eliminate cannonballers and other offending objects with the Content-Aware option.](image)

Try Proximity Match first, and if it doesn’t work, undo it and try Create Texture or Content-Aware.

4. **Select the Sample All Layers check box to heal an image by using all visible layers.**

   If you leave this check box deselected, you heal from only the active layer.

5. **Click, drag, or “paint” over the area you want to fix.**

   We painted over the cannonballer with the Spot Healing Brush and achieved realistic results, as shown in the after image in Figure 9-14.
Repositioning with the Content-Aware Move tool

The Content-Aware Move tool enables you to select and move a portion of an image. The best thing is, however, that when you move that portion, the hole left behind is miraculously filled using content-aware technology. In other words, Elements analyzes the area surrounding the selected portion you’re moving and then fills the hole with matched content.

Here’s how to use this beneficial editing tool:

1. **In Expert mode, open your image and select the Content-Aware Move tool.**

   It’s the tool that looks like two arrows. You can also press the Q key.

2. **Choose either Move or Extend mode.**

   - **Move:** Elements moves your selection to a new location and then fills the remaining hole with content-aware pixels. The Move mode works great when you need to move an object, or objects, in your image for a more desirable composition. Keep in mind that this technique works best when the background of the new location of the object is similar from which it was plucked.

   - **Extend:** Elements extends your selected area while maintaining any lines and structural elements and blending them into the existing object. This option works great for expanding or contracting objects such as hair, fur, trees, buildings and so on.

   For Figure 9-15, we chose the Move mode to move the girl to the right so we could add some type.

3. **Choose your desired Healing setting.**

   Healing controls the amount of flexibility Elements uses in determining how to shift pixels around and how strictly regions are preserved when determining the content-aware fill. The default setting is smack dab in the middle, which is what we stuck with.

   You can also select the Sample All Layers check box to use content from all of your layers. If you leave this check box deselected, you use only content from the active layer.

4. **Drag around the area of your image that you want to move or extend.**

   If you need to fine-tune your selection, you can use the Path Operations options on the Options bar. Or you can press the Shift key to add to
your selected area or press Alt (Option on the Mac) to delete from your selection.

5. Move your selection to your desired location.
6. Touch up any areas that require it.

You can break out the healing tools or the Clone Stamp tool to fix any mismatches or remaining flaws. We fixed a few spots along the girl that weren’t quite matched up, as shown in Figure 9-15. We also spot-healed the ugly light fixture at the top of the image.

Figure 9-15: Recompose your image by using the new Content-Aware Move tool.

Lightening and darkening with Dodge and Burn tools

The techniques of dodging and burning originated in the darkroom, where photographers fixed negatives that had overly dark or light areas by adding or subtracting exposure, using holes and paddles as an enlarger made prints. The Dodge and Burn tools are even better than their analog ancestors because they’re more flexible and much more precise. You can specify the size and softness of your tool by simply selecting from one of the many brush tips. You can also limit the correction to various tonal ranges in your image — shadows, midtones, or highlights. Finally, you can adjust the amount of correction that’s applied by specifying an exposure percentage.
Part III: Selecting and Correcting Photos

Use these tools only on small areas (such as the girl’s face shown in Figure 9-16) and in moderation. You can even make a selection prior to dodging and burning to ensure that the adjustment is applied only to your specific area. Also, keep in mind that you can’t add detail that isn’t there to begin with. If you try to lighten extremely dark shadows that contain little detail, you get gray areas. If you try to darken overly light highlights, you just end up with white blobs.

Figure 9-16: Use the Dodge and Burn tools to lighten and darken small areas.

Follow these steps to dodge or burn an image:

1. In Expert mode, choose either the Dodge (to lighten) or Burn (to darken) tool from the Tools panel.
   
   These tools look like a darkroom paddle and hand making an “O,” respectively. Press O to cycle through the Dodge and Burn tools. You can also select any of these tools and then choose your desired tool from the Tool Options.

2. Select a brush from the Brush Preset Picker panel and also adjust the brush size if necessary.
   
   Larger, softer brushes spread the dodging or burning effect over a larger area, making blending with the surrounding area easier.

3. From the Range drop-down menu, select Shadows, Midtones, or Highlights.
Select Shadows to darken or lighten the darker areas of your image. Select Midtones to adjust the tones of average darkness. Select Highlights to make the light areas lighter or darker.

In Figure 9-15, the original image had mostly dark areas, so we dodged the shadows.

4. **Choose the amount of correction you want to apply with each stroke by adjusting the Exposure setting in the Tool Options.**

Start with a lower percentage to better control the amount of darkening or lightening. Exposure is similar to the opacity setting that you use with the regular Brush tool. We used a setting of 10 percent.

5. **Paint over the areas you want to lighten or darken.**

If you don’t like the results, press Ctrl+Z (♯+Z on the Mac) to undo.

---

**Smudging away rough spots**

The Smudge tool, one of the focus tools, pushes your pixels around using the color that’s under the cursor when you start to drag. Think of it as dragging a brush through wet paint. You can use this tool to create a variety of effects. When it’s used to the extreme, you can create a warped effect. When it’s used more subtly, you can soften the edges of objects in a more natural fashion than you can with the Blur tool. Or you can create images that take on a painterly effect, as shown in Figure 9-17.

Keep an eye on your image while you paint, however, because you can start to eliminate detail and wreak havoc if you’re not careful with the Smudge tool.

---

*Figure 9-17: The Smudge tool can make your images appear to be painted.*
To use the Smudge tool, follow these steps:

1. **In Expert mode, choose the Smudge tool from the Tools panel.**
   
The tool looks like a finger. Press R to cycle through the Smudge, Blur, and Sharpen tools. You can also select any of these tools and then choose your desired tool from the Tool Options.

2. **Select a brush from the Brush Preset Picker panel. Use the Size slider to fine-tune your brush diameter.**
   
   Use a small brush for smudging tiny areas, such as edges. Larger brushes produce more extreme effects.

3. **Select a blending mode from the Mode drop-down menu.**

4. **Choose the strength of the smudging effect with the Strength slider or text box.**
   
The lower the value, the lighter the effect.

5. **If your image has multiple layers, select the Sample All Layers check box to make Elements use pixels from all the visible layers when it produces the effect.**
   
The smudge still appears on only the active layer, but the look is a bit different, depending on the colors of the underlying layers.

6. **Use the Finger Painting option to begin the smudge by using the foreground color.**
   
   Rather than use the color under your cursor, this option smears your foreground color at the start of each stroke. If you want the best of both worlds, you can quickly switch into Finger Painting mode by pressing the Alt key while you drag. Release Alt to go back to Normal mode.

7. **Paint over the areas you want to smudge.**
   
   Pay attention to your strokes because this tool can radically change your image. If you don’t like the results, press Ctrl+Z (⌘+Z on the Mac) to undo the changes and then lower the Strength percentage (discussed in Step 4) even more.

**Softening with the Blur tool**

The Blur tool can be used to repair images, as well as for more artistic endeavors. You can use the Blur tool to soften a small flaw or part of a rough edge. You can add a little blur to an element to make it appear as though it
was moving when photographed. You can also blur portions of your image to emphasize the focal point, as shown in Figure 9-18, where we blurred everything except the girl’s face. The Blur tool works by decreasing the contrast among adjacent pixels in the blurred area.

The mechanics of using the Blur tool and its options are similar to those of the Smudge tool, as we describe in the preceding section. When you use the Blur tool, be sure to use a small brush for smaller areas of blur.

**Focusing with the Sharpen tool**

If the Blur tool is yin, the Sharpen tool is yang. The Sharpen tool increases the contrast among adjacent pixels to give the illusion that things are sharper. You should use this tool with restraint, however. Sharpen can quickly give way to overly grainy and noisy images if you’re not cautious.

Use a light hand and keep the areas you sharpen small. Sometimes, the eyes in a soft portrait can benefit from a little sharpening, as shown in Figure 9-19. You can also slightly sharpen an area to emphasize it against a less-than-sharp background.
To use the Sharpen tool, grab the tool from the Tools panel and follow the steps provided for the Smudge tool in the section “Smudging away rough spots,” earlier in this chapter. Here are some additional tips for using the Sharpen tool:

- Use a low value, around 25 percent or less.
- Remember that you want to gradually sharpen your element to avoid the nasty, noisy grain that can occur from oversharpening.
- Because sharpening increases contrast, if you use other contrast adjustments, such as Levels, you boost the contrast of the sharpened area even more.
- Select the Protect Detail option to enhance the details in the image and minimize artifacts. If you leave this option unselected, your sharpening is more pronounced.

If you need to sharpen your overall image, try choosing either Enhance ➪ Unsharp Mask or Enhance ➪ Adjust Sharpness instead. These features offer more options and better control.

**Sponging color on and off**

The Sponge tool soaks up color or squeezes it out. In more technical terms, this tool reduces or increases the intensity, or *saturation*, of color in both color and grayscale images. Yes, the Sponge tool also works in Grayscale mode by darkening or lightening the brightness value of those pixels.

As with the Blur and Sharpen tools, you can use the Sponge tool to reduce or increase the saturation in selected areas in order to draw attention to or away from those areas.

Follow these steps to sponge color on or off your image:

1. **In Expert mode, choose the Sponge tool from the Tools panel.**
   
   The tool looks like a sponge. Press O to cycle through the Sponge, Dodge, and Burn tools. You can also select any of these tools and then choose your desired tool from the Tool Options.

2. **Select a brush from the Brush Preset Picker panel. Further adjust the size of the brush tip if needed.**
   
   Use large, soft brushes to saturate or desaturate a larger area.
3. Choose either Desaturate or Saturate from the Mode drop-down menu to decrease or increase color intensity, respectively.

4. Choose a flow rate with the Flow slider or text box.

   The flow rate is the speed with which the saturation or desaturation effect builds while you paint.

5. Paint carefully over the areas you want to saturate or desaturate with color.

   In the example shown in Figure 9-20, we used saturation to make one of the graduates a focal point and desaturated the others.

---

**Replacing one color with another**

The Color Replacement tool allows you to replace the original color of an image with the foreground color. You can use this tool in a multitude of ways:

- Colorize a grayscale image to create the look of a hand-painted photo.
- Completely change the color of an element, or elements, in your image, as shown in Figure 9-21, where we painted the field of pumpkins behind the girl with the Color Replacement tool using the color black.
- Eliminate red-eye (or yellow-eye in animals) if other, more automated methods don’t work to your satisfaction.

---

©istockphoto/Andresr Image #8312548

**Figure 9-20:** The Sponge tool increases or decreases the intensity of the color in your image.

©istockphoto.com/killerb10 Image #4233667

**Figure 9-21:** The Color Replacement tool replaces the color in your image with the foreground color.
What we particularly like about the Color Replacement tool is that it preserves all the tones in the image. The color that’s applied isn’t like the opaque paint that’s applied when you paint with the Brush tool. When you’re replacing color, the midtones, shadows, and highlights are retained. The Color Replacement tool works by first sampling the original colors in the image and then replacing those colors with the foreground color. By specifying different sampling methods, limits, and tolerance settings, you can control the range of colors that Elements replaces.

Follow these steps to replace existing color with your foreground color:

1. **In Expert mode, select the Color Replacement tool from the Tools panel.**
   
   The tool looks like a paintbrush with a small blue square next to it. Press B to cycle through the Brush, Impressionist Brush, and Color Replacement tools. You can also select any of these tools and then choose your desired tool from the Tool Options.

2. **In the Tool Options, choose your desired brush tip from the Brush Preset Picker panel.** Further adjust your brush size as needed. Then adjust the hardness, spacing, roundness, and angle under Brush Settings.

3. **Choose your desired blend mode.**
   
   Here’s a brief rundown of each one:
   
   - **Color:** The default, this mode works well for most jobs. This mode works great for eliminating red-eye.
   - **Hue:** Similar to color, this mode is less intense and provides a subtler effect.
   - **Saturation:** This mode is the one to use to convert the color in your image to grayscale. Set your foreground color to Black on the Tools panel.
   - **Luminosity:** This mode, the opposite of Color, doesn’t provide much of an effect.

4. **Select your Limits mode.**
   
   You have these options:
   
   - **Contiguous** replaces the color of adjacent pixels containing the sampled color.
   - **Discontiguous** replaces the color of the pixels containing the sampled color, whether or not they’re adjacent.
5. **Set your Tolerance percentage.**

*Tolerance* refers to a range of color. The higher the value, the broader the range of color that’s sampled, and vice versa.

6. **Set your Sampling method.**

You have these options:

- **Continuous** allows you to sample and replace color continuously while you drag your mouse.
- **Once** replaces color only in areas containing the color that you first sample.
- **Background Swatch** replaces colors only in areas containing your current Background color.

7. **Select the Anti-aliasing option.**

Antialiasing slightly softens the edges of the sampled areas.

8. **Click or drag your image.**

The foreground color replaces the original colors of the sampled areas. In Figure 9-21, we used a black foreground color.

If you want to be very precise, make a selection before you replace your color. We did this with the girl in Figure 9-21 so we could avoid coloring outside the lines.
Correcting Contrast, Color, and Clarity

In This Chapter

▶ Correcting shadows, highlights, and contrast
▶ Removing color casts and adjusting hue and saturation
▶ Adjusting skin tones
▶ Removing noise and artifacts and repairing dust and scratches
▶ Working with color variations
▶ Sharpening and blurring your image
▶ Working with the Smart Brush tools

If you’ve tried the quick and easy automatic fixes on your images and they didn’t quite do the job, you’ve come to the right place. The great thing about Elements is that it offers multiple ways and multiple levels of repairing and enhancing your images. If an auto fix doesn’t cut it, move on to a manual fix.

If you’re still not happy, you can consider shooting in Camera Raw format, as long as your camera can do so. Elements has wonderful Camera Raw support, enabling you to process your images to your exact specifications. (Covering Camera Raw, however, is beyond the scope of this book, but you can find a whole chapter about editing with Camera Raw in our other book, Photoshop Elements 12 All-in-One For Dummies.) Chances are good that if you can’t find the tools to correct and repair your images in Elements, those images are probably beyond salvaging.
This chapter covers the manual fixes you can make to your photos to correct lighting, contrast, color casts, artifacts, dust, scratches, sharpening, and blurring. We also cover using the Smart Brush tools to selectively apply an image adjustment.

**Editing Your Photos Using a Logical Workflow**

With the information in Chapter 9 (where we explain quick fixes) and this chapter at your fingertips, you can develop a logical workflow when you tackle the correction and repair of your images. By performing steps in a particular order, you will be less likely to exacerbate the flaws and more able to accentuate what’s good. For example, we use the following workflow when editing photos:

1. Crop, straighten, and resize your images, if necessary.
2. When you have the images in their proper physical state, correct the lighting and establish good tonal range for your shadows, highlights, and midtones to display the greatest detail possible.
   
   Often, just correcting the lighting solves minor color problems. If not, move on to adjusting the color balance.
3. Eliminate any color casts and adjust the saturation, if necessary.
4. Grab the retouching tools, such as the healing tools and filters, to retouch any flaws.
5. Apply any enhancements or special effects, if desired.
6. Sharpen your image if you feel that it could use a boost in clarity and sharpness.

By following these steps and allocating a few minutes of your time, you can get all your images in shape to print, post, and share with family and friends.
Adjusting Lighting

Elements has several simple, manual tools you can use to fix lighting if the Auto tools that we describe in Chapter 9 didn’t work or were just too, well, automatic for you. The manual tools offer more control over adjusting overall contrast, as well as bringing out details in shadow, midtones, and highlight areas of your images. Note that you can find all lighting adjustments in both Expert and Quick modes.

Fixing lighting with Shadows/Highlights

The Shadows/Highlights command offers a quick and easy method of correcting over- and underexposed areas, as shown on the left in Figure 10-1. This feature works especially well with images shot in bright, overhead light or in light coming from the back (backlit). These images usually suffer from having the subject partially or completely covered in shadows.

Figure 10-1: Correct the lighting in your images with the Shadows/Highlights adjustment.
To use the Shadows/Highlights adjustment, follow these steps:

1. **In Expert or Quick mode, choose Enhance > Adjust Lighting > Shadows/Highlights and make sure the Preview check box is selected.**

   When the dialog box appears, the default correction is automatically applied in your preview.

2. **If the default adjustment doesn’t quite do the job, move the sliders (or enter a value) to adjust the amount of correction for your shadows (dark areas), highlights (light areas), and midtones (middle-toned areas).**

   Your goal is to reveal more detail in the dark and light areas of your image. If, after you do so, your image still looks like it needs more correction, add or delete contrast in your midtone areas.

   Note that if only part of your image needs correcting, you can select just that portion before applying the adjustment. For more on selections, see Chapter 7.

3. **Click OK to apply the adjustment and close the dialog box.**

   If you want to start over, press Alt (Option on the Mac), and the Cancel button becomes Reset. Click Reset to start again.

---

**Using Brightness/Contrast**

Despite its aptly descriptive moniker, the Brightness/Contrast command doesn’t do a great job of brightening (making an image darker or lighter) or adding or deleting contrast. Initially, users tend to be drawn to this command because of its appropriate name and ease of use. But after users realize its limitations, they move on to better tools with more control, such as Shadows/Highlights and Levels.

The problem with the Brightness/Contrast command is that it applies the adjustment equally to all areas of your image. For example, a photo’s highlights may need darkening, but all the midtones and shadows are perfect. The Brightness slider isn’t smart enough to recognize that, so when you darken the highlights in your image, the midtones and shadows also become darker. To compensate for the unwanted darkening, you try to adjust the contrast, which doesn’t fix the problem.

The moral is, if you want to use the Brightness/Contrast command, select only the areas that need the correction, as shown in Figure 10-2. (For more on selections, see Chapter 7.) After you make your selection, choose Enhance > Adjust Lighting > Brightness/Contrast.
Chapter 10: Correcting Contrast, Color, and Clarity

Figure 10-2: The Brightness/Contrast adjustment is best reserved for correcting selected areas (left) rather than the entire image (right).

Pinpointing proper contrast with Levels

If you want real horsepower when it comes to correcting the brightness and contrast (and even the color) in your image, look no further than the Levels command. Granted, the dialog box is a tad more complex than what you find with the other lighting and color adjustment commands, but when you understand how the Levels dialog box works, it can be downright user-friendly.

You can get a taste of what Levels can do by using Auto Levels, detailed in Chapter 9. The Levels command, its manual cousin, offers much more control. And unlike the primitive Brightness/Contrast control, Levels enables you to darken or lighten 256 different tones. Keep in mind that you can use the Levels command on your entire image, a single layer, or a selected area. You can also apply the Levels command by using an adjustment layer, as we describe in Chapter 8.

If you’re serious about image editing, the Levels command is one tool you want to know how to use. Here’s how it works:

1. In Expert or Quick mode, choose Enhance ➪ Adjust Lighting ➪ Levels.

   We recommend using Expert mode for this command, where you’ll have access to the Info panel in Step 2.

   The Levels dialog box appears, displaying a histogram, as shown in Figure 10-3. This graph displays how the pixels of the image are distributed at each of the 256 available brightness levels. Shadows are shown on the left side of the histogram, midtones are in the middle, and highlights are on the right. Note that, in addition to viewing the histogram
of the composite RGB channel (the entire image), you can view the histogram of just the Red, Green, or Blue channel by selecting one of them from the Channel panel menu.

Although you generally make changes to the entire image by using the RGB channel, you can apply changes to any one of an image’s component color channels by selecting the specific channel from the Channel panel menu. You can also make adjustments to just selected areas, which can be helpful when one area of your image needs adjusting and others don’t.

2. In Expert mode, choose Window ➪ Info to open the Info panel.

3. Set the white points manually by using the eyedroppers in the dialog box:
   
   a. Select the White Eyedropper tool and then move the cursor over the image.
   
   b. Look at the Info panel, try to find the lightest white in the image, and then select that point by clicking it.

   The lightest white has the highest RGB values.

4. Repeat Step 3, using the Black Eyedropper tool and trying to find the darkest black in the image.

   The darkest black has the lowest RGB values.

   When you set the pure black and pure white points, the remaining pixels are redistributed between those two points.

   You can also reset the white and black points by moving the position of the white and black triangles on the input sliders (just below the histogram). Or you can enter values in the Input Levels boxes. The three boxes represent the black, gray, and white triangles, respectively. Use the numbers 0 to 255 in the white and black boxes.

5. Use the Gray Eyedropper tool to remove any color casts by selecting a neutral gray portion of your image, one in which the Info panel shows equal values of red, green, and blue.
Chapter 10: Correcting Contrast, Color, and Clarity

If your image is grayscale, you can’t use the Gray Eyedropper tool.

If you’re not sure where there’s a neutral gray, you can also remove a color cast by choosing a color channel from the Channel drop-down menu and doing one of the following:

- Choose the Red channel and drag the midtone slider to the right to add cyan or to the left to add red.
- Choose the Green channel and drag the midtone slider to the right to add magenta or to the left to add green.
- Choose the Blue channel and drag the midtone slider to the right to add yellow or to the left to add blue.

6. **If your image requires a tweak in reducing contrast, adjust the output sliders at the bottom of the Levels dialog box.**

   Moving the black triangle to the right reduces the contrast in the shadows and lightens the image. Moving the white triangle to the left reduces the contrast in the highlights and darkens the image.

7. **Adjust the midtones (or gamma values) with the gray triangle input slider.**

   The default value for gamma is 1.0. Drag the triangle to the left to lighten midtones and drag to the right to darken them. You can also enter a value.

8. **Click OK to apply your settings and close the dialog box.**

   Your image should be greatly improved, as shown in Figure 10-4.
If you’re not up to the task of manually adjusting your levels, you can opt to click the Auto button in the Levels dialog box. Elements applies the same adjustments as the Auto Levels command, as we explain in Chapter 9. Note the changes and subsequent pixel redistribution made to the histogram after you click this button.

**Adjusting Color**

Getting the color you want can seem about as attainable as winning the state lottery. Sometimes an unexpected *color cast* (a shift in color) can be avoided at the shooting stage, for example, by using (or not using, in some cases) a flash or lens filter or by setting the camera’s white balance for lighting conditions that aren’t present. After the fact, you can usually do a pretty good job of correcting the color with one of the many Elements adjustments. Occasionally, you may want to change the color of your image to create a special effect. Conversely, you may want to strip out an image’s color altogether to create a vintage feel. Remember that you can apply all these color adjustments to your entire image, a single layer, or just a selection. Whatever your color needs are, they’ll no doubt be met in Elements.

You can find all color adjustments in either Expert or Quick mode, except for Defringe Layers, which is reserved for Expert mode only.

If you’re looking for the Color Variations command, don’t bother. Adobe deleted it from the color adjustment lineup.

If you shoot your photos in the Camera Raw file format, you can open and fix your files in the Camera Raw dialog box. Remember that Camera Raw files haven’t been processed by your camera. You’re in total control of the color and the exposure.

**Removing color casts automatically**

If you ever took a photo in an office or classroom and got a funky green tinge in your image, it was probably the result of the overhead fluorescent lighting. To eliminate this green color cast, you can apply the Remove Color Cast command. This feature is designed to adjust the image’s overall color and remove the cast.

Follow these short steps to correct your image:

1. In either Expert or Quick mode, choose Enhance ➪ Adjust Color ➪ Remove Color Cast.
Chapter 10: Correcting Contrast, Color, and Clarity

The Remove Color Cast dialog box appears. Move the dialog box to better view your image.

2. Click an area in your photo that should be white, black, or neutral gray, as shown in Figure 10-5.

![Figure 10-5: Get rid of nasty color shifts with the Remove Color Cast command.](image)

In our example, we clicked the sky in the image on the left.

The colors in the image are adjusted according to the color you choose. Which color should you choose? The answer depends on the subject matter of your image. Feel free to experiment. Your adjustment is merely a preview at this point and isn’t applied until you click OK. If you goof up, click the Reset button, and your image reverts to its unadjusted state.

3. If you’re satisfied with the adjustment, click OK to accept it and close the dialog box.

If the Remove Color Cast command doesn’t cut it, try applying a photo filter (as we describe in the section “Adjusting color temperature with photo filters,” later in this chapter). For example, if your photo has too much green, try applying a magenta filter.

**Adjusting with Hue/Saturation**

The Hue/Saturation command enables you to adjust the colors in your image based on their hue, saturation, and lightness. *Hue* is the color in your image. *Saturation* is the intensity, or richness, of that color. And *lightness* controls the brightness value.
Follow these steps to adjust color by using the Hue/Saturation command:

1. **In either Expert or Quick mode, choose Enhance ➪ Adjust Color ➪ Adjust Hue/Saturation.**

   The Hue/Saturation dialog box appears. Be sure to select the Preview check box so that you can view your adjustments. Note that this command is also available in Guided mode.

2. **Select Master from the Edit drop-down menu to adjust all of the color or choose one color to adjust.**

3. **Drag the slider for one or more of the following attributes to adjust the colors as described:**

   - **Hue:** Shifts all the colors clockwise (drag right) or counterclockwise (drag left) around the color wheel.
   - **Saturation:** Increases (drag right) or decreases (drag left) the richness of the colors. Note that dragging all the way to the left gives the photo the appearance of a grayscale image.
   - **Lightness:** Increases the brightness values by adding white (drag right) or decreases the brightness values by adding black (drag left).

   The top color bar at the bottom of the dialog box represents the colors in their order on the color wheel before you make any changes. The lower color bar displays the colors after you make your adjustments.

   When you select an individual color to adjust, sliders appear between the color bars so that you can define the range of color to be adjusted. You can select, add, or subtract colors from the range by choosing one of the Eyedropper tools and clicking in the image.

   The Hue/Saturation dialog box also lets you colorize images, a useful option for creating sepia-colored images.

4. **(Optional) Select the Colorize option to change the colors in your image to a new, single color. Drag the Hue slider to change the color to your desired hue.**

   The pure white and black pixels remain unchanged, and the intermediate gray pixels are colorized.

5. **Click OK to apply your adjustments and exit the dialog box.**
Use the Hue/Saturation command, with the Colorize option, to create tinted photos, such as the one shown in Figure 10-6. You can also make selections in a grayscale image and apply a different tint to each selection. This can be especially fun with portraits. Tinted images can create a vintage or moody feel, and they can transform even mediocre photos into something special.

Figure 10-6: Adjust the color, intensity, or brightness of your image with the Hue/Saturation command.

Eliminating color with Remove Color

Despite all the talk in this chapter about color, we realize that there may be times when you don’t want any color. With the Remove Color command, you can easily eliminate all the color from an image, a layer, or a selection. To use this one-step command, simply choose Enhance ➪ Adjust Color ➪ Remove Color.

Sometimes, stripping away color with this command can leave your image flat, or low in contrast. If this is the case, adjust the contrast by using one of Elements’ many lighting fixes, such as Auto Levels, Auto Contrast, or Levels.
If you want to convert a selection, a layer, or an entire image to grayscale, you can do that with the Convert to Black and White dialog box, shown in Figure 10-7. (Choose Enhance ➪ Convert to Black and White.) But, rather than just arbitrarily strip color like the Remove Color command does, the Convert to Black and White command enables you to select a conversion method by first choosing an image style. To further tweak the results, you can add or subtract colors (Red, Green, or Blue) or contrast by moving the Intensity sliders until your grayscale image looks the way you want. Note that you aren’t really adding color; you’re simply altering the amount of data in the color channels. For more information on channels, see Chapter 3.

**Figure 10-7:** Wash away color with the Convert to Black and White command.

**Switching colors with Replace Color**

The Replace Color command enables you to replace designated colors in your image with other colors. You first select the colors you want to replace by creating a mask, which is a selection made by designating white
Follow these steps to get on your way to replacing color:

1. **In Expert or Quick mode, choose Enhance ➪ Adjust Color ➪ Replace Color.**
   
The Replace Color dialog box appears. Make sure to select the Preview check box.

2. **Choose either Selection or Image:**
   - *Selection* shows the mask in the Preview area. The deselected areas are black, partially selected areas are gray, and selected areas are white.
   - *Image* shows the actual image in the Preview area.

3. **Click the colors you want to select in either the image or the Preview area.**

4. **Shift-click or use the plus sign (+) Eyedropper tool to add more colors.**

5. **Press the Alt (Option on the Mac) key or use the minus sign (–) Eyedropper tool to delete colors.**

6. **To add colors similar to the ones you select, use the Fuzziness slider to fine-tune your selection, adding to or deleting from the selection based on the Fuzziness value.**

   If you can’t quite get the selection you want with the Fuzziness slider, try selecting the Localized Color Clusters option. This option enables you to select multiple clusters, or areas, of color and can assist in getting a cleaner, more precise selection, especially when trying to select more than one color.

7. **Move the Hue and/or Saturation sliders to change the color or color richness, respectively. Move the Lightness slider to lighten or darken the image.**

   Be careful to use a light hand (no pun intended) with the Lightness slider. You can reduce the tonal range too much and end up with a mess.

8. **View the result in the image window.**

9. **If you’re satisfied, click OK to apply the settings and close the dialog box.**
Correcting with Color Curves

Elements borrowed a much-used feature from Photoshop named Curves. However, Elements adds the word Color, and Color Curves doesn’t have all the sophistication of its Photoshop cousin. Nevertheless, the Color Curves adjustment attempts to improve the tonal range in color images by making adjustments to highlights, shadows, and midtones in each color channel. (For more on channels, see Chapter 3.) Try using this command on images in which the foreground elements appear overly dark due to backlighting. Conversely, the adjustment is designed to correct images that appear overexposed and washed out.

Here’s how to use this great adjustment on a selection, a layer, or an entire image:

1. In Expert or Quick mode, choose Enhance ➪ Adjust Color ➪ Adjust Color Curves.

The Adjust Color Curves dialog box appears.

2. Select a curve adjustment style from the Select a Style area to make your desired adjustments while viewing your image in the After window.

3. If you need greater precision, use the highlights, brightness, contrast, and shadows adjustment sliders, as shown in Figure 10-9, and then adjust the sliders as desired.

The graph on the right represents the distribution of tones in your image. When you first access the Color Curves dialog box, the tonal range of your image is represented by a straight line. While you drag the sliders, the straight line is altered, and the tonal range is adjusted accordingly.

To start over, click the Reset button.

4. Click OK when you’ve adjusted the image satisfactorily.

Check out Figure 10-10 for another before-and-after image.
Chapter 10: Correcting Contrast, Color, and Clarity

**Figure 10-9:** The Color Curves adjustment provides both basic and advanced adjustment controls.

**Figure 10-10:** Color Curves improves tonal range in color images.
Adjusting skin tones

Occasionally, you may find that the loved ones in your photos have taken on a rather sickly shade of green, red, or some other non-flesh-colored tone. To rectify that problem, Elements has a command specifically designed to adjust the overall color in the image and get skin tones back to a natural shade.

Here’s how to use this feature:

1. Open your image in Expert or Quick mode, select the Preview check box, and do one or both of the following:
   - Select the layer that needs to be adjusted. If you don’t have any layers, your entire image is adjusted.
   - Select the areas of skin that need to be adjusted. Only the selected areas are adjusted. This is a good way to go if you’re happy with the color of your other elements and just want to tweak the skin tones. For more on selection techniques, see Chapter 7.

2. Choose Enhance ⇒ Adjust Color ⇒ Adjust Color for Skin Tone.

   The Adjust Color for Skin Tone dialog box appears. This command is also found in Guided mode.

3. In the image window, click the portion of skin that needs to be corrected.

   The command adjusts the color of the skin tone, as well as the color in the overall image, layer, or selection, depending on what you selected in Step 1.

4. If you’re not satisfied with the results, click another area or fiddle with the Skin and Ambient Light sliders:
   - Tan adds or removes the amount of brown in the skin.
   - Blush adds or removes the amount of red in the skin.
   - Temperature adjusts the overall color of the skin, making it warmer (right toward red) or cooler (left toward blue).

   To start anew, click the Reset button. And, of course, to bail out completely, click Cancel.

5. When you’re happy with the correction, click OK to apply the adjustment and close the dialog box.

   The newly toned skin appears, as shown in Figure 10-11.
Chapter 10: Correcting Contrast, Color, and Clarity

Figure 10-11: Give your friends and family a complexion makeover with the Adjust Color for Skin Tone command.

Defringing layers
A telltale sign of haphazardly composited images is selections with fringe. We don’t mean the cute kind hanging from your leather jacket or upholstery; we mean the unattractive kind that consists of background pixels that surround the edges of your selections, as shown in Figure 10-12.

Inevitably, when you move or paste a selection, some background pixels are bound to go along for the ride. These pixels are referred to as a fringe or halo. Luckily, the Defringe command replaces the color of the fringe pixels with the colors of neighboring pixels that don’t contain the background color. In our example, we plucked the red flower out of a blue background and placed it on a white background. Some of the background pixels were included in our
selection and appear as a blue fringe. When we apply the Defringe command, those blue fringe pixels are changed to colors of nearby pixels, such as red, as shown in Figure 10-12.

![Figure 10-12: Remove the colored halo around your selections with the Defringe command.](image)

Follow these steps to defringe your selection:

1. **In Expert or Quick mode, copy and paste a selection onto a new or existing layer, or drag and drop a selection onto a new document.**

   For more on selections, see Chapter 7.

2. **Choose Enhance ➪ Adjust Color ➪ Defringe Layer.**

   The Defringe dialog box appears.

3. **Enter a value for the number of pixels you want to convert.**

   Try entering 1 or 2 first to see whether that does the trick. If not, you may need to enter a slightly higher value.

4. **Click OK to accept the value and close the dialog box.**

---

**Adjusting color temperature with photo filters**

Light has its own color temperature. A photo shot in a higher color temperature of light makes the image blue. Conversely, a photo shot in a lower color temperature makes the image yellow. In the old days, photographers placed colored glass filters in front of their camera lenses to adjust the color temperature of the light. They did this to either warm up or cool down photos or to just add a hint of color for subtle special effects. Elements gives you the digital version of these filters with the Photo Filter command.
To apply the Photo Filter adjustment, follow these steps:

1. **In Expert or Quick mode, choose Filter➪Adjustments➪Photo Filter.**
   
   The Photo Filter dialog box appears.

   Note that you can also apply the photo filter to an individual layer by creating a photo-filter adjustment layer. For details, see Chapter 8.

2. **In the dialog box, select Filter to choose a preset filter from the drop-down menu, or select Color to choose your own filter color from the Color Picker.**

   Here’s a brief description of each of the preset filters:

   - **Warming Filter (85), (81), and (LBA).** These adjust the white balance in an image to make the colors warmer, or more yellow. Filter (81) is like (85) and (LBA), but it’s best used for minor adjustments.

   - **Cooling Filter (80), (82), and (LBB).** These also adjust the white balance that’s shown, but instead of making the colors warmer, they make the colors cooler, or bluer. Filter (82) is like (80) and (LBB), but it’s designed for slight adjustments.

   - **Red, Orange, Yellow, and so on.** The various color filters adjust the hue, or color, of a photo. Choose a color filter to try to eliminate a color cast or to apply a special effect.

3. **Adjust the Density option to specify the amount of color applied to your image.**

4. **Select the Preserve Luminosity option to prevent the photo filter from darkening your image.**

5. **Click OK to apply your filter and close the dialog box.**

One way to minimize the need for color adjustments is to be sure you set your camera’s white balance for your existing lighting conditions before shooting your photo.

**Mapping your colors**

Elements provides color mapper commands that change the colors in your image by mapping them to other values. You find the color mappers on the Filter➪Adjustments submenu. Figure 10-13 shows an example of each command, all of which are also briefly described in the following list:
Part III: Selecting and Correcting Photos

Figure 10-13: Change the colors in your image by remapping them to other values.

- **Equalize**: This mapper first locates the lightest and darkest pixels in the image and assigns them values of white and black. It then redistributes all the remaining pixels among the grayscale values. The exact effect depends on your individual image.

- **Gradient Map**: This command maps the tonal range of an image to the colors of your chosen gradient. For example, colors (such as orange, green, and purple) are mapped to the shadow, highlight, and midtone areas.

- **Invert**: This command reverses all the colors in your image, creating a kind of negative. Black reverses to white, and colors convert to their complementary hues. Complementary colors (which are opposite each other on the color wheel), when combined in the proper proportions, produce white, gray, or black. So blue goes to yellow, red goes to cyan, and so on.

- **Posterize**: This command reduces the number of colors in your image. Choose a value between 2 and 255 colors. Lower values create an illustrative, poster-like look, and higher values produce a more photo-realistic image.

- **Threshold**: Threshold makes your image black and white, with all pixels that are brighter than a value you specify represented as white and all pixels that are darker than that value as black. You can change the threshold level to achieve different high-contrast effects.

**Adjusting Clarity**

After your image has the right contrast and color, and you fix any flaws (as we describe in Chapter 9), you’re ready to work on the overall clarity of that
image. Although you may have fixed the nitpicky blemishes with the healing tools, if your image suffers from an overall problem, such as dust, scratches, or artifacts (blocky pixels or halos), you may need to employ the help of a filter. After you totally clean up your image, your last chore is to give it a good sharpening. Why wait until the bitter end to do so? Sometimes, while you’re improving the contrast and color and getting rid of flaws, you can reduce the clarity and sharpness of an image. So you want to be sure that your image is as soft as it’s going to get before you tackle your sharpening tasks.

Sharpening increases contrast, so depending on how much of your image you’re sharpening, you may need to go back and fine-tune it by using the lighting adjustments described in the section “Adjusting Lighting,” earlier in this chapter.

Finally, with all this talk about sharpening, we know that you may find it strange when we say that you may also need to occasionally blur your image. You can use blurring to eliminate unpleasant patterns that occur during scanning, to soften distracting backgrounds to give a better focal point, or even to create the illusion of motion.

**Removing noise, artifacts, dust, and scratches**

Surprisingly, the tools you want to use to eliminate junk from your images are found on the Filter ➪ Noise submenu in Expert or Quick mode. With the exception of the Add Noise filter, the others help to hide noise, dust, scratches, and artifacts. Here’s the list of junk removers:

- **Despeckle**: Decreases the contrast, without affecting the edges, to make the dust in your image less pronounced. You may notice a slight blurring of your image (that’s what’s hiding the junk), but hopefully the edges are still sharp.

- **Dust & Scratches**: Hides dust and scratches by blurring those areas of your image that contain the nastiness. (It looks for harsh transitions in tone.) Specify your desired Radius value, which is the size of the area to be blurred. Also, specify the Threshold value, which determines how much contrast between pixels must be present before they’re blurred.

  Use this filter with restraint because it can obliterate detail and make your image go from bad to worse.

- **Median**: Reduces contrast around dust spots. The process the filter goes through is rather technical, so suffice it to say that the light spots darken, the dark spots lighten, and the rest of the image isn’t changed. Specify your desired radius, which is the size of the area to be adjusted.
Reduce Noise: Designed to remove luminance noise and artifacts from your images. Luminance noise is grayscale noise that makes images look overly grainy. Specify these options to reduce the noise in your image:

- **Strength**: Specify the amount of noise reduction.
- **Preserve Details**: A higher percentage preserves edges and details but reduces the amount of noise that’s removed.
- **Reduce Color Noise**: Remove random colored pixels.
- **Remove JPEG Artifact**: Remove the blocks and halos that can occur from low-quality JPEG compression.

**Blurring when you need to**

It may sound odd that anyone would intentionally want to blur an image. But, if your photo is overly grainy or suffers from a nasty moiré (wavy) pattern (as described in the following list), you may need to blur the image to correct the problem. Often, you may even want to blur the background of an image to deemphasize distractions or to make the foreground elements appear sharper and provide a better focal point.

All the blurring commands are found on the Filter ➪ Blur menu in Expert or Quick mode, with the exception of the Blur tool itself, found in the Tools panel (explained in Chapter 9):

- **Average**: This one-step filter calculates the average value of the image or selection and fills the area with that average value. You can use it for smoothing overly noisy areas in your image.
- **Blur**: Another one-step filter, this one applies a fixed amount of blurring to the whole image.
- **Blur More**: This one-step blur filter gives the same effect as Blur, but more intensely.
- **Gaussian Blur**: This blur filter is probably the one you’ll use most often. It offers a Radius setting to let you adjust the amount of blurring you desire.

Use the Gaussian Blur filter to camouflage moiré patterns on scanned images. A moiré pattern is caused when you scan halftone images. A halftone is created when a continuous-tone image, such as a photo, is digitized and converted into a screen pattern of repeating lines (usually between 85 and 150 lines per inch) and then printed. When you then scan that halftone, a second pattern results and is overlaid on the original
pattern. These two different patterns bump heads and create a nasty moiré pattern. The Gaussian Blur filter doesn’t eliminate the moiré — it simply merges the dots and reduces the appearance of the pattern. Play with the Radius slider until you get an acceptable trade-off between less moiré and less focus. If you happen to have a descreen filter (which attempts to remove the moiré pattern on scanned halftones) built into your scanning software, you can use that as well during the scanning of the halftone image.

✓ **Motion Blur:** This filter mimics the blur given off by moving objects. Specify the angle of motion and the distance of the blur. Make sure to select the Preview check box to see the effect while you enter your values.

✓ **Radial Blur:** Need to simulate a moving Ferris wheel or some other round object? This filter produces a circular blur effect. Specify the amount of blur you want. Choose the Spin method to blur along concentric circular lines, as shown in the thumbnail. Or choose Zoom to blur along radial lines and mimic the effect of zooming in to your image. Specify your desired Quality level. Because the Radial Blur filter is notoriously slow, Elements gives you the option of Draft (fast but grainy), Good, or Best (slow but smooth). The difference between Good and Best is evident only on large, high-resolution images. Finally, indicate where you want the center of your blur by moving the blur diagram thumbnail.

✓ **Smart Blur:** This filter provides several options to enable you to specify how the blur is applied. Specify a value for the radius and threshold, both defined in the following section. Start with a lower value for both and adjust from there. Choose a quality setting from the drop-down menu. Choose a mode setting: Normal blurs the entire image or selection; Edge Only blurs only the edges of your elements and uses black and white in the blurred pixels; Overlay Edge also blurs just the edges, but it applies only white to the blurred pixels.

✓ **Surface Blur:** This filter blurs the surface or interior of the image instead of the edges. If you want to retain your edge details but blur everything else, use this filter.

If you’ve ever experimented with the aperture settings on a camera, you know that you can set how shallow or deep your depth of field is. Depth of field relates to the **plane of focus** (the areas in a photo that are in front of or behind the focal point and that remain in focus) or how in-focus the foreground elements are when you compare them with the background elements. The Lens Blur filter, shown in Figure 10-14, enables you to give the effect of a shallower depth of field after you have already captured your image, thereby enabling you to take a fully focused image and create this selective focus.
Here’s how to use the Lens Blur filter:

1. **Choose Filter ➪ Blur ➪ Lens Blur.**
   The Lens Blur filter dialog box appears.

2. **Select your Preview mode.**
   The Faster option gives you a quick preview, whereas More Accurate shows you the final rendered image.

3. **Choose a Source from the drop-down menu for your depth map, if you have one.**
   You can choose between a layer mask and a transparency. The filter uses a depth map to determine how the blur works.
   A good way to create an image with this shallow depth of field effect is to create a layer mask on your image layer and fill it with a white-to-black gradient — black where you want the most focus and white where you want the least focus or most blur. Choose Transparency to make an image blurrier and more transparent.

4. **Drag the Blur Focal Distance slider to specify how blurry or in focus an area of the image is.** Or click the crosshair cursor on the part of the image that you want to be in full focus.

**Figure 10-14:** Use the Lens Blur filter to create a shallow depth of field effect.
Dragging the slider enables you to specify a value. You can also select Invert to invert, or reverse, the depth map source.

5. Choose an Iris shape, such as triangle or octagon, from the Shape drop-down menu.

The Iris settings are meant to simulate a camera lens. Specify the shape of the lens, as well as the radius (size of the iris), blade curvature (how smooth are the iris edges), and rotation of that shape.

6. Set the Brightness and Threshold values in the Specular Highlights area.

The Lens Blur filter averages the highlights of an image, which, if left uncorrected, cause some highlights to appear grayish. The Specular Highlights controls help to retain Specular Highlights, or those highlights that should appear very white. Set the Threshold value to specify which highlights should be specular (remain white). Set a Brightness value to specify how much to relighten any blurred areas.

7. Drag the Amount slider in the Noise area to add noise back into your image. Choose Monochromatic to add noise without affecting the color.

Blurring obliterates any noise (or film grain) that an image may have. This absence of noise can cause the image to appear inconsistent or unrealistic, in many cases.

8. Click OK to apply the Lens Blur and exit the dialog box.

Sharpening for better focus

Of course, if your images don’t need any contrast, color, and flaw fixing, feel free to jump right into sharpening. Sometimes, images captured by a scanner or a digital camera are a little soft, and it’s not due to any tonal adjustments. Occasionally, you may even want to sharpen a selected area in your image just so that it stands out more.

You can’t really improve the focus of an image after it’s captured. But you can do a pretty good job of faking it.

All sharpening tools work by increasing the contrast between adjacent pixels. This increased contrast causes the edges to appear more distinct, thereby giving the illusion that the focus is improved, as shown in Figure 10-15.

Remember that you can also use the Sharpen tool for small areas, as described in Chapter 9. Here’s a description of the two sharpening commands:
Figure 10-15: Sharpening mimics an increase in focus by increasing contrast between adjacent pixels.

Unsharp Mask: Found on the Enhance menu in Expert or Quick mode, Unsharp Mask (which gets its odd name from a darkroom technique) is the sharpening tool of choice. It gives you several options that enable you to control the amount of sharpening and the width of the areas to be sharpened. Use them to pinpoint your desired sharpening:

- **Amount**: Specify an amount (from 1 to 500 percent) of edge sharpening. The higher the value, the more contrast between pixels around the edges. Start with a value of 100 percent (or less), which usually gives good contrast without appearing overly grainy.

- **Radius**: Specify the width (from 0.1 to 250 pixels) of the edges that the filter will sharpen. The higher the value, the wider the edge. The value you use is largely based on the resolution of your image. Low-resolution images require a smaller radius value. High-resolution images require a higher value.

Be warned that specifying a value that’s too high overemphasizes the edges of your image and makes it appear too “contrasty” or even “goopy” around the edges.

A good guideline in selecting a starting radius value is to divide your image’s resolution by 150. For example, if you have a 300 ppi image, set the radius at 2 and then use your eye to adjust from there.

- **Threshold**: Specify the difference in brightness (from 0 to 255) that must be present between adjacent pixels before the edge is sharpened. A lower value sharpens edges with very little contrast difference. Higher values sharpen only when adjacent pixels are
very different in contrast. We recommend leaving Threshold set at 0 unless your image is very grainy. Setting the value too high can cause unnatural transitions between sharpened and unsharpened areas.

Occasionally, the values you enter for Amount and Radius may sharpen the image effectively but in turn create excess grain, or noise, in your image. You can sometimes reduce this noise by increasing the Threshold value.

✓ **Adjust Sharpness:** When you’re looking for precision in your image sharpening, Unsharp Mask is one option. The Adjust Sharpness command, as shown in Figure 10-16, is the other. This feature enables you to control the amount of sharpening applied to shadow and highlight areas. It also allows you to select from various sharpening algorithms.

Here are the various options you can specify:

• **Amount and Radius:** These work similar to the Unsharp Mask command; see the previous bullet.

![Figure 10-16: The Adjust Sharpness command.](image-url)
• **Remove:** Choose your sharpening algorithm. Gaussian Blur is the algorithm used for the Unsharp Mask command. Lens Blur detects detail in the image and attempts to respect the details while reducing the nasty halos that can occur with sharpening. Motion Blur tries to sharpen the blurring that occurs when you move the camera (or if your subject doesn’t sit still).

• **Angle:** Specify the direction of motion for the Motion Blur algorithm, described in the preceding bullet.

• **More Refined:** This option runs the algorithm more slowly than the default speed for better accuracy.

---

**Working Intelligently with the Smart Brush Tools**

The Smart Brush and Detail Smart Brush tools enable you to selectively apply an image adjustment or special effects that appear on all or part of your image. What’s even more exciting is that these adjustments and effects are applied via an adjustment layer, meaning that they hover over your layers and don’t permanently alter the pixels in your image. It also means that you can flexibly edit or delete adjustments, if so desired.

Follow these steps to use the Smart Brush tool:

1. **In Expert mode, select the Smart Brush tool from the toolbar.**
   
   The tool icon looks like a house paintbrush with an adjacent gear. You can also press F, or Shift+F, if the Detail Smart Brush tool is visible.

2. **Select an adjustment category and then your particular preset adjustment from the Preset Picker drop-down menu in the Tool Options, as shown in Figure 10-17.**
   
   In the Preset menu, you can find adjustments ranging from Photographic effects, such as a vintage Yellowed Photo, to Nature effects, such as Create a Sunset (which gives a warm, orange glow to your image).

   The Textures category has 13 presets such as Broken Glass and Old Paper. Use these textures with your smart brushes to jazz up backgrounds and other elements in your images. For example, if that white wall in your shot is less than exciting, give it a Brick wall texture. If the drop cloth behind your portrait to reduce background clutter is a tad boring, give it a satin ripple.
3. Choose your desired brush attributes, such as size. Or adjust attributes such as hardness, spacing, roundness, and angle from the Brush Settings drop-down panel.

For more on working with brushes, see Chapter 12.

4. Paint an adjustment on the desired layer in your image.

Note that while you paint, the Smart Brush tool attempts to detect edges in your image and snaps to those edges. In addition, while you brush, a selection border appears.

A new adjustment layer is automatically created with your first paint stroke. The accompanying layer mask also appears on that adjustment layer. For more on adjustment layers, see Chapter 8.

5. Using the Add and Subtract Smart Brush modes in the Tool Options, fine-tune your adjusted area by adding to and subtracting from it.

When you add to and subtract from your adjusted area, you’re essentially modifying your layer mask. Adding to your adjusted area adds white to your layer mask, and subtracting from your adjusted area adds black to your layer mask. For more on layer masks, see Chapter 8.

Figure 10-17: The Smart Brush enables you to paint on adjustments.
6. Make your necessary adjustments in the dialog box:

- **Refine your selected area.** Select the Refine Edge option in the Tool Options. For more on the Refine Edge option, see Chapter 7.

- **Apply the adjustment to your unselected area.** Select the Inverse option in the Tool Options.

- **Modify your adjustment.** Double-click the Adjustment Layer pin on your image. The pin is annotated by a small, square, black-and-red gear icon. After you double-click the pin, the dialog box corresponding to your particular adjustment appears. For example, if you double-click the Shoebox photo adjustment (under Photographic), you access the Hue/Saturation dialog box.

You can also right-click and select Change Adjustment Settings. Or you can select Delete Adjustment and Hide Selection from the same menu.

7. Click OK.

8. After you finish, simply deselect your selection by choosing Select ➪ Deselect.

You can add multiple Smart Brush adjustments. After you apply one effect, reset the Smart Brush tool and apply additional adjustments.

Follow these steps to work with the Detail Smart Brush tool:

1. **In Expert mode, select the Detail Smart Brush tool in the toolbar.**

   This tool shares the flyout menu with the Smart Brush tool. The tool icon looks like an art paintbrush. You can also press F, or Shift+F, if the Smart Brush tool is visible.

2. **Select your desired adjustment category and then your particular preset adjustment from the Preset Picker drop-down menu in the Tool Options.**

3. **Choose a brush tip preset drop-down menu and your desired brush size.**

   Feel free to change your brush tip and size as needed for your desired effect. You can also choose other brush preset libraries from the Brush drop-down menu in the Brush tip preset menu. For more on working with brushes, see Chapter 12.

   Several of the Special Effect adjustments are shown in Figure 10-18.
4. Paint an adjustment on the desired layer in your image.

A new adjustment layer is automatically created with your first paint stroke, along with an accompanying layer mask. For details on adjustment layers and layer masks, see Chapter 8.

5. Follow Steps 5 through 8 in the preceding list for the Smart Brush tool.
Part IV

Exploring Your Inner Artist

At www.dummies.com/extras/photoshopelements12, you can see examples of the five most useful blend modes in action.
In this part . . .

- Use tools to draw and paint on existing photos or create new, blank documents and create your own drawings.
- Apply different artistic effects by using many tools and customizing them for your own use.
- Discover tips for applying filters and styles to create dazzling images.
- Explore how to work with text — from setting headline type to creating special type effects.
Playing with Filters, Effects, Styles, and More

In This Chapter
▶ Fooling with filters
▶ Getting familiar with the Filter Gallery
▶ Making digital taffy with Liquify
▶ Fixing camera distortion
▶ Enhancing with effects
▶ Using layer styles
▶ Changing colors with blend modes
▶ Compositing images with Photomerge

After giving your images a makeover — edges cropped, color corrected, flaws repaired, focus sharpened — you may want to get them all gussied up for a night out on the town. You can do just that with filters, effects, layer styles, and blend modes. These features enable you to add that touch of emphasis, drama, whimsy, or just plain goofy fun. We’re the first to admit that often the simplest art (and that includes photographs) is the best. That gorgeous landscape or the portrait that perfectly captures the expression on a child’s happy face is something you may want to leave unembellished. But for the times when a little artistic experimentation is in order, turn to this chapter as your guide.
Having Fun with Filters

Filters have been around since the early days of digital imaging, when Photoshop was just a little bitty program. *Filters*, also called *plug-ins* because they can be installed or removed independently, change the look of your image in a variety of ways, as shown in Figure 11-1. They can correct less-than-perfect images by making them appear sharper or by covering up flaws, as we describe in Chapter 10. Or they can enhance your images by making them appear as though they’re painted, tiled, photocopied, or lit by spotlights. The following sections give you the basics on how to apply a filter, as well as a few filtering tips.

Create a backup of your original image if you plan on saving your filtered one. Filters ultimately change the pixels in your original photo, altering it permanently.

![Figure 11-1: Use filters to correct image imperfections or to completely transform images.](image)

You can’t apply filters to images that are in Bitmap or Index Color mode. And some filters don’t work on images in Grayscale mode. For a refresher on color modes, see Chapter 4.

Applying filters

You can apply a filter in three ways:

- **The Filter menu**: In either Expert or Quick mode, from the Filter menu, choose your desired filter category and then select a specific filter.
- **The Effects panel**: In Expert mode, open the panel by choosing Window ➪ Effects or by clicking the Effects icon in the bottom right of the workspace. Click the Filters tab at the top of the panel. Select your
filter category from the drop-down menu directly under the Filters tab. Double-click the thumbnail of your desired filter or drag the filter onto your image window.

**The Filter Gallery:** In either Expert or Quick mode, choose Filter➪Filter Gallery to apply one or more filters in a flexible editing environment. The Filter Gallery is described in the section “Working in the Filter Gallery,” later in this chapter.

When you’re using the Filter Gallery, make a backup copy of your image (or at least create a duplicate layer) before you apply filters. Filters change the pixels of an image permanently, and when you exit the Filter Gallery, the filters you apply can’t be removed, except for using the Undo command or History panel. But once those options are exhausted, you’re stuck with the image as is.

**Corrective or destructive filters**

Although there are no hard-and-fast rules, most digital-imaging folks classify filters into two basic categories:

- **Corrective filters** usually fix some kind of image problem. They adjust color, improve focus, remove dust or artifacts, and so on. Don’t get us wrong — pixels are still modified. It’s just that the basic appearance of the image remains the same, albeit modified, we hope for the better. Two of the most popular corrective filters, Sharpen and Blur, are covered in Chapter 10.

- **Destructive filters** are used to create some kind of special effect. Pixels are also modified, but the image may look quite different from its original. These kinds of filters create effects, such as textures, brush strokes, mosaics, lights, and clouds. They can also distort an image with waves, spheres, and ripples.

**One-step or multistep filters**

All corrective and destructive filters are one or the other:

- **One-step filters** have no options and no dialog boxes; select the filter and watch the magic happen.

- **Multistep filters** act almost like mini-applications. When you choose a multistep filter, you specify options in a dialog box. The options vary widely depending on the filter, but most come equipped with at least one option to control the intensity of the filter. A multistep filter appears on the menu with an ellipsis following its name, indicating that a dialog box opens when you choose the command.
Fading a filter

Sometimes you don’t want the full effect of a filter applied to your image. Fading a filter a bit softens the effect and can make it look less “computerish.” Here’s what you can do:

1. **Choose Layer ➪ Duplicate Layer.**
   The Duplicate Layer dialog box appears.

2. **Click OK.**

3. **Apply your desired filter to the duplicate layer.**
   Applying your filter to a duplicate layer enables you to blend the filtered layer with the unfiltered and gives you much more control over the result (see Step 4). See the earlier “Applying filters” section for details.

4. **Use the blend modes and opacity settings located on the Layers panel to merge the filtered layer with the original unfiltered image.**

5. **(Optional) With the Eraser tool, selectively erase portions of your filtered image to enable the unfiltered image to show through.**
   For example, if you applied a Gaussian Blur filter to soften a harshly lit portrait, try erasing the blurred portion that covers the subject’s eyes to let the unblurred eyes of the layer below show through. The sharply focused eyes provide a natural focal point.

Instead of erasing, you can also apply a layer mask to selectively show and hide portions of your filtered image. For details on layer masks, see Chapter 8.

Selectively applying a filter

Up to this point in the book, we refer to applying filters to your images. But we use this word loosely. You don’t necessarily have to apply filters to your entire image. You can apply filters to individual layers or even to selections. You can often get better effects when you apply a filter just to a portion of an image or layer. For example, you can blur a distracting background so that the person in your image gets due attention. Or, as shown in Figure 11-2, you can apply an Ocean Ripple or Wave filter to the ocean, leaving your surfer unfiltered to avoid that “overly Photoshopped” effect.
Chapter 11: Playing with Filters, Effects, Styles, and More

Figure 11-2: Selectively applying a filter can prevent an image from looking overly manipulated.

Exercising a little restraint in applying filters usually produces a more attractive image.

Working in the Filter Gallery

When you apply a filter, don’t be surprised if you’re presented with a gargantuan dialog box. This editing window, as it’s officially called, is the Filter Gallery. You can also access it by choosing Filter→Filter Gallery. In the flexible Filter Gallery, you can apply multiple filters, tweak their order, and edit them ad nauseam.

Follow these steps to work in the Filter Gallery:

1. In either Expert or Quick mode, choose Filter→Filter Gallery. The Filter Gallery editing window appears, as shown in Figure 11-3.

2. In the center of the editing window, click your desired filter category folder. The folder expands and shows the filters in that category. A thumbnail displays each filter’s effect.
Part IV: Exploring Your Inner Artist

Figure 11-3: Apply and edit multiple filters in the Filter Gallery.

3. Select your desired filter.
   You get a large, dynamic preview of your image on the left side of the dialog box. To preview a different filter, just select it. Use the magnification controls to zoom in and out of the preview. To hide the Filter menu and get a larger preview box, click the arrow to the left of the OK button.

4. Specify any settings associated with the filter.
   The preview is updated accordingly.

5. When you're happy with the results, click OK to apply the filter and close the editing window.

6. (Optional) If you want to apply another filter, click the New Effect Layer button at the bottom of the editing window.
   This step duplicates the existing filter.

7. Choose your desired new filter, which then replaces the duplicate in the Applied Filters area of the dialog box.
Each filter you apply is displayed in the lower-right area of the Filter Gallery dialog box.

You can make these changes to your filter:

- **Delete a filter.** Select it and click the Delete Effect Layer button.
- **Edit a filter’s settings.** Select the filter from the list and make any changes. Keep in mind that when you edit a filter’s settings, the edit may affect the look of any subsequent filters you’ve applied.
- **Rearrange the order of the applied filters.** Drag one of the filters above or below the other(s). Doing so changes the overall effect, however.

8. **When you’re completely done, click OK to apply the filters and close the editing window.**

**Distorting with the Liquify filter**

The Liquify filter is really much more than a filter. It’s a distortion that allows you to manipulate an image as though it were warm taffy. You can interactively twist, pull, twirl, pinch, and bloat parts of your image. You can even put your image on a diet, as we did in Figure 11-4. In fact, most ads and magazine covers feature models and celebrities whose photos have “visited” the Liquify filter once or twice. You can apply this distortion filter on the entire image, on a layer, or on a selection. This überfilter comes equipped with a mega–dialog box that has its own set of tools and options, as shown in Figure 11-4.

![Figure 11-4: The Liquify filter enables you to interactively distort your image.](https://www.istockphoto.com/photo/the-liquify-filter-enables-you-to-interactively-distort-your-image_1531763)
Follow these steps to turn your image into a melted Dalí-esque wannabe:

1. **In either Expert or Quick mode, choose Filter ➪ Distort ➪ Liquify.**
   Your image appears in the preview area.

2. **Choose your distortion weapon of choice.**
   You also have a number of tools to help zoom and navigate around your image window.

   Here’s a description of each tool to help you decide which to use. (The letter in parentheses is the keyboard shortcut.)

   - **Warp (W):** This tool pushes pixels forward while you drag, creating a stretched effect. Use short strokes or long pushes.
   - **Turbulence (T):** Drag to randomly jumble your pixels. Use this tool to re-create maelstroms of air, fire, and water with clouds, flames, and waves. Adjust how smooth the effect is by dragging the Turbulent Jitter slider in the Tool Options. The higher the value, the smoother the effect.
   - **Twirl Clockwise (R) and Twirl Counterclockwise (L):** These options rotate pixels either clockwise or counterclockwise. Place the cursor in one spot, hold down the mouse button, and watch the pixels under your brush rotate; or drag the cursor to create a moving twirl effect.
   - **Pucker (P):** Click and hold or drag to pinch your pixels toward the center of the area covered by the brush. To reverse the pucker direction (bloat), press the Alt (Option on the Mac) key while you hold or drag.
   - **Bloat (B):** Click and hold or drag to push pixels toward the edge of the brush area. To reverse the bloat direction (pucker), press the Alt (Option on the Mac) key while you hold or drag.
   - **Shift Pixels (S):** This tool moves pixels to the left when you drag the tool straight up. Drag down to move pixels to the right. Drag clockwise to increase the size of the object being distorted. Drag counterclockwise to decrease the size. To reverse any direction, press the Alt (Option on the Mac) key while you hold or drag.
   - **Reflection (M):** This tool drags a reversed image of your pixels at a 90-degree angle to the motion of the brush. Hold down the Alt (Option on the Mac) key to force the reflection in the direction opposite the motion of the brush. This tool works well for making reflections on water.
Chapter 11: Playing with Filters, Effects, Styles, and More

3. Specify your options in the Tool Options:
   - **Brush Size**: Drag the pop-up slider or enter a value from 1 to 600 pixels to specify the width of your brush.
   - **Brush Pressure**: Drag the pop-up slider or enter a value from 1 to 100 to change the pressure. The higher the pressure, the faster the distortion effect is applied.
   - **Turbulent Jitter**: Drag the pop-up slider or enter a value from 1 to 100 to adjust the smoothness when you’re using the Turbulence tool.
   - **Stylus Pressure**: If you’re lucky enough to have a graphics tablet and stylus, click this option to select the pressure of your stylus.

4. (Optional) If you get a little carried away, select the Reconstruct tool and then hold down or drag the mouse on the distorted portion of the image that you want to reverse or reconstruct.

   Reconstructing enables you to undo portions of your distorted image back to a less distorted or original state. Note that the reconstruction occurs faster at the center of the brush’s diameter. To partially reconstruct your image, set a low brush pressure and watch closely while your mouse drag across the distorted areas.

5. Click OK to apply the distortions and close the dialog box.

   If you mucked things up and want to start again, click the Revert button to get your original, unaltered image back. This action also resets the tools to their previous settings.
Correcting Camera Distortion

If you’ve ever tried to capture a looming skyscraper or cathedral in the lens of your camera, you know that it often involves tilting your camera and putting your neck in an unnatural position. And then, after all that, what you end up with is a distorted view of what was an impressive building in real life, as shown with the before image on the left in Figure 11-5. Fortunately, that’s not a problem with Elements. The Correct Camera Distortion filter fixes the distorted perspective created by both vertical and horizontal tilting of the camera. As a bonus, this filter also corrects other kinds of distortions caused by lens snafus.

Figure 11-5: The Correct Camera Distortion filter fixes distortions caused by camera tilt and lens flaws.

Here’s how to fix all:

1. **In either Expert or Quick mode, choose Filter ➪ Correct Camera Distortion.**
2. **In the Correct Camera Distortion dialog box, select the Preview option.**
3. **Specify your correction options:**
   
   • *Remove Distortion:* Corrects *lens barrel*, which causes your images to appear spherized or bloated. This distortion can occur when you’re using wide-angle lenses. It also corrects *pincushion* distortion, which creates images that appear to be pinched in at the center, a flaw that’s found when using telephoto or zoom lenses.
Move the slider while keeping an eye on the preview. Use the handy grid as your guide for proper alignment.

- **Vignette Amount**: Adjusts the amount of lightening or darkening around the edges of your photo that you can get sometimes from incorrect lens shading. Change the width of the adjustment by specifying a midpoint value. A lower midpoint value affects more of the image. Then move the Amount slider while viewing the preview.

- **Vertical Perspective**: Corrects the distorted perspective created by tilting the camera up or down. Again, use the grid to assist in your correction. We used the vertical perspective to correct Westminster Abbey, shown in Figure 11-5. It is a nice shot as is, but it could use a little tweaking.

- **Horizontal Perspective**: Also corrects the distorted perspective. Use the grid to make horizontal lines (real and implied) in your image parallel. For better results, set the angle of movement under the Angle option.

- **Angle**: Enables you to rotate the image to compensate for tilting the camera. You may also need to tweak the angle slightly after correcting the vertical or horizontal perspective.

- **Edge Extension Scale**: When you correct the perspective on your image, you may be left with blank areas on your canvas. You can scale your image up or down to crop into the image and eliminate these holes. Note that scaling up results in interpolating your image up to its original pixel dimensions. Basically, interpolation means Elements analyzes the colors of the original pixels in your image and creates new ones, which are then added to the existing ones. This often results in less than optimum quality. Therefore, if you do this, be sure to start with an image that has a high-enough pixel dimension, or resolution, to avoid severe degradation. For more on resolution, see Chapter 4.

- **Show Grid**: Shows and hides the grid, as needed. You can also choose the color of your grid lines.

- **Zoom Tool**: Zooms in and out for your desired view. You can also use plus (+) and minus (–) icons and the Magnification pop-up menu in the bottom-left corner of the window.

- **Hand Tool**: Moves you around the image window when you are zoomed in.

4. **Click OK to apply the correction and close the dialog box.**
Exploring Element’s Unique Filters

Elements has a set of its very own filters. Prior to Elements 11, all the filters were hand-me-downs from Photoshop. You can find the three unique filters under the Filter > Sketch submenu. To really get a feel for the cool effects these filters can create, we invite you to open a couple of your favorite images and play with the various presets and settings.

Here are the general steps to apply any of these filters:

1. In either Expert or Quick mode, choose Filter > Sketch > Your Specific Filter.
   For example, if you want to use the Comic filter, choose Filter > Sketch > Comic.

2. In the filter dialog box, choose from four presets.

3. Adjust any default settings.
   You can find details about each filter’s settings in the following sections outlining each filter.
   If you want to reset your sliders back to the default values for the preset, hold down the Alt (Option on the Mac) key, and the Cancel button in the dialog box changes to a Reset button.

4. Adjust your view as needed by using the following controls:
   - **Zoom**: Zoom in and out for your desired view. You can also use the 1:1 view (recommended) or Fit in Window view.
   - **Hand**: Moves you around the image window when you are zoomed in.

5. Click OK to apply the filter and close the dialog box.

Creating a comic

The Comic filter takes your image and creates an effect that mimics a hand-drawn comic book illustration. In the Comic filter dialog box, you can choose from four presets, as shown in Figure 11-6:

- **Comic**: The default setting creates a basic comic book illustrative effect.
- **Grayscale**: Like comic, but converts all colors to grayscale.
- **Sunny Day**: Makes a high contrast, vivid effect.
- **Old Print**: Creates a more desaturated, old-newspaper effect.
Then, using the sliders, you can adjust the default settings for the Color and Outline areas of the filtered image:

- **Soften**: Creates rounder or rougher areas of colors.
- **Shades**: A higher value adds more tonal levels.
- **Steepness**: A higher value makes the colored areas more defined and contrasty.
- **Vibrance**: Brightens the overall color of the image.
- **Thickness**: Affects the thickness and blackness of the outlined strokes.
- **Smoothness**: Fine-tunes your edges and enhances the overall filter effect.

![Image of Comic filter](https://www.istockphoto.com/vector/comic-filter-turns-photo-into-illustration-1638352)

**Figure 11-6**: The Comic filter turns a photo into an illustration.

---

**Getting graphic**

The Graphic Novel filter might take a bit of experimentation to create the effect you want. At least it did for us. But after you get your settings established, the look is pretty fun and the result is like an illustration sketched for a graphic novel. Note that all of the colors in your images convert to grayscale when you use this filter.

In the Graphic filter dialog box, choose from four presets, as shown in Figure 11-7:
Part IV: Exploring Your Inner Artist

- **Painted Gray**: Creates an effect with a lot of midtone grays.
- **Fine Detail**: Results in an image with more white areas and an emphasis on retaining detail.
- **Hard Edges**: Like Fine Detail, but the overall look is more contrasty and the edges are more “sketchy” and less finely rendered.
- **Twisted Plot**: Creates a harsher effect with more dark areas.

Then, using the sliders, you can adjust the default settings for the filtered image:

- **Darkness**: A higher value creates more areas of lightness.
- **Clean Look**: A higher value makes smoother, more refined strokes.
- **Contrast**: The higher the value, the more contrasty — and, overall, darker — an image appears. A lower value produces a lower-contrast, light-gray image.
- **Thickness**: Affects the thickness and blackness of the outlined strokes. A higher value produces a “goopier” stroke appearance.
- **Smoothness**: Fine-tunes your edges and enhances the overall filter effect.

![Figure 11-7: Create an image worthy of a graphic novel.](https://www.istockphoto.com/pamspix/image/4431556)
Using the Pen and Ink filter

The Pen and Ink filter creates an effect that looks like an hand-drawn pen-and-ink sketch.

In the Pen and Ink filter dialog box, choose from four presets, as shown in Figure 11-8. Each preset colors the image blue, purple, gray, or green, respectively.

Then you can adjust the default setting of the sliders for the various settings for the Pen and Ink areas of the filtered image:

- **Detail**: A higher value creates finer, crisper edges.
- **Width**: A higher value creates thicker, goopier strokes, and a lower value creates crisper strokes.
- **Darkness**: A higher value creates more areas of darkness.
- **Contrast**: The higher the value, the more contrasty the image and more dark ink strokes are applied.
- **Hue**: Adjust the slider to select your desired color along the color ramp.
- **Contrast**: A higher value adds more contrast, darkness, and colored areas.
- **Fill**: Fills the image with more areas of color and less white.

![Figure 11-8: Create a cartoon-like image with the Pen and Ink filter.](https://istockphoto.com/iconogenic Image #9543790)
Dressing Up with Photo and Text Effects

In addition to the multitude of filters at your disposal, Elements provides a lot of effects that you can apply to enhance your photos, such as the Fluorescent Chalk effect we applied in Figure 11-9. Note that some effects automatically create a duplicate of the selected layer, whereas other effects can work only on flattened images. (See Chapter 8 for details on layers.)

Unlike with filters, you can’t preview how an effect will look on your image or type, nor do you have any options to specify.

![Original](image1.png)

![Fluorescent Chalk effect](image2.png)

Figure 11-9: Enhance your images by adding effects.

Here are the steps to follow to apply an effect:

1. In **Expert mode**, select your desired image layer in the **Layers panel**.
Or, if you’re applying the effect to just a selection, make the selection before applying the effect.

2. **Choose Window ➪ Effects or click the Effects icon in the bottom right of the workspace.**

3. **Select the Effects tab at the top of the panel.**

4. **Select your desired category of effects from the drop-down menu in the upper-right area of the panel:**
   - **Frame:** Includes effects that enhance the edges of the layer or selection.
   - **Faded Photo, Monotone Color, Old Photo, and Vintage Photo:** This group of effects makes your image fade from color to grayscale, appear as a single color, or look like an old pencil sketch or a photo on old paper.
   - **Misc Effects:** Includes a wide variety of effects to make your image appear as though it’s snowing, made of lizard skin or neon tubes, or painted with oil pastels.
   - **Show All:** Shows all the effects described in this list.

5. **On the Effects panel, double-click your desired effect or drag the effect onto the image.**

   Note that you can view your styles and effects by thumbnails or by list. To change the view, click the down-pointing arrow in the upper-right corner of the panel to access the menu commands.

In Elements 12, Quick Mode sports its very own Effects panel. Click the Effects icon in the bottom-right corner of the workspace. To apply an effect, double-click it or drag it onto your image.

You may also want to check out the interesting effects found in Guided mode. Elements 12 even provides a couple of new effects, Puzzle and Zoom Burst, that are worth a whirl. Turn to Chapter 2 to find steps for applying Zoom Burst in Guided mode.

You can also apply an effect to type. Select your type layer and follow Steps 2 to 5 in the preceding list. Note that a dialog box alerts you that the type layer must be simplified before the effect can be applied. Simplifying that layer, of course, means you lose the ability to edit the text. Chapter 13 covers working with type in detail.
Adding Shadows, Glows, and More

Layer styles go hand in hand with filters and photo effects. Also designed to enhance your image and type layers, layer styles range from simple shadows and bevels to the more complex styles, such as buttons and patterns.

The wonderful thing about layer styles is that they’re completely nondestructive. Unlike filters, layer styles don’t change your pixel data. You can edit them or even delete them if you’re unhappy with the results.

Here are some important facts about layer styles:

✓ **Layer styles can be applied only to layers.** If your image is just a background, convert it to a layer first.

✓ **Layer styles are dynamically linked to the contents of a layer.** If you move or edit the contents of the layers, the results are updated.

✓ **When you apply a layer style to a layer, an fx symbol appears next to the layer’s name on the Layers panel.** Double-click the fx icon to bring up the Style Settings dialog box and perform any editing that’s necessary to get the look you want.

Applying layer styles

Layer styles are stored in a few different libraries. You can add shadows, glows, beveled and embossed edges, and more complex styles, such as neon, plastic, chrome, and various other image effects. Figure 11-10 shows a sampling of styles.

Figure 11-10: Add dimension by applying shadows and bevels to your object or type.
Here are the steps to apply a style and a description of each style library:

1. **Select your desired image, shape, or type layer on the Layers panel.**
   You can apply layer styles to type layers, and the type layer doesn’t need to be simplified.

2. **Choose Window: Effects or click the Effect icon in the bottom-right corner of the workspace.**

3. **Click the Styles button at the top of the Effects panel.**

4. **Select your desired library of styles from the drop-down menu in the upper-right area of the panel:**
   - **Bevels:** Bevels add a three-dimensional edge on the outside or inside edges of the contents of a layer, giving the element some dimension. Emboss styles make elements appear as though they’re raised off or punched into the page. You can change the appearance of these styles, depending on the type of bevel chosen. Adjust parameters, such as the lighting angle, distance (how close the shadow is to the layer contents), size, bevel direction, and opacity.
   - **Drop and Inner Shadows:** Add a soft drop or an inner shadow to a layer. Choose from the garden-variety shadow or one that includes noise, neon, or outlines. You can adjust the lighting angle, distance, size, and opacity as desired.
   - **Outer and Inner Glows:** Add a soft halo that appears on the outside or inside edges of your layer contents. Adjust the appearance of the glow by changing the lighting angle, size, and opacity of the glow.
   - **Visibility:** Click Show, Hide, or Ghosted to display, hide, or partially show the layer contents. The layer style remains fully displayed.
   - **Complex and others:** The remaining layer styles are a cornucopia of different effects ranging from simple glass buttons to the more exotic effects, such as Groovy and Rose Impressions. You can customize all these layer styles to a certain extent by adjusting the various settings, which are similar to those for other styles in this list.

5. **On the Layer Styles panel, double-click your desired effect or drag the effect onto the image.**
   The style, with its default settings, is applied to the layer. Note that layer styles are cumulative. You can apply multiple styles — specifically, one style from each library — to a single layer.
Working with layer styles

Here are a few last tips for working with layer styles:

✓ **Edit the style’s settings.** Either double-click the fx icon on the Layers panel or choose Layer ➪ Layer Style ➪ Style Settings.

✓ **Delete a layer style or styles.** Choose Layer ➪ Layer Style ➪ Clear Layer Style or drag the fx icon on the Layers panel to the trash icon.

✓ **Copy and paste layer styles onto other layers.** Select the layer containing the layer style and choose Layer ➪ Layer Style ➪ Copy Layer Style. Select the layer(s) on which you want to apply the effect and choose Layer ➪ Layer Style ➪ Paste Layer Style. If it’s easier, you can also just drag and drop an effect from one layer to another while holding down the Alt (Option on the Mac) key.

✓ **Hide or show layer styles.** Choose Layer ➪ Layer Style ➪ Hide All Effects or Show All Effects.

✓ **Scale a layer style.** Choose Layer ➪ Layer Style ➪ Scale Effects. Check the Preview option and enter a value between 1 and 1,000 percent. This action allows you to scale the style without scaling the element.

If by chance you apply a layer style and nothing seems to happen, choose Layer ➪ Layer Style ➪ Show All Effects.

Mixing It Up with Blend Modes

Elements sports a whopping 25 blend modes. **Blend modes** affect how colors interact between layers and also how colors interact when you apply paint to a layer. Not only do blend modes create interesting effects, but you can also easily apply, edit, or remove blend modes without touching your image pixels.

The various blend modes are located on a drop-down menu at the top of your Layers panel in Expert mode. The best way to get a feel for the effect of blend modes is not to memorize the descriptions we give you in the following sections. Instead, grab an image with some layers and apply each of the blend modes to one or more of the layers to see what happens. The exact result varies, depending on the colors in your image layers.
General blend modes

The Normal blend mode needs no introduction. It’s the one you probably use the most. Dissolve is the next one on the list and, ironically, is probably the one you use the least.

Figure 11-11 shows both blend modes:

- **Normal:** The default mode displays each pixel unadjusted. Note that you can’t see the underlying layer at all with the Normal blend mode.

- **Dissolve:** This mode can be seen only on a layer with an opacity setting of less than 100 percent. It allows some pixels from lower layers, which are randomized, to show through the target (selected) layer.

![Normal and Dissolve blend modes](https://via.placeholder.com/200x200)

Figure 11-11: The Dissolve blend mode allows pixels from one layer to peek randomly through another.

Darken blend modes

These blend modes produce effects that darken your image in various ways, as shown in Figure 11-12:

- **Darken:** Turns lighter pixels transparent if the pixels on the target layer are lighter than those below. If the pixels are darker, they’re unchanged.

- **Multiply:** Burns the target layer onto the layers underneath, thereby darkening all colors where they mix. When you’re painting with the Brush or Pencil tool, each stroke creates a darker color, as though you’re drawing with markers.
**Color Burn**: Darkens the layers underneath the target layer and burns them with color, creating a contrast effect, like applying a dark dye to your image.

**Linear Burn**: Darkens the layers underneath the target layer by decreasing the brightness. This effect is similar to Multiply but often makes parts of your image black.

**Darker Color**: When blending two layers, the darker color of the two colors is visible.

![Blend Modes](https://istockphoto.com/OlsenMatt Image #2195921, Elpiniki Image #1861345)

**Figure 11-12**: These blend modes darken your image layers.

### Lighten blend modes

The lighten blend modes are the opposite of the darken blend modes. All these blend modes create lightening effects on your image, as shown in Figure 11-13:

**Lighten**: Turns darker pixels transparent if the pixels on the target layer are darker than those below. If the pixels are lighter, they’re unchanged. This effect is the opposite of Darken.

**Screen**: Lightens the target layer where it mixes with the layers underneath. This effect is the opposite of Multiply.
✓ **Color Dodge:** Lightens the pixels in the layers underneath the target layer and infuses them with colors from the top layer. This effect is similar to applying bleach to your image.

✓ **Linear Dodge:** Lightens the layers underneath the target layer by increasing the brightness. This effect is similar to Screen but often makes parts of your image white.

✓ **Lighter Color:** When blending two layers, the lighter color of the two colors is visible.

![Blend modes examples](https://via.placeholder.com/150)

**Figure 11-13:** These blend modes lighten your image layers.

---

**Lighting blend modes**

This group of blend modes plays with the lighting in your layers, as shown in Figure 11-14:

✓ **Overlay:** Overlay multiplies the dark pixels in the target layer and screens the light pixels in the underlying layers. It also enhances the contrast and saturation of colors.

✓ **Soft Light:** This mode darkens the dark (greater than 50 percent gray) pixels and lightens the light (less than 50 percent gray) pixels. The effect is like shining a soft spotlight on the image.
✓ **Hard Light:** This mode multiplies the dark (greater than 50 percent gray) pixels and screens the light (less than 50 percent gray) pixels. The effect is similar to shining a bright, hard spotlight on the image.

✓ **Vivid Light:** If the pixels on the top layer are darker than 50 percent gray, this mode darkens the colors by increasing the contrast. If the pixels on the top layer are lighter than 50 percent gray, the mode lightens the colors by decreasing the contrast.

✓ **Linear Light:** If the pixels on the top layer are darker than 50 percent gray, the mode darkens the colors by decreasing the brightness. If the pixels on the top layer are lighter than 50 percent gray, the mode lightens the colors by increasing the brightness.

**Figure 11-14:** Some blend modes adjust the lighting between your image layers.
✓ **Pin Light**: If the pixels on the top layer are darker than 50 percent gray, the mode replaces pixels darker than those on the top layer and doesn’t change lighter pixels. If the pixels on the top layer are lighter than 50 percent gray, the mode replaces the pixels lighter than those on the top layer and doesn’t change pixels that are darker. The mode is usually reserved for special effects.

✓ **Hard Mix**: This mode is similar to Vivid Light but reduces the colors to a total of eight: cyan, magenta, yellow, black, red, green, blue, and white. This mode creates a posterized effect.

### Inverter blend modes

The inverter blend modes invert your colors and tend to produce some radical effects, as shown in Figure 11-15:

✓ **Difference**: Produces a negative effect according to the brightness values on the top layers. If the pixels on the top layer are black, no change occurs in the underlying layers. If the pixels on the top layer are white, the mode inverts the colors of the underlying layers.

✓ **Exclusion**: Like Difference, but with less contrast and saturation. If the pixels on the top layer are black, no change occurs in the underlying layers. If the pixels on the top layer are white, this mode inverts the colors of the underlying layers. Medium colors blend to create shades of gray.

![Difference](image1)

![Exclusion](image2)

**Figure 11-15**: Difference and Exclusion blend modes invert colors.
HSL blend modes

These blend modes use the HSL (hue, saturation, lightness) color model to mix colors, as shown in Figure 11-16:

✓ **Hue**: Blends the *luminance* (brightness) and *saturation* (intensity of the color) of the underlying layers with the *hue* (color) of the top layer.

✓ **Saturation**: Blends the luminance and hue of the underlying layers with the saturation of the top layer.

✓ **Color**: Blends the luminance of the underlying layers with the saturation and hue of the top layer. This mode enables you to paint color while preserving the shadows, highlights, and details of the underlying layers.

✓ **Luminosity**: The opposite of Color, this mode blends the hue and saturation of the underlying layers with the luminance of the top layer. This mode also preserves the shadows, highlights, and details from the top layer and mixes them with the colors of the underlying layers.

![Figure 11-16: Some blend modes mix colors based on the actual hue, richness, and brightness of color.](https://istockphoto.com/OlsenMatt Image #2195921, Elpiniki Image #1861345)
Using Photomerge

The awesome Photomerge features help you to create fabulous composites from multiple images. Whether it’s creating the perfect shot of a group of friends or of your favorite vacation spot (without the passing cars and people), the Photomerge feature is the go-to tool to get it done. The following sections tell you how the Photomerge commands help to create the special type of composite image you need.

You can access all Photomerge commands in all three Photo Editor modes or in the Organizer.

Photomerge Panorama

The Photomerge Panorama command enables you to combine multiple images into a single panoramic image. From skylines to mountain ranges, you can take several overlapping shots and stitch them together into one.

The following tips can help you start with good source files that will help you successfully merge photos into a panorama:

- Make sure that when you shoot your photos, you overlap your individual images by 15 to 40 percent, but no more than 50 percent.
- Avoid using distortion lenses (such as fish-eye) and your camera’s zoom setting.
- Try to keep the same exposure settings for even lighting.
- Try to stay in the same position and keep your camera at the same level for each photo. If possible, using a tripod and moving both the tripod and camera along a level surface, taking the photos from the same distance and angle is best. However, if conditions don’t allow for this, using a tripod and just rotating the head is the next best method. Be aware, however, that it can be harder to keep the lighting even, depending on the angle of your light source relative to the camera. You can also run into perspective-distortion issues with your shots.

Follow these steps to create a Photomerge Panorama image:

1. In Expert mode, choose Enhance→Photomerge→Photomerge Panorama.

   The Photomerge dialog box opens, as shown at the top in Figure 11-17.
2. Select Files or Folder from the Use drop-down menu.

3. Click Add Open Files to use all open files or click the Browse button and navigate to where your files or folder are located.

4. Choose your desired mode under Layout.

Here’s a brief description of each mode:

- **Auto:** Elements analyzes your images.
- **Perspective:** If you shot your images with perspective or at extreme angles, this is your mode. Try this mode if you shot your images with a tripod and rotating head.
- **Cylindrical:** If you shot your images with a wide-angle lens or you have those 360-degree, full-panoramic shots, this is a good mode.
- **Spherical:** This projection method aligns images by rotating, positioning, and uniformly scaling each image. It may be the best choice for pure panoramas, but you can also find it useful for stitching images together using common features.
- **Collage:** This mode is handy when stitching together a 360-degree panorama, in which you have a wide field of view, both horizontally and vertically. Use this option for shots taken with a wide-angle lens.
- **Reposition:** Elements doesn’t take any distortion into account; it simply scans the images and positions them as best it can.

5. Select from the following options:

- **Blend Images Together:** Corrects the color differences that can occur from blending images with different exposures.
- **Vignette Removal:** Corrects exposure problems caused by lens vignetting (when light at the edges of images is reduced and the edges are darkened).
- **Geometric Distortion Correction:** Corrects lens problems such as radial distortions — for instance, barrel distortion (bulging out) and pincushion distortion (pinching in).
Figure 11-17: Combine multiple images into a single panorama with Photomerge.
6. **Click OK to create the panorama.**

   Elements opens and automatically assembles the source files to create the composite panorama in a new file.

   Note that with any of the modes, Elements leaves your merged image in layers. You’ll also notice that a layer mask has been added to each layer to better blend your panoramic image. You can edit your layer masks or move your layers to fine-tune the stitching of the images. For more on layer masks, see Chapter 8.

   Elements alerts you if it can’t composite your source files. If that happens, you may have to composite your images manually by creating a large canvas and dragging and dropping your images onto that canvas.

---

**Photomerge Group Shot**

We’re sure you know how hard it is to get a group of people to all look great in one shot. Well, Photomerge Group Shot lets you take multiple group photos and merge the best of them to get that perfect shot.

Here are the steps to create a Photomerge Group Shot image:

1. **Select two or more photos from your Photo Bin.**

2. **Choose Enhance ➪ Photomerge ➪ Photomerge Group Shot in any of the edit modes.**

3. **Take your best overall group shot and drag it from the Photo Bin onto the Final window.**

4. **Select one of your other photos in the Photo Bin to use as your source image. Drag it to the Source window.**

5. **With the Pencil tool, draw a line around the portions of the source photo you want to merge into your final photo, as shown in Figure 11-18.**

   You can choose to show your pencil strokes and/or show your regions, which will be highlighted with an overlay.

6. **Repeat Steps 4 and 5 with any remaining photos.**

   If your photos aren’t aligned, you can use the Alignment tool under the Advanced Options.

7. **With the Alignment tool, click your source image and position the three target markers on three key locations. Do the same on the final image and choose similar locations.**

8. **Click the Align Photos button.**

   As with Photomerge Panorama, the more alike in framing, size, and so on that your source and final images are, the better the merged result.
Chapter 11: Playing with Filters, Effects, Styles, and More

Figure 11-18: Get the perfect group shot from several images.

Note that if you see any noticeable seams on your final image around the copied area, you can click the Pixel Blending button to help smooth over those flaws.

If you make a mess of things, click the Reset button.

9. **When you’re satisfied with the result, click Done.**

The file opens as a new file in Elements.
Part IV: Exploring Your Inner Artist

Photomerge Scene Cleaner

Photomerge Scene Cleaner (see Figure 11-19) sounds like a tool you might see in an episode of *CSI* to mop up a crime scene, but it isn’t quite that gory. This member of the Photomerge commands family enables you to create the optimum image by allowing you to eliminate annoying distractions, such as cars, passersby, and so on.

To get the best source images for a clean scene, take multiple shots of your scene from the same angle and distance. It also works best when the elements you want to eliminate are moving.

Follow these steps to create a Photomerge Scene Cleaner composite:

1. Select two or more photos from your Photo Bin.
2. Choose Enhance ➪ Photomerge ➪ Photomerge Scene Cleaner in any of the edit modes.
   
   Elements attempts to auto-align your images the best it can.
3. Take your best overall shot of the scene and drag it from the Photo Bin onto the Final window.
4. Select one of your other photos in the Photo Bin to use as your source image. Drag it to the Source window.
5. With the Pencil tool, draw a line around the elements in the final photo that you want to be replaced by content from the source photo.
6. Repeat Steps 4 and 5 with the remaining shots of the scene.
   
   If your photos aren’t aligned, you can use the Alignment tool under the Advanced Options.
7. With the Alignment tool, click your source image and position the three target markers on three key locations. Do the same on the final image, choosing similar locations.

Photomerge Faces

Photomerge Faces, a more-fun-than-useful tool, lets you blend features from multiple faces to get a kind of hybrid face. To create a hybrid human by using the Photomerge Faces feature, select two or more photos from your Photo Bin and choose File ➪ New ➪ Photomerge Faces in any of the edit modes. Use the Alignment and Pencil tools to choose how you’d like to merge the photos, similar to the steps described in the section “Photomerge Group Shot.”
8. **Click the Align Photos button in the Advanced Options section.**

Again, as with the other Photomerge commands, the more similar your starting source images are (framing, angle), the better the merged result.

9. **(Optional) If you see any noticeable seams on your final image around the copied area, click the Pixel Blending button to help smooth over those flaws.**

   If you make a mess of things, click the Reset button and start over.

10. **When you’re satisfied with the result, click Done.**

    The resulting image opens as a new file in Elements.

---

**Figure 11-19:** Eliminate annoying distractions with Photomerge Scene Cleaner.

### Photomerge Exposure

Sometimes you need to capture a shot that poses an exposure challenge — your foreground and background require different exposure settings. This dilemma often occurs in shots that are backlit. For example, suppose you have a person in front of an indoor window in the day or someone in front of a lit nighttime cityscape. With Photomerge Exposure, you can take shots with
two different exposure settings and let the command blend them together for the perfect shot.

You can shoot your initial images using exposure bracketing (shooting at consecutive exposure camera settings) or with a flash and then without. Elements can detect all these camera settings. We recommend that you use a tripod, if possible, to keep your shots aligned. The added stability helps the blending algorithm do its job. Also, if your camera supports a timer, use it. That way, you don’t accidentally bump the camera when pressing the shutter button.

Here’s how to use this great command:

1. **Select two or more photos from your Photo Bin.**
2. **In any of the edit modes, choose Enhance ➪ Photomerge ➪ Photomerge Exposure.**
3. **Choose either Automatic or Manual mode.**
   - If you’ve done a good job keeping your shots aligned, leave the mode on Automatic and go to Step 4.
   - If you feel the need for even more control, click the Manual tab and go to Step 5.
4. **Select an option in Automatic mode and then skip to Step 11:**
   - **Simple Blending:** Elements automatically blends the two images.
   - **Smart Blending:** Access sliders to adjust the Highlights, Shadows, and Saturation settings for finer tuning of the resulting images. If you muck things up, click the Reset button.
5. **In Manual mode (shown in Figure 11-20), choose your first shot from the Photo Bin and drag it to the Final window. If your other image isn’t already the source image, drag it from the Photo Bin to the Source window.**
6. **With the Pencil tool, draw over the well-exposed areas you want to retain in the source image.**
   - As you draw, your final image shows the incorporation of those drawn areas, as shown in Figure 11-20.
Figure 11-20: Combine images shot with two different exposures into a hero shot.
7. If you mistakenly draw over something you don’t want, grab the Eraser tool and erase the Pencil tool marks.

Choose the appropriate option to have your preview show strokes or regions.

8. **Control the blending by dragging the Transparency slider.**

Dragging to the right blends less of the source areas into the final image. Check the Edge Blending option to get an even better blend of the two images.

9. **If your photos aren’t aligning correctly, grab the Alignment tool under Advanced Options.**

With the Alignment tool, click your source image and position the three target markers on three key locations.

Do the same on the final image, choosing similar locations.

10. **Click the Align Photos button.**

As with the other Photomerge commands, the more similar your starting source images are (framing, angle), the better the merged result.

Again, if you make a mess of things, click the Reset button.

11. **When you’re satisfied with the result, click Done.**

The image opens as a new, layered file in Elements. The blended image appears on Layer 1. The background is your starting final image. You can either flatten the layered file, which keeps the appearance of Layer 1, or you can double-click your background to convert it to a layer and then delete it by dragging it to the trash icon in the Layers panel.

**Photomerge Style Match**

You can match or apply the style of one image onto another image. It’s hard to explain exactly what Adobe defines as “style,” but basically, tonal properties are transferred from one image to another. But rather than read a definition of the feature, it’s best to spend a couple of minutes trying it.

Here are the steps to transfer a style from one image onto another:

1. **Select a photo from your Photo Bin onto which you would like to transfer a style.**

2. **In any of the edit modes, choose Enhance ‹› Photomerge ‹› Photomerge Style Match.**
3. Your selected photo appears in the right window as your source (After) image.

4. Drag an image from the Style Bin to the left window to act as your sample (Style) image from which your desired style will be transferred.

   To add more images to the Style Bin, click the green plus sign and choose to add sample images from either the Organizer or your hard drive.

5. Adjust the following sliders, as shown in Figure 11-21:
   - **Intensity**: Specifies the intensity or strength of the style transfer. Keep the number low to blend more of the original image with the styled image.
   - **Clarity**: Specifies how clearly the style transfer appears.
   - **Details**: Enhances or decreases details in the styled image.

   Note that the results depend on your chosen images, so experiment with the preceding options to get your desired result.

6. Further define the styled image by adjusting the following options under Basic mode:
   - **Style Eraser**: Paint with this tool to erase the style from areas on your source image.
   - **Style Painter**: Paint with this tool to add the style to areas on your source image.
   - **Soften Stroke Edges**: Drag the slider to clean up your image and remove any seams between the styled and original image areas.
   - **Transfer Tones**: Select the check box to transfer the tonal values of the source image onto the styled image.

7. To use more than one image as your sample image, repeat Steps 4 through 6.

   Again, if you make a mess of things, click Reset (blue curved arrow icon) in the top right of the panel.

8. When you’re satisfied with the result, click Done.

   The file opens as a new file in Elements.
Figure 11-21: Copy a style from one image to another.
Elements is such a deluxe, full-service image-editing program that it doesn’t stop at giving you tools to select, repair, organize, and share your images. It figures that you may need to add a swash of color, either freeform with a brush or pencil, or in the form of a geometric or organic shape. Don’t worry: This drawing and painting business isn’t just for those with innate artistic talent. In fact, Elements gives you plenty of preset brushes and shapes to choose from. If you can pick a tool and drag your mouse, you can draw and paint.

Choosing Color

Before you start drawing or painting, you may want to change your color to something other than the default color of black. If you read the earlier chapters in this book, you may have checked out the Elements Tools panel and noticed the two overlapping color swatches at the bottom of the panel. These two swatches represent two categories of color: foreground and background.
Here’s a quick look at how they work with different tools:

- **Foreground**: When you add type, paint with the Brush tool, or create a shape, you’re using the foreground color.

- **Background**: On the background layer of an image, when you use the Eraser tool, or when you increase the size of your canvas, you’re accessing the background color.

- **Foreground and background**: When you drag with the Gradient tool, as long as your gradient is set to the default, you’re laying down a blend of color from the foreground to the background.

Elements gives you three ways to choose your foreground and background colors: the Color Picker, the color swatches, and the Eyedropper tool, which samples color in an image. In the following sections, we explore each one.

**Working with the Color Picker**

By default, Elements uses a black foreground color and a white background color. If you’re experimenting with color and want to go back to the default colors, press the D key. If you want to swap between foreground and background colors, press the X key. If you want any color other than black and white, click your desired swatch (either foreground or background) at the bottom of the Tools panel. This action transports you to the Color Picker, as shown in Figure 12-1.

Here are the steps to choose your color via the Color Picker:

1. **Click either the foreground or background color swatch on the Tools panel.**
   
   The Color Picker appears.

2. **Drag the color slider or click the color bar to get close to the general color you desire.**

3. **Choose the exact color you want by clicking in the large square, or color field, on the left.**

   The circle cursor targets your selected color. The two swatches in the upper-right corner of the dialog box represent your newly selected color and the original foreground or background color.

   The numeric values on the right side of the dialog box also change according to the color you selected. If you happen to know the values of your desired color, you can enter them in the text boxes. RGB (red, green, blue) values are based on brightness levels from 0 (black) to 255 (white). You can also enter HSB (hue, saturation, brightness) values or the hexadecimal formula for web colors.

4. **When you’re happy with your color, click OK.**
Chapter 12: Drawing and Painting

If you want to save your color for later use, do so by using the Color Swatches panel, described shortly.

**Dipping into the Color Swatches panel**

Elements enables you to select a foreground or background color by selecting a color on the Color Swatches panel. The Color Swatches panel is a digital version of the artist’s paint palette. In addition to preset colors, you can mix and store your own colors for use now and later. You can have palettes for certain types of projects or images. For example, you may want a palette of skin tones for retouching portraits. Choose Window ➪ Color Swatches to bring up the panel, as shown in Figure 12-2.
To grab a color from the Color Swatches panel, click the color swatch you want. By the way, it doesn’t matter which tool you have. As soon as you move the tool over the panel, it temporarily converts to an eyedropper that samples the color and makes it your new foreground or background color.

Although the Color Swatches panel is a breeze to use, here are a few tips to help you along:

✓ **Change the background color.** Either first click the background swatch on the Tools panel or Ctrl-click (⌘-click on the Mac) a swatch in the Color Swatches panel.

✓ **Use preset colors.** To load a particular preset swatch library, select it from the drop-down menu at the top of the Color Swatches panel. Elements offers libraries specific to web graphics, photo filters, and Windows and OS X systems.

✓ **Add a color to the Color Swatches panel.** Choose New Swatch from the panel menu. You can also simply click an empty portion of the panel. Name your swatch and click OK. Remember, it doesn’t matter whether you created the color by using the Color Picker or sampling with Eyedropper tool — adding the color for later use is done the same way.

✓ **Save swatches.** Choose Save Swatches from the panel menu in the upper-right corner of the panel. We recommend saving the swatch library in the default Color Swatches folder in the Presets folder. If by chance this folder doesn’t come up by default, just navigate to the Color Swatches folder by following this partial path: Adobe\Photoshop Elements 12.0\Presets\Color Swatches (Windows) or Adobe/Adobe Photoshop Elements 12/Presets/Color Swatches (Mac).

✓ **Save swatches for Exchange.** Choose this command from the panel menu to save your swatches for use in another Adobe program. Name the swatch set and save it in the same folder listed in the previous list item.

✓ **Load swatches.** If you want to load a custom library created by you or someone else, choose Load Swatches from the panel menu. In the dialog box, select your desired library from the Color Swatches folder. The new library is added to your current library.

You can also work with swatches by using the Preset Manager. For more on the Preset Manager, see Chapter 3.

✓ **Delete swatches.** To delete a swatch, drag it to the trash icon at the bottom of the panel or Alt-click (Option-click on the Mac) the swatch.

✓ **Change the panel’s appearance.** Click the panel menu in the upper-right corner to choose Small or Large Thumbnail (swatch squares) or Small or Large List (swatch squares with a name).
Replace your current swatch library with a different library. Choose Replace Swatches from the panel menu. Choose a library from the Color Swatches folder.

Sampling with the Eyedropper tool

Another way that Elements enables you to choose color is via the Eyedropper tool. The Eyedropper tool comes in handy when you want to sample an existing color in an image and use it for another element. For example, you may want your text to be the same color as the green background in the image shown in Figure 12-3. Grab the Eyedropper tool (or press I) and click a shade of green in the background. The tool samples the color and makes it your new foreground color. You can then create the type with your new foreground color.

Here are a few things to remember when you’re using the Eyedropper tool:

- **Sample a new foreground or background color.** Obviously, you can select either the foreground or background swatch on the Tools panel before you sample a color. But if the foreground color swatch is active, holding down the Alt key (Option key on the Mac) samples a new background color, and vice versa.

- **Choose a color from any open image.** If you have multiple images open, you can even sample a color from an image that you’re not working on!

- **Choose your sample size in the Tool Options.** You can select the color of just the single pixel you click (Point Sample), or Elements can average the colors of the pixels in a 3-x-3- or 5-x-5-pixel area.

Figure 12-3: The Eyedropper tool enables you to sample color from your image to use with other elements, such as type.
✓ **Make colors web-safe.** If you right-click your image to bring up the contextual menu, you have a hidden option: Copy Color as HTML. This option provides the web hexadecimal color formula for that sampled color and copies it to the Clipboard. You can then paste that formula into an HTML file or grab the Type tool and choose Edit ➤ Paste to view the formula in your image.

✓ **Choose to sample All Layers or just the Current Layer.** If you have multiple layers in your image, you can choose to sample from all of those layers or just your currently active layer.

✓ **Toggle between the Eyedropper and other tools.** Elements, multitasker that it is, enables you to temporarily access the Eyedropper tool when you’re using the Brush, Pencil, Color Replacement, Gradient, Paint Bucket, Cookie Cutter, or Shape tool. Simply press the Alt (Option on the Mac) key to access the Eyedropper tool. Release the Alt (Option on the Mac) key to go back to your original tool.

---

### Getting Artsy with the Pencil and Brush Tools

If you want to find out how to paint and draw with a color you’ve chosen, you’ve come to the right place. The Pencil and Brush tools give you the power to put your creative abilities to work, and the following sections show you how.

When you use these two tools, you benefit immensely from the use of a pressure-sensitive digital drawing tablet. The awkwardness of trying to draw or paint with a mouse or trackpad disappears and leaves you with tools that behave much closer to their analog ancestors.

#### Drawing with the Pencil tool

Drawing with the Pencil tool creates hard edges. You can’t get the soft, feathery edges that you can with the Brush tool. In fact, the edges of a pencil stroke can’t even be antialiased. (For more on antialiasing, see the following section.) Keep in mind that if you draw anything other than vertical or horizontal lines, your lines will have some jaggies when they’re viewed up close. But hey, don’t diss the Pencil just yet. Those hard-edged strokes can be perfect for web graphics. What’s more, the Pencil tool can erase itself, and it’s great for digital sketches, as shown in Figure 12-4.

*Illustration by Chris Blair*  

**Figure 12-4:** The Pencil tool can be used for digital drawings.
Chapter 12: Drawing and Painting

Follow these steps to become familiar with the Pencil tool:

1. **Select the Pencil tool from the Tools panel.**
   
   You can also press the N key. By default, the Pencil tool’s brush tip is the 1-pixel brush. Yes, even though the Pencil tip is hard-edged, we still refer to it as a brush. In the next few steps, you customize the brush by setting various options.

2. **Click the arrow and select your desired brush from the Brush Preset Picker drop-down panel.**
   
   To load another preset library, click the Brushes menu at the top of the panel.

   You aren’t limited to the standard old brush strokes. Check out the Assorted and Special Effects brushes found in the Brush drop-down menu at the top of the Brush Preset Picker panel, as shown in Figure 12-5. You’ll be surprised by the interesting brushes lurking on these panels. Use them to create stand-alone images or to enhance your photographic creations.

   Access the menu on the Brush Preset picker panel menu to save, rename, or delete individual brushes and also save, load, and reset brush libraries. For more on these operations, see the following section.

3. **Choose your brush size.**
   
   If you want to change the size of that brush tip, drag the Size slider.

4. **If you want the background to show through your strokes, adjust the opacity by dragging the slider or entering an opacity percentage less than 100 percent.**
   
   The lower the percentage, the more the background images show through.

   Your strokes must be on a separate layer above your images for you to be able to adjust the opacity and blend modes after you draw them. For more on layers, see Chapter 8.
5. **Select a blend mode.**

   Blend modes alter the way the color you’re applying interacts with the color on your canvas. You can find more about blend modes in Chapter 11.

6. **(Optional) Select Auto Erase if you want to enable that option.**

   This option removes portions of your pencil strokes. For example, say that your foreground color is black and your background color is white, and you apply some black strokes. With Auto Erase enabled, you apply white if you drag back over the black strokes. If you drag over the white background, you apply black.

7. **Click and drag with the mouse to create your freeform lines.**

   To draw straight lines, click at a starting point, release the mouse button, and then Shift-click at a second point.

**Painting with the Brush tool**

The Brush tool creates soft-edged strokes. How soft those strokes are depends on which brush you use. By default, even the hardest brush has a slightly soft edge because it’s antialiased. Antialiasing creates a single row of partially filled pixels along the edges to produce the illusion of a smooth edge. You can also get even softer brushes, which use feathering. For details on feathering, see Chapter 7.

The Brush tool shares most of the options found in the Pencil tool, except that the Auto Erase feature isn’t available. Here’s the lowdown on the unique Brush options:

- **Airbrush:** Click the Airbrush button in the Options panel to apply the Airbrush Mode. In this mode, the longer you hold down the mouse button, the more paint the Brush pumps out and the wider the airbrush effect spreads.

- **Tablet Settings:** If you’re using a pressure-sensitive digital drawing tablet, check the settings you want the tablet to control, including size, scatter, opacity, roundness, and hue jitter. The harder you press with the stylus, the greater the effect of these options.

- **Brush Settings:** These options, referred to as brush dynamics, change while you apply your stroke. See Figure 12-6 for an example of each one. These options include the following:
  
  - **Fade:** The lower the value, the more quickly the stroke fades. However, 0 creates no fade.
  - **Hue Jitter:** Vary the stroke between the foreground and background colors. The higher the value, the more frequent the variation.
  - **Scatter:** The higher the value, the higher the number of brush marks and the farther apart they are.
Chapter 12: Drawing and Painting

- **Spacing:** The higher the number, the more space between marks.

- **Hardness:** The higher the value, the harder the brush.

- **Roundness:** A setting of 100 percent is totally circular. The lower the percentage, the more elliptical your brush becomes.

- **Angle:** If you create an oval brush by adjusting the roundness this option controls the angle of that oval brush stroke. It’s so much easier to drag the points and the arrow on the diagram than to guesstimate values in the text boxes.

You can lock in these brush dynamics by selecting the Set This As a Default check box; this ensures that every brush you select adopts these settings.

As with the Pencil tool, you can load additional Brush libraries from the Brush drop-down menu at the top of Brush Preset picker panel. Additional features for the Brush tool also appear in the menu on the Brush Preset Picker panel. Here’s a quick description of each:

- **Save Brush:** Allows you to save a custom brush as a preset. See the following section for details.

- **Rename Brush:** Don’t like your brush’s moniker? Change it with this option.

- **Delete Brush:** Don’t like your entire brush? Eliminate it with this option.

- **The display options:** Not a single command, but a set of commands that enable you to change the way your brush tips are displayed. The default view is Stroke Thumbnail, which displays the appearance of the stroke. These commands include Text Only, Small and Large Thumbnail, and Small and Large List.

- **Reset Brushes:** Reverts your current brush library to the default.

- **Save Brushes:** Saves custom brushes in a separate library.

- **Load Brushes:** Loads a preset or custom brush library.
You can also manage brush-tip libraries by using the Preset Manager. See Chapter 3 for information on using the Preset Manager.

**Using the Impressionist Brush**

The Impressionist Brush is designed to paint over your photos in a way that makes them look like fine art paintings. You can set various options that change the style of the brush strokes.

Here’s how to use this artistic brush:

1. **Select the Impressionist Brush from the Tools panel.**
   
   It looks like a brush with a curlique next to it. You can also press B to cycle through the brushes.

2. **Set your brush options.**
   
   The Brushes presets (Size, Opacity, and Mode options) are identical to those found with the Brush tool, described in the section “Painting with the Brush tool,” earlier in this chapter. You can also find some unique options on the Advanced drop-down panel in the Tool Options:
   
   - **Style:** This drop-down menu contains various brush stroke styles, such as Dab and Tight Curl.
   - **Area:** Controls the size of your brush stroke. The larger the value, the larger the area covered.
   - **Tolerance:** Controls how similar color pixels have to be before they’re changed by the brush stroke.

3. **Drag on your image and paint with your brush strokes, as shown in Figure 12-7.**
   
   The best way to get a feel for what this tool does is to open your favorite image, grab the tool, and take it for a test drive.
Creating your own brush

After playing with all the various options, if you really like the Franken-brush you’ve created, feel free to save it as a preset that you can access in the future. Choose Save Brush from the panel menu on the Brush Preset Picker panel. Name the brush and click OK. Your new custom brush shows up at the bottom of the Brush Preset Picker drop-down panel.

There’s one additional way to create a brush. Elements allows you to create a brush from all or part of your image. The image can be a photograph or something you’ve painted or drawn.

Here’s how to create a brush from your image:

1. Select part of your image with any of the selection tools.
   - If you want to use the entire image or entire layer, deselect everything.
   - For more on selections, see Chapter 7.

2. Choose Edit ➪ Define Brush or Edit ➪ Define Brush from Selection.
   - You see one command or the other, depending on what you do in Step 1.

3. Name the brush and click OK.
   - The new brush shows up at the bottom of your Brush Preset Picker drop-down panel. Note that your brush is only a grayscale version of your image. When you use the brush, it automatically applies the color you’ve selected as your foreground color, as shown in Figure 12-8.

Filling and Outlining Selections

At times, you may want to create an element on your canvas that can’t quite be created with a brush or pencil stroke. Maybe it’s a perfect circle or a five-point star. If you have a selection, you can fill or stroke that selection to
create that element, rather than draw or paint it on. The Fill command adds a color or a pattern to the entire selection, whereas the Stroke command applies the color to only the edge of the selection border.

**Fill 'er up**

You won't find a Fill tool on the Tools panel. Elements decided to avoid the overpopulated panel and placed the Fill and Stroke commands on the Edit menu.

Here are the simple steps to fill a selection:

1. **Grab the selection tool of your choice and create your selection on a new layer.**
   
   Although you don’t have to create a new layer to make a selection to fill, we recommend it. That way, if you don’t like the filled selection, you can delete the layer, and your image or background below it remains safe. See Chapter 7 for more on selections and Chapter 8 for details on working with layers.

2. **Select either the foreground or background color and then choose a fill color.**
   
   See the section “Choosing Color,” earlier in this chapter, if you need a refresher.

3. **Choose Edit ➤ Fill Selection.**
   
   The Fill Layer dialog box, shown in Figure 12-9, appears.

   If you want to bypass the Fill Layer dialog box (and the rest of these steps), you can use these handy keyboard shortcuts instead:

   - To fill the selection with the foreground color, press Alt+Backspace (Option+Delete on the Mac).
   - To fill it with the background color, press Ctrl+Backspace (⌘+Delete on the Mac).

4. **Choose your desired fill from the Use drop-down menu.**
   
   You can select whether to fill with the foreground or background color. You also can choose Color, Pattern, Black, 50% Gray, or White. If you
select Color, you’re transported to the Color Picker. If you choose Pattern, you must then choose a pattern from the Custom Pattern drop-down panel. For more on patterns, see the section “Working with Patterns,” later in this chapter.

If you don’t have an active selection border in your image, the command says Fill Layer and your entire layer is filled with your color or pattern.

5. **In the Blending area, specify whether to preserve transparency, which enables you to fill only the portions of the selection that contain pixels (the nontransparent areas).**

Although you can also choose a *blend mode* (how the fill color interacts with colors below it) and opacity percentage, we urge you not to adjust your blend mode and opacity in the Fill Layer dialog box. Make those adjustments on your layer later, by using the Layers panel commands, where you have more flexibility for editing.

6. **Click OK.**

The color or pattern fills the selection.

**Outlining with the Stroke command**

Stroking a selection enables you to create colored outlines, or *borders*, of selections or layers. You can put this border inside or outside the selection border or centered on it. Here are the steps to stroke a selection:

1. **Choose a foreground color and create a selection.**

2. **Choose Edit ➪ Stroke (Outline) Selection.**

   The Stroke dialog box opens.

3. **Select your desired settings.**

   Many settings are the same as those found in the Fill Layer dialog box, as we explain in the preceding section. Here’s a brief rundown of the options that are unique to strokes:

   - *Width*: Enter a width of 1 to 250 pixels for the stroke.
   - *Location*: Specify how Elements should apply the stroke: outside the selection, inside the selection, or centered on the selection.

4. **Click OK to apply the stroke.**

   We gave a 30-pixel centered stroke to our selection, as shown in Figure 12-10.

   **Figure 12-10**: Stroke a selection to create a colored border.
Splashing On Color with the Paint Bucket Tool

The Paint Bucket tool is a longtime occupant of the Tools panel. This tool, whose icon looks just like a bucket, behaves like a combination of the Fill command and the Magic Wand tool. (See Chapter 7.) It makes a selection based on similarly colored pixels and then immediately fills that selection with color or a pattern. Like the Magic Wand tool, this tool is most successful when you have a limited number of colors, as shown in Figure 12-11.

To use the Paint Bucket tool, simply click inside the selection you want to fill. Before you click, however, specify your settings in the Tool options:

- **Color:** Choose among paint, a fill of the foreground color, or a pattern.
- **Pattern:** If you select Pattern, choose a preset pattern from the drop-down panel. For more details on patterns, see the section “Working with Patterns,” later in this chapter.
- **Opacity:** Adjust the opacity to make your fill more or less transparent.
- **Tolerance:** Choose a tolerance level that specifies how similar in color a pixel must be before it’s selected and then filled. The lower the value, the more similar the color must be. For more on tolerance, see the section on the Magic Wand in Chapter 7.
- **Mode:** Select a blending mode to change how your fill color interacts with the color below it.
- **Anti-aliasing:** Choose this option to smooth the edges between the filled and unfilled areas.
- **Contiguous:** If selected, this option selects and fills only pixels that are touching within your selection. If the option is deselected, pixels are selected and filled wherever they lie within your selection.
- **All Layers:** This option selects and fills pixels within the selection in all layers that are within your tolerance level.
Working with Multicolored Gradients

If one color isn’t enough for you, you’ll be pleased to know that Elements enables you to fill a selection or layer with a gradient. A gradient is a blend of two or more colors that gradually dissolve from one to another. Elements provides a whole slew of preset gradients, but creating your own custom gradient is also fun and easy.

Applying a preset gradient

Similar to colors, patterns, and brushes, gradients have a whole group of presets that you can apply to your selection and layers. You can also load other libraries of gradients from the Gradient panel menu.

Here’s how to apply a preset gradient:

1. **Make the selection you want to fill with a gradient.**
   - We recommend making the selection on a new layer so that you can edit the gradient later without harming the underlying image.
   - If you don’t make a selection, the gradient is applied to the entire layer or background.

2. **Select the Gradient tool from the Tools panel or press the G key.**
   - It looks like a rectangle that goes from black on the left to white on the right.

3. **In the Tool Options, click the down-pointing arrow on the Gradient Picker swatch.**
   - The Gradient Picker drop-down panel appears.

4. **Choose a preset gradient.**
   - Remember that you can choose other preset libraries from the Gradient panel menu. Libraries, such as Color Harmonies and Metals, contain interesting presets.

5. **Choose your desired gradient type by clicking one of the icons.**
   - See Figure 12-12 for an example of each type.

6. **Choose from the following options in the Tool Options:**
   - **Mode:** Select a blending mode to change how the color of the gradient interacts with the colors below it.
• **Opacity**: Specify how opaque or transparent the gradient is.

• **Reverse**: Reverse the order in which the colors are applied.

• **Transparency**: Deselect this option to make Elements ignore any transparent areas in the gradient, making them opaque instead.

• **Dither**: Add noise, or random information, to produce a smoother gradient that prints with less banding (weird stripes caused by printing limitations).

7. **Position your gradient cursor at your desired starting point within your selection or layer.**

8. **Drag in any direction to your desired end point for the gradient.**

   Longer drags result in a subtler transition between colors, whereas shorter drags result in a more abrupt transition. Hold down the Shift key to restrain the direction of the gradient to multiples of a 45-degree angle.

9. **Release the mouse button to apply the gradient.**

   We applied an Orange Yellow radial gradient from the Color Harmonies 2 preset library to a selection of a sun in Figure 12-13. We selected the Reverse option and dragged from the center of the sun to the tip of the top ray.

---

**Figure 12-12**: Choose one of five gradient types.

**Figure 12-13**: We filled our sun selection with a radial Orange Yellow gradient.
Customizing gradients

If you can’t find the exact gradient you need, you can easily create your own. The Gradient Editor lets you create your own custom gradient using as many colors as you want. After you create a custom gradient, you can save it as a preset to reuse in the future.

Follow these steps to create a custom gradient:

1. Select the Gradient tool from the Tools panel.
2. Click the Edit button in the Tool Options.
   The Gradient Editor dialog box opens, as shown in Figure 12-14.
3. Pick an existing preset to use as the basis for your new gradient.
   If you want to choose a gradient from a different Preset library, select that library from the Preset drop-down menu.
4. Choose your gradient type, either Solid or Noise, from the Type drop-down menu.
   A Noise gradient contains random colors. Interestingly, each time you create a Noise gradient, the result is different.
   Note that as soon as you start to edit the existing gradient, the name of the gradient changes to Custom.

Figure 12-14: Use the Gradient Editor to edit and customize gradients.
5. Choose your options for either a Solid or Noise gradient, depending on what you chose in Step 4:

- If you chose Solid, adjust the Smoothness percentage to determine how smoothly one color blends into another.

- If you chose Noise, you can choose which Color Model to use to set the color range.

You can also adjust the Roughness, which affects how smoothly or abruptly the color transitions from one to another. Click Restrict Colors to avoid oversaturated colors. The Add Transparency option adds transparency to random colors. Click the Randomize button to randomly generate a new gradient.

You can then skip to Step 13 to finish the gradient-making process.

6. If you're creating a solid gradient, choose the first color of your gradient by double-clicking the left color stop under the gradient bar. (Refer to Figure 12-14.)

The triangle on top of the stop turns black to indicate that you’re working with the starting point of the gradient, and the Color Picker appears so that you can then choose your desired color.

In the Stops area, you can also single-click the left color stop and then click the Color swatch to access the Color Picker. If you click the Color down-pointing arrow, you access the Color Swatches drop-down menu, where you can choose from various Preset Swatch libraries from the top of the panel.

7. Select the ending color by double-clicking the right color stop. Repeat the process in Step 6 to define the color.

8. Change the percentage of one color versus the other by moving the starting or ending point’s color stop to the left or right. Drag the midpoint slider (a diamond icon) to where the colors mix equally, 50/50.

You can also change the position of the midpoint by typing a value in the Location box.

9. To add another color, click below the gradient bar at the position you want to add the color. Define a color in the same way you did in Steps 7 to 9.

10. Repeat Step 10 to add colors.

11. To add transparency to your gradient, select an opacity stop (refer to Figure 12-14) and adjust the Opacity slider to specify the amount of transparency you desire.
By default, a gradient has colors that are 100-percent opaque. You can fade a gradient to transparency so that the portion of the image under the gradient shows through.

You can also add opacity stops in the same way you add color stops.

12. **Adjust your color and opacity stops and their midpoint sliders to vary the percentages of each color.**

You can also redefine any of the colors. To delete a color stop, drag it up or down off the gradient bar.

13. **When you’re done, name your gradient and click the New button.**

Your gradient is added to the Presets menu.

After all that work, you may want to consider saving your gradients for later use. To save a gradient, click the Save button in the Gradient Editor dialog box. Save the current presets, with your new gradient, under the current library’s name or a new name altogether. You can later load that preset library. You can also manage your gradient presets with the Preset Manager, as we explain in Chapter 3.

---

**Working with Patterns**

If you’ve ever seen someone wearing leopard-print pants with an argyle sweater and a plaid blazer, you’re familiar with patterns. You can use patterns to occasionally fill selections or layers. (Don’t go overboard, though — patterns aren’t always pretty when used without restraint.) You can also stamp your image by using the Pattern Stamp tool. You can even retouch by using a pattern with the Healing Brush tool. Elements offers a lot of preset patterns to keep you happy. If you’re not happy with Elements’ selection, you can create your own, of course.

**Applying a preset pattern**

Although you can apply patterns by using many different tools, this chapter sticks with applying patterns as fills. To fill a layer or selection with a preset pattern, follow these steps:

1. **Choose the layer or selection you want to fill with a pattern.**

   Again, we recommend making your selection on a new layer above your image for more flexible editing later on.
2. Choose Edit ➪ Fill Selection or Fill Layer and choose Pattern from the Use drop-down menu.

3. Click the down-pointing arrow and select a pattern from the Custom Pattern drop-down panel, as shown in Figure 12-15.

If you don’t see a pattern to your liking, click the panel pop-up menu at the bottom of the submenu and choose another preset library.

4. Choose any other fill options you want to apply, such as Mode, Opacity, or Preserve Transparency.

For details on these options, see the section “Filling and Outlining Selections,” earlier in this chapter.

5. Click OK to fill the layer or selection with the chosen pattern.

Creating a new pattern

You may someday want to create your own pattern. Patterns can be easily created from any existing photo or painting you create in Elements. You can even scan your signature or logo, define it as a pattern, and use it with the Pattern Stamp tool to sign all your work.

To create your own pattern, follow these steps:

1. Open the photographic, painted, or scanned image that contains the area you want to use as a pattern.

2. Use the Rectangular Marquee tool to select the area you want to convert into a pattern.

Make sure that your Feather option is set to 0, or the pattern command won’t be available.

If you don’t make a selection, Elements uses your entire layer as a basis for the pattern.

3. Choose Edit ➪ Define Pattern from Selection or Edit ➪ Define Pattern.

The Pattern Name dialog box appears.
4. **Enter a name for your pattern.**

Your new pattern now appears in every Pattern panel, wherever it may lurk in Elements.

In addition to filling your selection with a pattern, you can stamp on a pattern with the Pattern Stamp tool. Press S to select the Pattern Stamp tool. If you get the Clone Stamp tool, press S again. Choose your desired pattern from the Pattern Picker drop-down menu and your desired brush tip from the Brush Preset Picker drop-down menu. Select your brush Size, Opacity, and Mode and then brush your pattern on your image. You can also select the Impressionist option to have your pattern appear more “painterly.”

---

**Creating Shapes of All Sorts**

In this section, we leave the land of pixels and head into uncharted territory — Vectorville. Before we discuss the ins and outs of creating shapes, here’s a little overview that explains the difference between pixels and vectors:

- **Pixel images describe a shape in terms of a grid of pixels.** When you increase the size of a pixel-based image, it loses quality and begins to look blocky, mushy, and otherwise nasty. For more details on resizing pixel-based images and the ramifications of doing so, see Chapter 4.

- **Vectors describe a shape mathematically.** The shapes comprise paths made up of lines, curves, and anchor points. Because vector shapes are math-based, you can resize them without any loss of quality whatsoever.

In Figure 12-16, you can see both types of images.

When you create a shape in Elements, you’re creating a vector-based element. Shapes reside on a special kind of layer called, not surprisingly, a *shape layer*. Use shapes to create simple logos, web buttons, and other small spot illustrations.
**Drawing a shape**

Elements offers an assortment of shape tools for you to choose from. Follow these steps to draw a shape in your document:

1. **Choose your desired shape tool from the Tools panel.**
   
   You can also press U to cycle through the shape tools. All the following tools have associated Geometry options, which are described in the section “Specifying Geometry options,” later in this chapter. Here are the available tools:
   
   - *Rectangle and Ellipse:* As with their Marquee counterparts, you can hold down the Shift key while dragging to produce a square or circle; hold down the Alt (Option on the Mac) key to draw the shape from the center outward.
   
   - *Rounded Rectangle:* This tool works like the regular Rectangle but with the addition of a radius value used to round off the corners of the rectangle.
   
   - *Polygon:* This tool creates a polygon with a specified number of sides, from 3 to 100.
   
   - *Star:* This tool creates a polygon or star with a specified number of sides/vertices, from 3 to 100.
   
   - *Line:* This tool draws a line with a width from 1 to 1,000 pixels. You can also add arrowheads at either end.
   
   - *Custom:* Custom is the most varied shape tool. You have numerous preset custom shapes to choose from. As with any shape, hold down Shift to constrain proportions or the Alt (Option on the Mac) key to draw from the center out.

2. **In the Tool Options, click the down-pointing arrow to access Geometry options.**
   
   By default, the option is set to Unconstrained. For detailed explanations on the various Geometry options, see the upcoming sections.

3. **If you chose the Custom Shape tool in Step 1, click the Custom Shapes Preset picker down-pointing arrow to access the pop-up Shapes panel and choose your desired shape.**
   
   You can access more preset shape libraries via the pop-up menu at the top of the panel.

4. **Select your desired color from the Color drop-down menu.**
   
   Click the color-wheel icon in the bottom-right corner to access the Color Picker for additional color choices.
5. Select a style from the Style picker drop-down panel.

To jazz up the shape with bevels and other fancy edges, choose a style from the panel. For more on styles, see Chapter 11.

6. Drag in the document to draw the shape you defined.

The shape appears in the image window on its own shape layer. Check out the Layers panel to see this phenomenon. Figure 12-17 shows our shape, a Japanese hairstyle, from the Dressup preset library, which we add to in the following section.

**Drawing multiple shapes**

After you create a shape layer, you can draw additional shapes on that layer. You can add, subtract, overlap, and intersect shapes in exactly the same way you do with selections. (See Chapter 7.) Just follow these steps:

1. **Select your desired state button in the Tool Options.**

   You can choose from the following options:
   - *New Shape Layer*: Creates your initial shape layer.
   - *Add to Shape Area*: Combines and joins two or more shapes.
   - *Subtract from Shape Area*: Subtracts one shape from another shape.
   - *Intersect Shape Areas*: Creates a shape from only the areas that overlap.
   - *Exclude Overlapping Shape Areas*: Creates a shape from only the areas that don’t overlap.

2. **Choose your desired shape tool and draw the next shape.**

   We completed the shape by adding the face, as shown in Figure 12-18.
### Specifying Geometry options

Geometry options help define how your shapes look. Click the down-pointing arrow in the Tool Options to access the Geometry options described in the sections that follow.

#### Rectangle and Rounded Rectangle Geometry options

Here are the Geometry options for the Rectangle and Rounded Rectangle shapes:

- **Unconstrained**: Enables you to have free rein to draw a rectangle at any size or proportion.
- **Square**: Constrains the shape to a perfect square.
- **Fixed Size**: Lets you draw rectangles in fixed sizes, as specified by your width and height values.
- **Proportional**: Allows you to define a proportion for the rectangle. For example, specifying 2W and 1H makes a rectangle twice as wide as it is high.
- **From Center**: Enables you to draw from the center out.
- **Snap**: Aligns the shape to the pixels on your screen.
- **Radius**: For Rounded Rectangles, applies the radius of a circle used to round off the corners. Note that this option is found in the Tool options itself, not in the Geometry options pop-up menu.

#### Ellipse geometry options

The Ellipse shape has the same options that are available for rectangles, except for the Snap option. The only difference is that, instead of being able to create a perfect square, you can create a perfect circle with the Circle option.

#### Polygon Geometry options

The Geometry options for the Polygon shape are as follows:

- **Sides**: Specify the number of sides for your polygon.
- **Smooth**: Corners: Round off the corners.

#### Star Geometry options

The Geometry options for the Star shape are as follows:

- **Sides**: Specify the number of points for your star.
- **Smooth**: Corners: Round off the inner corners of indented sides or round off the corners.
- **Smooth**: Indents: Determine the amount that the sides indent inward.
Chapter 12: Drawing and Painting

**Line Geometry options**
The line’s Geometry settings include whether to put arrowheads at the start or end of the line. You can also adjust the width, length, and concavity settings to change the arrowhead shapes.

**Custom Shape Geometry options**
The Custom Shape options are similar to those you find for the other shapes, but with a couple of unique options:

- **Defined Proportions:** Draws a shape based on the original proportions you used when you created it.
- **Defined Size:** Draws a shape based on its original size when you created it.

**Editing shapes**
You can edit shapes that you create by using a variety of tools and techniques. Here’s a list of the things you can do to modify your shapes:

- **Select.** Choose the Shape Selection tool to move one or more shapes in their layers. You can find this tool in the Tool Options along with the Shapes tools.
- **Move.** Choose the Move tool (press V) to move the entire contents of the shape layer.
- **Delete.** Select a shape with the Shape Selection tool and press Delete to remove it.
- **Transform shapes.** Choose the Shape Selection tool and select your shape. Choose Image ➪ Transform Shape and choose your desired transformation.
- **Change the color.** Double-click the thumbnail of the shape layer on the Layers panel. This action transports you to the Color Picker, where you can choose a new color.
- **Clone a shape.** Hold down the Alt (Option on the Mac) key and move the shape with the Move tool.

To convert your vector-based shape into a pixel-based shape, click the Simplify button in the Tool Options or choose Layer ➪ Simplify Layer. Note that you can’t edit a shape after you simplify it except to modify the pixels. But you can now apply filters to the layer. See Chapter 11 for more on fun with filters.
Working with Type

In This Chapter
▶ Understanding type basics
▶ Creating point, paragraph, and path type
▶ Setting type options
▶ Editing type
▶ Simplifying (rasterizing) type
▶ Masking with type
▶ Stylizing and warping type

Although we spout on in this book about how a picture says a thousand words, we would be terribly negligent if we didn’t at least give a nod to the power of the written word as well. You may find that you never need to go near the type tools. That’s fine. We won’t be offended if you skip right past this chapter.

Then again, you may have an occasional need to add a caption, a headline, or maybe even a short paragraph to an image. Although it’s by no means a word-processing or even page-layout program, Elements does give you ample tools for creating, editing, stylizing, and even distorting type.

Understanding Type Basics
Elements has seven type tools. Two of them are for entering horizontally oriented type, and two are for entering vertically oriented type. Don’t worry about the vertical type tools. Although you can use them, they’re really designed for the Asian market so users can enter Chinese and Japanese characters. The remaining three tools are for creating type on a selection, shape, or path.
Tools

The horizontal and vertical type tools are identical in their attributes, so we cover just the two horizontal type tools here. For the sake of simplicity, we call them the Type and Type Mask tools:

✓ **Type**: Use this tool to enter type. This type is created on its own type layer except when used in Bitmap mode or Indexed Color mode, neither of which supports layers.

We refer to layers a lot in this chapter, so if your layer knowledge is rusty, check out Chapter 8.

✓ **Type Mask**: This tool doesn’t create actual type; instead, it creates a selection border in the shape of the type you want to enter. The selection border is added to the active layer. You can do anything with a type selection that you can do with any other selection. (Chapter 7 is your one-stop guide to selections.)

The remaining three type tools all create type on a path in different ways:

✓ **Text On Selection**: This tool enables you to draw on your image to create a selection, similar to the Quick Selection tool. The selection converts into a path upon which you can then enter text, which flows along that path.

✓ **Text On Shape**: This tool enables you to draw any chosen shape from your shapes menu, upon which you then enter and apply your text.

✓ **Text On Custom Path**: This tool lets you draw any custom path that you desire on your image. Enter text on that custom path and it adheres to that path.

The three path type tools all create a type layer. Find out how to use these tools in the upcoming section, “Creating Path Type.”

A path has three components: anchor points, straight segments, and curved segments. The path essentially hovers above the image in its own “space,” thereby not altering or marking the image in any way. The path in this context is merely a track upon which the text can flow. You can alter the path to your liking by using the Refine Path option. Find out more in the later “Creating Path Type” section.

Modes

You can enter text in Elements in three different modes: point, paragraph, and path. Both the Type and Type Mask tools can enter either point or paragraph mode. Here’s a brief description of each mode (for the step-by-step process of creating the text, see the following sections):
Point: Use this mode if you want to enter only a few words. Select the Type tool, click in your image, and, well, type. The text appears while you type and continues to grow. In fact, it even continues past the boundary of your image!

Point type never wraps around to a new line. To wrap to the next line, you must press Enter (Return on a Mac).

Paragraph: Use this mode to enter longer chunks (or constrained blocks) of text on an image. Click and drag your type tool to create a text bounding box and then type. All the text is entered in this resizable bounding box. If a line of text is too long, Elements automatically wraps it around to the next line.

Path: Elements also offers the capability of placing text along a path via three unique type tools. Double-click the path and type; the text appears, adhering to the shape of the path.

**Formats**

Elements is capable of displaying and printing type in two formats. Each format has its pros and cons, and which format you use depends on your needs. Here’s the lowdown on both of them:

Vector: All text in Elements is initially created as vector type. Vector type provides scalable outlines that you can resize without producing jaggy edges in the diagonal strokes. Vector type remains fully editable and always prints with optimum quality, appearing crisp and clean. Vector type is the default type format in Elements, except for images in bitmap or Indexed color modes.

Raster: When Elements converts vector type into pixels, the text is rasterized. Elements refers to this rasterization process as simplifying. When text is simplified, it’s no longer editable as text but is converted into a raster image. You usually simplify your vector type when you want to apply filters to the type to produce a special effect or when you want to merge the type with the image. You can’t resize simplified type without losing some quality or risking jagged edges. For more details, see the section “Simplifying Type,” later in this chapter.

**Creating Point Type**

The majority of your type entry will most likely be in point type mode. Point type is useful for short chunks of text, such as headlines, labels, logos, and headings for web pages.
Point type is so called because it contains a single anchor point, which marks the starting point of the line of type. Remember that point-type lines don’t wrap automatically, as you can see in Figure 13-1.

Follow these steps to create point type:

1. Open the Photo Editor and choose Expert mode.
2. Open an image or create a new, blank Elements file (File ➪ New ➪ Blank File).
3. Select the Horizontal Type tool from the Tools panel.
   You can also press T to cycle through the various type tools. Additionally, you can also select the Horizontal Type tool from the Tool Options. It looks like a capital letter T.
4. On the image, click where you want to insert your text.
   Your cursor is called an I-beam. When you click, you make an insertion point.
   A small, horizontal line about one-third of the way up the I-beam shows the baseline (the line on which the text sits) for horizontal type.
5. Specify your type options from the Tool Options.
   All the options are described in detail in the section “Specifying Type Options,” later in this chapter.
6. Type your text and press Enter (Return on a Mac) to begin a new line.
   When you press Enter (or Return), you insert a hard return that doesn’t move.
7. When you finish entering the text, click the Commit button (the green check-mark icon) near your text. If you want to bail out, click the Cancel button (the red No icon).
   You can also commit the type by pressing Enter on the numeric keypad or by clicking any other tool on the Tools panel. A new type layer with your text is created. Type layers appear on your Layers panel and are indicated by the T icon.
Creating Paragraph Type

If you have larger chunks of text, it’s usually more practical to enter the text as paragraph type. Entering paragraph type is similar to entering text in a word-processing or page-layout program, except that the text is contained inside a bounding box. When you type and come to the end of the bounding box, Elements automatically wraps the text to the next line.

To enter paragraph type, follow these steps:

1. **Open the Photo Editor and choose Expert mode.**
2. **Open an image or create a new, blank Elements file.**
3. **Select the Horizontal Type tool from the Tools panel or press T to cycle through the various type tools.**
   
   You can also select the Horizontal Type tool from the Tool Options.
4. **On the image, insert and size the bounding box by using one of two methods:**
   
   - **Drag to create a bounding box close to your desired size.** After you release the mouse button, you can drag any of the handles at the corners and sides of the box to resize it.
   
   - **Hold down the Alt (Option on the Mac) key and click the image.** The Paragraph Text Size dialog box appears. Enter the exact dimensions of your desired bounding box. When you click OK, your specified box appears, complete with handles for resizing later.
5. **Specify your type options from the Tool Options.**
   
   Options are described in detail in the following section.
6. **Enter your text; to start a new paragraph, press Enter (Return on a Mac).**
   
   Each line wraps around to fit inside the bounding box, as shown in Figure 13-2.

   If you type more text than can squeeze into the text box, an overflow icon appears (box with a plus sign inside). Resize the text box by dragging a bounding box handle.
7. **Click the Commit button (the green check-mark icon) next to the text box or press Enter on the numeric keypad. If you’re not happy with the text, you can click the Cancel button (red No icon).**
   
   Elements creates a new type layer.
Paragraph type wraps automatically without your assistance, so there’s no need to enter a hard return as you type.

Figure 13-2: Paragraph type automatically wraps to fit within your bounding box.

Creating Path Type

If you want your type to flow in a circle, wave, stair step, or any other shape, you’re in luck. Elements provides three type tools that enable you to do just that. The great thing is that path type is easy to create, totally editable, and the type resides on its very own layer.

Using the Text On Selection tool

You can create path type by first creating a selection of your image, which is similar to the way you create a selection with the Quick Selection tool. Here’s how:

1. Open the Photo Editor and choose Expert mode.
2. Open an image or create a new, blank Elements file.
3. Select the Text On Selection tool from the Tools panel or press T to cycle through the various type tools.
   You can also select the Text On Selection tool from the Tool Options. It looks like a capital letter T with a dotted square around it.
4. On the image, “paint” (drag) over your desired selection.
5. Refine your selection by adding or subtracting from it in one of four ways:
• Press the Shift key and drag around the additional area that you want to include in your selection.

• Press the Alt (Option on the Mac) key and drag around the area that you want to subtract from your selection.

• Select the Add to Selection or Subtract from Selection buttons in the Tool Options and drag around your desired areas.

• In the Tool Options, drag the Offset slider right to expand, or left to contract, your selection.

You can specify additional options, which are common to all the type tools; these are described in detail in the later section, “Specifying Type Options.”

6. **When your selection is complete, click the Commit check-mark icon to convert your selection to a path.**

   If you want to start over, click the red Cancel (slashed circle) icon to do so.

7. **Position your mouse pointer over the path and, when the cursor icon changes to an I-beam (capital letter I with a crooked line crossing over), click the path and type your text.**

   The text wraps along the path. If you type more text than can fit on the path, an overflow icon appears. Resize the selection until all your text appears.

8. **When you’re done entering your text, click the Commit check-mark icon.**

   Elements creates a new type layer. You can edit any attributes, such as font and size, just as you can with point or paragraph text. See the upcoming section “Editing Text” for details.

**Using the Text On Shape tool**

The Text On Shape tool enables you to create type that flows along the perimeter of any shape. To do so, follow these steps:

1. **Open the Photo Editor and choose Expert mode.**

2. **Open an image or create a new, blank Elements file.**

3. **Select the Text On Shape tool from the Tools panel or press T to cycle through the various type tools.**

   You can also select the Text on Shape tool from the Tool Options. It looks like a capital letter T with a wavy box around it.
4. Select your desired shape from the shape options in the Tool Options.

5. Drag your tool over the image to create the shape.
   - To constrain your proportions, hold down the Shift key while dragging.
   - To draw from the center outward, hold down the Alt (Option on the Mac) key while dragging.

6. (Optional) Transform your shape by choosing Image ➤ Transform Shape and choosing your desired transformation.

   You can specify additional options, which are common to all the type tools; these are described in detail in the following section, “Specifying Type Options.”

   For details on transformations, see Chapter 8.

7. Position your mouse pointer over the path and, when the cursor icon changes to an I-beam (capital letter I with a crooked line crossing over), click the path and type your text.

   The text wraps along the shape’s path, as shown in Figure 13-3.

   If you type more text than can fit on the path, an overflow icon appears. Adjust the path until all your text appears.

8. When you’re done entering your text, click the Commit check-mark icon. If you want to start over, click the red Cancel icon.

   Elements creates a new type layer. You can edit any attributes, such as font and size, just as you can with point or paragraph text. See the section “Editing Text” for details.

   You can also refine your shape path by using the Refine Path tool (labeled “Modify”), which appears in the Tool Options when the Text On Custom Path tool is selected. Just be sure that you have your type layer selected before working with this option.
Using the Text On Custom Path tool

If you want to create your own path or shape as the basis for your type, the Text On Custom Path tool is for you. Here’s how:

1. Open the Photo Editor and choose Expert mode.
2. Open an image or create a new, blank Elements file.
3. Select the Text On Custom Path tool from the Tools panel or press T to cycle through the various type tools.
   
   You can also select the Text On Custom Path tool from the Tool Options. It looks like a capital letter T on a line.
4. Drag your tool over the image to create the custom path of your choice.
5. Refine your path by selecting the Refine Path option (labeled “Modify”) in the Tool Options. Drag the anchor points or path segments with the tool to get your desired shape.
   
   You can also transform your custom path by choosing Image ➤ Transform Shape. For details on transformations, see Chapter 8.
   
   You can specify additional options, which are common to all the type tools; these are described in detail in the following section, “Specifying Type Options.”
6. Position your mouse pointer over the path and, when the cursor icon changes to an I-beam (capital letter I with a crooked line crossing over), click the path and type your text.
   
   The text wraps along the shape’s path.

   If you type more text than can fit on the path, an overflow icon appears. Adjust the path as needed so all the text appears.
7. When you’re done entering your text, click the Commit check-mark icon or click the red Cancel icon to start again.
   
   Elements creates a new type layer. You can edit any attributes, such as font and size, just as you can with point or paragraph text. See the section “Editing Text” for details.
8. To create a new custom path, select the background layer and repeat Steps 3 through 7.
Specifying Type Options

When you’re using a Type tool, the Tool Options (found at the bottom of the workspace) includes several character and paragraph type settings, as shown in Figure 13-4. These options enable you to specify your type to your liking and pair it with your images.

Figure 13-4: Specify your type options, such as font family and size, before you type.

Here’s an explanation of each available option in the Tool Options:

- **Font Family:** Select the font you want from the drop-down list. Elements provides a WYSIWYG (What You See Is What You Get) font menu. After each font name, the word *Sample* is rendered in the actual font — no more selecting a font without knowing what it really looks like.

  You also find one of these abbreviations before each font name to let you know what type of font it is:
  - *a:* Adobe Type 1 (PostScript) fonts
  - *TT:* TrueType fonts
  - *O:* OpenType fonts

  Fonts with no abbreviation are bitmapped fonts.

- **Font Style:** Some font families have additional styles, such as light or condensed. Only the styles available for a particular font appear in the list. This is also a WYSIWYG menu.

- **Font Size:** Select your type size from the drop-down list or just type a size in the text box. Note that type size is most commonly measured in points (where 72 points equals about 1 inch at a resolution of 72 ppi). You can switch to millimeters or pixels by choosing Edit ➪ Preferences ➪ Units & Rulers (on the Mac, Adobe Photoshop Elements Editor ➪ Preferences ➪ Units & Rulers).

- **Text Color:** Click the color swatch to select a color for your type from the Color Picker. You can also choose a color from the Swatches panel.
Chapter 13: Working with Type

✓ **Leading**: Leading (pronounced *LED-ding*) is the amount of space between the baselines of lines of type. A *baseline* is the imaginary line on which a line of type sits. You can choose Auto Leading or specify the amount of leading to apply. When you choose Auto Leading, Elements uses a value of 120 percent of your type point size. Therefore 10-point type gets 12 points of leading. Elements adds that extra 20 percent so that the bottoms of the lowest letters don’t crash into the tops of the tallest letters on the line below them.

✓ **Text Alignment**: These three options align your horizontal text on the left or right, or in the center. If you happen to have vertical text, these options rotate 90 degrees clockwise and change into top, bottom, and center vertical settings.

✓ **Anti-aliasing**: Select this option to slightly smooth out the edges of your text. The Anti-aliasing option softens that edge by 1 pixel, as shown in Figure 13-5. For the most part, you want to keep this option turned on. The one occasion in which you may want it turned off is when you’re creating small type to be displayed onscreen, such as on web pages. The soft edges can sometimes be tough to read.

✓ **Faux Bold**: Use this option to create a fake bold style when a real bold style (which you’d choose under Font Style) doesn’t exist. Be warned that, although the sky won’t fall, applying faux styles can distort the proportions of a font. You should use fonts with real styles, and if they don’t exist, oh well.

✓ **Faux Italic**: This option creates a phony oblique style and carries the same warning as the Faux Bold option.

✓ **Underline**: This setting (obviously) underlines your type, like *this*.

✓ **Strikethrough**: Choose this option to apply a strikethrough style to your text.

✓ **Style**: Click this option to access a drop-down panel of preset layer styles that you can apply to your type. Note that this option is accessible after you have committed your type. For more on this option and the Create Warped Text option (described in the last bullet), see the section “Stylizing and Warping Type,” later in this chapter.

Figure 13-5: The Anti-aliasing option softens the edges of your type.
**Editing Text**

To correct typos, add and delete type, or change any of the type options, simply follow these steps:

1. **Select the Type tool from the Tools panel.**
2. **Select your desired type layer on the Layers panel or click within the text to automatically select the type layer.**
3. **Make any changes to your text:**
   - Change the font family, size, color, or other type option. If you want to change all the text, simply select that type layer on the Layers panel. To select only portions of the text, highlight the text by dragging across it with the I-beam of the Type tool. Then select your changes in the Tool Options; see the section “Specifying Type Options” earlier in this chapter for details about your options for the Type tool.
   - Delete text. Highlight the text by dragging across it with the I-beam of the Type tool. Then press the Backspace key (Delete on the Mac).
   - Add text. Make an insertion point by clicking your I-beam within the line of text. Then type your new text.

Note that these editing steps apply to all types of text — point, paragraph, and path.

4. **When you’re done editing your text, click the Commit check-mark icon.**

You may also occasionally need to transform your text. To do so, make sure that the type layer is selected on the Layers panel. Then choose Image ➪ Transform ➪ Free Transform. Grab a handle on the bounding box and drag to rotate or scale. Press Ctrl (§ on the Mac) and drag a handle to distort. When you’re done, double-click inside the bounding box to commit the transformation. For more details on transformations, see Chapter 8.

For path type, applying the transformation command enables you to change the shape of your path but not the actual type itself. When you double-click the bounding box, the type will then rewrap along the transformed path.
**Simplifying Type**

As we explain in the section “Understanding Type Basics” earlier in this chapter, Elements can display and print type in two different formats: vector and raster.

As long as you keep type in a vector format on a type layer, you can edit and resize that type all day long.

Occasionally, however, you may need to simplify your type — to convert your type into pixels. After it’s simplified, you can apply filters, paint on the type, and apply gradients and patterns. If you’re working with layers and flatten your image (merge your layers into a single background image), your type layer is also simplified and merged with the other pixels in your image. By the way, if you try to apply a filter to a type layer, Elements barks at you that the type layer must be simplified before proceeding and gives you the opportunity to click OK (if you want to simplify) or Cancel.

To simplify your type, select the type layer on the Layers panel and choose Layer ➪ Simplify Layer. Your type layer is then converted (the T icon disappears) into a regular layer on which your type is now displayed as pixels against a transparent background, as shown in Figure 13-6.

To avoid having to re-create your type from scratch, make all necessary edits before simplifying. This includes sizing your text. After you simplify your type, you can’t resize your text without risking the dreaded jaggies. The other downside to remember about simplified type is that although it looks identical to vector type onscreen, it never prints as crisply and cleanly as vector type. Even at higher-resolution settings, a slight jagged edge always appears on simplified type. So, if you’re experimenting with painting or filters on your type, just make a duplicate of your type layer before simplifying it and then hide that layer.

**Masking with Type**

Using the Type Mask tool epitomizes the combination of type and image. Unlike the Type tool, the Type Mask tool doesn’t create a new layer. Instead, it creates a selection on the active layer. Type Mask is the tool of choice for filling text with an image or cutting text out of an image so that the background shows through, as shown in Figure 13-7.
Figure 13-7: The Type Mask tool enables you to cut type out of solid color or image layers.

A selection is a selection no matter how it was created. So, even though type mask selections look like letters, they act like selections. You can move, modify, and save them.

Here are the steps to create a type mask:

1. **In the Photo Editor in Expert mode, open the image of your choice.**
   
   We selected a stone texture.

2. **Convert your background into a layer by double-clicking the word Background on the Layers panel, and then click OK.**
   
   This step enables you to jazz up the type with styles later on.

3. **Choose the Horizontal Type Mask tool from the Tools panel.**

4. **Specify your type options (such as font family, style, and size) in the Tool Options.**

5. **Click the image, and type your desired text. When you’re done, click the Commit check-mark icon.**
   
   A selection border in the shape of your type appears on your image.

6. **Choose Select ➪ Inverse, which deselects your letter selections and selects everything else.**
7. Press the Backspace (Delete on a Mac) key to delete everything outside your selection border.

Your type is now filled with your image.

8. Choose Select ➪ Deselect.

9. Experiment with applying layer styles to your type.
   a. Choose Window ➪ Effects or click the Effects button at the bottom of the workspace (assuming you’re in Basic Workspace). If you need to get back to the Basic Workspace, click the arrow on the More button in the bottom-right corner of the workspace and choose Basic Workspace from the submenu.
   b. Click the Styles button located at the top of the Effects panel.
   c. Select the type of layer styles you desire from the drop-down menu at the top of the panel, such as Drop Shadows or Bevels.
   d. Double-click the exact style you want. We used a drop shadow and a simple inner bevel in Figure 13-8. See Chapter 11 for more about layer styles.

If you want to admire your type against a solid background, as we did, create a new layer, choose Edit ➪ Fill Layer, and then choose your desired color from the Use drop-down menu.

Figure 13-8: Fill type with imagery by using the Type Mask tool.

Stylizing and Warping Type

If you’ve tried your hand at creating a type mask, you know that Elements is capable of much more than just throwing a few black letters at the bottom of your image. With a few clicks here and there, you can warp, distort, enhance, and stylize your type. If you’re not careful, your creative typography can outshine your image.
Adjusting type opacity

If you checked out Chapter 8 before reading this chapter, you know that layers are a digital version of the old analog transparency sheets. You can change element opacity on layers to let the underlying layer show through in varying degrees. This is also possible on a type layer. Figure 13-9 shows how varying the opacity percentage of your type layer makes more of the underlying layer show through. In Figure 13-9, the underlying layer is an image of water.

To change the opacity of a type layer, simply select the layer on the Layers panel, click the arrow to the right of the Opacity percentage, and drag the slider. The lower the percentage, the less opaque the type (and the more the underlying layer shows through).

Applying filters to your type

One of the most interesting things you can do with type in Elements that you can’t do in a word-processing or page-layout program is apply special effects, such as filters. You can make type look like it’s on fire, underwater, or on the move — as shown in Figure 13-10, where we applied a motion blur.

The only caveat is that type has to be simplified before a filter can be applied. Be sure to do all your text editing before you move to the filtering stage.

Applying the filter is as easy as selecting the simplified type layer on the Layers panel and choosing a filter from the Filter menu. For more on filters, see Chapter 11.
Painting your type with color and gradients

Changing the color of text is as easy as highlighting it and selecting a color from the Color Picker. But what if you want to do something a little less conventional, such as apply random brush strokes of paint across the type, as we did in the top image shown in Figure 13-11? It’s really easier than it looks. Again, as with applying filters to text, the only criterion is that the type has to be simplified first. After that’s done, select a color, grab the Brush tool with settings of your choice, and paint. In our example, we used the Granite Flow brush, found in the Special Effect Brushes presets. We used a diameter of 39, 15, and 6 pixels and just swiped our type a few times.

If you want the color or gradient to be confined to the type area, select the text by either Ctrl-clicking (⌘-clicking on a Mac) the layer containing the text or locking the layer’s transparency on the Layers panel.

You can also apply a gradient to your type. Here are the steps to follow after simplifying your type:

1. Select the Gradient tool from the Tools panel.
2. In the Tool Options, click the down-pointing arrow next to the Gradient Picker to access the Gradient Picker panel.
3. Choose your desired gradient.
   If you want to create a custom gradient, find out how in Chapter 12.
4. Position your gradient cursor on the text where you want your gradient to start; drag to where you want your gradient to end.
   Don’t like the results? Drag again until you get the look you want. You can drag at any angle and to any length, even outside your type. In the bottom image shown in Figure 13-11, we used the copper gradient and just dragged from the top of the letters to the bottom. We also locked the transparent pixels on the layer to confine the gradient to just the type area.
Warping your type

If horizontal or vertical text is just way too regimented for you, try the Warp feature. The best part about the distortions you apply is that the text remains fully editable. This feature is fun and easy to use. Click the Create Warped Text button at the far right of the Tool Options. (It’s the T with a curved line below it.) This action opens the Warp Text dialog box, where you find a vast array of distortions on the Style drop-down menu with descriptive names such as Bulge, Inflate, and Squeeze.

After selecting a warp style, you can adjust the orientation, amount of bend, and degree of distortion by dragging the sliders. The Bend setting affects the amount of warp, and the Horizontal and Vertical Distortions apply perspective to that warp. Luckily, you can also view the results while you adjust. We could give you technical explanations of these adjustments, but the best way to see what they do is to just play with them. See Figure 13-12 to get a quick look at a few warp styles. The names speak for themselves.

You can also use the Transform command, such as scale and skew, to manipulate text. See Chapter 8 for details on transforming.

Figure 13-12: Text remains fully editable after you apply distortions with the Warp command.
Part V
Printing, Creating, and Sharing

Learn how to create a calendar at www.dummies.com/extras/photoshopelements12.
In this part . . .

- Manage color, use color profiles, and get your output to closely match your screen view.
- Print your pictures.
- Share your pictures with family and friends using social media and online sharing services.
- Display your photos in photo books, greeting cards, calendars, and slide shows.
Perhaps the greatest challenge when using programs such as Photoshop Elements (and even the professionals who use its granddaddy, Adobe Photoshop) is getting what you see on your monitor to render a reasonable facsimile on a printed page. You can find all sorts of books on color printing — how to get color right, how to calibrate your equipment, and how to create and use color profiles — all for the purpose of getting a good match between your computer monitor, your printer, and the paper used to print your output. It’s downright discouraging to spend a lot of time tweaking an image so that all the brilliant blue colors jump out on your computer monitor, only to find that all those blues turn to murky purples when the photo is printed.

If you read Chapters 3 and 4, you’re ahead of the game because you know a little bit about color management, color profiles, and printer resolutions. After you check out those chapters, your next step is to get to know your printer and understand how to print your pictures correctly.

In this chapter, we talk about options — many options — for setting print attributes for printing to your own color printer. If you need to, reread this chapter a few times just to be certain that you understand the process for printing good-quality images. A little time spent here will, we hope, save you some headaches down the road.
Part V: Printing, Creating, and Sharing

Getting Pictures Ready for Printing

The first step toward getting your photos to your desktop printer is to prepare each image for optimum output. You have several considerations when you’re preparing files, including the ones in this list:

- **Set resolution and size.** See your printer’s documentation to find out what resolution the manufacturer recommends. As a general rule, 200 to 300 ppi (pixels per inch) works best for most desktop printers printing on high-quality paper. If you print on plain paper, you often find that lower resolutions work just as well or even better. Chapter 4 explains setting size and resolution in detail.

- **Make all brightness and color corrections before printing.** Make sure that your pictures appear their best before sending them off to your printer. If you have your monitor properly calibrated, as we discuss in Chapter 3, you should see a fair representation of what your pictures will look like before you print them. Chapters 9 and 10 cover corrections.

- **Decide how color will be managed before you print.** You can color-manage output to your printer in three ways, as we discuss in the next section. Know your printer’s profiles and how to use them before you start to print your files.

- **Get your printer ready.** When printing to desktop color printers, always be certain your ink cartridges have ink and the nozzles are clean. Make sure you use the proper settings for paper and ink when you send a file to your printer. Be sure to review the manual that came with your printer so you know how to perform all the steps required to make a quality print.

Various sources offer alternatives for purchasing inks. You can purchase third-party inks for your printer, use refillable ink cartridges, or have your printer modified to hold large ink tanks that last much longer than the manufacturer-supplied cartridges. These alternatives provide you with significant savings when purchasing inks.

However, using any inks other than manufacturer-recommended inks can produce color problems. Each developer provides printer profiles specific for their recommended inks. With third-party inks, you don’t have the advantage of using color profiles that have been tested by a printer manufacturer. If getting the most accurate color on your prints is important to you, use only those inks and papers recommended by your printer manufacturer.
Working with Color Printer Profiles

In Chapter 3, we talk about creating color profiles for your monitor and selecting a color workspace. The final leg in a color-managed workflow is to convert color from your color workspace profile to your printer’s color profile. Basically, this conversion means that the colors you see on your monitor in your current workspace are accurately converted to the color that your printer can reproduce. To print accurate color, a color profile designed for your printer and the paper you use needs to be installed on your computer.

You can manage color in Photoshop Elements in three ways when it comes time to print your files:

✓ **Printer Manages Colors.** This method permits your desktop color printer to decide which profile to use when you print your photo. Your printer makes this decision according to the paper you select. If you choose Epson Premium Glossy Photo Paper, for example, your printer chooses the profile that goes along with that particular paper. If you choose another paper, your printer chooses a different color profile. This method is all automatic, and color profile selection is made when you print your file.

✓ **Photoshop Elements Manages Colors.** When you make this choice, color management is taken out of the hands of your printer and is controlled by Elements. You must choose the color profile. If color profiles are installed by your printer, you can choose a color profile from the list of profiles that match your printer and the paper source.

✓ **No Color Management.** You use this choice if you have a color profile embedded in one of your pictures. You’ll probably rarely use this option. Unless you know how to embed profiles or receive files with embedded profiles from other users, don’t make this choice in the Print dialog box. Because very few Elements users work with files with embedded profiles, we skip covering this method of printing your files.

Each of these three options requires you to decide how color is managed. You make choices (as we discuss later in this chapter when we walk you through the steps for printing) about whether to color-manage your output. These selections are unique to the Print dialog box and more specifically to the More Options dialog box for your individual printer.

Color profiles are also dependent upon the ink being used, and refilling cartridges with generic ink can (in some cases) result in colors shifting. Similarly, if the nozzles aren’t clean and delivering ink consistently, you may see very strange results.
Part V: Printing, Creating, and Sharing

Printer color profiles

Color profiling has been developed quite well by the three top desktop color printer developers (Epson, HP, and Canon). You can find a wealth of information on the Internet for using color profiles with each of these printers. For starters, take a look at the following URLs for more information about printing using color profiles:

**Epson Printers**


**HP Printers (Windows)**


**HP Printers (Mac)**

http://h20000.www2.hp.com/bizsupport/TechSupport/Document.jsp?objectID=c00284884&lang=en&cc=us&taskId=135&contentType=SupportFAQ&prodSeriesId=1129389

**Canon Printers**


Printing a photo with the printer managing color

Without going into all the settings you have to choose from in the Print and More Options dialog boxes, for now we look at printing a photo and letting the printer manage color. We explain more print options that are available later in this chapter in the section “Exploring Other Print Options.”

The color management options are different in Windows between the Print dialog box in the Organizer and Photo Editor. Always print your files from the Photo Editor to make use of all the color-management options available in the More Options dialog box.

For the following example, we use an Epson printer. If you have a different printer, some of the dialog boxes and terms may appear different. With a little careful examination of the Print dialog box, you should be able to apply the following steps for any printer:

1. **With a photo open in the Photo Editor, choose File→Print or press Ctrl+P (⌘+P on the Mac).**
The Print dialog box that opens contains all the settings you need to print a file, as shown in Figure 14-1.

2. Click Page Setup at the bottom of the Print dialog box and select the orientation of your print. Click OK.
   Your orientation choices are Portrait and Landscape. After you click OK, you return to the Print dialog box.

3. Choose your printer from the Select Printer drop-down menu.

4. Set the print attributes.
   Select the paper size, type of print, print size, and number of copies you want. (Note the items shown in Figure 14-1.)

5. Click More Options and click Color Management from the list on the left in the More Options dialog box.
   In the Color Management area, shown in Figure 14-2, choose how to manage color when you print files.

**Figure 14-1:** The Print dialog box.
6. **From the Color Handling drop-down menu, choose Printer Manages Colors.**

   This choice uses your current workspace color — either sRGB or Adobe RGB (1998) — and later converts the color from your workspace to the printer output file when you open the Print dialog box. (We introduce color workspaces in Chapter 3.)

7. **Set the printer preferences.**

   **Windows:** Click the Printer Preferences button in the More Options dialog box. The printing preferences dialog box for your printer driver opens, as shown in Figure 14-3. Proceed to Step 8.

   Note that you can also click OK in the More Options dialog box and click the Change Settings button (item 2 in the right panel of the Print dialog box) to open the same printer preferences dialog box.

   **Mac:** You don’t have a Printer Preferences button in the More Options dialog box, and there is no Change Settings button in the Print dialog box.

   First, set the color settings in the More Options dialog box. Then set color management.

   a. **Click OK.**

   b. **Click Print.**
Chapter 14: Getting It on Paper

Figure 14-3: Click Preferences in the first dialog box that opens, and the selected printer preferences dialog box opens.

The OS X Print dialog box opens. You need to make two choices here.

- Open the drop-down menu below the Pages item in the Print dialog box and choose Print Settings, as shown in Figure 14-4.
- From the Media Type drop-down menu, choose the paper for your output.
• To set color management:

a. Open the Print Settings drop-down menu and choose Color Management, as shown in Figure 14-5. Make sure the default setting of Color Controls is selected; this setting is used when the printer manages color.

b. Click Print.
8. (Windows only) Set print attributes from your printer’s dialog box.

Select a paper type, such as Epson Premium Glossy (or another paper from the Type drop-down menu that you may be using; refer to Figure 14-3). Then click the Best Photo radio button.

Now it’s time to color-manage your file. This step is critical in your print-production workflow.

9. (Windows only) Click the Advanced tab.

The Printing Preferences dialog box opens, displaying advanced settings, as shown in Figure 14-6.

![Figure 14-6: Click the Advanced tab.](image)

10. (Windows only) Make your choices in the advanced printing preferences dialog box.

Here are the most important choices:

- **Select a paper type.** In this example, we printed a letter-size photo on Epson Premium Glossy paper, so we chose those settings in the Paper & Quality Options section of the dialog box. Choose the same paper here as you did in Step 8.
Part V: Printing, Creating, and Sharing

- **Turn on color management.** Because you’re letting the printer driver determine the color, you need to be certain that the Color Controls radio button is active. This setting tells the printer driver to automatically select a printer profile for the paper type you selected.

- **Set the color mode.** Don’t use Epson Vivid. This choice produces inferior results on photos. Choose Best Photo, the Epson Standard, or Adobe RGB, depending on your printer.

If you frequently print files using the same settings, you can save your settings by clicking the Save Setting button.

11. **(Windows only)** To print the photo, click OK and then click OK again in the Print dialog box.

Your file is sent to your printer. The color is converted automatically from your source workspace of sRGB or Adobe RGB (1998) to the profile the printer driver automatically selects for you.

**Printing a photo with Elements managing color**

Another method for managing color when you’re printing files is to select a printer profile from the available list of color profiles installed with your printer. Whereas in the preceding section you used your printer to manage color, this time you let Photoshop Elements manage the color.

The steps in this section are the same as the ones described in the preceding section (for printing files for automatic profile selection) when you’re setting up the page and selecting a printer. To let Elements handle the color conversion, follow these steps:

1. **Choose File > Print from the Photo Editor.** In the Print dialog box, click More Options to open the More Options dialog box.

2. **Click Color Management in the left pane to display the color-management options.** Click Photoshop Elements Manages Colors.

3. **From the Printer Profile drop-down menu, choose the color profile designed for use with the paper you’ve chosen.**

In this example, we use a profile designed for a specific printer, as shown in Figure 14-7. (Note that custom color profiles you acquire from a profiling service come with recommended color-rendering intents. For this paper, Relative Colorimetric is recommended and is selected on the Rendering Intent drop-down menu, as shown in Figure 14-7.)
4. Click the Printer Preferences button.

You arrive at the same dialog box shown in Figure 14-3. On the Mac, you arrive at the same dialog box shown in Figure 14-4.

5. Choose a paper.

- In Windows, click the Best Photo radio button. From the Type drop-down menu, select the recommended paper choice.

- On the Mac, make your paper choice as shown in Figure 14-4.

Custom color profiles are also shipped with guidelines for selecting proper paper.

6. Go to the Advanced settings.

- In Windows, click the Advanced tab and click Continue to arrive at the same dialog box shown earlier in Figure 14-6.

- On the Mac, choose Color Management from the pop-up menu to arrive at the same dialog box shown in Figure 14-5.

The paper choice selection is automatically carried over from the previous Properties dialog box; refer to Figure 14-6. The one setting you change is in the Color Management section.

7. Choose color management.

- In Windows, select the ICM (Image Color Management) radio button and select the Off (No Color Adjustment) check box, as shown in Figure 14-8.

- On the Mac, select the Off (No Color Adjustment) radio button. (Refer to Figure 14-5.)

8. After making all the color-management choices, click OK to return to the Print dialog box.

9. Click Print, and the file is printed to your printer.

Because you selected the color profile in Step 3 and you’re letting Elements manage the color, be sure the Color Management feature is turned off. If you don’t turn off Color Management, you end up double-profiling your print.
Part V: Printing, Creating, and Sharing

Deciding whether to manage color is simplified in Photoshop Elements. In the Color Management area of the dialog box, a message appears each time you make a selection from the Color Handling drop-down menu. Right below the Rendering Intent drop-down menu, you see a message asking whether you remembered to turn color management on or off. Each time you make a selection for the color handling, pause a moment and read the message (shown earlier in Figure 14-7). This is your reminder that you need to follow the recommendation to properly handle color.

Each time you print a file — whether it be a single photo, a contact sheet, a photo package, or other type of print — you use the same steps for color management. In the next section, we talk about a number of options you have for printing photos, but remember that you need to manage the color for each type of print you want.

Getting Familiar with the Print Dialog Box

Because the Print dialog box options are identical in the Organizer and the Photo Editor in Windows (with the exception for color profile management), you find the same menus and buttons when you choose File→Print from either the Organizer or Photo Editor. On the Mac, inasmuch as you can choose File→Print in the Organizer, the actual printing is only available in the Photo Editor.

The following are the individual items you find in either dialog box (see Figure 14-9):
Figure 14-9: The Print dialog box gives you plenty of options.

A. **Image Thumbnails:** When you select multiple images in the Organizer, all the selected images appear in a scrollable window on the left side of the dialog box.

B. **Scroll bar:** When so many photos are selected that they all cannot be viewed in the thumbnail list on the left side of the dialog box, you can use the scroll bar to see all images.

C. **Add/Remove:** If the Print dialog box is open and you want to add more photos to print, click the Add (+) icon to open the Add Photos dialog box. A list of thumbnails appears, showing all photos in the current open catalog. Select the check boxes adjacent to the thumbnails to indicate the photos you want to add to your print queue. You can also choose an entire catalog, albums, photos marked with keyword tags, and photos that have a rating.
If you want to remove a photo from the list to be printed, click the photo in the scrollable list in the Print dialog box and click the Remove (–) icon.

D. **Help:** Click the Help button to open help information pertaining to printing photos.

E. **Page Setup:** Click this button to open the Page Setup dialog box. See “Using Page Setup,” later in this chapter.

F. **More Options:** Click More Options to open another dialog box that allows you to choose additional options. (See the section “Using More Options,” later in this chapter.)

G. **Scroll Print Preview:** Click the arrows to go through a print preview for all images in the list. Move the slider to zoom photos in the Print Preview.

H. **Print Preview:** This image displays a preview of the image to be printed.

I. **Print:** Click Print after making all adjustments in the Print dialog box.

J. **Cancel:** Clicking Cancel dismisses the dialog box without sending a photo to the printer.

K. **Select Printer:** Choose a target printer from the drop-down menu.

L. **Printer Settings (Windows only):** Click this button to open properties unique to the selected printer.

M. **Select Paper Size:** Choose from print sizes that your printer supports. This list may change when you choose a different printer from the Select Printer drop-down menu.

N. **Select Type of Print:** In Windows, you have three options available — Print Individual Prints, Contact Sheets, and Picture Packages. On the Mac, these options appear as separate menu commands in the File menu in Expert mode. For more information on contact sheets and picture packages, see the section “Exploring Other Print Options,” later in this chapter.

O. **Select Print Size:** Select from the print size options that your printer supports.

P. **Crop to Fit:** Select this check box to crop an image to fit the selected paper size.

Q. **Print __ Copies of Each Image:** By default, one copy is printed. You can choose to print multiple copies by entering the number you want in the text box.
Using Page Setup

When you click the Page Setup button in the Print dialog box, the Page Setup dialog box opens. In this dialog box, you can select print attributes that may be specific to your printer. However, you can control the options for most desktop printers in the Print dialog box.

Using More Options

When printing photos from the Organizer or Photo Editor (Windows) or Photo Editor only (Mac), click the More Options button in the Print dialog box. The More Options dialog box opens; refer to Figure 14-2.

If you’ve used Photoshop Elements prior to version 8, these three items moved from the Print dialog box to the More Options dialog box (refer to Figure 14-2):

- **Printing Choices**: Similar to what was available in earlier versions of Elements.
- **Custom Print Size**: Various settings for the output size.
- **Color Management**: Handles color profile selection and color management options.

When you want to manage color in Elements, as we explain earlier in the section “Working with Color Printer Profiles,” you need to open the More Options dialog box.

The default selection is Printing Choices when you open the More Options dialog box. Choices available for printing your photos include the following:

- **Photo Details**: Select the check boxes for the detail items you want printed as labels on your output.
- **Iron-on Transfer**: This option is used for heat-transfer material such as Mylar, LexJet, and other substrates that require E-down printing (*emulsion-down* printing, where the negative and the image are flipped).
- **Border**: Select the check boxes to print a border on the photo prints.
- **Trim Guidelines**: Select the Print Crop Marks check box to print crop marks.
Exploring Other Print Options

The basic principles of color management are used each time you send a file to your printer, but you don’t have to stick to the basics. In the preceding sections, we talk about printing a single photo with basic settings. However, Elements provides you with choices for printing multiple pictures at a time. You also have options for printing files without borders, as well as a number of choices for printing photos with decorative frames, picture packages, and contact sheets.

In the Organizer or Expert Photo Edit mode, you can choose to print multiple images as either a contact sheet or picture package. From within Expert Photo Edit mode in Windows, when you choose to print a contact sheet or picture package, Elements switches you to the Organizer. You then proceed in the Organizer and leave Expert Photo Edit mode.

As an example, look at Figure 14-10. In the Print dialog box, we chose Picture Package from the Select Type of Print drop-down menu, and we added an Antique Oval frame. Elements displays a preview of your choices in the Preview pane.
Sharing Your Work

In This Chapter
▶ Understanding packaging and sharing options
▶ Using Adobe Revel
▶ Sending e-mail attachments
▶ Working with video
▶ Creating files for web viewing

Elements is a great packaging tool that can deploy your photos and projects for screen viewing — and not just on your computer monitor. You can edit photos or assemble creations that are exported for web viewing, and you can even prepare files to show on your television.

In Chapter 4, you can find out about resolutions and color modes. In Chapter 14, we cover the output requirements for printing files, which are much different from what you use for screen viewing.

In this chapter, we cover the options for web and screen viewing that get you started with the basics, including saving images for the web (or for screen viewing), as online slideshows, sharing files on social networks such as Adobe Revel and Facebook, and in Windows burning your images on CDs or DVDs.

Getting Familiar with the Elements Sharing Options

Before you delve into making creations for screen viewing in Chapter 16, you should be familiar with your available options for not only screen images but also sharing — particularly online sharing services. You also need to be familiar with the acceptable standards for online hosts, where you eventually expect to send your creations, and the kinds of devices people are likely to use to view your creations.
Planning ahead

Before you choose a sharing activity and ultimately begin work on a creation, you need to ask a few questions:

✓ What device(s) are going to display my creations? When it comes to viewing photos and movies, you have choices that include computers (including desktops, notebooks, and netbooks), handheld devices such as cellphones and tablets (such as the Apple iPad and Samsung Galaxy), and TVs. If you want your creations to be viewable on all devices, you need to use different Elements tools and file formats than you would use for showing creations exclusively on a TV or on a computer.

Consider two factors regarding devices and viewing your creations:

- Adobe Flash: Some online hosts convert your video uploads to Adobe Flash. If you want to share photos with iPhone/iPod/iPad users (several hundred million and counting), stay away from any host that supports Flash-only conversions.

- Storage space: Hosts vary greatly in terms of space allocated for storing content. If you want to share large video files, be certain the storage host you choose allocates enough storage space to permit you to upload your files.

✓ What storage hosts are the most popular? From within Photoshop Elements, you can export photos directly to Facebook, Flickr, Adobe Revel, or SmugMug. For videos, you have direct support for YouTube and Vimeo.

In Elements 12, you also have a direct link to Twitter. Twitter is increasing its support for hosting photos.

✓ What types of creations can I share? Obviously, you can upload individual photos to any one of the online services. You can use the Share panel and choose to share directly to Flickr, Facebook, SmugMug, YouTube, Vimeo, Twitter, and Adobe Revel. In addition to uploading single photos to a service, some of the creations you might want to share include the following:

- Albums: You can create photo albums and share the albums on many different sites.

- Slide shows: In Windows, you can create a slide show and choose to export the slide show as a movie file (.wmv) or a PDF. On the Mac, you’re limited to PDF only. If you use Windows, export to .wmv and upload your file to an online host. If you use Facebook, all devices show your creations. Slide shows have an additional benefit in supporting audio files. You can add audio to the creations, and the audio plays on all devices if you upload them to Facebook.
Chapter 15: Sharing Your Work

- **Videos:** If you want to host videos on your own website and make the videos available to iPhone/iPod/iPad users as well as computer users, you need a little help from Adobe Premiere Elements. In Premiere Elements, you can export video for mobile devices, and the resultant file can be viewed on an iPhone/iPod/iPad as well as a computer. Also, Premiere Elements supports some of the services on the Mac that you don’t have available in Photoshop Elements, such as slide shows exported as movie files.

**Understanding social media websites**

Not all sharing providers are directly linked to Photoshop Elements. There are many more social media sharing providers than those you find in the Elements Share panel. You can always make creations and manually upload creations, photos, and videos to many other services. A list of the more popular websites is shown in Table 15-1.

<table>
<thead>
<tr>
<th>Table 15-1 Social Media Sharing Providers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source</strong></td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Adobe Revel</td>
</tr>
<tr>
<td>dotPhoto</td>
</tr>
<tr>
<td>Facebook</td>
</tr>
<tr>
<td>Flickr</td>
</tr>
</tbody>
</table>

(continued)
### Table 15-1 (continued)

<table>
<thead>
<tr>
<th>Source</th>
<th>URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photobucket</td>
<td><a href="http://s903.photobucket.com">http://s903.photobucket.com</a></td>
<td>Up to 2GB photo and video uploads per month.</td>
</tr>
<tr>
<td>Shutterfly</td>
<td><a href="http://www.shutterfly.com">www.shutterfly.com</a></td>
<td>Unlimited free photo storage for noncommercial use.</td>
</tr>
<tr>
<td>SlickPic</td>
<td><a href="http://www.slickpic.com">www.slickpic.com</a></td>
<td>Unlimited storage of up to 1600x1200px images and maximum of 10MB per image.</td>
</tr>
<tr>
<td>SmugMug</td>
<td><a href="http://smugmug.com">http://smugmug.com</a></td>
<td>Monthly fee of $5 per month for up to 50MB of photos and videos.</td>
</tr>
<tr>
<td>Twitter</td>
<td><a href="https://twitter.com">https://twitter.com</a></td>
<td>Allows 100 maximum, and most recent uploads are displayed.</td>
</tr>
<tr>
<td>YouTube</td>
<td><a href="http://www.youtube.com">www.youtube.com</a></td>
<td>Free unlimited video uploads of up to 10 minutes and not exceeding 100MB.</td>
</tr>
</tbody>
</table>

![Video](image)

**Figure 15-1:** Video on Facebook is shown on an Apple iPad.
Working with Adobe Revel

We momentarily deviate from using the Share panel and discuss sharing photos using Adobe Revel, which you access from the Import panel on the left side of the Organizer.

Adobe Revel is a web hosting service for storing your photos in the cloud, where you can view and share your photos on all your devices, such as computers, smartphones, tablets, notebooks, and so on. When you edit a photo, the photo is automatically updated on all devices.

As of this writing, Adobe Revel is going through many changes and may not be fully updated by the time this book is printed. Be sure to check our web extras for any updates we might have at www.dummies.com/extras/photoshopelements12.

In Elements 11, when Adobe Revel was first introduced, there was a direct link in the Share panel to Adobe Revel on both Windows and the Mac. In Elements 12, Adobe Revel occupies a space in the Import panel on the left side of the Organizer and a link in the Share panel.

During the first release of Adobe Revel, the service was a subscription that required a monthly fee. Now Revel provides users with a free service that permits you to upload up to 50 photos per month. You can upgrade the subscription for a paid service that provides you more storage space for a monthly service fee.

Earlier versions of Elements had support for Photoshop.com and Adobe Showcase. These services are being discontinued in favor of Adobe Revel. For a limited time, you can migrate your media from other Adobe services to Adobe Revel.

When you visit the Adobe Revel website at www.adoberevel.com and log in with your Adobe ID and password, you arrive at your Carousel, which displays all your photo uploads. The Adobe Revel website is limited to viewing photos and sharing your photos. As of this writing, there are no provisions on the website to edit your photos from within your web browser.

Knowing what Adobe Revel offers you

Adobe Revel is more than just a hosting service. You can perform many tasks with Adobe Revel, such as the following:

- **Store photos and sync in the cloud**: Your photos are safely stored on the Adobe website, and you can sync the photos to all your devices such as computer, tablet, and phone.
Privacy: As a default, all your photos are uploaded to your private account. Only you can see the photos you upload. When you want to share the photos, you can share them to the public or to selected users.

Photo albums: You can add photos to albums and view the photos within a given album in a Slideshow view.

Edit photos: Adobe Revel is the only photo sharing service that offers you Adobe Lightroom performance for editing photos. As of this writing, you can edit photos with the Adobe Revel application, which is available for mobile devices using iOS and for Macs.

Downloading the Adobe Revel applications (Mac only)

In Photoshop Elements, you can upload and download photos through the link to Adobe Revel.

The Adobe Revel application — which you can download for free — enables you to edit photos. When you save the edited photos, you can view the updated photos on all your devices. Here’s where you can find the applications:

For Macs: As of this writing, the Adobe Revel desktop application is available only for the Mac. You can download the application directly from the Apple App Store or through iTunes.

For iOS devices: Adobe Revel can be downloaded to iOS devices for use on your iPhone, iPod touch, or iPad. These versions provide you with sharing and editing features. Your device needs to have iOS version 6 and greater.

For Android devices: You can download Adobe Revel for Android devices; however, as of this writing, Android versions of Adobe Revel support sharing photos and don’t offer any editing options. You can download Adobe Revel for Android from the Google Play Store, and the app requires Android version 2.2.

Windows users, do not despair. Adobe is likely to provide the same options with desktop and Android apps as found currently with the iOS and Mac desktop apps. Be certain to check the Adobe website regularly at www.adoberevel.com for new updates and announcements.

Understanding the Adobe Revel interface

Regardless of whether you work on a desktop or an iOS device, the applications provide you with similar features, although there are some slight differences in the interfaces. Figure 15-2 shows the Revel interface on an iOS device.
Here are the main features:

A. **Toggle Library Panel**: Tap the icon to open the left panel where you can choose between photos downloaded from Photoshop.com and photos stored in your Adobe Revel Carousel. Think of the Adobe Carousel as a library of photos.

B. **Add**: On an iOS device, tapping this button opens the Camera Roll on your device. (Camera Roll is where the photos you take on your device are stored.) You can tap a photo or multiple photos from your Camera Roll and add them to your library. On the desktop version, a dialog box opens, allowing you to navigate your hard drive and add photos stored in folders.

---

**Figure 15-2**: Adobe Revel application as shown on an iPad.
C. **Grid view:** The photos are viewed as thumbnails on a grid similar to the Media Browser view in Photoshop Elements. In the desktop application, you see Grid appearing in the top-left corner of the Adobe Revel window.

D. **Track view:** This view displays the photos from top to bottom in a single row. Date information appears as a caption, and you can use the pencil icon to add the photo as an event. In the desktop application, you click the date to open a dialog box where you can add event information.

E. **Sort:** Two options appear in a drop-down menu: Oldest First and Newest First. In the desktop application, you can sort by All Photos by Date, Events by Date, Events by Name, and Added By. The Added By option is the username for the person who added the photo.

F. **Action menu:** This menu provies options for:
   - **Add to Album:** Tap this menu item and tap photos from the thumbnails view to add selected photos to an existing album or create a new album. In the desktop version, a dialog box opens and allows you to navigate your hard drive and add photos from folders to existing albums.
   - **Share Photos:** Check the photos you want to share and you find options at the bottom of the window for Email, Facebook, and More. When you tap the More button, you find additional options to assign a photo to your contacts or copy the photo. In the desktop version, the Share button appears in the top-left corner of the window adjacent to the + symbol used for adding photos to an album. When you tap the Share button, a menu opens that provides options for copying the link to an e-mail, viewing an album in a web browser, and stop sharing the photo or album.
   - **Save to Camera Roll:** This option is available only on iOS devices. Choose this option to save a photo to your device’s Camera Roll.
   - **Delete Photos:** Tap this option to delete the photo from your Carousel/Library. On the desktop version, you can Control-click and choose Remove Photo from Album.

G. **Photo thumbnails:** This view shows all the photos in your Revel account for the photos stored in your Carousel or from your Photoshop.com download depending on which item you have selected in the left panel.

H. **Display all photos:** By default, this view appears where all photos are displayed.

I. **Favorites:** This view displays photos you have marked as Favorites. To mark a photo as a Favorite, you need to first tap the photo and then tap the Add to Favorites icon represented by a heart shape. On the desktop version, you view Favorites by clicking the My Favorites button at the top of the left panel. When you click a photo on the desktop version, you mark a photo as a Favorite by clicking the star icon at the top right of the window.
J. **Albums:** Tap this button to display all albums. In the desktop version, the albums are listed in a hierarchical view in the left panel according to album name.

K. **Explore view:** The Explore view displays your photos in larger thumbnail sizes, and you can move the photos around the window by tapping and dragging to scroll through them. This view appears only on iOS devices.

L. **Share Album:** As of this writing, the Share Album button opens a window without much information. Tap anywhere on the window, and the Album view appears. You can select an album and share it — however, this method isn’t much different from tapping the Albums button and choosing a share option. We suspect that the version of Adobe Revel we’re currently using is not quite finished and we may find this option changed when the Adobe Revel team completes their development.

The real power in Adobe Revel is editing photos, which we talk about in the next section.

**Editing a photo with Revel**

To edit a photo using Adobe Revel on a Mac or iOS device, do the following:

1. **Log in to your Adobe Revel account.**
   
   Launch the application on your Mac or iOS device. Sign in using your e-mail address and password. If you haven’t created an Adobe ID, you can choose the option to create a new account. After you log in, you see the photos you have in your Carousel (library) or photos you imported from a Photoshop.com library.

2. **Tap a photo in iOS or click a photo on the desktop app.**
   
   The view changes to an editing view where the editing tools are available, as shown in Figure 15-3.
3. Make photo edits.

The tools available include the following:

A. Favorites: On iOS devices, the Favorites icon is represented with a heart. On desktops, the Favorites icon is a star. Tap or click the icon, and the photo you’re viewing is added to your favorites.

B. Comment: Tap the Comment icon, and a comments panel opens so that you can type a comment.

C. Slideshow view: The first icon at the bottom left of the window is used to run a slide show. This icon works if you tap an album. If you have a single photo selected, tapping this icon prevents you from swiping to change photos. To exit the Slideshow view, tap anywhere outside a photo or press the Esc key on your keyboard.

D. Keyboard: Tap this icon, and the keyboard pops up on iOS devices. You can type a caption that’s added at the bottom of the photo. On the desktop version, a panel opens that provides a number of different sharing options.

E. Edit: Tap this icon to enter editing mode. You have choices for making an auto fix, changing white balance, adjust exposure and contrast, make red-eye corrections, and crop and rotate a photo. The best way to familiarize yourself with the editing tools is to play with them and make changes for auto correction, exposure, contrast, cropping, and rotation if needed. Figure 15-4 shows a photo targeted for cropping.

F. Delete: Click the Trash icon to delete a photo.

4. Compare your edits with the original photo.

To make a comparison between your edits and the original photo, keep your finger pressed on the Compare icon at the top of the window. While your finder is depressed on the icon, you see the original photo before any edits. When you release your finger from the icon, you see the photo as you have edited it.

5. Save your edits.

Tap the check mark at the top-right corner of the window, and your edits are saved and the file is updated. When updated, the new edited file appears the same on all your devices.

6. Dismiss the editing mode.

Tap the X icon at the top-left corner and you return to your library view. (Refer to Figure 15-2.)
Chapter 15: Sharing Your Work

Figure 15-4: Cropping a picture in Adobe Revel on an iPad.

Sharing photos with Adobe Revel

After you make some edits on photos and update them, you can see the new edited photos on all your devices as long as they’re connected to the cloud. However, the photos are secure, and only you can view them unless you decide to share them.

Share your photos with an iOS device using the following steps:

1. Select a photo in your library.
2. Tap the Action icon on your device.
3. Tap Share or Share to Facebook, as shown in Figure 15-5.

Figure 15-5: The action menu on an iOS device.
If you want to share your photo via Facebook, tap the Share to Facebook option. If you want to share via Twitter, Flickr, or e-mail, tap Share.

4. Tap an option for where you want to send the file.

In our example, we share to Facebook.

In the window that opens, you can type a title for your photo and identify a location, as shown in Figure 15-6.

5. Add a title and location.

6. Tap the Post button to upload the photo to your Facebook account.

To share a photo from your desktop Mac, click the Action icon to choose a share option. However, the choices available to you are very different (as of this writing) from those available on iOS, as shown in Figure 15-7.

You have options to share the selected album or photo to Facebook, Twitter, Flickr, through e-mail, Message (SMS), or AirDrop (a local WiFi ad hoc Apple service for sharing across all Apple devices).

Choose the sharing option you want and follow the instructions provided in menus to post your photo.

**Working with Revel Carousels and Photoshop.com libraries**

Your online Revel photos are comprised of two libraries: your Revel Carousel, which contains photos you upload to your Revel account, and a Photoshop.com library if you used Photoshop.com in an earlier version of Elements. The Photoshop.com library is added to your Revel account when you first log in from the Organizer. You can download selected photos or an entire library from your Revel account from both your Carousel and Photoshop.com libraries.
To download photos from your Revel account to the Organizer, do the following:

1. **Click the + button next to the Mobile Albums link in the Import panel on the left side of the Organizer.**

   A log-in window for Adobe Revel opens.

2. **Type your e-mail address and your Adobe ID password and click the Sign In button to access your Adobe Revel account.**

   Alternatively, you can sign in to Adobe Revel by choosing File ➤ Sign In to Adobe Revel. The window shown in Figure 15-8 opens.

3. **Choose what you want to access from your mobile albums:**
   - **Access your entire Elements catalog from your smartphones and tablets.** Select this option if you want to access your entire Elements catalog from your mobile and tablet devices.
   - **Choose specific photos and videos you want to view on your smartphone.** Select this option if you want to select specific photos you want to view on your devices.

4. **Click Next.**

   Your entire Revel library or the selected photos appear in the Media Browser. This step can take some time, so be patient if you have a lot of photos hosted online. When you complete the task, your media is synced and can be viewed in the Elements Organizer and on your devices.

You can choose how to sync your media in Photoshop Elements Preferences. In the Organizer, press Ctrl+K (Windows) or ⌘+K (Mac) and click Adobe Revel. You can turn the automatic sync on and off in this preference setting. When the Revel Agent is on, new and edited photos automatically appear in the Media Broswer.

### Using the Share Panel

The Create and Share panels are available in the Organizer and the Photo Editor. For this chapter, we stick to the Share panel, and in Chapter 16 we show you how to use the Create panel.
The Share panel is almost identical in Windows and on the Mac. (See Figure 15-9.) The only exception you find in Elements 12 is that Photo Mail is restricted to Windows users only.

![The Share panel as it appears in Windows (left) and on the Mac (right).](image)

When you choose an option in the Share panel by clicking one of the buttons, one of two interfaces appears. Some choices provide you options within the Share panel, and other choices open a window where you log on to an account for sharing photos. The choices for sharing photos with other services open windows for logging on to your account and proceeding through steps to prepare and upload images.

In the sections ahead, we explore using the different interfaces and making choices for preparing photos for sharing.

**E-mailing photos**

Rather than save your file from Elements and then open your e-mail client (such as Outlook or Apple Mail) and select the photo to attach to an e-mail, you can use Elements to easily share photos via e-mail with one click.

When you want to e-mail a photo or a creation like some of those we talk about in Chapter 16, follow these steps:

1. **In the Organizer, select the photos you want to e-mail to a friend.**
2. Open the Share panel and select Email Attachments.

3. Choose a quality setting for the attachment and click Next.

   Drag the Quality slider and observe the file size noted at the bottom of the panel where you see Estimated Size, as shown in Figure 15-10. If the file is large, you may need to resize it in the Image Size dialog box before e-mailing the photo. Chapter 4 explains how to resize images.

4. (Optional) Add recipients.

   The next panel provides settings for adding a message and adding recipients from an Address Book.

   You can bypass adding recipients from your Address Book. If no recipients are listed in the Select Recipients panel, you can add recipient e-mail addresses in the new message window in your e-mail client.

5. Click Next, and the photo(s) are attached to a new e-mail message in your default e-mail client.

   Elements attaches the media to a new e-mail message. You need to toggle to your e-mail client in order to see the message and send the mail.

6. Review the To, Subject, and Attach fields to be certain the information is correct. Then click the Send button.

   By default, Elements uses your primary e-mail client application, which may or may not be the e-mail program you use. You can change the default e-mail client by pressing Ctrl+K (⌘+K on the Macintosh) to open the Preferences dialog box when you’re in the Organizer and then clicking Sharing in the left pane. From a drop-down menu in the Sharing preferences, choose the e-mail client application that you want Elements to use.

**Working with Adobe Premiere Elements**

Several options in the Share and Create panels require that you use Adobe Premiere Elements. The items denoted as Burn Video DVD/BluRay, Online Video Sharing, and Mobile Phones and Players all require Adobe Premiere Elements.
If any of these items interest you, you can download a free trial of Adobe Premiere Elements and work with it for 30 days. If Premiere Elements is a tool you find worthwhile, you can purchase it from the Adobe Store. If you’re perusing this book and have not yet purchased Elements 12, you can purchase the Adobe Photoshop Elements 12 and Adobe Premiere Elements 12 bundle. Buying the bundle purchase is much less expensive than buying the products separately.

Photoshop Elements and Premiere Elements have joined the Creative Suite applications where you can purchase a subscription service rather than purchase the programs. For more information on subscription services log in to Adobe’s Create Cloud website at https://creative.adobe.com.

For Adobe Premiere Elements trial versions, just click one of the options for video sharing in the Share panel, and you’re prompted to download a trial version of Premiere Elements.

**Sharing your photos on social networks**

You have a variety of options for sharing photos and placing orders on a number of service networks. We don’t have enough space in this book to cover each and every service that Elements supports, so we walk through the more popular services (Flickr, Facebook, and Twitter) as an example for connecting with a service provider. If other services interest you, poke around and explore options for the services you use.

Previous users of Elements will immediately notice that services such as Flickr, Facebook, and SmugMug have been promoted from options nested in the More Options drop-down menu to buttons shown in the Share panel.

**Sharing photos on Flickr, Facebook, and Twitter**

Uploading photos to Flickr, Facebook, and Twitter involves the same process. You first select photos, albums, or creations in the Organizer and then click either the Flickr, Facebook, or Twitter button in the Share panel.

You need to authorize Elements to communicate with these social networks before uploading any content. Click the Authorize button, and you proceed to a login page where you supply your account username and password information.

After you are logged in to a site, the process for uploading images is easy, as shown in Figure 15-11, where we logged in to Facebook.
Chapter 15: Sharing Your Work

Figure 15-11: After authorizing Facebook, the Share to Facebook window permits you to upload selected photos to your Facebook account.

Attribute choices in the Share to Facebook window are straightforward and easy to follow. Here’s what you find:

✔ If you want to add more photos, click the plus (+) button. Selecting a thumbnail in the window and clicking the minus (–) button deletes the photo.

✔ You can choose to add photos to existing Facebook albums or create a new album by making the respective radio button choice, as shown in Figure 15-11.

✔ Notice that you also have privacy options. For Facebook, open the Who Can See These Photos? drop-down menu and make a choice for whom you want to see your photos. In Flickr, you have choices for Private and Public. Within the Private option, you have choices for visibility to Friends or Family.

After a photo is uploaded, you see the photo on your timeline or in a photo collection (as shown in Figure 15-12).

Figure 15-12: Uploaded photo as it appears on Facebook.
Part V: Printing, Creating, and Sharing

Using other online services

After you become familiar with uploading photos to a service, you can easily follow similar steps to upload photos to any of the services that are supported by Elements. You first encounter the window to authorize an account. When setting up a new account, you can log in to the service and create the new account.

When you enter a site for sharing photos, printing photos, or creating items such as photo frames, follow the easy online steps that each service provides.
Adobe Photoshop Elements offers you a number of creations that you can share onscreen or in print. From both the Create and Share panels in the Panel Bin in the Organizer and Photo Editor, you have a number of menu choices for making creations designed for sharing.

In this chapter, we talk about creations designed for print and sharing. It’s all here in Photoshop Elements, for both Windows and Mac users. If you’re looking for how to create files for screen and web viewing, flip back to Chapter 15.

Getting a Grip on Creations

The Create panel differs from the Share panel that we discuss in Chapter 15 with different creation types and different options. Like the Share panel you can open the Create panel from either the Organizer or the Photo Editor.

When you click the Create tab above the Panel Bin, you find almost identical options in Windows and the Mac. There’s only one exception: On the Mac, you won’t find a Slide Show option, as shown in Figure 16-1. This feature is unique for Windows users.
As you look at the Create panel in Figure 16-1, note the first five items at the top of the panel in Windows and the Mac. When you make a creation from one of the first five items, the settings, adjustments, features, and such are almost identical in terms of the creation process. What you create, of course, is quite different depending on what item you click in the panel, but the process is very similar. We talk about the basic assembly procedures in the section that follows.

**Grasping Creation-Assembly Basics**

Creations such as photo books, greeting cards, photo calendars, and photo collages that you assemble from the Create panel (refer to Figure 16-1) are intended for output to either print or screen sharing.

Many creation options follow a similar set of steps to produce a file that is shared with other users or sent to an online printing service. In the Panel Bin, you can find all you need to make a new project by choosing layouts and producing a creation. Here are the common steps to follow when making a choice from the Create panel:

1. **Select photos.**

   In the Organizer or in the Photo Bin in the Photo Editor, select the photos you want to use for your creation. Sort photos or use keyword tags (as we explain in Chapters 5 and 6) to simplify finding and selecting photos you want to use for a creation.
2. Click the Create tab.

The Create panel opens in the Panel Bin. The minute you click a creation you are automatically switched to the Photo Editor.

3. Click an option for the type of creation you want.

You can click Photo Book, Photo Calendar, Greeting Card, Photo Collage, and so on.

After you select the kind of creation you want to make, a wizard opens where you choose the options you want and you are switched to the Photo Editor.

4. Select a size for the output in the left column.

In Figure 16-2, we selected to make a photo book, and the sizes are displayed in the left column.

5. Select a theme/layout.

Many of the creation options enable you to select a template. When you click a creation option on the Create panel, the panel changes to display choices for various themes, backgrounds, and borders. You make choices by clicking the theme or background. In Figure 16-2, you can see the Themes column for a photo book creation.

![Figure 16-2: Select a theme for your creation.](image-url)
Elements automatically creates the number of pages to accommodate the number of photos you selected in the Organizer or Photo Bin.

6. **Select options in the Create panel. Click OK.**

After you click OK, the Create panel changes to a wizard and displays three icons to the right of the Layers icon at the bottom of the panel as shown in Figure 16-3:

- **Pages**: Add or delete pages.
- **Layouts**: Choose a layout, as shown in Figure 16-4. You can click different layouts and view the results in the wizard.
- **Graphics**: Add artwork and text with the Graphics panel. Explore each item and choose options available for editing your creation.

7. **(Optional) Select options in the creation’s Advanced mode.**

   Up to this point, you haven’t been able to make any changes to your photos because the wizard interface is separate from the Organizer and Photo Editor.

   Click the Advanced Mode button in the upper-left corner of the wizard, and you have access to the Photo Editor Tools panel. You can now make edits on any photos in the creation, as shown in Figure 16-5.
Figure 16-4: The Layout panel offers choices for many layouts.

Figure 16-5: Advanced mode provides you with the Photo Editor tools where you can edit photos in your creation before saving or printing.
When you click Advanced Mode the button name changes to Basic Mode. Click the Basic Mode button to return to the Create panel.

8. Click the output option at the bottom of the wizard:

- **Save**: Save the file as a Photoshop Elements Project. You can return to the project and edit it at a later time.

- **Print**: Before the output is generated, look over the preview of your creation. If you’re using Advanced mode, click the Basic button at the top of the window and scroll through the pages to preview the creation.

Whether you want to create a photo book, a calendar, or any one of the other first five options in the Create panel, you follow the same steps.

When you make a creation that will ultimately be shared with other users or sent to an online service for printing, keep in mind that you must first select the photos you want in your creation. For example, creating a photo book by clicking the Photo Book button on the Create panel first requires you to select photos.

The reason you must first select photos — in either the Organizer or Photo Bin — is because the creation process involves using a wizard to set the attributes for your creation. You leave either the Organizer or Photo Bin when you begin the process; Elements makes no provision for you to drag and drop photos from the Organizer or Photo Bin to the wizard.

### Creating a Slide Show (Windows Only)

This *Million Dollar Baby* is no *Mystic River* — it’s simply *Absolute Power*! Well, maybe you won’t travel the same path from Rowdy Yates to multiple Academy Award–winning director and filmmaker Clint Eastwood, but even Mr. Eastwood might be impressed with the options for moviemaking with the Photoshop Elements slide show creations. When he’s not rolling out his Panaflex camera, he may just want to take photos of the grandkids and do the directing and producing, as well as the editing, right in Photoshop Elements.

The rest of us can channel our own Clint Eastwood by using the powerful features of the Photoshop Elements Slide Show Editor to create PDF slide shows and movie files. It’s so easy that Elements promises you won’t be *Unforgiven.*
You create a slide show in the Slide Show Editor and then export it for a number of uses. In the first section, you find out how to create and save your project. In the following section, you dive into exporting.

**Creating a Slide Show project (Windows)**

A Photoshop Elements project has an advantage over a PDF document in regard to revising the content. You can simply open your project, make revisions, and produce the slide show — something you cannot do with a PDF file.

Here’s how you go about creating a Slide Show project that you can edit and export later:

1. **Open the Organizer and select the pictures you want to use in your slide show.**

   You can also choose files you may have open in the Photo Bin in the Photo Editor.

2. **Click the Create button in the Panel Bin and click Slide Show.**

   The Slide Show Preferences dialog box opens. Just about everything in the dialog box can be adjusted in the Slide Show Editor, so don’t worry about making choices here. If you want to keep the Slide Show Preferences dialog box from reappearing when you make slide show creations, deselect the Show This Dialog Each Time a New Slide Show Is Created check box.

3. **Click OK in the Slide Show Preferences dialog box.**

   The Slide Show Editor opens, as shown in Figure 16-6.

4. **If your Slide Show Editor doesn’t show a screen similar to the one in Figure 16-6, click the Maximize button in the upper-right corner of the window.**

   This way, you can see the timeline at the bottom of the screen and the Panel Bin on the right side of the editor.

5. **(Optional) Create a Pan & Zoom view.**

   When slides are shown, you can zoom and pan a slide. Select the Enable Pan & Zoom check box and click the Start thumbnail. A rectangle appears in the preview area. Move any one of the four corner handles in or out to resize the rectangle. Clicking inside the rectangle and dragging the mouse enables you to move the rectangle around the preview.
For the end zoom position, click the End thumbnail and size the rectangle to a zoomed view or a view where you want to stop the zoom. Notice in Figure 16-6 that the End thumbnail is selected and the rectangle is sized down to the zoom area on a portion of the photo.

![Figure 16-6: The Slide Show Editor is where you create slide shows.](image)

6. **(Optional) Add a graphic.**

A library of graphics appears on the Extras pane in the Panel Bin. Drag a graphic to a slide. If you want a blank slide to appear first and then add text and graphics to the blank slide, click Add Blank Slide on the Shortcuts bar at the top of the editor.

7. **(Optional) Add text.**

Click the Text tool on the Extras pane in the Panel Bin and then drag a text style to the blank slide or the opening slide in the slide show. After you drag text to a slide, the Properties pane opens in the Panel Bin. The text you drag to the slide becomes a placeholder.
To edit the text, click Edit Text in the Properties pane. You can also select a font, style, size, color, and alignment. After setting the type attributes, click inside the text and move it to the position you want.

8. **(Optional) Set transitions.**

The icons between the slides in the timeline (at the bottom of the Slide Show Editor) indicate a default transition. You can change transition effects for each slide independently or for all the slides in the show. Click the right-pointing arrow on the right side of a transition icon to open a pop-up menu containing a number of transitions, as shown in Figure 16-7. If you want to apply the same transition to all slides, choose Apply to All at the top of the menu commands.

Be conservative with the transition effects. Too many transitions of different types can make the slide show appear amateurish and can be distracting to the viewers.

9. **(Optional) Add audio and media.**

You can add audio to the slide show by choosing Add Media ➤ Audio from Organizer (or from Folder). Select an audio file and click OK.

You can also add movie files to your slide show. A movie file can be added on top of a slide or on a new slide. When you play the slide show, the video file plays. Choose Add Media ➤ Photos and Videos from Organizer (or from Folder).

You can add more pictures to the slide show with the same menu command.

10. **(Optional) Record your own sounds.**

If you want to add narration, click the Narration tool (represented by a microphone icon to the right of the Text tool) in the Panel Bin. The Extras panel changes to provide you with tools to record a sound or import a sound file. Note that this option requires you to have a microphone properly configured on your computer.
11. (Optional) Fit slides to the audio.

If you have 3 minutes of audio and the slide duration is 2 minutes and 30 seconds, you can, with a single mouse-click, fit the slide duration uniformly to fit the 3-minute audio time. Just click the Fit Slides to Audio button below the preview image.

If you want to manually adjust time for slide durations, click the down arrow on the time readout below the slide thumbnails in the timeline.

12. Click the Output button on the Shortcuts bar and then, in the dialog box that opens, type a name and click Save.

Your project is added to the Organizer and is available for further editing later. Or you can open the project to save in a number of different output formats, as we explain in the following section.

13. Preview the slide show.

Before exporting the slide show, you can see a preview by clicking the buttons directly below the image preview area. If you want a full-screen preview, click the Full Screen Preview button on the Shortcuts bar and click the Play button.

This section doesn’t tell you how to export the slides to a file. It simply saves a project that you can reopen and edit. To create the slide show file, follow the directions in the next section, “Exporting to slides and video.”

If you don’t like the order of the slides when you open the Slide Show Editor, you can easily reorder the slides by dragging them back and forth along the timeline.

**Exporting to slides and video**

After creating a project, you have a number of output options. You can write a project to disc for archival purposes and include slide shows on a video CD (videodisc) or DVD. You can e-mail a slide show to another user, share a project online, write a project compatible for display on a TV, or save to either a PDF slide show or Windows movie file.

To write a PDF slide show or a movie file, follow these steps:

1. In the Organizer, double-click the project thumbnail.

   The project opens in the Adobe Photoshop Elements Slide Show Editor.

2. Click the Output button on the Shortcuts bar.

   The Slide Show Output Wizard opens. Figure 16-8 shows the wizard as it appears in Windows.
Figure 16-8: Click the Output button in the Photoshop Elements Slide Show Editor to open the Slide Show Output Wizard.

3. **Select the type of file you want to export and click OK:**

   - *Movie File (.wmv):* Select this option to export a Windows media video file. Your exported video can be viewed in Elements or in the Windows Media Player. You can import the video in all programs that support .wmv files.

   - *PDF File (.pdf):* Select this option if you want to create a PDF slide show. If you create a PDF slide show, some of the animation features, such as zooming slides and transition effects, aren’t shown in the resultant PDF document. Users can view the slide show by using the free Adobe Reader software.

   To find out how to convert video for viewing on iPhone and iPad and viewing PDF documents on these devices, you need more information than we can cover in this book. There’s quite a bit to understand regarding video formats. For more information regarding iOS devices and video format conversions, see *Photoshop Elements 12 All-in-One For Dummies,* which we also wrote.

4. **In the dialog box that opens, prompting you to add your output file to the Organizer, click Yes.**

   You can now easily view the file by double-clicking it in the Organizer.

   If you use an iPhone, iPod, or iPad, and have Adobe Premiere Elements installed, you can choose the last option in the Slide Show Output Wizard: Edit with Premiere Elements Editor. In Premiere Elements, you can export directly to iPod/iPhone format, which is readable on all your iOS devices as well as Mac computers.
Making Additional Creations

Unfortunately, we don’t have room in this book to cover each creation. If you want more detail on all the creation types, see Photoshop Elements 12 All-in-One For Dummies. Fortunately, many of the other creation types are intuitive and easy to master. To create instant videos, you need Adobe Premiere Elements. Other readily available items include photo books, greeting cards, photo stamps, calendars, and burning creations to CD/DVDs (Windows only). For each creation type, Elements provides you with many editing options. Explore each of the creations available to you and consult the online Help file for steps you can follow.
Find out how to add attractive flair to your images by checking out the web extras at www.dummies.com/extras/photoshopelements12.
In this part . . .

✓ Find our top ten tips for composing better photos, such as the rule of thirds, framing, and other simple tricks that can make your photos look better than ever.

✓ Discover great ideas for projects you can create for your home or work, such as flyers, posters, inventories, and more.
Ten Tips for Composing Better Photos

In This Chapter
▶ Finding a focal point and using the rule of thirds
▶ Cutting the clutter and framing your shot
▶ Employing contrast, leading lines, and viewpoints
▶ Using light and giving direction
▶ Considering direction of movement

We can help you take photographs that are interesting and well composed. Some of these tips overlap and contain common concepts, but they’re all free; they don’t require any extra money or equipment.

Find a Focal Point

One of the most important tools for properly composing a photo is establishing a focal point — a main point of interest. The eye wants to be drawn to a subject.

Keep these tips in mind to help find your focal point:

✓ Pick your subject and then get close to it.
✓ Include something of interest in scenic shots.
✓ When it’s appropriate, try to include an element in the foreground, middle ground, or background to add depth and a sense of scale.
Use the Rule of Thirds

When you’re composing your shot, mentally divide your frame into vertical and horizontal thirds and position your most important visual element at any intersecting point; see Figure 17-1. When you’re shooting landscapes, remember that a low horizon creates a dreamy and spacious feeling and that a high horizon gives an earthy and intimate feeling. For close-up portraits, try putting the face or eyes of a person at one of those points.

If you have an autofocus camera, you need to lock the focus when you’re moving from center.

Cut the Clutter

Here are some ways you can cut the clutter from your background:

- Try to fill the frame with your subject.
- Shoot at a different angle.
- Move around your subject.
- Move your subject.
- Use background elements to enhance your subject.
- Use space around a subject to evoke a certain mood.
- If you’re stuck with a distracting background, use a wider aperture (such as f/4).
Frame Your Shot

When it’s appropriate, use foreground elements to frame your subject. Frames lead you into a photograph. You can use tree branches, windows, archways, and doorways, as shown in Figure 17-2. Your framing elements don’t always have to be sharply focused. Sometimes, if they’re too sharp, they distract from the focal point.

Employ Contrast

Just remember, “Light on dark, dark on light.”

A light subject has more impact and emphasis if it’s shot against a dark background, and vice versa, as shown in Figure 17-3. Keep in mind, however, that contrast needs to be used carefully. Sometimes it can be distracting, especially if the high-contrast elements aren’t your main point of interest.

Experiment with Viewpoints

Not much in the world looks fascinating when photographed from a height of 5 to 6 feet off the ground. Try to break out of this common mode by taking photos from another vantage point. Experiment with taking a photo from above the subject (bird’s-eye view) or below it (worm’s-eye view). A different angle may provide a more interesting image.
Use Leading Lines

Leading lines are lines that lead the eye into the picture and, hopefully, to a point of interest. The best leading lines enter the image from the lower-left corner. Roads, walls, fences, rivers, shadows, skyscrapers, and bridges provide natural leading lines, especially in scenic or landscape photos. The photo shown in Figure 17-4 of the Great Wall of China is an example of curved leading lines.

Figure 17-4: You don’t have to trek to China to find leading lines, although you may not find a longer unbroken curve than the Great Wall.

Use Light

Here are a few tips about light:

✓ The best light is in early morning and later afternoon.
✓ Avoid taking portraits at midday.
✓ Overcast days can be great for photographing, especially portraits.
✓ Backlighting can produce dramatic results. See Figure 17-5.
✓ Ensure that the brightest light source isn’t directed into the lens to avoid lens flare.
Use a flash in low light. For portraits especially, positioning your flash so the light comes from above at a 30 to 45 degree angle gives better depth and eliminates the risk of red-eye.

Get creative. Look for interesting patterns and effects created by the light.

Give Direction

Don’t be afraid to play photo stylist:

- Get someone to help direct.
- Give directions about where you want people to stand, look, and so on. See Figure 17-6.
- Designate the location.
- Arrange people around props, such as trees or cars.
- Use a variety of poses.
- Try to get people to relax.

Figure 17-5: Backlighting can yield dramatic images.
Consider Direction of Movement

When the subject is capable of movement, such as a car, a person, or an animal, make sure that you leave more space in front of the subject than behind it, as shown in Figure 17-7. Likewise, if a person is looking out onto a vista, make sure that you include that vista.

Figure 17-6: Provide direction to the people you’re photographing while also trying to capture their personalities.

Figure 17-7: Leave space in the frame for your subject to move into.
Even though Elements already gives you a wide array of creations to make — from photo books to greeting cards to CD covers — you can easily do even more with the program. In this chapter, you find ideas for using your inventory of digital images to make your life more productive, more organized, and more fun. This chapter just scratches the surface. Before you know it, your photos will be a part of every aspect of your life, from your clothing to the art on your walls.

**Screen Savers**

If you have two or more photos you want to use, you can create a screen saver in Windows or OS X. Follow these steps in Windows 7:

1. Select the desired photos from the Organizer.
2. Choose File ➪ Export as New File(s). In the Export New Files dialog box that appears, choose JPEG as the file type.
3. Select your photo size and choose a quality setting.
Part VI: The Part of Tens

We recommend using a size that matches the resolution setting you’re using for your monitor. Use a quality setting of 12 for maximum quality.

4. Click the Browse button.

5. Click the Make New Folder button, save the photos as JPEGs to that folder, and name the folder something appropriate, such as Screen Saver. Click OK.

6. Choose whether to use the original names of your files or a common base name, such as screen 1, screen 2, and so on.

7. Click Export.

    If all goes well, Elements informs you that it has executed the command.

8. Click OK.

9. Right-click your desktop and choose Personalize. Then select Screen Saver from the window’s bottom-right corner.

10. Click the downward-pointing arrow in the Screen Saver box and select a screen saver.

11. Specify your other options, such as wait time, power settings, and so on.

12. Click OK to close the window.

Mac users can create custom screen savers even more easily:

1. Choose System Preferences from the Apple menu.

2. Click Desktop & Screen Saver and then click the Screen Saver tab.

3. To choose one of your photos, click the plus sign and choose Add Folder of Pictures. Find the folder with your images and choose the photo.

4. Specify options.

5. Click Test to see a preview. If you’re happy, click the Close button in the top-left corner.

---

Flyers, Ads, and Online Auctions

Whether you’re selling puppies or advertising an open house, adding a photo to an ad or flyer really helps to drive home your message. Here are the abbreviated steps to quickly create an ad or a flyer:

1. In Expert mode, choose File ➪ New ➪ Blank File.

2. In the New dialog box, enter your specs and then click OK.
Enter the final dimensions and resolution for your desired output. If you want to print your ad or flyer on your desktop printer or at a service bureau, a good guideline for resolution is 300 pixels per inch (ppi). Leave the color mode as RGB and the Background Contents as White.

To fill your background with color, as in Figure 18-1, choose Edit » Fill Layer and choose Color from the Contents pop-up menu. Choose your desired color in the Color Picker and then click OK.

3. Open your photos and then drag and drop them onto your new canvas with the Move tool.

Each image is on a separate layer.

Choose Window » Images » Cascade or Tile to view all your canvases at the same time.
4. Select the Type tool, click the canvas, add your desired text, and then position your type with the Move tool.

Figure 18-1 shows a drop shadow on the type. If you want to add a drop shadow as well, select your Type layer and in the Styles panel of the Effects panel (Window ➪ Effects), choose Drop Shadows from the pop-up menu. Double-click the shadow of your choice.

5. When you’re done, choose File ➪ Save.

6. Name your file, choose Photoshop (.PSD) from the Format drop-down menu and make sure that the Layers and Color check boxes are selected.

If you’re taking your document to a copy shop, save your document as a Photoshop PDF (.pdf) file.

7. If you want to save a copy of your ad or flyer in the Organizer, select the Include in the Elements Organizer check box. In addition, select the Layers, ICC Profile (Embed Color Profile on the Mac), and Use Lower Case Extension (Windows only) options.

8. Click Save.

**Clothes, Hats, and More**

Buy plain white T-shirts at your local discount store or plain aprons and tote bags at a craft or fabric store. Then buy special transfer paper at your office supply, big-box, or computer store. Print your photos on the transfer paper (be sure to flip the images horizontally first) and iron the print onto the fabric. When you’re done, you have a personalized gift for very little cash.

**Posters**

You can get posters and large prints at many copy shops and even your local Costco. Call and talk to a knowledgeable rep so you know exactly how to prepare your file. Here are a few questions to ask:

- What file format and resolution should the file be?
- What print sizes do you offer?
- Do you provide mounting and lamination services?
**Household and Business Inventories**

Shoot pictures of your items. In the Organizer, select the image and choose Edit ➪ Add Caption to include makes, models, purchase dates, and dollar values of each piece. Then create a single PDF document from those multiple files by creating a slide show. Chapter 15 explains how to create the slide show PDF. After the PDF is finished, you can upload it to a cloud (online) storage site or burn a CD or DVD and store it somewhere else (in a safety deposit box or other secure location).

**Project Documentation**

If you’re taking a class or workshop, take your camera to class (if the instructor doesn’t mind). Documenting the positions or steps of that new yoga, pottery, or gardening class can help you practice or re-create it on your own. Import your desired photos into the Organizer and create notes on each step of the project in the caption area. When you’re done, output the images to a PDF slide show. For details on creating PDF slide shows, see Chapter 15.

**School Reports and Projects**

Have to write a paper on the habits of the lemurs of Madagascar? Trek down to your local zoo and have a photo shoot. Create a simple collage of lemurs eating, sleeping, and doing the other things that lemurs do. You can use the Photo Collage command on the Create panel or create a custom collage by making selections (see Chapter 7) and dragging and dropping them onto a blank canvas.

**Blogs**

Creating a simple blog is a great way to share not only your latest and greatest photos but also recent news about family and friends. Some of the most popular free blogging platforms are [http://blogger.com](http://blogger.com), [http://wordpress.com](http://wordpress.com), [www.tumblr.com](http://www.tumblr.com), and [www.livejournal.com](http://www.livejournal.com).
Welcome — There’s More

Before you start taking your photos to the next dimension, consider a few extra ideas: Make fun place cards for dinner party guests; create your own business cards or letterhead; design your own bookmarks, bookplates, and notepads; or label storage boxes with photos of their contents. Check out www.kodak.com, www.bhg.com, and other sites for a slew of projects to do with photos.
Index

A

Actions panel, 43–44
adjustment layers, 184–186, 262–265
adjustments. See image correction
Adjustments panel, 44
Adobe Create Cloud website, 384
Adobe Flash, sharing issues, 370
Adobe Partner Services preference panel, 64
Adobe PDF format. See PDF files
Adobe Premiere Elements
free trial download, 384
instant video creation, 398
Mac options, 126, 371
mobile device support, 371
Adobe Revel
application downloads, 374
description, 10
downloading photos from, 380–381
editing photos in, 377–379
e-mail photo sharing, 376
exporting photos directly to, 370
free trial upload, 373
library, managing, 380–381
Mac sharing options, 380
main features, 375–377
migrating to, 373
photo sorting, 376
preference settings, 65
security, 379, 385–386
sharing between devices, 379
sharing via Facebook, 379–380
storing photos and albums, 373–374
synching with Organizer, 104
thumbnails display, 376
Adobe Revel preference panel, 65
Adobe RGB workspace, 69
ads, creating, 408–410
airbrushing, 314
AirDrop (Apple), 380
albums
Adobe Revel, adding to, 376
creating, 47, 114–116
editing and adding, 117
location in Organizer, 103
overview, 112–113
preference settings, 64
sharing online, 370, 377
sharing temporary work, 116
Smart Albums (discontinued), 118
antialiasing
Brush tool, 314
Magic Eraser tool, 171
Marquee tools, 150
Paint Bucket tool, 320
selections, applying to, 150, 159
text application, 343
Apple. See also Macs
AirDrop, sharing with, 380
Camera Connection Kit, 27
iPhoto, editing with, 16
iTunes, uploading to, 27
Preview application, viewing PDF files in, 93
QuickTime video format, 97
audio
formats supported, 97
slideshow, adding to, 395–396
Auto Color Correction
overview, 210–211
Quick mode, access from, 215
Auto Contrast command
overview, 210
Quick mode, access from, 215
Auto Erase, 314
auto fix
Auto Color Correction, 210–211
Auto Contrast, 210
Auto Levels, 209–210
Auto Red Eye fix, 212–213
Auto Sharpen, 211–212
Auto Smart Fix, 208–209
Auto Smart Tone, 207
overview, 206
Auto Levels
overview, 209–210
Quick mode, access from, 215
Auto Red Eye fix, 212–213
Auto Sharpen, 211–212
Auto Smart Fix
  overview, 208–209
  Quick mode, access from, 215
Auto Smart Tone, 207
autofocus adjustments (camera), 402

Background Eraser tool, 169–170
backlighting
  Color Curves adjustments, 248
  photo composition suggestions, 404
  Shadows/Highlights adjustments, 237–238
backups
  catalogs, 122–124
  erasing before, 169
  file organizing before, 122
  files and photos, 124
  filtering before, 270–271
  full versus incremental, 123
  baseline, 336, 343
bitmap file formats (BMP, RLE, DIB), 92
Bitmap mode
  bitmap file format versus, 92
  converting from RGB images, 82–83
  overview, 81
black and white, converting to, 246, 254
blend modes
  color inversions, 292–293
  darkening choices, 289–290
  dissolve versus normal, 289
  HSL, 294
  lightening choices, 290–291
  lighting adjustments, 291–292
  overview, 288
  pencil tool, using with, 314
Blur tool, 228–229
blur tools
  Eraser, using with, 272
  Gaussian Blur filters, 256–257
  blurring, filter choices, 256–259
BMP formats (BMP, RLE, DIB), 92
Boolean expressions, 134
borders, creating, 319
bracketing techniques, 302
Brightness/Contrast command, 238–239
Brush tool
  airbrushing, 314
  brush dynamics, 314–315
  brush libraries, 315–316
  defaults, setting, 315
  overview, 314

Calibration (monitor), 68, 353
Camera
  autofocus adjustments, 402
  Camera Raw format, 235, 242
  depth of field effects, 257
  distortion, correcting, 278–279
  downloading photos directly, 11–14
  downloading photos via computer, 10–11
  exposure bracketing techniques, 302
  image enlargement for displays, 75
  iPhone/iPad downloads, 26
  metadata use, 136–139
  panoramic image recommendations, 295–298
  preference settings, 64
  white balance settings, 242, 253
  zooming, for panorama images, 295
Camera Connection Kit (Apple), 27
Camera or Card Reader preference panel, 64
Camera Raw format, 235, 242
captions
  adding and searching, 137
  type tools, adding with, 333
Catalog Manager
  creating new catalogs, 120–121
  free music, importing, 121
  performance optimization, 122
  photos, finding and adding, 121
catalogs
  backup options, 122–124
  corrupted file repair, 122
  creating new, 120–121
  links, reestablishing, 120
  switching between, 122
channels
  contrast, adjusting with, 241
  overview, 66–67
clarity adjustments
  blurring, intentional, 256–259
  grain reduction, 261
junk elimination, 255–256
overview, 254–255
sharpening techniques, 259–262
Smart Brush tools, 262–265
Clone Stamp tool, 218–220, 327
CMYK color mode, 81
color adjustments
color cast corrections, 242–243
Color Curves techniques, 248–249
Convert to Black and White command, 246
fringe removal, 251–252
hue/saturation changes, 243–245
Remove Color command, 245
Replace Color command, 246–248
skin tones, 250–251
temperature filters, 252–253
tonal range improvements, 207–208, 225, 248–249
Color Curves, 248–249
color management. See also color modes; printing
Auto Color Correction, 210–211
background versus foreground choices, 308
blend modes, using, 292–294
borders, creating, 319
calibration, 68, 353
Camera Raw format, advantages of, 242
channels, 66–67, 241
color modes, 71, 81
Color Picker tool, 308–309
Color Replacement tool, 231–233
color swatch libraries, 65
Color Swatches panel, 309–311
correction choices, 215–216
Eyedropper tool, 311–312
filling selections, 317–319
grayscale images, colorizing, 231, 244–245
ink choices, 354–355
inversions in blend modes, 292–293
matching output to display, 67
monitor calibration, 68, 353
outlining selections and layers, 319
Paint Bucket tool, 320
pixel filtering, 66
printing considerations, 353–354
profile settings, 69–70
saturation/desaturation techniques, 230–231, 243–245
selection edge decontamination, 174
styles, transferring between images, 304–306
text, modifying, 349
workspace choices, 69
color modes
Bitmap conversions from RGB, 81–83
Bitmap direct image acquisitions, 82
BMP files versus Bitmap, 82
CMYK images, 81
combining multiple modes, 81–82
Grayscale conversions from RGB, 84–86
Indexed Color conversions from RGB, 87
overview, 71, 81
RGB versus Indexed Color, 87
color modes, converting
color data preservation, 84–85
overview, 81
RGB to Bitmap, 82–83
RGB to Grayscale, 84–86
RGB to Indexed Color, 87
Color Picker tool, 308–309
color profiles, 69–70
Color Replacement tool, 231–233
Color Swatches panel
choosing and managing colors, 310–311
overview, 44, 309
color temperature
overview, 252
Photo Filter, adjusting with, 253
colorizing, 231, 244–245
ColoVision Spyder2express, 68
Comic filter, 280–281
composing photos
autofocus adjustments, 402
background considerations, 401–402
clutter removal, 402
contrast, managing, 403
depth of field effects, 257–259
exposure bracketing, 302
flash suggestions, 405
focal point, establishing, 401
framing ideas, 403
leading lines, using, 404
lighting suggestions, 404–405
movement, considering, 406
posing subjects, 405–406
Rule of Thirds, 402
scale, defining, 401
viewpoint selection, 403
Photoshop Elements 12 For Dummies

composite images, creating, 295
CompuServe GIF format (GIF), 90, 92
contact sheets, 368
Content-Aware tool, 224–225
context menus, 39, 130–131
contrast adjustments
   Auto Levels, correcting with, 209–210
gamma value changes, 241
   Levels command, correcting with, 239–242
photo composition, 403
Convert to Black and White command, 246
Cookie Cutter tool, 167–168
Correct Camera Distortion filter, 278–279
correcting photos. See also auto fix; clarity
   adjustments; color adjustments;
   contrast adjustments; lighting
   adjustments
Camera Raw format, advantages of, 242
cloning with Clone Stamp tool, 218–220
cloning with Healing Brush tool, 220–222
color replacement, 231–233
colorizing, 231
Content-Aware tool, moving with, 224–225
dodging and burning, 225–227
flaws, fixing, 217
image sharpening, 217
red eye removal, 212–213, 216, 231, 278–279
sharpening focus, 229–230
smudging, 227–228
softening effects, 228–229
special effects, adding, 217
sponging effects, 230–231
spot healing, 222–223
teeth whitening, 216–217
workflow suggestions, 236
Create Cloud website, 384
Create panel
   new projects, layout choices, 388–392
Photo Editor, selecting photos in, 388
creations
   ads and flyers, designing, 408–410
audio, adding, 121, 370
blogs, 411
Create/Share panel locations, 45, 387–388
defined, 32
display considerations, 370
editing photos, 390–391
fabrics, transferring photos to, 410
graphics, adding, 390
Inventory documents, 411
Photo Bin Options menu, using, 34
photo selections, 388, 392
posters, designing, 410
project suggestions, 398, 407–412
screen savers, designing, 407–408
Slide Show overview, 392–393
Slide Show projects, creating, 393–396
Slide Show projects, exporting, 396–397
theme selections, 389–390
uploading to social networks, 370–371, 384
cropping
   Golden Ratio, 201–202
   option settings, 200
Organizer, working from, 202
printing crop marks, 367
Quick mode choices, 215
Rule of Thirds, 201
scaling images, 279
custom tags, 106–110
Custom Workspace panel, 44
default tags, 109–110
defringing selections, 251–252
depth of field effects, 257–259
despeckling, 255
digital drawing tablets, 152
dimensions
   image alteration, 75
   resolution versus, 75–76
Display and Cursors preference pane, 62
dissolving, 289
distortions
   camera, correcting, 278–279
   Liquify filter, creating with, 275–277
   reconstructing, 277
text, modifying, 348–350
docking photos, 32, 61
document creation
   attribute selection, 48–49
   new blank files, 48
Downloader
   advantages of, 11
importing camera images directly, 13–14
mobile device support, 26–27
organizing photos, issues with, 17
drag and drop
adjustment layer deletions, 185
duplicating layers, 84
layer styles, 287
layers, rearranging, 180
Move tool operations, 147, 184, 190–191
panel docking/undocking, 45
photos, adding to albums, 115
photos, assigning to Events, 133
photos, copying sections from, 188, 190–191
selections, moving, 147
slideshow editing, 396
tagging photos, 107
undocking photos, 32
drawing
color choices, 307–312
Pencil tool, using, 312–314
straight lines, 314
Dropbox, 27

E

editing. See also image correction
with Adobe Revel, 377–379
enabling additional editors, 64
with iPhoto, 16
preference settings, 64
workflow suggestions, 236
Editing preference panel, 64
Editor. See also layers; preference settings;
selections
contextual menus, 39
creation wizard, 32
creations, setting up, 388–392
docking and undocking images, 32
document creation, 47–49
editoring mode choices, 31
Expert mode options, 32–34
foreground image management, 32
Guided mode options, 51–53
help menus, 56–57
launching methods, 30–31
Layout choices menu, 33
links, reestablishing, 120
menu bar overview, 38–39
multiple image opening, 32
Organizer, returning to, 33
overview, 29–30
Panel Bin options, 34
paragraph type, adding, 337–338
photo tabs, 32
Photomerge, accessing, 295
point type, adding, 336
printing from, 356
Quick mode options, 49–51
saving work regularly, 55–56
Slide Show projects, 392–396
Tool Options, 33
tool selections, 33
tooltips, 57
Undo History commands, 54–56
effects
filters versus, 284
Fluorescent Chalk, 284–285
layers versus flattened images, 284
Effects panel, 43, 285
Elements, Adobe Premiere
free trial download, 384
instant video creation, 398
Mac options, 126, 371
mobile device support, 371
Elements Downloader
advantages of, 11
importing camera images directly, 13–14
mobile device support, 26–27
organizing photos, issues with, 17
Elements Organizer. See also facial
recognition; Media Browser;
preference settings
Adobe Revel albums, synching, 104
catalogs, importing, 10
color management, 65–70
Crop tool selection, 202
e-mail photo sharing, 382–383
event tagging, 105
Events creation and photo assignment, 133
folder management, 104
images, adding to folders, 14–15
images, tagging, 105
importing camera images directly, 11,
13–14
importing images from files and folders,
11–12
iPhoto image importing, 16
launching from Welcome screen, 9
launching Photo Editor, 30–31
map location tags, adding, 104
overview, 9–10, 101–105, 134
Photoshop Elements 12 For Dummies

Elements Organizer (continued)
Quick mode options, 104
scanning images, 21–25
slide show searching, 105
Slideshow view, 126–128
social network sharing, 384–385
sorting tagged photos, 103, 111–112
tags, adding icons, 107–108
tags, creating, 105–107
tags, customizing, 109–110
thumbnails, 12, 17
View menu choices, 124–125
viewing options, 124
Elements Photo Editor. See layers; Photo Editor; preference settings; selections
e-mail
Action menu, using, 376
Adobe Revel, downloading files from, 381
album sharing, 380
blogs, 411
mobile devices, downloading from, 26
photo sharing, 382–383
searching in History, 137
equalizing effect, 254
Erase Highlights Marked for Protection tool, 204–205
Erase Refinements tool, 174
Eraser tool, 41, 169, 272
erasing
Background Eraser tool, 169–170
brush size, changing, 65
Erase Highlights Marked for Protection tool, 204–205
Erase Refinements tool, 174
Eraser tool, 41, 169, 272
Gaussian Blur filters, using with, 272
Magic Eraser tool, 171
marking tools, 165
overview, 168–169
Pencil tool, using for, 312
Style Eraser tool, 305
tool types, 168
Events
creation and photo assignment, 133
tagging, 105
Expert mode
blend modes, accessing, 288
blurring commands, 256–259
cloning with Clone Stamp tool, 218–220
cloning with Healing Brush tool, 220–222
color cast removal, 242–243
color replacement, 231–233
Content-Aware moving, 224–225
converting color modes, 85
converting formats, 82
Correct Camera Distortion filter, 278–279
cropping options, 200–203
distorting with Liquify filter, 275–277
docking/undocking preference settings, 61
dodging and burning, 225–227
designing images, 144
effects, applying, 284–285
hue/saturation changes, 243–245
layers, required for, 178
paragraph type, adding, 337–338
Photo Editor choices, 32–35
Photomerge, accessing, 295
point type, adding, 336
Quick mode toggling, 49, 51
Quick mode versus, 50–51
recomposing options, 204–206
resolution adjustments, 89
selection and correction, required for, 148
Shadows/Highlights command, 238
Sketch filters, 280
spot healing, 222–223
straightening options, 203–204
Unsharp Mask tool, 260–262
exporting
albums, 117
keyword tags, 109
movie files, 397
PDF files, 94, 397
Premier Elements, advantages of, 126, 371
slideshows and video, 370, 396–397
exposure adjustments, 301–304
exposure bracketing techniques, 302
Eyedropper tools
color replacements, 247
color selecting, 311–312
contrast adjustments, 240–241
hue/saturation changes, 244
toggling from other tools, 312
Facebook, exporting to, 370, 379–380
facial recognition
difficulties with, 20
manually tagging faces, 20–21
organizing photos with, 18–19
preference settings, 64
Favorites panel, 43
feathering
Marquee options, 150
Refine Edge menu choices, 173
Refine Edge method, 159
selections, applying after, 172
selections, applying before, 150, 172
file attributes, 48–49
file formats
attributes chart, 96
audio, supported, 97
bitmap, 92
converting audio/video, 97
GIF, 92
overview, 91
Photo Project Format, 92
Photoshop, 91
Photoshop PDF, 93
Pixar, 94
PNG, 94
selecting, 88
TIFF, 94–95
video, supported, 97
web file considerations, 89–91
file management. See also Catalog Manager
backup options, 124
corrupted file repair, 122
filename sorting, 135
format choices, 88
overview, 101
preference settings, 64
saving options, 88–89
saving versions, 89
thumbnail displays, 89
web file format choices, 89–91
Files preference panel, 64
Fill command, 317–319
fill layers, 186–187
Filter Gallery, 273–275
filters
clarity tools, 255–256
color cast removal, 243
color temperature changes, 252–253
Comic, 280–281
Correct Camera Distortion, 278–279
corrective versus destructive, 271
editing and organizing, 275
effects versus, 284
Graphic Novel, 281–282
Liquify, 275–277
menu bar options, 39
one-step versus multistep, 271
overview, 269–270
Pen and Ink, 283
permanency of use, 271
Radial Blur, 257
selective application, 272–273
Smart Blur, 257
Surface Blur, 257
Flash (Adobe), sharing issues with, 370
flash suggestions (camera), 405
Flickr, exporting to, 370
floating windows
panel management, 34, 43–45
photo viewing, 32
preference settings, 61
flyers, creating, 408–410
focal point, 401
fonts, 342
format attributes, 96
fringe removal, 251–252
full backups, 123
Full Screen view
context menus, opening, 130–131
editing and organizing, 128–129
overview, 126–128
viewing versus saving, 130
Fuzziness values, 247

gamma values
adjusting, 241
defined, 68
Gaussian Blur filters
Eraser, using with, 272
erasing with, 272
overview, 256–257
General preference panel, 64
GIF (CompuServe GIF) format, 90, 92
Golden Ratio (Golden Rectangle), 201–202
Google maps, placing photos on, 131–132
gradient mapping, 254
Gradient tool
  custom gradients, creating, 323–325
  overview, 321
  preset choices, 321–322
Graphic Novel filter, 281–282
graphics
  color choices, 87, 310
  creations, adding to, 390
  format and quality choices, 89
  pencil tool, using for, 312
  slideshows, adding to, 394
Graphics panel, 34, 43
grayscale images
  colorizing, 231, 244–245
  comics, creating with, 280
  converting to, 232, 244–246
  scanning in color, 22
Grayscale mode
  color data preservation, 84–85
  converting from RGB images, 84–86
  filtering in, 270
  overview, 84
  grid line selection, 47
Grow command, 175
Guided mode
  Adjust Color for Skin Tone command, accessing, 250
  Hue/Saturation command, accessing, 244
Out of Bounds effects, 53
overview, 51
Perfect Portrait effect, 53
Photo Stack effect, 53
Photomerge effect, 53
Quick mode versus, 51
Saturated Slide Film effect, 53
Soft Focus effect, 53–54
special effects, 53
Zoom Burst effect, 52–53
Guides & Grid preference pane, 62
halftones, 256–257
halo removal, 251–252
Help menus, 56–57
hidden photos, 141–142
histogram display, 239–240
Histogram panel, 44
History panel, 44, 137–138
Horizontal Type tool
  paragraph type, creating, 337–338
  point type, creating, 336
hue
  adjusting, 294
  defined, 243
Hue/Saturation command, 243–245
I-beam, using, 336, 339–340
icons
  editing and adding, 106–108
  enlarging, 110
  predefined, 110–111
  subcategory identification, 111
  timeline usage, 395
image correction. See also auto fix; clarity
  adjustments; color adjustments;
  contrast adjustments; lighting
  adjustments
Camera Raw format, advantages of, 242
cloning with Clone Stamp tool, 218–220
cloning with Healing Brush tool, 220–222
color replacement, 231–233
colorizing, 231
Content-Aware tool, moving with, 224–225
dodging and burning, 225–227
flaws, fixing, 217
image sharpening, 217
red eye removal, 212–213, 216, 231, 278–279
sharpening focus, 229–230
smudging, 227–228
softening effects, 228–229
special effects, adding, 217
sponging effects, 230–231
spot healing, 222–223
teeth whitening, 216–217
workflow suggestions, 236
image layers, 183–184
image window
  adding multiples, 35
  information box options, 36–37
  opening images, 34–35
  overview, 33, 35–36
images. See also image correction; Organizer; Photo Editor  
acquisition preference settings, 64  
Apple mobile device connections, 26–27  
backup options, 124  
captioning, 333  
cataloging, 119–122  
color correction, 210  
colorizing, 231, 241–245  
contrast correction, 210  
cropping options, 200–202  
dimension changes, 75–76  
distracting elements, removing, 300–301  
editing in Adobe Revel, 377–379  
exposure adjustments, 301–304  
external storage recommendations, 8  
facial recognition, 20–21  
file size management, 37  
Google maps, placing on, 131–132  
group shots, creating from multiple images, 298–299  
grouping, 141–144  
importing camera images directly, 11, 13–14  
importing options, 7, 11  
Media Browser, viewing in, 17–18  
menu bar options, 38  
mobile devices, acquiring from, 26  
panoramic photos, creating, 295–298  
pixel versus vector, 327  
Quick mode enhancement, 49–50  
raster versus vector, 72  
rating photos, 113–114  
recomposing options, 204–206  
red eye correction, 212–213  
resizing issues, 72, 327  
resolution choices, 73–75  
scanning, 22–25  
skin tone adjustments, 250–251  
social media, sharing on, 384–386  
sorting tagged photos, 111–112  
straightening, 203–204  
styles, transferring between images, 304–306  
text, adding, 333  
uploading with Dropbox or iTunes, 27  
View menu sorting, 124–125  
Impressionist Brush tool  
custom brushes, creating, 317  
overview, 316  
incremental backups, 123  
Indexed Color mode, 87  
Info panel, 44  
intensity, adjusting, 243–245  
interpolation  
cautions, 193  
scaling, 279  
inverting colors, 254  
iPad Camera Connection Kit, 27  
iPad/iPhone/iPod  
Camera Roll, saving to, 375–376  
photo downloads, 26  
sharing issues, 370, 397  
iPhoto image importing, 16  
Iris settings, 259  
iTunes, 27  

JPEG (Joint Photographic Experts Group) format  
data loss cautions, 92–95  
overview, 92–93  
progressive option, 93  
selecting, 90  

keyboard shortcuts, 41  
Keyword tags, 106  
Keyword Tags and Albums preference panel, 64  

Lasso tools  
freeform selections, 152–153  
Magnetic Lasso, 155–156  
overview, 152  
polygon selections, 153–154  
layers  
adjustment, 184–186, 262–265  
background conversions, 179  
copying, 189  
defringing selections, 251–252  
drag-and-drop, advantages of, 190–191  
duplicating, 190, 272  
fill, 186–187  
filters, applying, 272–273
layers (continued)
flattening, 196–197
gradients, filling with, 321–325
image, 183–184
layer masks, creating, 180, 183, 191, 298
Layers panel selections, 179–181
Layers panel versus Layers menu, 182
linking, 181–182
locking/unlocking, 181
Magic Eraser tool, sampling with, 171
Magic Wand selection of, 159
masking techniques, 194–195
menu bar options, 38
merging, 189, 195–197
Move tool options, 192
moving contents of, 192
multiple selections, adding, 188
naming, 181
new, creating, 188–190
outlines, adding, 319
overview, 177–178, 188
Paste into Selection command, 191
patterns, filling with, 325–327
printing, 180
Select menu adjustments, 183
selections, placing, 189
shape, 187–188, 327–329
shape tool choices, 328
Smart Brush adjustments, 262–264
styles, applying, 286–288
transforming, 193–194
type, overview, 188
type masks, 345–347
vector paths, converting to pixels, 187
Layers menu
Layers panel versus, 182
location of, 182
managing layers with, 182
Layers panel
Layers menu versus, 182
managing layers with, 179–181
overview, 42
leading, applying to text, 343
Lens Blur filter, 257–259
lens flare, avoiding, 404
Levels command, 239–242
library, Adobe Revel, 380–381
lighting adjustments
blend modes, using, 291–292
Brightness/Contrast command, 238–239
contrast corrections, 209–210, 239–242
gamma value changes, 241
photo composition suggestions, 404–405
Shadows/Highlights command, 237–238
lightness
adjusting, 247, 294
defined, 243
line art, 22
links
catalog files, 120
layer grouping, 181
layer styles, 286
Liquify filter, 275–277
Lomo effect, 53
luminance noise, 256
luminosity, adjusting, 294

M

Macs (Apple)
Adobe Revel, 2
AutoPlay Assistant, 11
backup options, 122–124
Control key equivalent, 2
Elements Editor location, 38
file formats, 93–94
iPhoto use, 11, 13, 16
launching Photoshop Elements, 9
Organizer choices, 102, 125–126
sample images locations, 35
scanning options, 24
scroll bar settings, 36
slideshow viewing, 126
thumbnail generation, 61
video editing, 64
video formats supported, 97
versus Windows, 124–126
Magic Eraser tool, 171
Magic Extractor tool, 171
Magic Wand tool
antialiasing choices, 159
base color selection, 158
contiguous pixel selection, 159
edge refinement, 159
Grow and Similar command, 175
multiple layer selection, 159
overview, 157
Tolerance settings, 157–159
Marquee tools
antialiasing, 150
Aspect menu, 151
circle and square selections, 149–150
edge refinement, 151
elliptical selections, 149
feathering, 150, 159
option choice before tool choice, 150
rectangular selections, 148
Width and Height values, 151
masking
Background Eraser options, 170–171
blending layers, 194–195
cropping masks, creating, 182
color channel gray levels, 66–67
Cookie Cutter tool options, 167–168
copying, 189
dragging layers, 195
layer masks, creating, 180, 183, 191, 298
output, sending to masks, 174
overview, 194
Paste into Selection command, 191
Selection Brush options, 161–163
Media Browser
album management, 115
facial recognition, 18–21
Import panel views, choosing, 17–18
overview, 17
rating images, 113
search options, 134
sorting rated images, 114
sorting tagged photos, 111–112
sorting thumbnails, 103
Media-Analysis preference panel, 64
menu bar, 38–39
menus
accessing within panels, 45
contextual, 45
Elements Help file, 56
Forum command, 57
Key Concepts help, 56
Support command, 56–57
Video Tutorials, 57
metadata
dates, 136
names, 134
overview, 138
searching, 138–139
mobile devices, downloading from, 26, 381
moiré patterns, 256–257
monitor calibration, 68, 353
Motion Blur filter, 257
Move tool
drag and drop operations, 147, 184, 190–191
layer transformations, 193–194
setting options, 192
MP3 file format (audio), 97
music, importing free files, 121

N

narration, adding to slideshows, 395
Navigator panel, 44
noise removal, 256
notes, adding and searching, 137

O

Old Fashioned Photo effect, 53
online sharing. See also Adobe Revel; Share panel
display planning, 370
exporting directly from Elements, 370–371
Flash conversion issues, 370
iPad/iPhone/iPod considerations, 370
overview, 369
security concerns, 385–386
social media websites, exporting to, 370–372
social networks, 384–386
storage space considerations, 370
uploading manually to websites, 371–372
Photoshop Elements 12 For Dummies

Organizer. See also facial recognition; Media Browser; preference settings
Adobe Revel albums, synching, 104
catalogs, importing, 10
color management, 65–70
Crop tool selection, 202
e-mail photo sharing, 382–383
event tagging, 105
Events creation and photo assignment, 133
folder management, 104
images, adding to folders, 14–15
images, tagging, 105
importing camera images directly, 11, 13–14
importing images from files and folders, 11–12
iPhoto image importing, 16
launching from Welcome screen, 9
launching Photo Editor, 30–31
map location tags, adding, 104
overview, 9–10, 101–105, 134
Quick mode options, 104
scanning images, 21–25
slide show searching, 105
Slideshow view, 126–128
social network sharing, 384–385
sorting tagged photos, 103, 111–112
tags, adding icons, 107–108
tags, creating, 105–107
tags, customizing, 109–110
thumbnails, 12, 17
View menu choices, 124–125
viewing options, 124
organizing photos. See also Organizer;
Search; tagging
cataloging overview, 119–120
downloading to computer, 10–11
external storage recommendations, 8
hiding images, 141–142
links, reestablishing, 120
sorting in folders, 8, 9, 131
stacking images, 142–143
version sets, 143–144
outlining selections, 319

Paint Bucket tool, 320
painting
Brush tool, using, 314–316
color choices, 307–312
Impressionist Brush tool, using, 316–317
Panel Bin Actions menu
album creation, 47
grid line selection, 47
Photomerge actions, 47
printing multiple images, 46
Style Bin reset, 47
panels. See also Tool Options panel;
Tools panel
accessing menus within, 45
Actions, 43–44
Adjustments, 44
Color Swatches, 44, 309, 310–311
creating and sharing, 45
Custom Workspace, 44
Effects, 43, 285
Favorites, 43
Graphics, 34, 43
Histogram, 44
History, 44, 137–138
Info, 44
Layers, 42, 179–182
menu bar options, 39
Navigator, 44
panning
enabling in slideshows, 393–394
Sync Panning and Zooming tool, 129
panoramic images, creating, 295–298
Pantone huey Pro, 68
paragraph type, 337
Paste into Selection command, 191
Pattern Stamp tool, 327
patterns
Clone Stamp tool, 327
custom, creating, 326–327
Paint Bucket tool, using, 320
Pattern Stamp tool, 326–327
preset choices, 325–326
PDD (Photoshop) format, 91
PDF (Portable Document Format) files
  cataloged in Organizer, 9
  copy shop printing from, 410
  exporting, 94, 397
  interactive, preparing, 89
  layers, supported in, 196
  overview, 93–94
  Photoshop Elements projects versus, 393
  scans, saving as, 24
  slide show creation, 126, 370, 396–397
  vector data retained, 72
Pencil tool
  Auto Erase, enabling, 314
  erasing with, 312
  overview, 312
  selecting and adjusting, 313–314
  straight lines, drawing, 314
People tags, 106
Perfect Portrait effect, 53
Photo Bin
  filename displays, 46
  image manipulation, 46
  Panel Bin Actions menu, 46–47
  thumbnail rearranging, 45
Photo Bin Options menu
  overview, 34
  thumbnails, adding to, 35
photo composition
  autofocus adjustments, 402
  background considerations, 401–402
  clutter removal, 402
  contrast, managing, 403
  depth of field effects, 257–259
  exposure bracketing, 302
  flash suggestions, 405
  focal point, establishing, 401
  framing ideas, 403
  leading lines, using, 404
  lighting suggestions, 404–405
  movement, considering, 406
  posing subjects, 405–406
  Rule of Thirds, 402
  scale, defining, 401
  viewpoint selection, 403
photo corrections. See also auto fix; clarity adjustments; color adjustments; contrast adjustments; lighting adjustments
Camera Raw format, advantages of, 242
cloning with Clone Stamp tool, 218–220
cloning with Healing Brush tool, 220–222
color replacement, 231–233
colorizing, 231
Content-Aware tool, moving with, 224–225
dodging and burning, 225–227
flaws, fixing, 217
image sharpening, 217
red eye removal, 212–213, 216, 231, 278–279
sharpening focus, 229–230
smudging, 227–228
softening effects, 228–229
special effects, adding, 217
sponging effects, 230–231
spot healing, 222–223
teeth whitening, 216–217
workflow suggestions, 236
Photo Downloader
  advantages of, 11
  importing camera images directly, 13–14
  mobile device support, 26–27
  organizing photos, issues with, 17
Photo Editor. See also layers; preference settings; selections
  contextual menus, 39
  creation wizard, 32
  creations, setting up, 388–392
  docking and undocking images, 32
  document creation, 47–49
  editing mode choices, 31
  Expert mode options, 32–34
  foreground image management, 32
  Guided mode options, 51–53
  help menus, 56–57
  launching methods, 30–31
  Layout choices menu, 33
  links, reestablishing, 120
  menu bar overview, 38–39
  multiple image opening, 32
  Organizer, returning to, 33
  overview, 29–30
Photoshop Elements 12 For Dummies

Photo Editor (continued)
Panel Bin options, 34
paragraph type, adding, 337–338
photo tabs, 32
Photomerge, accessing, 295
point type, adding, 336
printing from, 356
Quick mode options, 49–51
saving work regularly, 55–56
Slide Show projects, 392–396
Tool Options, 33
tool selections, 33
tooltips, 57
Undo History commands, 54–56
Photo Filter tool, 253
Photo Project Format (PSE), 92
Photo Stack effect, 53
Photomerge
composite commands, accessing, 295
exposure adjustments, 301–304
group shots, creating from multiple images, 298–299
Guided options choices, 53
hybrid faces, creating, 300
overview, 295
panoramic images, creating, 295–298
Scene Cleaner, using, 300–301
styles, transferring between images, 304–306
photos. See images; photo composition; photo corrections
Photoshop Elements Downloader
advantages of, 11
importing camera images directly, 13–14
mobile device support, 26–27
organizing photos, issues with, 17
Photoshop Elements Organizer. See facial recognition; Media Browser; Organizer; preference settings
Photoshop Elements Photo Editor. See layers; Photo Editor; preference settings; selections
Photoshop formats (PSD, PDD), 91
Photoshop PDF format. See PDF files
Photoshop.com library (obsolete), 380–381
Pixar format (PXR), 94
pixels
algorithm conversions, 81
antialiasing options, 150
defined, 66
filter versus layer style adjusting, 286
filters, altering with, 271
image output management, 72
interpolation, cautions about, 193
Liquify filter, manipulating with, 276
raster images, 72
relationship to resolution, 71
vector path conversions, 187
vectors versus, 327
Places tags, 106
plane of focus, 257
Plug-Ins preferences pane, 62
PNG (Portable Network Graphics) format
overview, 94
PNG-24 file format, 90
PNG-8 file format, 90
point type, 336
Portable Document Format. See PDF files
posterizing, 254
posters, designing, 410
preference settings
Allow Floating Documents, 61
changing panes, 61
common pane items, Organizer, 63
common pane items, Photo Editor, 61
Enable Floating Document Window Docking, 61
Organizer choices, 63–65
overview, 59–60
pane listing, Organizer, 64–65
pane listing, Photo Editor, 62–63
Photo Editor choices, 60–62
Premiere Elements, Adobe
free trial download, 384
instant video creation, 398
Mac options, 126, 371
mobile device support, 371
preset libraries, 65
Preset Manager, 65–66
printing
attributes, setting, 357, 361, 367
borders, 367
color management, Elements controlling, 362–367
color management, printer controlling, 357–362
contact sheets, 368
downsampling versus upsampling, 78–80
ink choices, 354–355
iron-on transfers, 367
management options, 355–356
More Options dialog box, 367
overview, 353
Photo Editor versus Organizer, 356
picture packages, 368
preferences, setting, 358–362
Print dialog box options, 365–366
printing from, 365–366
recommended resolutions chart, 80
resolution optimization, 73
testing output resolutions, 80
trim guidelines, 367
process color, 81
PSD (Photoshop) format, 91
PSE (Photo Project Format), 92
Puzzle effect, 53

Quick mode
  blurring commands, 256–259
color cast removal, 242–243
Correct Camera Distortion filter, 278–279
cropping options, 200–203
effects, applying, 285
Expert mode, returning to, 51
Expert mode versus, 50–51
hue/saturation changes, 243–245
Liquify filter, distorting with, 275–277
Organizer options, 104
overview, 49–50
photo correcting, 213–217
Shadows/Highlights command, 238
Sketch filters, 280
Unsharp Mask tool, 260–262
Quick Selection tool, 163–165
QuickTime file format, 97

Radial Blur filter, 257
rasterizing
data, 72
images, 72
text, 335, 345
rating images, 113–114
Recompose tool
  option settings, 204–206
  overview, 165–167
Reconstruct tool, 277
red eye correction, 212–213, 216, 231, 278–279
Red Eye Removal tool, 50, 212–213, 216
Refine Edge menu, 173–174
Refine Edge method, 159
Remove Color Cast command, 242–243
Replace Color command, 246–248
resampling
cropping versus, 76
dimensions and resolution, redefining, 77
downsampling versus upsampling, 78–80
methods chart, 78
options available, 77
resolution
cropping options, 200
display versus image, 72–75
image and display, 74–75
image dimension versus, 75–76
overview, 73
pixel versus vector images, 327
pixels, relationship to, 71
printing, recommended for, 80, 354
resampling choices, 76–77
screen size capabilities, 73
zooming consequences, 75
Restore Old Photo Guided Edit, 52
Revel (Adobe). See Adobe Revel
Revel Carousel, 380
Revert command, 55–56
RGB color channels. See channels
RLE (BMP) format, 92
rotate menu, 33
Rule of Thirds, 201, 402
Sampling methods, 233
Saturated Slide Film effect, 53
saturation
  adjusting, 294
  defined, 243
scaling
  edge extensions, 279
  layer styles versus elements, 288
layers, images in, 193
patterns, 186
Scanner preferences panel, 64
scanning
  bit depth choices, 22
Elements command options, 22–24
Elements plug-in installation, 22
gray scale versus color, 22
image size choices, 21–22
Mac options, 24
multiple image acquisition, 24
multiple image manipulation, 24–25
preference settings, 64
resolution and output choices, 21–22
scratch disk
  overview, 62
  RAM versus, 37
screen savers, creating, 407–408
SCSI (Small Computer System Interface), 21
Search
  advanced options, 134–135
  Boolean expressions, using, 134
captions and notes, 137
date options, 136
duplicate photos, 139–140
history of operations, 137–138
Media Browser, accessing from, 134–135
metadata, 134, 138–139
objects in photos, 140–141
similar photos, 139
untagged items, 136
security, Adobe Revel, 379, 385–386
Select menu, 183
Selection Brush, 161–163
selections. See also Lasso tools; Magic Wand tool; Marquee tools
  border modification, 159–161
borders, outlines, and marquees, 148
  defining image area, 147
digital drawing tablet use, 152
digitizing tools, 152
edge refinement, 173–175
Expert mode required, 148
feathering options, 172
filling, 317–319
gradients, filling with, 321–325
inversing actions, 172
keyboard collision issues, 160–161
outlining, 319
Paint Bucket tool, coloring with, 320
patterns, filling with, 325–327
reselecting and restoring, 172
saving and loading, 175
type masks, 345–347
Shadows/Highlights command, 237–238
shape layers, 187–188, 327–329
shapes
  drawing tools, adjusting, 328–329
drawing tools, choosing, 328
digitizing tools, 152
ingredients, 152
editing, 331–332
filters, applying, 332
geometry options, specifying, 330–331
multiple selections, adding to layers, 329
vector-based, converting into pixel-based, 332
Share panel
  e-mailing photos from, 382–383
  overview, 381–382
sharing, online. See also Adobe Revel; Share panel
display planning, 370
exporting directly from Elements, 370–371
Flash conversion issues, 370
iPad/iPhone/iPod considerations, 370
overview, 369
security concerns, 385–386
social media websites, exporting to, 370–372
social networks, 384–386
storage space considerations, 370
uploading manually to websites, 371–372
sharing images, 116–117
Sharing preference panel, 64
Sharpen tool, 229–230
sharpening techniques
  overview, 259
  Unsharp Mask tool, 260–262
Similar command, 175
simplified (rasterized) text, 335, 345
Slide Show Output Wizard, 396–397
Slideshow toolbar
  context menus, opening, 130–131
  editing and organizing, 128–129
  overview, 126–128
  toolbar options, 129–130
  viewing versus saving, 130
slideshows
  audio/media, adding, 395–396
  editing, 393
  exporting, 396–397
  graphics, adding, 394
  Mac versus Windows, 387–388
  narration, adding to, 395
  overview, 392–393
  photos, selecting, 393
  previewing, 396
  sharing online, 370
  Slide Show Output Wizard, 396–397
  Slide Show projects, creating, 393–396
  text, adding, 394–395
  transitions, 395
  zooming and panning, enabling, 393–394
Small Computer System Interface (SCSI), 21
Smart Albums, 118
Smart Blur filter, 257
Smart Brush tools, 262–265
Smudge tool, 227–228
SmugMug, exporting photos directly to, 370
  social networks, sharing on, 370–372,
  384–386. See also Adobe Revel
Soft Focus effect, 53
sorting
  Adobe Revel options, 376
  filenames, 135
  tagged photos, 111–112
special effects
  blurring, 256–259
  color mapping, 253–254
  comics, creating, 280–281
  dissolving, 289
  filters, creating with, 271
  Fluorescent Chalk effects, 284–285
  graphic novel, creating, 281–282
  Guided panel options, 53
  impressionism, 316
  layer styles, 286–288
  Liquify filter, distorting with, 275–277
  Lomo, 53
  Old Fashioned Photo, 53
  Pen and Ink filter, 283
  Perfect Portrait, 53–54
  printing options, 367–368
  Puzzle, 53
  Saturated Slide Film, 53
  Smart Brush adjustments, 262–265
  Soft Focus, 53
  text effects, 345–350
  Sponge tool, 230–231
  Spot Healing Brush, 222–223
  sRGB workspace, 69
  stacking photos, 142–143
  Straighten tool, 203–204
  Stroke command, 318–319
  Style Bin reset, 47
  Style Eraser, 305
  styles. See also Photomerge
    applying, 286–287
    choices, 287
    editing and organizing, 288
    overview, 286
  subcategories, 111. See also tagging
  Surface Blur filter, 257
  Sync Panning and Zooming tool, 129
  synching with Organizer, 380–381

• T •
tagged files
  finding untagged, 136
  searching in Organizer, 103
Tagged Image File Format (TIFF)
  advantages, 94
  compression options, 95
tagging
  category choices, 106–107
  creating and naming, 107
  default versus custom, 109
  icons, editing and adding, 106–108
  overview, 105
  photo selection, 107
  subcategory management, 111
Tags panel
  custom tag creation, 106–107
  custom tag management, 109–110
  default tag modification, 110
  icons, editing and adding, 106–108
  overview, 105
  subcategory management, 111
  temperature filters, 252–253

Text. See also type tools
  alignment options, 343
  color options, 342
  editing, 344
  font options, 342–343
  layers, adding to, 188
  leading, applying, 343
  opacity, adjusting, 348
  orientation options, 344
  overview, 349
  paragraph type mode, 337–338
  path type mode, 338–341
  point type mode, 335–336
  rasterized (simplified), 335, 345
  slideshows, adding to, 394–395
  special effects, 347–350
  type masks, using, 345–347
  vector versus raster, 335, 345

Text formats, 335
  Text On Custom Path tool, 334, 341
  Text On Selection tool, 334, 338–339
  Text On Shape tool, 334, 339–340
  themes, selecting for creations, 389–390
  threshold effect, 254

Thumbnails
  Adobe Revel display, 376
  corrupted file indications, 122
  filtering with, 273–275
  image browsing, 17
  image correction, 215–216
  links versus image copies, 12
  multiple opening, 32
  Photo Bin display, 33, 45
  printing from, 365–366
  rearranging, 45
  saving files as, 89
  sorting in Media Browser, 103

TIFF (Tagged Image File Format)
  advantages, 94
  compression options, 95
  timeline
  slideshow creations, 393
  sorting photos with, 125

Tolerance settings
  Color Replacement tool, 231–233
  Impressionist Brush tool, 316
  Magic Wand tool, 42, 157–158
  overview, 157
  Paint Bucket tool, 320
  tonal range improvements, 207–208, 225, 248–249

Tool Options menu, 33

Tool Options panel
  adjusting tool features, 33, 42
  Background Eraser choices, 170
  Brushes and Erasers choices, 165–166
  brush-tip adjustments, 65
  cloning tool choices, 218–222
  Color Replacement tool choices, 232–233
  Cookie Cutter choices, 167–168
  Crop choices, 200–202
  Eraser choices, 169
  Grow and Similar command tolerances, 175
  Lasso tool, adjusting, 152–153
  layer tool choices, 192
  Magic Eraser choices, 171
  Magic Wand, adjusting, 158–159
  Magnetic Lasso, adjusting, 155
  Marquee tool, adjusting, 149–150
  Move tool settings, 192
  overview, 42
  Quick Selection tool adjustments, 163–164
  Refine Edge choices, 173–174
  Selection Brush, adjusting, 161–162
  selection options, 160–161
  shape tool choices, 328–329
  shapes, geometry options for, 330–331
  Smart Brush adjustments, 262–264
  Smudge tool choices, 228
  Spot Healing Brush choices, 222–223
  tools, finding additional, 40
Type formatting choices, 188
Type tool choices, 342–344
Tools panel
  Background Eraser, 169–170
  Cookie Cutter tool, 167–168
  Eraser tool, 169
  Eyedropper, 311–312
  Horizontal Type tool, 336–337
  Impressionist Brush, 320
  keyboard shortcuts, 41
  Lasso tool, 152–156
  Magic Eraser tool, 171
  Magic Extractor tool, 171
  Magic Wand, 157–159
  Marquee tools, 148–151
  Paint Bucket, 320
  Pencil, 312–314
  Quick Selection tool, 163–165
  Recompose, 165–167, 204–206
  Selection Brushes, 161–163
  shape tool choices, 328
  Tool Options, 42
  tool selection /deselection, 41
  tooltips, 57
  touchscreen monitor support, 236
  Transparency preference pane, 62
  Twitter, exporting photos directly to, 370
  type layers
    layer styles, applying, 286–288
    layers menu, accessing from, 182, 336
    opacity, adjusting, 348
    overview, 188
    select menu, accessing from, 183
    type tools, using, 334
  Type Mask tool
    mode choices, 334–335
    overview, 334
  type masks, 346–347
  Type preference pane, 62
  Type tool
    mode choices, 334–335
    text, adding to layers, 188
    type tools. See also text
      mode choices, 334–335
      overview, 333
      special effects, 347–350
  Text On Custom Path, 334, 341
  Text On Selection, 334, 338–339
  Text On Shape, 334, 339–340
  Type, 188, 334–335
  Type Mask tool, 334, 346–347
  Undo History command
    freeing memory for speed, 55
    limitations, 55
    progressive editing with, 54–55
    saving work regularly, 55–56
    undocked photos, 32
  Units & Rulers preference pane, 62
  Unsharp Mask preference pane, 62
  vector images, 72, 327
  vector paths, converting to pixels, 187
  version sets, 143–144
  videos
    exporting, 396–397
    formats supported, 97
    Premiere Elements advantages, 398
    sharing online, 371
  View menu, 124–125
  Vimeo, exporting videos directly to, 370
  WAV file format (audio), 97
  web file formats, 89–91
  white balance settings, 242, 253
  Whiten Teeth tool, 216–217
  Windows
    Adobe Revel, 2
    AutoPlay Assistant, 11
    backup options, 122–124
    Control key equivalent, 2
    Elements Editor location, 38
    file formats, 93–94
    iPhoto use, 11, 13, 16
Windows (continued)
launching Photoshop Elements, 9
versus Mac, 124–126
Organizer choices, 102, 125–126
sample images locations, 35
scanning options, 24
scroll bar settings, 36
slideshow viewing, 126
thumbnail generation, 61
video editing, 64
video formats supported, 97
Windows Media Player (WMV) files, 97, 397
WMA file format (audio), 97

YouTube, exporting videos directly to, 370

Zoom Burst effect, 52–53
zooming
camera images, enlarging, 75
Liquify filter effects, 277
menu bar options, 39
Quick mode navigation, 214–215
resolution, effects on, 74–75
Sketch filters, 280
slideshows, enabling for, 393–394
About the Authors

Barbara Obermeier is the principal of Obermeier Design, a graphic design studio in Ventura, California. She is the author of Photoshop CS6 All-in-One For Dummies and has contributed as author or co-author on over two dozen books on Photoshop, Photoshop Elements, Illustrator, PowerPoint, and digital photography for John Wiley & Sons, Peachpit Press, and Adobe Press. She is currently a faculty member in the School of Design at Brooks Institute.

Ted Padova is the former chief executive officer and managing partner of The Image Source Digital Imaging and Photo Finishing Centers of Ventura and Thousand Oaks, California. He has been involved in digital imaging since founding a service bureau in 1990. He retired from his company in 2005 and now spends his time writing and speaking on Acrobat, PDF forms, LiveCycle Designer forms, and Adobe Design Premium Suite applications.

Ted has written more than 50 computer books and is the world’s leading author on Adobe Acrobat. He has written books on Adobe Acrobat, Adobe Photoshop, Adobe Photoshop Elements, Adobe Reader, Microsoft PowerPoint, and Adobe Illustrator. Recent books published by John Wiley & Sons include Adobe Acrobat PDF Bible (versions 4, 5, 6, 7, 8, 9, and X), Acrobat and LiveCycle Designer Forms Bible, Adobe Creative Suite Bible (versions CS, CS2, CS3, CS4, and CS5), Color Correction for Digital Photographers Only, Microsoft PowerPoint 2007 For Dummies: Just the Steps, Creating Adobe Acrobat PDF Forms, Teach Yourself Visually Acrobat 5, and Adobe Acrobat 6.0 Complete Course. He also coauthored Adobe Illustrator Master Class — Illustrator Illuminated and wrote Adobe Reader Revealed for Peachpit/Adobe Press.

Authors’ Acknowledgments

We would like to thank our excellent project editor, Rebecca Senninger, who kept us on track throughout the development of this work; Bob Woerner, our great and very supportive executive editor; Andy Cummings, For Dummies royalty; Dennis Cohen, technical editing wizard, who made what we wrote sound better; and all the dedicated production staff at Wiley.

Barbara Obermeier: A special thanks to Ted Padova, my co-author and friend, who always reminds me there is still a 1 in 53 million chance that we can win the lottery.

Ted Padova: As always, I’d like to thank Barbara Obermeier for her continued collaborations and lasting friendship. Also, a special thanks to Regis and Malou Pelletier; Curtis and Grace Cooper; Irene Windley; Mike Bindi; and my bridge buddies Stefan, George, and Richard for all their special modeling assistance. A very special thank you to my friend Giuseppe Morisco of MasterChef Season 2 fame and host of www.foodloversretreats.com for posing in many photos and offering me some of his great cooking secrets.
Publisher's Acknowledgments

Executive Editor: Bob Woerner
Project Editor: Rebecca Senninger
Copy Editor: Virginia Sanders
Technical Editor: Dennis Cohen
Editorial Assistant: Annie Sullivan
Sr. Editorial Assistant: Cherie Case

Project Coordinator: Katherine Crocker

Front Cover Image: Courtesy of
Barbara Obermeier; Girl with Pinwheel ©iStockphoto.com/FurmanAnna; Field and Sky ©iStockphoto.com/R-J-Seymour; Butterflies ©iStockphoto.com/imv; Decorative Line Art ©pixel77.com.

Back Cover Images: (left) Portrait of Woman ©iStockphoto.com/OlsenMatt; Flower Overlay ©iStockphoto.com/Elpiniki; (right) Portrait of Children ©iStockphoto.com/ImagesbyTrista.
Mobile Apps
FOR
DUMMIES

There’s a Dummies App for This and That

With more than 200 million books in print and over 1,600 unique titles, Dummies is a global leader in how-to information. Now you can get the same great Dummies information in an App. With topics such as Wine, Spanish, Digital Photography, Certification, and more, you’ll have instant access to the topics you need to know in a format you can trust.

To get information on all our Dummies apps, visit the following:

www.Dummies.com/go/mobile from your computer.